Introduction

This document is the reference manual for ProSafe-RS engineering functions. Usage and cautions for engineering functions to generate SCS applications are described. You can read the chapters for your necessary information.

The structure of this manual is as follows:

• Chapter 1: Common Items to Engineering Functions
  Describes specifications common to engineering tasks. You need to read this chapter if you want to understand the specifications common to Builders and SCS Manager used for engineering.

• Chapter 2: ProSafe-RS Projects
  Describes relations of Projects used by the ProSafe-RS and how to define RS Project. You need to read this chapter if you want to understand the relations between the ProSafe-RS projects and CENTUM projects.

• Chapter 3: Operations on SCS Projects
  How to operate an SCS project is explained in this chapter. You need to read this chapter if you want to understand about operation the SCS projects.

• Chapter 4: Definitions of Inputs/Outputs
  How to use the related tools for configuring the inputs and outputs are outlined in this chapter. You need to read this chapter if you want to understand about I/O Wiring View or I/O Parameter Builder regarding the configuration of the inputs and outputs.

• Chapter 5: Creation of Application Logic
  Describes how to display the windows for creating application logics and how to define inter-SCS safety communications and SCS Link Transmission. You need to read this chapter if you want to understand the engineering for inter-SCS safety communications and SCS Link Transmission.

• Chapter 6: Library Projects
  The concepts of the library projects used by multiple SCSs are explained in this chapter. You need to read this chapter if you want to understand about procedures and cautions for generating the library projects.

• Chapter 7: SOE Collection Definition
  The engineering works regarding the SCS SOE (Sequence of Events) collection are explained in this chapter. You need to read this chapter if you want to understand about the settings for events.

• Chapter 8: Safety Analyzers
  The features and usages of Integrity Analyzer and Cross Reference Analyzer for safety applications are explained in this chapter. You need to read this chapter if you want to understand about the analysis procedures for the safety analyzers.

• Chapter 9: Types of Downloading
How to download applications from SENG to SCS is explained in this chapter. You need to read this chapter if you want to understand about offline download, online change download and master database offline download.

• Chapter 10 : Self Documentation
  How to apply the self-documentation capability to print out the application documents is explained in this chapter. You need to read this chapter if you want to understand about the self-documentation details, settings of print range and print contents.

• Chapter 11 : Database Validity Check Tool
  How to use the tools to check the validities of the databases in SENG or SCS is explained in this chapter. You need to read this chapter if you want to understand about the detailed procedures for checking the database validities.

• Chapter 12 : Master Database Restoring Function
  When discrepancies are found between the databases in SENG and SCS, how to use the tool to restore the master database so as to equalize the databases in SENG and SCS is explained in this chapter. You need to read this chapter if you want to understand about the detailed usages of the tool as well as the settings such as restoring ranges of the database.

• Chapter 13 : Version Control
  How to use a tool to control the versions in accordance with the SCS project modifications is explained in this chapter. You need to read this chapter if you want to understand about database check-in and check-out as well as the details of version control.

• Chapter 14 : Import/Export
  Describes import/export functions for SCS project files. You need to read this chapter when you reuse applications.

• Chapter 15 : Project Comparing Tool
  You need to read this chapter when you use the Project Comparing Tool to check differences between two SCS projects.

• Chapter 16 : Access Control/Operation History Management Function
  The access control/operation history management function controls security on an individual SENG user basis. You need to read this chapter when you use the CHS5170 Access Control and Operation History Management Package.
Safety Precautions for Use

Safety, Protection, and Modification of the Product

• To protect the system controlled by the Product and the Product itself and to ensure safe operation, please observe the safety precautions described in this Manual. Yokogawa Electric Corporation (“YOKOGAWA”) assumes no liability for safety if users fail to observe the safety precautions and instructions when operating the Product.

• If the Product is used in a manner not specified in the User’s Manuals, the protection provided by the Product may be impaired.

• If any protection or safety circuit is required for the system controlled by the Product or for the Product itself, please install it externally.

• Use only spare parts that are approved by YOKOGAWA when replacing parts or consumables of the Product.

• Do not use the Product and its accessories such as power cords on devices that are not approved by YOKOGAWA. Do not use the Product and its accessories for any purpose other than those intended by YOKOGAWA.

• Modification of the Product is strictly prohibited.

• The following symbols are used in the Product and User’s Manuals to indicate the accompanying safety precautions:
  - Indicates that caution is required for operation. This symbol is labeled on the Product to refer the user to the User’s Manuals for necessary actions or behaviors in order to protect the operator and the equipment against dangers such as electric shock. In the User’s Manuals, you will find the precautions necessary to prevent physical injury or death, which may be caused by accidents, such as electric shock resulting from operational mistakes.
  - Identifies a protective conductor terminal. Before using the Product, you must ground the protective conductor terminal to avoid electric shock.
  - Identifies a functional grounding terminal. A terminal marked “FG” also has the same function. This terminal is used for grounding other than protective grounding. Before using the Product, you must ground this terminal.
  - Indicates an AC supply.
  - Indicates a DC supply.
  - Indicates the ON position of a power on/off switch.
  - Indicates the OFF position of a power on/off switch.

Notes on Handling User’s Manuals

• Hand over the User’s Manuals to your end users so that they can keep the User’s Manuals on hand for convenient reference.

• Thoroughly read and understand the information in the User’s Manuals before using the Product.

• For the avoidance of doubt, the purpose of the User’s Manuals is not to warrant that the Product is suitable for any particular purpose but to describe the functional details of the Product.

• Contents of the User’s Manuals are subject to change without notice.
• Every effort has been made to ensure the accuracy of contents in the User's Manuals. However, should you have any questions or find any errors, contact us or your local distributor. The User's Manuals with unordered or missing pages will be replaced.

■ Warning and Disclaimer
• Except as specified in the warranty terms, YOKOGAWA shall not provide any warranty for the Product.
• YOKOGAWA shall not be liable for any indirect or consequential loss incurred by either using or not being able to use the Product.

■ Notes on Software
• YOKOGAWA makes no warranties, either expressed or implied, with respect to the Software Product's merchantability or suitability for any particular purpose, except as specified in the warranty terms.
• Purchase the appropriate number of licenses of the Software Product according to the number of computers to be used.
• No copy of the Software Product may be made for any purpose other than backup; otherwise, it is deemed as an infringement of YOKOGAWA's Intellectual Property rights.
• Keep the software medium of the Software Product in a safe place.
• No reverse engineering, reverse compiling, reverse assembling, or converting the Software Product to human-readable format may be performed for the Software Product.
• No part of the Software Product may be transferred, converted, or sublet for use by any third-party, without prior written consent from YOKOGAWA.
Documentation Conventions

Symbols

The following symbols are used in the User’s Manuals.

- **CAUTION**
  Identifies instructions that must be observed to avoid physical injury, electric shock, or death.

- **WARNING**
  Identifies instructions that must be observed to prevent damage to the software or hardware, or system failures of the Product.

- **IMPORTANT**
  Identifies important information required to understand operations or functions.

- **TIP**
  Identifies additional information.

- **SEE ALSO**
  Identifies referenced content.

In online manuals, you can view the referenced content by clicking the links that are in green text. However, this action does not apply to the links that are in black text.

Typographical Conventions

The following typographical conventions are used throughout the User’s Manuals.

- **Commonly Used Conventions throughout the User’s Manuals**
  - **Δ Mark**
    Indicates that a space must be entered between character strings.
    **Example:**
    \[ .ALΔPIC010Δ-SC \]
  - **Character string enclosed by braces {}**
    Indicates character strings that may be omitted.
    **Example:**
    \[ .PRΔTAG{Δ.sheet name} \]

- **Conventions Used to Show Key or Button Operations**
  - **Characters enclosed by brackets []**
    When characters are enclosed by brackets in the description of a key or button operation, it indicates a key on the keyboard, a button name in a window, or an item in a list box displayed in a window.
    **Example:**
    To alter the function, press the [ESC] key.

- **Conventions of a User-defined Folder**
  - **User-defined folder name enclosed by parenthesis ( )**
    User definable path is written in a pair of parentheses.
    **Example:**
    \( (RS\ Project\ Folder)\SCS0101 \)
If the RS Project Folder is C:\MYRJPJT, the above path becomes C:\MYRJPJT\SCS0101.

## Drawing Conventions

Drawings used in the User’s Manuals may be partially emphasized, simplified, or omitted for the convenience of description.

Drawings of windows may be slightly different from the actual screenshots with different settings or fonts. The difference does not hamper the understanding of basic functionalities and operation and monitoring tasks.

### Integration with CENTUM

The Product can be integrated with CENTUM VP or CENTUM CS 3000. In the User’s Manuals, the integration with CENTUM VP or CENTUM CS 3000 is referred to as “Integration with CENTUM.”

In the User’s Manuals, the explanations for integrating the Product with CENTUM VP or CENTUM CS 3000, the glossary for various features of CENTUM VP is used instead of the glossary for CENTUM CS 3000. For example, the term “CENTUM VP System Alarm View” is used instead of “CENTUM CS 3000 System Alarm window.” Nevertheless, if the features for integrating the Product with CENTUM VP and CENTUM CS 3000 are different, both features will be explained separately.

### Explanation of Hardware and Software Behaviors in the User’s Manuals

In the User’s Manuals, system behaviors are explained assuming that the latest versions of YOKOGAWA software and hardware at the time of publication of the User’s Manuals are installed.

If additional precise information about the safety of legacy versions of software or hardware is required, a link to the corresponding explanation is provided. Please refer to the information according to your system.

### Station Types

A safety control station (hereafter referred to as SCS) is named according to the type of the safety control unit used in it.

<table>
<thead>
<tr>
<th>Name of SCS</th>
<th>Model of the safety control unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>SCSV1-S</td>
<td>SSC10S/SSC10D</td>
</tr>
<tr>
<td>SCSP1-S</td>
<td>SSC50S/SSC50D</td>
</tr>
<tr>
<td>SCSP2-S</td>
<td>SSC60S/SSC60D</td>
</tr>
<tr>
<td>SCSU1-S</td>
<td>SSC57S/SSC57D</td>
</tr>
</tbody>
</table>

In the User’s Manuals, the following abbreviations may be used to describe functions of these SCS as a whole.
• SCSV1: Abbreviation of SCSV1-S
• SCSP1: Abbreviation of SCSP1-S
• SCSP2: Abbreviation of SCSP2-S
• SCSU1: Abbreviation of SCSU1-S
Copyright and Trademark Notices

All Rights Reserved

The copyright of the programs and online manuals contained in the software medium of the Software Product shall remain with YOKOGAWA.

You are allowed to print the required pages of the online manuals for the purposes of using or operating the Product; however, reprinting or reproducing the entire document is strictly prohibited by the Copyright Law.

Except as stated above, no part of the online manuals may be reproduced, transferred, sold, or distributed to a third party in any manner (either in electronic or written form including, without limitation, in the forms of paper documents, electronic media, and transmission via the network). Nor it may be registered or recorded in the media such as films without permission.

Trademark Acknowledgments

• CENTUM, ProSafe, Vnet/IP, and STARDOM are registered trademarks of YOKOGAWA.
• Microsoft, Windows, Windows Vista, Windows Server, Visual Basic, Visual C++, and Visual Studio are either registered trademarks or trademarks of Microsoft Corporation in the United States and other countries.
• Adobe, Acrobat, and Adobe Reader are registered trademarks of Adobe Systems Incorporated.
• Ethernet is a registered trademark of Xerox Corporation.
• HART is a registered trademark of the HART Communication Foundation.
• Modicon and Modbus are registered trademarks of Schneider Electric SA.
• All other company and product names mentioned in the User's Manuals are trademarks or registered trademarks of their respective companies.
• TM or ® mark are not used to indicate trademarks or registered trademarks in the User's Manuals.
• Logos and logo marks are not used in the User’s Manuals.
CONTENTS

1. Common Items to Engineering Functions................................. 1-1
   1.1 SCS Manager................................................................. 1-2
   1.2 Window Components Common to Builders.......................... 1-6
   1.3 Builder Environment Tool............................................. 1-10

2. ProSafe-RS Projects............................................................. 2-1
   2.1 Definitions of RS Projects............................................. 2-3
   2.2 Relationship Between ProSafe-RS Projects and CENTUM Projects...... 2-5

3. Operations on SCS Projects................................................... 3-1
   3.1 Creation of New SCS Projects........................................ 3-2
      3.1.1 SCS Project Creation Procedure............................. 3-3
      3.1.2 SCS Project Properties Dialog Box........................... 3-5
      3.1.3 SCS Constants Builder........................................... 3-8
   3.2 Opening and Closing SCS Projects.................................. 3-13
   3.3 Backing up SCS Projects............................................. 3-14

4. Definitions of Inputs/Outputs............................................... 4-1
   4.1 Input/Output Module Types........................................... 4-2
   4.2 Input/Output Definition Operations................................ 4-3
   4.3 I/O Wiring View.......................................................... 4-4
   4.4 I/O Parameter Builder.................................................. 4-10

5. Creation of Application Logic............................................... 5-1
   5.1 Windows Used to Create Application Logic....................... 5-2
   5.2 Inter-SCS Safety Communication Definition..................... 5-4
   5.3 SCS Link Transmission Definition................................ 5-11
   5.4 Procedure after Creating Application Logic..................... 5-21

6. Library Projects............................................................... 6-1
   6.1 Creation of Library Projects....................................... 6-2
   6.2 Items Set for Library Projects..................................... 6-4
   6.3 Precautions on Library Projects.................................... 6-6

7. SOER Collection Definition................................................ 7-1
   7.1 Definition of Event Collection Objects.......................... 7-2
   7.2 Selection of Time Synchronization Method......................... 7-4
15.3 Comparing Two SCS Projects .......................................................... 15-6

15.4 Checking Contents of Detected Differences ..................................... 15-11
  15.4.1 Displaying Detailed Differences .............................................. 15-12
  15.4.2 Printing Detailed Differences .................................................. 15-15

16. Access Control/Operation History Management Function .............. 16-1

  16.1 Overview of Access Control/Operation History Management .......... 16-2
    16.1.1 Overview of Access Control for Engineers.......................... 16-4
    16.1.2 Structure of Access Control/Operation History Management Function .................................................. 16-5
    16.1.3 Access Control/Operation History Management Target Operation List .............................................................. 16-7

  16.2 Setting Up Access Control/Operation History Management ............ 16-10
    16.2.1 Settings for Access Control ................................................ 16-12
    16.2.2 Setup Related to Operation History Management .................. 16-15
    16.2.3 Registering Engineers ...................................................... 16-19
    16.2.4 Starting Operation History Management .............................. 16-33
    16.2.5 Window Configuration of Engineers' Account Builder ............. 16-34

  16.3 Operations of SENG That Use Access Control/Operation History Management ................................................................. 16-36
    16.3.1 Engineer Operations under Access Control ......................... 16-37
    16.3.2 Operations Performed by Administrators ............................ 16-41

  16.4 Browsing Operation History Data .................................................... 16-51
    16.4.1 Browsing and Printing Operation Logs ............................... 16-52
    16.4.2 Browsing and Printing Modification Files ......................... 16-59
    16.4.3 Steps to Browse Backed-up Operation History Database .......... 16-67
    16.4.4 Lists of Viewer Tool Buttons .............................................. 16-68

  16.5 Detailed Information of Access Control/Operation History Management ................................................................. 16-70
    16.5.1 Operation History Database Structure ............................... 16-71
    16.5.2 Access Rights Category List .............................................. 16-73
    16.5.3 Information Recorded in Operation Logs ............................. 16-77
1. Common Items to Engineering Functions

The ProSafe-RS engineering functions are used to perform engineering tasks and maintenance of applications that run on SCSs. These functions run on the SENG.

This chapter describes the specifications that are common to the SCS Manager and Builders used for engineering.

SEE ALSO
For more information about an overview of the functions used in engineering, refer to:


For more information about an overview of the builders and tools used for engineering, refer to:

1.1 SCS Manager

SCS Manager is used to make definitions related to SCS projects.

From the [Tools] menu of SCS Manager, three launchers can be started.

From each launcher, various engineering functions such as builders, SCS related tools and SCS Maintenance Support Tool can be launched. This section mainly explains the launchers started from SCS Manager.

Starting and Closing SCS Manager

The following explains how to start and close SCS Manager.

- **Starting SCS Manager**

  Select [All Programs] > [YOKOGAWA ProSafe] > [Workbench] from the [Start] menu of Windows. SCS Manager starts up.

  **TIP**

  It is not possible to open SCS Manager and Version Control Tool, or to open SCS Manager and Master Database Restoring Function at the same time.

- **Closing SCS Manager**

  Select [Exit] from the [File] menu.

  **TIP**

  - When you close SCS Manager, builders and launchers started from the [Tools] menu are closed as well.
  
  - If the SCS security level is other than Level 2 when closing SCS Manager, a warning message is displayed. SCS Manager closes even if the security level is other than Level 2. To recover the security level to Level 2, restart SCS Manager and change the level using the security level operation function.

Starting and Closing Launchers

From the [Tools] menu of SCS Manager, the following three launchers can be started.

- **[Engineering]**

  Starts the Engineering launcher such as builders.

- **[Controller]**

  Starts the SCS launcher.

- **[Maintenance]**

  Starts the Maintenance launcher.

**TIP**

The menu items for starting launchers are also displayed in the pop-up menu opened by right-clicking when a configuration and/or resource are selected in SCS Manager or Dictionary View is opened.

- **Starting Launchers**

  Each launcher is started from the [Tools] menu. If the same launcher has already been started, a new launcher is not started; instead, the already started launcher is displayed on the foreground and given the focus.

  The Engineering launcher and the Maintenance launcher have a push-pin icon. If you place the push-pin icon in the pressed status, the corresponding launcher is always displayed on the foreground without being hidden by other windows. If you disable the push-pin icon, the launcher may be hidden by other windows.

  The Controller launcher is always displayed on the foreground.

  If two or more launchers are set to be displayed on the foreground, the launcher started up later is displayed on the foreground.
### Closing Launchers

Each launcher is closed if you click "Close" button of the launcher or close SCS Manager. If you close a launcher by clicking "Close" button, only the launcher is closed and windows opened from the launcher are not closed.

The Controller launcher closes if a menu is selected and the corresponding tool is started.

### Engineering Launcher

The table below shows builders and tools that can be started from the Engineering launcher.

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>SCS Project Properties</td>
<td>Opens the SCS Project Properties dialog box</td>
</tr>
<tr>
<td>SCS Constants Builder</td>
<td>Starts SCS Constants Builder</td>
</tr>
<tr>
<td>I/O Parameter Builder</td>
<td>Starts I/O Parameter Builder</td>
</tr>
<tr>
<td>Communication I/O Builder</td>
<td>Starts Communication I/O Builder</td>
</tr>
<tr>
<td>SCS Link Transmission Builder</td>
<td>Starts SCS Link Transmission Builder</td>
</tr>
<tr>
<td>Modbus Address Builder</td>
<td>Starts Modbus Address Builder</td>
</tr>
<tr>
<td>DNP3 Communication Builder (*1)</td>
<td>Starts DNP3 Communication Builder</td>
</tr>
<tr>
<td>Tag Name Builder (*2)</td>
<td>Starts Tag Name Builder</td>
</tr>
<tr>
<td>Alarm Priority Builder (*2)</td>
<td>Starts Alarm Priority Builder</td>
</tr>
<tr>
<td>Alarm Processing Table Builder (*2)</td>
<td>Starts Alarm Processing Table Builder</td>
</tr>
<tr>
<td>Integrity Analyzer</td>
<td>Starts Integrity Analyzer</td>
</tr>
<tr>
<td>Cross Reference Analyzer</td>
<td>Starts Cross Reference Analyzer</td>
</tr>
<tr>
<td>Database Validity Check</td>
<td>Starts Database Validity Check Tool</td>
</tr>
<tr>
<td>SCS Information</td>
<td>Opens the SCS Information dialog box</td>
</tr>
</tbody>
</table>

*1: DNP3 Communication Builder is displayed only for the SCS projects of SCSU1 that are created by the software version R3.02.20 or later.

*2: Only opened in the case of CENTUM integration structures.

If a library project is open in SCS Manager, only the [SCS Project Properties] and [Integrity Analyzer] menu items are displayed.

### Controller Launcher

The table below shows tools that can be started from the Controller launcher.

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save Operation Marks (*1)</td>
<td>Save the operation marks set on CENTUM HIS to SENG</td>
</tr>
<tr>
<td>Download Operation Marks (*1)</td>
<td>Download the saved operation marks to SCS</td>
</tr>
<tr>
<td>Reset SCS</td>
<td>Restarts an SCS</td>
</tr>
<tr>
<td>Master Database Offline Download</td>
<td>Performs master database offline download</td>
</tr>
</tbody>
</table>

*1: Only opened in the case of CENTUM integration structures.

If a library project is open in SCS Manager, the Controller launcher cannot be started.
# Maintenance Launcher

The table below shows tools that can be started from the Maintenance launcher.

## Table 1.1-3 Maintenance Launcher Menu

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>SCS Status Overview</td>
<td>Starts the SCS Status Overview of SCS Maintenance Support Tool</td>
</tr>
<tr>
<td>SCS State Management</td>
<td>Starts the SCS State Management of SCS Maintenance Support Tool</td>
</tr>
<tr>
<td>Set SCS Security Level</td>
<td>Opens the Set SCS Security Level dialog box.</td>
</tr>
<tr>
<td>I/O Lock Window</td>
<td>Starts the I/O Lock Window</td>
</tr>
<tr>
<td>Communication I/O Lock Window</td>
<td>Starts the Communication I/O Lock Window</td>
</tr>
<tr>
<td>SCS Link Transmission Lock Window</td>
<td>Starts SCS Link Transmission Lock Window</td>
</tr>
<tr>
<td>Inter-SCS Communication Lock Window</td>
<td>Starts Inter-SCS Communication Lock Window</td>
</tr>
<tr>
<td>SCS Test Function (*1)</td>
<td>Starts SCS Test Function</td>
</tr>
<tr>
<td>Update SCS Test Database (*1)</td>
<td>Updates SCS Test Database</td>
</tr>
</tbody>
</table>

*1: In the case of CENTUM integration structures, this menu item is displayed when the SCS project is a default project or a user-defined project.

If a library project is open in SCS Manager, the Maintenance launcher cannot be started.

---

**IMPORTANT**

If SCS Manager is in the logic simulation mode, the I/O Lock window, Communication I/O Lock window, SCS Link Transmission Lock window, and Inter-SCS Communication Lock window cannot be started.

---

## Show/Hide SCS Manager Toolbars

If you launch SCS Manager or Multi-Language Editor, the displayed toolbar will be the same as that before, when you closed last time. The toolbar display is retained per each Safety Engineering PC (SENG) and cannot be set per each user. If you hid the toolbar last time you used the SCS Manager or Multi-Language Editor and if you want the toolbar to show this time, for example, change the show/hide status of the toolbar. Follow the steps below to show or hide the toolbar.


   ![Figure 1.1-1 Layout Dialog Box](image)

2. Select the check boxes of the toolbar you want to show.
If you want to hide the toolbar, clear all the check boxes.

3. Click [OK].
   To change the docking or floating status of the toolbar, drag it to the position you like.

SEE ALSO

For more information about the detailed procedures to show/hide the toolbar, refer to:

"Toolbars" in "Appearance" of "Workbench" of the Workbench User's Guide
1.2 Window Components Common to Builders

Multiple builders are used for engineering applications that will run on the SCS. This section describes the base window layout common to all the builders, taking the SCS Constants Builder window as an example.

Figure 1.2-1 Window of SCS Constants Builder

- **Title Bar**
  The title bar displays project name, file name, etc.

- **Menu Bar**
  The menu bar contains the [Edit], [Tools] and other menus. The menu structure of the menu bar differs depending on the builder; the menu bar used on most builders is as follows.

  **Table 1.2-1 File Menu**

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>Opens a file created by this builder and saved with a specific name (SVA file)</td>
</tr>
<tr>
<td>Close</td>
<td>Closes the window</td>
</tr>
<tr>
<td>Save</td>
<td>Saves the data displayed in the window in a file</td>
</tr>
<tr>
<td>Save As (*1)</td>
<td>Saves the data displayed in the window in a file with a specific name</td>
</tr>
</tbody>
</table>

Continues on the next page
### Table 1.2-1 File Menu (Table continued)

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>External File - &gt; Import</td>
<td>Imports the contents saved in a file with a specific format to the currently opened window</td>
</tr>
<tr>
<td>External File - &gt; Export</td>
<td>Exports the contents of the currently opened window into a file with the specific format</td>
</tr>
<tr>
<td>Properties</td>
<td>Displays a dialog box for displaying and editing information related to the window properties</td>
</tr>
<tr>
<td>Print</td>
<td>Launches Document Generator for printing the data displayed in the window</td>
</tr>
<tr>
<td>Status Label - &gt; (*2) Custom Import</td>
<td>Imports the alarm status texts modified on the CENTUM builders.</td>
</tr>
<tr>
<td>Status Label - &gt; (*2) Delete</td>
<td>Deletes the alarm status texts imported from the CENTUM builders.</td>
</tr>
<tr>
<td>Latest File</td>
<td>Shows a list of files saved with specific names (SVA files) that were opened in the past</td>
</tr>
<tr>
<td>Exit SCS Constants Builder (*3)</td>
<td>Closes SCS Constants Builder</td>
</tr>
</tbody>
</table>

*1: On the SCS Constants Builder, you need to save the settings separately on each tab sheet.

*2: Only available on SCS Constants Builder

*3: Builder name is displayed as the affix of the menu name.

---

**TIP**

If there is no document window, only [Open], [Latest File] and [Exit SCS Constants Builder] are displayed.

### Edit Menu

#### Table 1.2-2 Edit Menu

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>Cancels the previously performed edit operation</td>
</tr>
<tr>
<td>Cut</td>
<td>Deletes the selected character string and copies it onto the clipboard</td>
</tr>
<tr>
<td>Copy</td>
<td>Copies the selected character string onto the clipboard</td>
</tr>
<tr>
<td>Paste</td>
<td>Inserts the character string stored in the clipboard</td>
</tr>
<tr>
<td>Clear</td>
<td>Clears the character string of the selected field</td>
</tr>
<tr>
<td>Find</td>
<td>Displays a dialog box to search for a specified character string set in the builder</td>
</tr>
<tr>
<td>Replace</td>
<td>Displays a dialog box to search and replace a specified character string set in the builder</td>
</tr>
</tbody>
</table>

### View Menu

#### Table 1.2-3 View Menu

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toolbar</td>
<td>Determines whether or not to display the toolbar</td>
</tr>
<tr>
<td>Status Bar</td>
<td>Determines whether or not to display the status bar</td>
</tr>
<tr>
<td>Data Menu Area</td>
<td>Determines whether or not to display the data menu area</td>
</tr>
<tr>
<td>Message Display Area</td>
<td>Specifies whether or not to show the message display area</td>
</tr>
</tbody>
</table>
### Tools Menu

Table 1.2-4 Tools Menu

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Environment Setting...</td>
<td>Starts Builder Environment Tool for setting the operation environment commonly used for builders</td>
</tr>
</tbody>
</table>

### Window Menu

Table 1.2-5 Window Menu

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cascade</td>
<td>Arranges document windows so that they overlap</td>
</tr>
<tr>
<td>Tile Horizontally</td>
<td>Arranges document windows horizontally</td>
</tr>
<tr>
<td>Tile Vertically</td>
<td>Arranges document windows vertically</td>
</tr>
<tr>
<td>Arrange Icons</td>
<td>Arranges minimized document windows</td>
</tr>
</tbody>
</table>

### Toolbar

The toolbar contains icons representing frequently used functions in the menu bar.

![Figure 1.2-2 Toolbar](image)

Table 1.2-6 Functions Assigned to the Toolbar

<table>
<thead>
<tr>
<th>Button</th>
<th>Name</th>
<th>Assigned function</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Open]</td>
<td>Open</td>
<td>Same as [Open] of the [File] menu</td>
</tr>
<tr>
<td>![Save]</td>
<td>Save</td>
<td>Same as [Save] of the [File] menu</td>
</tr>
<tr>
<td>![Print]</td>
<td>Print</td>
<td>Same as [Print] of the [File] menu</td>
</tr>
<tr>
<td>![Cut]</td>
<td>Cut</td>
<td>Same as [Cut] of the [Edit] menu</td>
</tr>
<tr>
<td>![Copy]</td>
<td>Copy</td>
<td>Same as [Copy] of the [Edit] menu</td>
</tr>
<tr>
<td>![Paste]</td>
<td>Paste</td>
<td>Same as [Paste] of the [Edit] menu</td>
</tr>
<tr>
<td>![Undo]</td>
<td>Undo</td>
<td>Same as [Undo] of the [Edit] menu</td>
</tr>
<tr>
<td>![Display/Hide Data Menu]</td>
<td>Display/Hide Data Menu</td>
<td>Same as [Data Menu Area] of the [View] menu</td>
</tr>
</tbody>
</table>

### Data Menu Area

The data menu area has the following functions.

- Displays input guidelines for the selected data (e.g., meaning of an input item and data input range).
- If data has options, the area displays the option menus and allows selecting an option. In that case, it is also possible to select an option by pressing a key.
- Displays tree view and changes the workspace tabs (except for SCS Constants Builder).

**Message Display Area**

The message display area displays the execution result of saving files, etc.
1.3 Builder Environment Tool

Builder Environment Tool can be used for configuring builder font and other builder environment settings. This section describes how to use the Environment Setting window.

- **Target Builders of Builder Environment Tool**
  
  This tool is used as required when customizing builder operations. The use of this tool is not mandatory. The target builders of this tool are shown below.
  
  - SCS Constants Builder
  - I/O Parameter Builder
  - Tag Name Builder
  - Alarm Priority Builder
  - Alarm Processing Table Builder
  - Modbus Address Builder
  - Communication I/O Builder
  - DNP3 Communication Builder

  Note that settings made in this tool are not applied to SCS Manager and Multi-Language Editor.

- **Displaying Builder Environment Tool**

  Builder Environment Tool is opened by selecting [Environment Setting] in the [Tools] menu of each of the builders.

  When the Environment Setting window is displayed, the builders of this tool cannot be operated on.

  Click [OK] button to reflect the setting when starting up a builder.

  ![Environment Setting Window](image)

  **Figure 1.3-1 Environment Setting Window**

  - **Common**

    This section allows setting font type and size for character strings displayed in the workspace.

    Click [Select] to display the following Font selection dialog box. Select a font type from [Font] and [Script], and specify the size as well. Note that [Font style] cannot be specified with this dialog box.
Figure 1.3-2 Font Selection Dialog Box

- **Operation after Pressing Enter Key**
  
  In this section, it is possible to specify the destination field that the cursor jumps to when the [Enter] key is pressed in spreadsheet type windows.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Do Not Move</td>
<td>Do not move the cursor</td>
</tr>
<tr>
<td>Move to Next Field</td>
<td>Move the cursor to the next field</td>
</tr>
<tr>
<td>Move to Next Line</td>
<td>Move the cursor to the next line</td>
</tr>
</tbody>
</table>

- **Number of Lines**
  
  In this section, it is possible to specify the maximum number of lines that can be displayed in the document window. This setting is applied to Comm. I/O Wiring Tab of Communication I/O Builder and Modbus Address Builder.

  If [All] is selected, the maximum number of displayed lines of the builder will be set as the maximum number of lines for each tab. If another value is specified, the value is set as the maximum number of displayed lines. If more lines than the maximum number of displayed lines are to be displayed, a page switch button is displayed on the upper part of the tab.

  For example, if 1000 is specified for the maximum number of display lines in a tab that displays 4000 lines, four page switch buttons are displayed.

  The default value is 1000.
2. ProSafe-RS Projects

This section describes the relationships among SCS projects, RS projects and CENTUM projects used in ProSafe-RS and how to define RS projects.

**SCS Projects**

An SCS Project is defined for each SCS. RS Project is a combination of all the SCS Projects in order to bundle the engineering data of SCS projects.

An SCS project has the following databases.

• Work database (SCS database and source files)
• Master database (running SCS database and source files)

**Work Database**

SCS project and its files stored in SENG are called Work database. When applications are stored after being edited using SCS Manager, Multi-Language Editor, or Builders, the Work database is updated.

If [Build] is executed on the application and the application is downloaded to an SCS, the SCS database in the SCS is overwritten with the SCS database of the Work database in SENG. And a copy of the Work database is created in SENG as a Master database.

**Master Database**

The master database refers to the copied SCS database when the SCS database is downloaded to the SCS with offline download or online change download, and a group of its base source files.

The following engineering functions are related to the master database.

• Master Database Saving Function
  This function automatically saves the master database within an SCS project when the SCS database is downloaded to the SCS via offline download or online change download, and maintains it at all times in the SENG. Thus there is no provision for the user to upload the database from SCS to SENG.

• Master Database Restoring Function
  This function restores the data of the master database in the work database. It also has the function to download the master database to an SCS.

The master database is also used to detect differences from the work database by both online change download and Cross Reference Analyzer.

Master Database Saving Function and Master Database Restoring Function allow the user to perform the following operations.

• The user can perform monitoring based on the database running on an SCS regardless of whether the work database is being modified or not.
• The user can save the SCS projects including the master database in external media such as CD-ROM.
• Even if an SCS hardware failure occurs and a CPU module and/or input/output module require replacement, the user can restore the SCS application by master database offline download and IOM download.
• The user can restore the work database from the master database in order to cancel changes made to the SCS work database.

IMPORTANT
Do not edit the master database using Windows explorer.

SEE ALSO
For more information about master database offline download, refer to:
9.3, “Master Database Offline Download” on page 9-10
For more information about Master Database Restoring Function, refer to:
12., “Master Database Restoring Function” on page 12-1
2.1 Definitions of RS Projects

A folder for an RS project is automatically created when ProSafe-RS software is installed. It is possible to create new RS projects as well.

When performing engineering of projects on several SENGs, the RS project folders must be shared.

- **Initial Status of RS Projects**

  An RS project is created automatically when ProSafe-RS software is installed to the PC; it is named as the "C:\RS-Projects\MYRSPJT" folder. The RS project is regarded as one folder. If the folder is used as is, there is no need to create a new RS project.

- **Creation of New RS Projects**

  It is possible to create new RS projects in addition to the RS project created at the installation. In this case, use Windows Explorer to create a folder with the name of new RS project. The folder name is used as the name of the RS project. The following restrictions apply to the folder name:
  - Folder name: Up to 8 characters, starting with an upper case alphabet character
  - Characters that can be used: Upper case alphabet characters, numerals, underscore and hyphen.
  - Absolute path of the folder: Up to 16 characters (except for \, /, ;, :, ?, *, " , <, >, |, . and space)

- **Operations when Sharing a RS Project**

  When performing engineering on several SENGs, specify the "C:\RS-Projects," which is automatically created, as a shared folder or create an RS project below a shared folder.

  If you create an RS project below a shared folder, use Windows Explorer to create a folder with the same name as the RS project to be created. The folder name is used as the name of the RS project. The following restrictions apply to the folder name:
  - Folder name: Up to 8 characters, starting with an upper case alphabet character
  - Characters that can be used: Upper case alphabet characters, numerals, underscore and hyphen.
  - Absolute path of the folder: Up to 16 characters (except for \, /, ;, :, ?, *, " , <, >, |, . and space)

- **Backing up RS Projects**

  When you back up all the folders under an RS project folder, all the SCS projects containing the implementation data of an application are also backed up.

  The RS project backup shall be saved in external media, by saving folders below the RS project folder using Windows Explorer.

<2.1 Definitions of RS Projects >

**IMPORTANT**

The RS project backup operation must be performed when the engineering function and SCS Maintenance Support Tool are not used.

When you choose the standard model of IT security, you need to logon to the PC with a user account that is authorized to access the ProSafe-RS related folders so as to perform back-ups.
2.2 Relationship Between ProSafe-RS Projects and CENTUM Projects

A CENTUM project is a project of a CENTUM system.

In the case of a CENTUM integration structure, where ProSafe-RS is connected to CENTUM, an SCS becomes a station that is treated equally with an FCS or an HIS in a CENTUM project. The state of safety applications running on the SCS can be monitored on an HIS or an FCS.

For more information about relations among SCS projects, RS projects, and CENTUM projects, refer to:

■ Relationship between Projects” in 2.16, “CENTUM Integration” in Engineering Guide (IM 32Q01C10-31E)

Rules in Folder Configuration

An RS project and a CENTUM project must be placed in separate folders so that they do not overlap. These two projects can be placed in the same PC or different PCs.

Relationship with CENTUM project

In a CENTUM integration structure, safety applications of a ProSafe-RS project are not affected by any CENTUM project.

However, in the SCS Simulation tests and connection tests with CENTUM, the attribute of CENTUM project will affect the safety applications of a ProSafe-RS project, because the CENTUM Test Function is used in these tests.

For more information about the SCS Simulation tests and connection tests with CENTUM, refer to:

3., “SCS simulation tests” in ProSafe-RS System Test Reference (IM 32Q04B30-31E)

Relationship with Tag Name Generation

HISs and FCSs can access SCS data using tag names. In order to do so, define a list of tag names to be accessed in ProSafe-RS and pass the tag list to CENTUM.

• The SCS engineering functions on the ProSafe-RS output the SCS tag list to the communication folder of the CENTUM project.
• The CENTUM engineering functions on the CENTUM are then able to generate a HIS tag list based on the passed SCS tag list.
3. Operations on SCS Projects

This section explains the following operations of SCS projects.

- Creation of new SCS projects
- Opening SCS Projects
- Closing SCS Projects
- Backing up SCS Projects

SEE ALSO

For more information about restoration of SCS project master database, refer to:

12., "Master Database Restoring Function" on page 12-1

For more information about restoration of SCS projects, refer to:

13., "Version Control" on page 13-1
3.1 Creation of New SCS Projects

This section explains the procedure to create new SCS projects. It also explains the SCS Project Properties dialog box and SCS Constants Builder, which are required to perform the procedure.
3.1.1 SCS Project Creation Procedure

The procedure to create SCS projects is explained here.
To create new SCS projects, make the following settings using SCS Manager.

1. Setting an SCS project folder
   Set a folder in which to store the SCS project data.

2. Setting SCS project items
   Set Domain number and Station number etc. of the SCS project. Some of the items can only be specified in the process of creating a new SCS project and others can be changed later.

3. Setting a resource
   A resource refers to a set of SCS application logics. In this step, the resource name and resource number are specified. In ProSafe-RS, one resource can be set for one SCS.

4. Setting a configuration
   A configuration refers to a software object corresponding to one SCS. The configuration name is specified in this step. In ProSafe-RS, one configuration can be set for one SCS. A configuration includes a resource.

5. Setting an IP address
   Specify an address related to TCP/IP communication of the SCS.

### Setting an SCS Project Folder

In order to create a new project, select [New Project/Library] from the [File] menu of SCS Manager. On the displayed dialog box, the folder name and other settings need to be specified. Specify "SCSddss" (dd: domain number, ss: station number) for the folder name.

The path to the SCS project folder cannot contain the following characters:

Space, \, /, :, ;, *, ?, "", <, >, |

**SEE ALSO**

For more information about SCS project folder settings, refer to:

*"Working with projects" of "Workbench" of the Workbench User's Guide*

### Setting SCS Project Items

When the setting of the SCS project folder is completed, the SCS Project Properties dialog box appears. Use the "SCS" tab and the "Project" tab of this dialog box to make settings related to the SCS and project.

In the case of CENTUM integration structures, specify a CENTUM project folder in the SCS Project Properties dialog box.

**SEE ALSO**

For more information about SCS Project Properties dialog box, refer to:

3.1.2, "SCS Project Properties Dialog Box" on page 3-5

### Setting a Resource

A resource refers to a set of application logics created by the user. Multiple programs can be run in one resource. Only one resource can be run in one SCS.

Right click the resource on Link Architecture View and then choose [Properties] from the pop-up menu so as to display the Resource Properties dialog box. The resource name and the resource number can be defined on the General tab. Specify "SCSddss" for the resource name and "ddss" (dd: domain number, ss: station number) for the resource number.
Setting a Configuration

In order to execute an application logic set, it is necessary to specify the hardware configuration of each SCS.
Right click the configuration on Hardware Architecture View and then choose [Properties] from the pop-up menu so as to display the Configuration Properties dialog box. The configuration name can be defined on General tab.

Specify "SCSddss" (dd: domain number, ss: station number) for the configuration name.

Setting an IP Address

The IP address can be defined on Hardware Architecture View. Double click "Connection" so as to display Connection - Properties dialog box. The IP address needs to be set for "Value" item.

In the standard, the IP address sets "172.16.dd.ss" (dd: domain number, ss: station number).

Setting SCS Constants

Specify constant values for SCS and parameters for communicating with external systems in SCS Constants Builder.

SEE ALSO
For more information about resource settings, refer to:
"Resources" in "Link architecture view" of "Workbench" of the Workbench User's Guide

SEE ALSO
For more information about configuration settings, refer to:
"Configuration properties" in "Hardware Architecture View" of "Workbench" of the Workbench User's Guide

SEE ALSO
For more information about IP address settings, refer to:
"Connections" in "Hardware Architecture View" of "Workbench" of the Workbench User's Guide

SEE ALSO
For more information about SCS Constants Builder, refer to:
3.1.3, “SCS Constants Builder” on page 3-8
3.1.2 SCS Project Properties Dialog Box

The SCS Project Properties dialog box is used to make various basic settings for an SCS, including domain number and station number.

### Calling the SCS Project Properties Dialog Box

The SCS Project Properties dialog box appears if you perform the following operations in SCS Manager:

- When a new SCS project is created
  - The SCS Project Properties dialog box appears automatically when the SCS project folder settings are completed.
- When a menu is selected from the Engineering launcher menu of SCS Manager
  - To edit an SCS project after it is created, select [Engineering] from the [Tools] menu of SCS Manager. The Engineering launcher menu appears; select [SCS Project Properties].

### Components of the SCS Project Properties Dialog Box

The SCS Project Properties dialog box has the following components.

#### SCS Tab

![SCS Tab](image)

The table below shows the components of the "SCS" tab.

<table>
<thead>
<tr>
<th>Item</th>
<th>Setting (*1)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Station Type</td>
<td>Only possible when a new project is created</td>
<td>Specify the model of the SCS station.</td>
</tr>
<tr>
<td>Database Type</td>
<td>Display only</td>
<td>Database type is displayed.</td>
</tr>
</tbody>
</table>

Continues on the next page
### Table 3.1.2-1 Setting Items in the "SCS" Tab (Table continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Setting (*1)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Station Address</td>
<td>Yes</td>
<td>Select the check box to allow setting the domain number and station number. The check box is selected by default when a new project is created. The check box is not selected by default when this dialog box is opened from the Engineering launcher menu.</td>
</tr>
<tr>
<td>Domain Number</td>
<td>Yes</td>
<td>Specify the domain number. Select a value using the spin box or enter a character string directly. A value in the range from 1 to 31 can be specified.</td>
</tr>
<tr>
<td>Station Number</td>
<td>Yes</td>
<td>Specify the station number. Select a value using the spin box or enter a character string directly. A value in the range from 1 to 64 can be specified.</td>
</tr>
<tr>
<td>IP Address</td>
<td>Display only</td>
<td>The IP address set in Hardware Architecture View is displayed.</td>
</tr>
<tr>
<td>Component Number</td>
<td>Yes</td>
<td>Enter the component number. (*2) Up to 4 characters, which can be any alphanumeric characters, can be entered.</td>
</tr>
</tbody>
</table>

*1: Yes: Setting possible  
*2: This is a number assigned to identify the devices belonging to an RS project. It is assigned when installing an SCS in a cabinet, etc., and used to show the connection origin and destination of each cable when wiring cables.

---

**IMPORTANT**

- Make sure to specify [Station Type] when creating a new SCS project. It cannot be changed later.
- Changing a station address (domain number and station number) has a significant impact on the SCS database; be careful when doing so. If a station address is changed, the master database is deleted; it is necessary to perform a build and offline download again in SCS Manager.

---

**"Project" Tab**

![SCS Project Properties](image)

**Figure 3.1.2-2 "Project" Tab**
The table below shows the components of the "Projects" tab.

### Table 3.1.2-2 Setting Items in the "Projects" Tab

<table>
<thead>
<tr>
<th>Item</th>
<th>Setting (*1)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Version</td>
<td>Display only</td>
<td>The version number is displayed if the versions of the project data are maintained. The field is blank in the case of an SCS project that has never been checked in with Version Control Tool.</td>
</tr>
<tr>
<td>CENTUM Project Folder</td>
<td>Yes</td>
<td>Specify the top folder of the CENTUM project. Enter the path directly or specify the path from the Folder Selection dialog box that is displayed by clicking [Browse]. (*2) (*3) This is only valid when a license for the CENTUM VP/CS 3000 Integration Package has been granted to the PC.</td>
</tr>
<tr>
<td>SCS Project</td>
<td>Display only</td>
<td>Displays SCS project attribute. Project Attribute: Default Project, Current Project, User-Defined Project</td>
</tr>
<tr>
<td>Originally Created</td>
<td>Display only (*4)</td>
<td>Displays the software revision number of the SENG that the project was created from.</td>
</tr>
</tbody>
</table>

*1: Yes: Setting possible  
*2: If the entire length of the specified path cannot be displayed in the text edit box, the middle part of the path is omitted and displayed as [...].  
*3: A path specified in the local drives format is automatically converted to a path in UNC format.  
*4: If the project was created in SENG with a software revision number prior to R1.03, the software revision number cannot be displayed.

**TIP**  
SCS Project Properties dialog box is available for both SCS project and Library project. It differs in the SCS project properties dialog box of Library project as follows:  
- This dialog box will not automatically start when the project is newly created.  
- When started from SCS Manager, only "Project" tab will be displayed.  
- There is no need to specify [CENTUM Project Folder].  
- [Default Project] will be displayed as SCS Project.
### 3.1.3 SCS Constants Builder

SCS Constants Builder is used to specify constant values for SCS and parameters for communicating with external systems.

#### Calling SCS Constants Builder


**Figure 3.1.3-1 Communication Tab of SCS Constants Builder Window**

SCS Constants Builder contains the following tab sheets:

- **SCS tab**
  - For setting parameters related to Optical ESB Bus Repeater

- **Communication tab**
  - For setting parameters related to communication with external systems

For more information about the menu bar, toolbar, data menu area and message display area, refer to:

1.2, "Window Components Common to Builders" on page 1-6

### SCS Tab

On the SCS tab, you can set the following items:

- **Optical ESB Bus Repeater: SCSV1/SCSP1**
  
  Select [Yes] if you use the Optical ESB Bus Repeater. [No] if not. The initial setting is [No].

- **Maximum Extension Distance: SCSV1/SCSP1**
  
  Set the Maximum Extension Distance for the Optical ESB Bus Repeater.
If Optical ESB Bus Repeater is set to [Yes] for SCSP1, the maximum distance can be set within the range from 5 to 50 km in 5 km units. If Optical ESB Bus Repeater is set to [Yes] for SCSV1, [5 km] can be set. The initial setting is 5 km.

![Figure 3.1.3-2 "SCS" Tab of SCS Constants Builder](image)

**Extend Scan Period Automatically**
Select [Yes] or [No] to set whether to adjust the scan period of the application logic automatically. The default setting is [No]. If set to [Yes], the scan period will be extended automatically when the execution time of the application logic has extended the scan period specified on the SENG for some reasons. This prevents the communication performed by the SCS, for example, inter-SCS safety communication, from being discontinued. This setting is changeable by online change download.

**Behavior at Abnormal Calculation**
Select [SCS fails] or [SCS continues] to set the behavior of the SCS when an abnormal calculation has occurred in the application logic. The default setting is [SCS fails]. This setting is changeable by online change download.

**Locking of Internal Variables : SCSP2**
Select [Enable] or [Disable] to set whether to allow locking of internal variables used in the application logic. This setting is only displayed for SCSP2 when the extend scan period automatically is set to [Yes]. The default setting is [Disable]. This setting is changeable by online change download.
For more information about locking of internal variables, refer to:

- "Locking internal variables" in A8.1, "Variable locking" in Safety Control Station Reference (IM 32Q03B10-31E)

### Automatic IOM Download

Select [Enable] or [Disable] to set whether to enable automatic IOM download. The default setting is [Disable]. This setting is changeable by online change download.

For more information about automatic IOM download, refer to:

B7.3, "Automatic execution of IOM download" in Safety Control Station Reference (IM 32Q03B10-31E)

### Communication Tab

On the Communication tab, you can set the following items:

- **Interval of Repeated Warning Alarms**

  This item should be set in the case of a CENTUM integration structure.

  Set the time from the occurrence of a process alarm to the next occurrence of the same alarm. Repeated warning alarms are intended to notify the engineer that serious process alarms are existing continuously.

  If the cause of an alarm still persists after a certain time has elapsed from the occurrence of the alarm, the process alarm message is sent again, regardless of whether or not the alarm is acknowledged.

  The interval of repeated warning alarms can be specified in the range from 0 to 3600 seconds. The initial setting is 600 seconds.

  If 0 is specified for the interval of repeated warning alarms, repeated warning alarms are disabled.

- **Synchronous Mode**

  This item allows specifying the method of synchronizing system time. The time of the SCS is used for the time stamps of messages recorded in SOERs.

  For SCSV1, two options [IRIG-B] and [V net] are provided for time synchronization. The default is [V net].

  For SCSP1/SCSP2, only one option [Vnet/IP] is provided for time synchronization.

  **Table 3.1.3-1 Time Synchronous Mode**

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IRIG-B time synchronization</td>
<td>The time information is acquired from the GPS clock via IRIG-B and set to the SCS. In this case, it is necessary to connect the GPS clock and CPU nodes of all SCSs with IRIG-B. Specify this option when highly accurate synchronization in discrete input module time between different SCSs is required.</td>
</tr>
<tr>
<td>V net time synchronization</td>
<td>The V net time is set to the SCS. The V net time is used for the time stamps of messages recorded in SOERs as well.</td>
</tr>
<tr>
<td>Vnet/IP</td>
<td>The Vnet/IP time is set to the SCS. The Vnet/IP time is used for the time stamps of messages recorded in SOERs as well. If SNTP server is connected, Vnet/IP time synchronizes with the SNTP server time.</td>
</tr>
</tbody>
</table>

For more information about time synchronization, refer to:

A3.2, "Time synchronization of SCS" in Safety Control Station Reference (IM 32Q03B10-31E)
Scan Period for External System

Specify the scan period used when connecting to external systems such as CENTUM. The scan period for external system setting refers to the operating period at which the connection function is executed. Select either 1 second or 2 seconds. Default: 1 second.

Modbus Word Order

When establishing a connection with an external system and acquiring 32-bit data from the external system, the order of the most significant word and least significant word can be changed. Select either the order of the most significant word and then the least significant word, or the reverse order. The reverse order is used generally in Modbus. [Direct] is selected by default.

<table>
<thead>
<tr>
<th>32-bit data</th>
<th>Most significant word</th>
<th>Least significant Word</th>
</tr>
</thead>
<tbody>
<tr>
<td>Direct</td>
<td>40001</td>
<td>40002</td>
</tr>
<tr>
<td>Reverse</td>
<td>40002</td>
<td>40001</td>
</tr>
</tbody>
</table>

Figure 3.1.3-3 Modbus Word Order

16-bit Modbus Master Support Mode

This item specifies whether to allow the following accesses by the external Modbus master in Modbus slave communications. These accesses are allowed when 16-bit Modbus master support mode is set to [Enable]. By default, it is set to [Disable].

- Write to a single holding register
  Function code is 06.
- Read 16-bit data
  Function codes are 03 and 04.
- Write 16-bit data
  Function code is 16.

Alarm Notify Action when AOF Released

This item should be set in the case of a CENTUM integration structure. Specify to (or not to) output the suppressed messages when AOF is deactivated.

When you output the suppressed process alarm message, you need to set this setting to [Yes], otherwise, you can set this setting to [No]. By default, this setting is [No].

PV Status of S_ANLG_S

This item should be set in the case of a CENTUM integration structure. With this setting, whether to keep the PV status on the mapping block (S_ANLG_S) of ANLG_S (Analog Input Block with Data Status) can be defined. If you want to have BAD data status on the mapping block S_ANLG_S when the data status of IN terminal of ANLG_S
block is BAD, you need to set this setting to [Yes], otherwise, you can set this setting to [No]. By default, this setting is [Yes].

TIP
This setting is displayed only for the SCS projects created by the software version R1.03 or later. For the SCS projects created by the software prior to R1.03, this setting is not displayed and the default action is equivalent to [No]. When using the software version R1.03 or later to import the old SCS projects, the default action will become [Yes].

- **DNP3 Slave Function**

  When you use the DNP3 slave function, you need to set it to Enable, otherwise, you can set it to Disable. By default, it is set to Disable.

  TIP
  This setting is displayed only for the SCS projects of SCSU1 that are created by the software version R3.02.20 or later. When the SCS projects that are created by the software prior to R3.02.20 are imported, this setting is set to Disable.

### Change Process Alarm Name of Analog Input Block with Data Status

The alarm name of the ANLG_S (Analog Input Block with Data Status) can be changed so as to match the alarm name on the diagnosis information window and SOE Viewer with the alarm name of CENTUM.

Before changing the alarm name, the CENTUM process alarm text strings need to be modified first. For more information about defining the process alarm text strings, please contact Yokogawa agents.

**IMPORTANT**

When applying this feature, if the SCS project to be monitored on CENTUM contains both ANLGI and ANLG_S blocks, the ANLGI blocks should be changed to ANLG_S blocks.
3.2 Opening and Closing SCS Projects

This section explains how to open and close SCS projects.

- **Opening SCS Projects**
  
  In order to open a previously created SCS project, select [Open Project/Library] from the [File] menu of SCS Manager.

  **TIP**
  
  - Projects that have not been created as databases to be edited in SCS Manager of ProSafe-RS cannot be opened.
  - It is not possible to open the same SCS project in SCS Manager, Version Control Tool and Master Database Restoring Function at the same time.

  **IMPORTANT**
  
  SCS projects cannot be opened if you cancelled password input (except when read-only access is permitted without entering a password) or failed to enter the correct password three times while attempting to open SCS projects for which passwords are set. Close SCS Manager and try opening it again.

- **Closing SCS Projects**
  
  SCS Manager is not equipped with a function to close SCS projects. Close SCS Manager to close the currently opened SCS project. If you open an SCS project while the same SCS project or a different SCS project is already open, the SCS project that has been open so far closes.

  - When you close SCS Manager, all the related builders, Safety Analyzer and launchers close. If the security level is not Level 2 when closing, a message prompting the user to return to Level 2 appears, but SCS manager closes without changing the level. In order to return to Level 2, use the SCS security level operation function.
  - SCS Maintenance Support Tool is not closed even if SCS Manager is closed.

  **TIP**
  
  The SCS project opened in SCS Manager cannot be opened in Version Control Tool or Master Database Restoring Function. To use these tools, close SCS Manager.

  **SEE ALSO**
  
  For more information about how to use SCS security level operation function, refer to:

3.3 Backing up SCS Projects

Every time you make changes to SCS projects, backup them as a precaution against unexpected troubles such as a hard disk failure.
Use Version Control Tool for backing up the SCS projects.

SEE ALSO For more information about Version Control Tool, refer to:

13., "Version Control" on page 13-1
4. Definitions of Inputs/Outputs

When defining inputs and outputs, use Dictionary View, I/O Wiring View and I/O Parameter Builder to set the following items.

Table 4-1 Definitions of Inputs and Outputs

<table>
<thead>
<tr>
<th>Definition</th>
<th>Description</th>
<th>Tool used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input/output variable definition</td>
<td>Define input/output variables.</td>
<td>Dictionary View</td>
</tr>
<tr>
<td>Input/output module definition</td>
<td>Define the configuration of input/output modules. Specify the model and mounting position (node number and slot number) of a module, as well as redundancy.</td>
<td>I/O Wiring View</td>
</tr>
<tr>
<td>Wiring of channels and input/output variables</td>
<td>Assign input/output variables to channels.</td>
<td></td>
</tr>
<tr>
<td>Node parameter setting</td>
<td>Set parameters for nodes.</td>
<td>I/O Parameter Builder</td>
</tr>
<tr>
<td>Input/output module parameter setting</td>
<td>Set parameters for input/output modules.</td>
<td></td>
</tr>
<tr>
<td>Channel parameter setting</td>
<td>Set parameters for channels.</td>
<td></td>
</tr>
</tbody>
</table>

*1: ST can be used for user-defined FB/FU only.

Figure 4-1 Definitions of Inputs/Outputs

See also

For more information about I/O Wiring View, refer to:
4.3, "I/O Wiring View" on page 4-4

For more information about I/O Parameter Builder, refer to:
4.4, "I/O Parameter Builder" on page 4-10

For more information about Dictionary View, refer to:
"Dictionary View" of "Workbench" of the Workbench User's Guide

For more information about setting the communication I/Os for the subsystem communication, refer to:
B1.4, "Setting items relating to subsystem communication" in Open Interfaces (IM 32Q05B10-31E)
### 4.1 Input/Output Module Types

The available types of input and output modules include analog input/output modules (AIO: Analog Input/Analog Output), discrete input/output modules (DIO: Digital Input/Digital Output). In addition, communication modules are also available for communications with external devices.

The table below shows AIO/DIO modules for which input/output can be defined and communication modules.

<table>
<thead>
<tr>
<th>Model</th>
<th>Type</th>
<th>AIO/DIO</th>
<th>Redundancy ((^1))</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAI143</td>
<td>4 to 20 mA, 16-channel, module isolation</td>
<td>Analog Input</td>
<td>Yes</td>
</tr>
<tr>
<td>SAV144</td>
<td>1 to 5 V/1 to 10 V, 16-channel, module isolation</td>
<td>Analog Input</td>
<td>Yes</td>
</tr>
<tr>
<td>SAT145</td>
<td>Thermocouple/mV, 16-channel, isolated channels</td>
<td>Analog Input</td>
<td>Yes</td>
</tr>
<tr>
<td>SAR145</td>
<td>RTD, 16-channel, isolated channels</td>
<td>Analog Input</td>
<td>Yes</td>
</tr>
<tr>
<td>SAI533</td>
<td>4 to 20 mA, 8-channel, module isolation</td>
<td>Analog Output</td>
<td>Yes</td>
</tr>
<tr>
<td>SDV144</td>
<td>24 V DC, 16-channel, module isolation</td>
<td>Digital Input</td>
<td>Yes</td>
</tr>
<tr>
<td>SDV521</td>
<td>24 V DC, 4-channel, module isolation</td>
<td>Digital Output</td>
<td>Yes</td>
</tr>
<tr>
<td>SDV526</td>
<td>100-120 V AC, 4-channel, module isolation</td>
<td>Digital Output</td>
<td>Yes</td>
</tr>
<tr>
<td>SDV531</td>
<td>24 V DC, 8-channel, module isolation</td>
<td>Digital Output</td>
<td>Yes</td>
</tr>
<tr>
<td>SDV53A</td>
<td>48 V DC, 8-channel, module isolation</td>
<td>Digital Output</td>
<td>Yes</td>
</tr>
<tr>
<td>SDV541</td>
<td>24 V DC, 16-channel, module isolation</td>
<td>Digital Output</td>
<td>Yes</td>
</tr>
<tr>
<td>ALR111</td>
<td>RS-232C communication module (2-Port)</td>
<td></td>
<td>Yes ((^2))</td>
</tr>
<tr>
<td>ALR121</td>
<td>RS-422/RS-485 communication module (2-Port)</td>
<td></td>
<td>Yes ((^2) (^3))</td>
</tr>
<tr>
<td>ALE111 ((^4))</td>
<td>Ethernet communication module (10BASE-T, 1-Port)</td>
<td></td>
<td>No ((^5))</td>
</tr>
</tbody>
</table>

\(^1\): Yes : Possible  
No : Impossible

\(^2\): If redundant configuration is required for the Modbus slave communication, you need to use two serial communication modules and control the communication route by the Modbus master.

\(^3\): When ALR121 is used for ProSafe-SLS communication function, the redundant configuration cannot be set by using two modules.

\(^4\): When the CPU node of SCS is SSC10D or SSC10S, do not define ALE111.

\(^5\): If redundant configuration is required for the Modbus slave communication, you need to use two Ethernet communication modules and control the communication route by the Modbus master. For DNP3 slave function, the redundant configuration cannot be set by using two modules.

---

**SEE ALSO**

For more information about defining the Modbus slave communication I/Os, refer to:

C., “Modbus slave communication” in Open Interfaces (IM 32Q05B10-31E)

For more information about defining the subsystem communication I/Os, refer to:

B1.4, “Setting items relating to subsystem communication” in Open Interfaces (IM 32Q05B10-31E)

For more information about ProSafe-SLS communication, refer to:

B4., “ProSafe-SLS communication (for ALR121)” in Open Interfaces (IM 32Q05B10-31E)
4.2 Input/Output Definition Operations

Input/output definitions are made using Dictionary View, I/O Wiring View and I/O Parameter Builder.

**IMPORTANT**

If you changed I/O definitions and saved them in I/O Wiring View, make sure to save them also in I/O Parameter Builder.

Make input/output definitions according to the following procedure.

1. **Input/output variable definition**
   Define input/output variables using Dictionary View.

2. **Definitions of input/output modules**
   Define input/output modules using I/O Wiring View and specify the mounting positions (node number and slot number) and redundancy.

3. **Wiring of channels and input/output variables**
   Use I/O Wiring View to associate the channels of the input/output module with the input/output variables.

4. **Parameter settings**
   Use I/O Parameter Builder to set parameters for nodes, input/output modules and channels.

**TIP**

Steps "1. Definitions of input/output variables" and "2. Definitions of input/output modules" can be performed independently. Both steps must be performed before "3. Wiring of channels and input/output variables." "4. Parameter settings" must be performed after "2. Definitions of input/output modules."

**SEE ALSO**

For more information about how to define inputs and outputs in communicating with subsystems, refer to:

B1.4, “Setting items relating to subsystem communication” in Open Interfaces (IM 32Q05B10-31E)

For more information about Dictionary View, refer to:

"Dictionary View" of "Workbench" of the Workbench User’s Guide
4.3 I/O Wiring View

I/O Wiring View is used to define input/output modules. Make the following definitions in I/O Wiring View:

- Creation and deletion of input/output modules
- Specification of mounting positions of input/output modules
- Selection of redundant and single input/output module configurations
- Wiring of variables and channels

**IMPORTANT**

- When editing definitions in I/O Wiring View, close I/O Parameter Builder first.
- If you changed I/O definitions and saved them in I/O Wiring View, make sure to save them also in I/O Parameter Builder.

### How to Display I/O Wiring View

Select [I/O Wiring] from the [Project] menu of SCS Manager; I/O Wiring View appears.

### I/O Wiring View Window Structure

I/O Wiring View consists of I/O Wiring Tree View that lists input/output modules and I/O Wiring Grid View that lists input/output variables that can be wired to channels.

---

**Figure 4.3-1 I/O Wiring View**

**SEE ALSO**

For more information about I/O Wiring View, refer to:

"I/O Wiring View" of "Workbench" of the Workbench User's Guide
Setting Items in I/O Wiring View

Set the following items in I/O Wiring View.

- Model of input/output module
- Device index
- Node number
- Slot number
- Specification of redundancy
- Wiring of channels and input/output variables

However, to change the model of input/output module or device index, you need to first delete the model and then add the new setting.

Creation of Input/Output Modules

To add input/output modules, click "Add Device" button in the toolbar. The Device Selection dialog box appears.

![Device Selection Dialog Box](image)

---

Adding AIO/DIO Modules or Communication Modules

When adding an AIO/DIO module or communication module, specify the model of the module in I/O Wiring View.

The following table shows the input/output modules that can be specified.

Table 4.3-1 Input/Output Modules that can be specified

<table>
<thead>
<tr>
<th>Input/output module</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAI143</td>
<td>Analog input module (4 to 20 mA, 16-channel, module isolation)</td>
</tr>
<tr>
<td>SAI143H</td>
<td>Analog input module (4 to 20 mA, 16-channel, module isolation, with HART communication)</td>
</tr>
<tr>
<td>SAV144</td>
<td>Analog input module (1 to 5 V/1 to 10 V, 16-channel, module isolation)</td>
</tr>
<tr>
<td>SAT145</td>
<td>Analog input module (thermocouple/mV, 16-channel, isolated channels)</td>
</tr>
<tr>
<td>SAR145</td>
<td>Analog input module (RTD, 16-channel, isolated channels)</td>
</tr>
<tr>
<td>SAI533H</td>
<td>Analog output module (4 to 20 mA, 8-channel output, module isolation, with HART communication)</td>
</tr>
<tr>
<td>SDV144</td>
<td>Digital input module (16-channel, module isolation)</td>
</tr>
<tr>
<td>SDV521</td>
<td>Digital output module (4-channel, module isolation)</td>
</tr>
</tbody>
</table>

Continues on the next page
### Table 4.3-1 Input/Output Modules that can be specified (Table continued)

<table>
<thead>
<tr>
<th>Input/output module</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SDV526</td>
<td>Digital output module (4-channel, module isolation)</td>
</tr>
<tr>
<td>SDV531</td>
<td>Digital output module (8-channel, module isolation)</td>
</tr>
<tr>
<td>SDV53A</td>
<td>Digital output module (8-channel, module isolation)</td>
</tr>
<tr>
<td>SDV531L</td>
<td>Digital output module (8-channel, module isolation, long distance type)</td>
</tr>
<tr>
<td>SDV541</td>
<td>Digital output module (16-channel, module isolation)</td>
</tr>
<tr>
<td>SEC402/SEC401 (*1)</td>
<td>ESB bus coupler module</td>
</tr>
</tbody>
</table>

*1: SEC402/SEC401 is not an AIO/DIO module, however, in order to link the CPU node and the I/O node, SEC401 needs to be configured.

The table below shows the communication modules that can be specified.

### Table 4.3-2 Communication Modules that can be specified

<table>
<thead>
<tr>
<th>Communication module</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALR111</td>
<td>RS-232C communication module (2-Port)</td>
</tr>
<tr>
<td>ALR121</td>
<td>RS-422/RS-485 communication module (2-Port)</td>
</tr>
<tr>
<td>ALE111 (*1)</td>
<td>Ethernet communication module (10BASE-T, 1-Port)</td>
</tr>
</tbody>
</table>

*1: When the CPU node of SCS is SSC10D or SSC10S, do not define ALE111.

You can specify the serial communication modules based on the type of communication as follows:

- Specify ALR111 or ALR121 to add a serial communication module for Modbus slave communication.
- Specify ALR111M or ALR121M to add a serial communication module for subsystem communication. After specifying a module, the module will be displayed as ALR111M or ALR121M in I/O Wiring View and I/O Parameter Builder. While in other SENG windows and the HIS Status window, the module will be displayed as ALR111 instead of ALR111M and as ALR121 instead of ALR121M.

**TIP**

For SSB401, SNT401, SNT411, SNT501 and SNT511, no setting in the I/O Wiring View is required.

#### Device Index

Device indexes play the role of identifiers assigned to input/output modules. Specify unique numbers in the range of 0 to 255. Though the index numbers are irrelevant to the actual installation of the input/output modules, it is recommended to use the relevant numbers for the indexes.

**IMPORTANT**

- The number greater than 256 should not be used though the number can be entered.
- The index cannot be changed after creating the input/output modules.

#### Number of Channels

The number of channels in the defined input/output module is displayed.
Mounting Position of Input/Output Module and Setting of Redundancy

Double-click [Parameters] of an input/output module in I/O Wiring Tree View of I/O Wiring View. The I/O Parameters dialog box appears. Select a parameter of the input/output module and set the mounting position (node number and slot number) and whether or not to use redundancy. ALR121 that is used in ProSafe-SLS communication function cannot be duplicated.

![I/O Parameters - SAI143 Table]

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Comment</th>
<th>Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>NodeNo</td>
<td>2</td>
<td></td>
<td>WORD</td>
</tr>
<tr>
<td>SlotNo</td>
<td>1</td>
<td></td>
<td>WORD</td>
</tr>
<tr>
<td>IsRedundant</td>
<td>FALSE</td>
<td></td>
<td>BOOLEAN</td>
</tr>
</tbody>
</table>

Figure 4.3-3 I/O Parameters Dialog Box

IMPORTANT

The I/O Parameters dialog box is used to specify the mounting position and redundancy. Parameters of input/output modules are specified in I/O Parameter Builder.

- **NodeNo (Node Number) and SlotNo (Slot Number)**
  Specify the mounting position of the input/output module.
  A value in the range from 1 to 10 can be set for the node number for SCSV1/SCSP1. A value in the range from 1 to 14 can be specified for SCSP2. To use 11 or more nodes for SCSP2, you need the CFS1350 Node Expansion Package (for SSC60S/SSC60D).
  A value in the range from 1 to 8 can be specified for the slot number.
  When multiple nodes are used, the node number of ESB bus coupler module (SEC402/SEC401) should be set to 1 and the slot number should be set to 7. Since SEC402/SEC401 is always put into dual-redundant configuration, slot 8 is reserved and cannot be used by other modules.

- **Is Redundant (Switching Between Redundant and Single Input/Output Module Configurations)**
  Specify whether or not to make the input/output module redundant. Specify TRUE for redundant configuration and FALSE for single configuration. Redundancy can be specified only for input/output modules mounted in odd slot numbers. Note that the adjacent slot number (the odd slot number + 1) must be unspecified as it is specified for the other input/output module in the redundant configuration.
### Wiring of Channels and Input/Output Variables

Wiring is an operation where channels are associated with input/output variables. Assign one input variable or output variable to one channel.

**IMPORTANT**

Make sure to use input/output variables in order to access channel data from the application logic.

---

Figure 4.3-4 Wiring of Channels and Input/Output Variables

When you select a channel in I/O Wiring Tree View, a list of input/output variables that can be wired to the channel is displayed in I/O Wiring Grid View. Double-click the input/output variable for which you want to specify wiring with the channel.

The result of wiring is displayed in I/O Wiring Tree View. It is also displayed in the parameter setting view of each channel in I/O Parameter Builder and Dictionary View.
The association between the channel and input/output variable is displayed in Tree View.

Double-click

ProSafe-RS - [SCS0101(*) - I/O Wiring - 111:SCS0101(*)]

Figure 4.3-5 Example of Wiring between a Channel and Input/Output Variable

**TIP**
Deletion of wiring is also performed in I/O Wiring View.

The table below shows the relationship between input/output variables and channels that can be wired.

Table 4.3-3 Input/Output Variables and Channels that can be Wired

<table>
<thead>
<tr>
<th>Channel type</th>
<th>Type of input/output variable</th>
<th>Description</th>
</tr>
</thead>
</table>
| AI (current input, voltage input, TC/mV input, RTD input) | Type: IO_REAL
Direction: Input
Attribute: Read | Wiring of an analog input channel and an input variable |
| AO (current output)   | Type: IO_REAL
Direction: Output
Attribute: Write or Free | Wiring of an analog output channel and an output variable |
| DI (discrete input)   | Type: IO_BOOL
Direction: Input
Attribute: Read | Wiring of a discrete input channel and an input variable |
| DO (discrete output)  | Type: IO_BOOL
Direction: Output
Attribute: Write or Free | Wiring of a discrete output channel and an output variable |

**Settings Prohibited in I/O Wiring View**

The following settings are not allowed in I/O Wiring View. Even if you make these settings, the operations of an SCS do not change.

- **Channel filtering**
  Filtering should be set as a channel parameter using I/O Parameter Builder.

- **Channel mapping**
  The functions provided in the Channels Map dialog box cannot be used. Even if you specify the mapping in I/O Wiring View, the setting is ignored in the SCS.

- **Virtual device**
  It is not allowed to switch to virtual device. If you specify a device as a virtual device in I/O Wiring View, an error occurs at building.
4.4 I/O Parameter Builder

I/O Parameter Builder is used to specify parameters for input/output modules defined in I/O Wiring View.

Make the following settings in I/O Parameter Builder.
- Node parameters
- Input/output module parameters
- Channel parameters

**IMPORTANT**

When editing settings in I/O Parameter Builder, close I/O Wiring View first.

How to Display I/O Parameter Builder

2. The Engineering launcher menu appears; select [I/O Parameter Builder] and launch I/O Parameter Builder.

I/O Parameter Builder Window Structure

I/O Parameter Builder displays a window, which is used to specify parameters for I/O nodes and input/output modules. The tabs of the workspace changes depending on the model of input/output module.

![I/O Parameter Builder Window Structure](image)

**Figure 4.4-1 I/O Parameter Builder**
Data Menu Area (I/O Structure Display Panel)

The I/O structure display panel displays the I/O structure specified in I/O Wiring View. Select one target (node or input/output module) for which you want to specify a parameter from this panel. Once you select the target, the corresponding tab appears in the workspace.

The hierarchical structure of the I/O structure display panel is shown below.

<table>
<thead>
<tr>
<th>Layer</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O</td>
<td>Displayed as the top layer under which all inputs and outputs are arranged.</td>
</tr>
<tr>
<td>Node</td>
<td>Layer indicating CPU node or I/O nodes. The node numbers are displayed.</td>
</tr>
<tr>
<td>Module</td>
<td>Layer indicating input/output modules. Mounting position, model of input/output module, Device Number and redundancy are displayed.</td>
</tr>
</tbody>
</table>

Workspace

The workspace displays items that can be specified for the node or input/output module selected in the I/O structure display panel classified into separate tabs.

<table>
<thead>
<tr>
<th>Setting target</th>
<th>Type of tab displayed</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Node</td>
<td>&quot;Node&quot; tab</td>
<td>Parameter setting for the node</td>
</tr>
<tr>
<td>Analog input module</td>
<td>&quot;Module&quot; tab</td>
<td>Setting of module parameters for the analog input module</td>
</tr>
<tr>
<td></td>
<td>&quot;Channel&quot; tab</td>
<td>Setting of channel parameters for the analog input module</td>
</tr>
<tr>
<td>Analog output module</td>
<td>&quot;Module&quot; tab</td>
<td>Setting of module parameters for the analog output module</td>
</tr>
<tr>
<td></td>
<td>&quot;Channel&quot; tab</td>
<td>Setting of channel parameters for the analog output module</td>
</tr>
<tr>
<td>Digital input module</td>
<td>&quot;Module&quot; tab</td>
<td>Setting of module parameters for the discrete input module</td>
</tr>
<tr>
<td></td>
<td>&quot;Channel&quot; tab</td>
<td>Setting of channel parameters for the discrete input module</td>
</tr>
<tr>
<td>Digital output module</td>
<td>&quot;Module&quot; tab</td>
<td>Setting of module parameters for the discrete output module</td>
</tr>
<tr>
<td></td>
<td>&quot;Channel&quot; tab</td>
<td>Setting of channel parameters for the discrete output module</td>
</tr>
<tr>
<td>Serial Communica-</td>
<td>&quot;Module&quot; tab</td>
<td>Setting of common parameters for the serial communication module</td>
</tr>
<tr>
<td>tion module</td>
<td>&quot;Port 1&quot; tab</td>
<td>Setting of parameters for port 1 of the serial communication module</td>
</tr>
<tr>
<td></td>
<td>&quot;Port 2&quot; tab</td>
<td>Setting of parameters for port 2 of the serial communication module</td>
</tr>
</tbody>
</table>

TIP

Even though the SEC402/SEC401 is selected on the I/O Structure Display panel, no information will be available in the workspace.
Items Set for Nodes

Settings for nodes are performed in the "Node" tab. The items that can be displayed and specified in the "Node" tab are explained below.

- **Node Number**
  The node number is displayed; setting is not allowed.

- **Component Number**
  A component number is a number assigned to a node when storing it in a cabinet, etc. It is used to indicate the connection origin and destination of each cable when wiring cables. Specify the component number using up to 8 alphanumeric characters. The component number setting can be omitted.

- **Comment**
  Enter a comment for the node using up to 24 alphanumeric characters. The node comment entry can be omitted.

- **Extends Node Bus : SCSP2**
  In case of SCSP2, set this setting to [Yes] if Optical ESB Bus Repeater is used; otherwise, set this setting to [No]. The default setting is [No].

- **Extends To : SCSP2**
  If [Extends Node Bus] is set to [Yes] for SCSP2, the extension distance can be set to a distance from 5 km to 50 km and incremented by 5 km. The initial setting is 5 km.

- **Extends Node Bus : SCSP1**
  In case of SCSP1, set this setting to [Yes] if Optical ESB Bus Repeater is used; otherwise, set this setting to [No]. The initial setting is [No].

- **Extends To : SCSP1**
  If [Extends Node Bus] is set to [Yes] for SCSP1, the extension distance can be set to a distance from 0 km to 50 km and incremented by 5 km. The initial setting is 0 km.

  However, if this setting is longer than the [Maximum Extension Distance] defined on the SCS Constants Builder, an error will occur when performing a build operation.

**SEE ALSO**
For more information about setting the [Maximum Extension Distance] on SCS Constants Builder, refer to:

"SCS Tab" on page 3-8

For more information about cautionary notices on setting the node extension distance, refer to:

A4.3, “Common input/output setting items” in Safety Control Station Reference (IM 32Q03B10-31E)

Setting of AIO/DIO Modules

Settings related to AIO/DIO modules are performed in the "Module" tab for the AIO/DIO module and the "Channel" tab for the channels.
For more information about the settings of "Module" and "Channel" in the AIO/DIO modules, refer to:

A4., "AIO/DIO data inputs/outputs for SCS stations" in Safety Control Station Reference (IM 32Q03B10-31E)

**Setting of Communication Modules**

Settings related to communication modules are performed in the "Module" tab, the "Port 1" tab and the "Port 2" tab for the communication module.

For more information about the setting items of "Module" and "Port" of the communication module for MOD-BUS slave, refer to:

C2.2, “Definitions in I/O Parameter Builder” in Open Interfaces (IM 32Q05B10-31E)

For more information about the setting items of "Module" and "Port" in the communication module for subsystems, refer to:

B1.4.1, “Settings using the I/O Parameter Builder” in Open Interfaces (IM 32Q05B10-31E)
5. Creation of Application Logic

In ProSafe-RS, an application logic is created by combining programs, function blocks and functions.

Programs, function blocks and functions are referred as POU for a generic name. POUs are defined using Link Architecture View and Multi-Language Editor of SCS Manager. How to define POUs is described as follows:

- **Program**
  Implemented by combining variables, function blocks and functions

- **Function block**
  Implemented by combining input/output parameters, internal variables, function blocks and functions

- **Function**
  Implemented by combining input/output parameters and functions

**SEE ALSO**

For more information about an overview of POU, refer to:

2.4, “Overview of POU” in Engineering Guide (IM 32Q01C10-31E)

For more information about important points when creating an application, refer to:

3.2, “Precautions for Engineering” in Engineering Guide (IM 32Q01C10-31E)

### Definitions of Variables and Parameters

Use Dictionary View of SCS Manager to define input/output variables, internal variables and parameters used in an application logic.

It is possible to perform the following operations in Dictionary View.

- **Creation and deletion of variables**
  It is possible to create and delete variables used in application logics.

- **Creation and deletion of parameters**
  It is possible to create and delete parameters used in function blocks and functions.

**SEE ALSO**

For more information about Dictionary View details, refer to:

“Dictionary View” under "Workbench" in the Workbench User’s Guide

### User-defined Function Blocks and User-defined Functions

ProSafe-RS provides standard function blocks and functions such as "TON" and "AND" but the user can define customized function blocks and functions to implement a logic used commonly in several applications.

Function blocks and functions defined by users are called user-defined function blocks and user-defined functions, respectively.

User-defined function blocks and user-defined functions can be used in any programs, function blocks and functions in the same way as standard function blocks and functions.
5.1 Windows Used to Create Application Logic

You can create application logic by using Link Architecture View and Multi-Language Editor of SCS Manager.

- **Link Architecture View**
  
  You can create, remove or copy POUs in Link Architecture View of SCS Manager.
  
  To show Link Architecture View, click the [Link Architecture View] on the toolbar of SCS Manager.

  **SEE ALSO**
  
  For more information about Link Architecture View details, refer to:
  
  "Link Architecture View" under "Workbench" in the Workbench User's Guide

- **Multi-Language Editor**
  
  Multi-Language Editor is used to create and edit application logics for SCSs using the following programming languages defined by IEC 61131-3.
  
  The following three languages can be used in ProSafe-RS.
  
  - Function block diagram (FBD)
  - Ladder diagram (LD)
  - Structured Text (ST)

  A window for editing an FBD, a window for editing an LD and a window for editing an ST can be opened at the same time in one Multi-Language Editor. In order to create a new POU, select a language by selecting [Insert] > [Add Program], [Add Function], or [Add Function Block] menu in Link Architecture View: Multi-Language Editor automatically launches.

**IMPORTANT**

Do not use ST for creating Programs.
Figure 5.1-1 Multi-Language Editor Window Structure (Example of Editing an FBD Program)

**TIP**

The scripts of FB and FU written in Structured Text are decorated with the following colors:

- Structured Text Statements of IEC 61131-3: Pink
- Numbers: Brown
- Comments: Green
- Other Texts: Black

The background color can be changed. Click [Option] menu to open Customize dialog box. On the "Colors and Fonts" tab, choose the [ST editor] to change the background color. However, the color of texts cannot be changed.

Showing or hiding the tool bar on the Multi-Language Editor window is the same as that on the SCS Manager.

**SEE ALSO**

For more information about showing or hiding the tool bar on the Multi-Language Editor window, refer to:

"Show/Hide SCS Manager Toolbars" on page 1-4

For more information about Multi-language editor, refer to:

"Workbench," "Language Editors" in the Workbench User's Guide
5.2 Inter-SCS Safety Communication Definition

With ProSafe-RS, it is possible to exchange data between SCSs. This section provides an overview of inter-SCS safety communication definition and engineering tasks, and explains the setting rules.

- **Overview of Inter-SCS Safety Communication Definition**

In order to implement inter-SCS safety communication, binding variables and inter-SCS communication function blocks are used to create application logics. BOOL-type, DINT-type and REAL-type data are grouped for each communicating SCS. Binding variables here stand for the identifiers that bind the SCS variables of sender and receiver.

The variables are defined in Dictionary View of SCS Manager.

The association among variables communicated is defined in Binding List View.

A variable that creates (sends) data is called a variable on the producing end and a variable that reads (receives) data is called a variable on the consuming end.

**SEE ALSO**

For more information about Dictionary View details for defining variables, refer to:

- "Dictionary View" under "Workbench" in the Workbench User's Guide

For more information about Binding List View details for linking two variables between SCSs, refer to:


For more information about inter-SCS safety communication function details, refer to:

- A5., “Inter-SCS safety communication” in Safety Control Station Reference (IM 32Q03B10-31E)

- **Overview of Engineering Tasks when Defining Inter-SCS Safety Communication**

In order to communicate data between SCSs, group and define data in SCSs on the producing side and consuming side, respectively. An overview of the engineering tasks involved is provided below.

- **Producing Side**

  - Prepare an FB (PROD_B, PROD_I or PROD_R, hereinafter referred to as PROD_*) for inter-SCS safety communication for the producing side and a corresponding binding variable for each data.

  - Define a global variable for the binding variable. Make sure to observe the naming rules for binding variables.

  - Connect the variable to be sent with the input of the PROD_* and bind the output of the PROD_* with the binding variable.

  - Make binding settings for the binding variable.

  - Do not connect more than one output for PROD_* to one binding variable.

  - It is recommended to describe information of the consuming side as the comment for the binding variable.

  - Assign a binding group for each SCS on the consuming side.

  - An error of V net communication can be output by using a SYS_DIAG. When engineering, VNER parameter of SYS_DIAG can be used for outputting the alarms.
For more information about naming rules for binding variables, refer to:

"Binding Variable" on page 5-7

- **Consuming Side**
  - Prepare a binding variable, a corresponding FB (CONS_B, CONS_I or CONS_R, hereinafter referred to as CONS_*) for inter-SCS safety communication for the consuming side and a corresponding internal variable for each data.
  - Define a global variable for the binding variable. Make sure to observe the naming rules for binding variables.
  - Set a fail-safe value to be output in case the communication cannot be established or a communication error occurs and a timeout value (reception interval timeout value and transmission delay timeout value) for judging that a communication error has occurred for each data.
  - Make binding settings for the binding variable.
  - Assign a binding group for each SCS on the producing side.
  - The communication status can be output. When engineering, NR output parameter of CONS_* for each data can be used for outputting the alarms. CMER output parameter of SYS_DIAG for the entire data can be used for outputting the alarms.

---

**IMPORTANT**

It is recommended to create a mechanism to latch requests in the logic related to inter-SCS safety communication on the consuming side.

---

The following illustration shows the overall scheme of applications for inter-SCS safety communication.
Combination of Communication Data and FBs for Inter-SCS Safety Communication

Use the following combinations of FBs for inter-SCS safety communications according to the type of data to be communicated.

<table>
<thead>
<tr>
<th>Communicated data type</th>
<th>FB for inter-SCS safety communication on the producing side</th>
<th>FB for inter-SCS safety communication on the consuming side</th>
<th>Type of binding variable</th>
</tr>
</thead>
<tbody>
<tr>
<td>BOOL-type</td>
<td>PROD_B</td>
<td>CONS_B</td>
<td>COM_BOOL</td>
</tr>
<tr>
<td>Integer-type (DINT)</td>
<td>PROD_I</td>
<td>CONS_I</td>
<td>COM_DINT</td>
</tr>
<tr>
<td>Real-number-type (REAL)</td>
<td>PROD_R</td>
<td>CONS_R</td>
<td>COM_REAL</td>
</tr>
</tbody>
</table>

### Figure 5.2-1 Overall Image of Applications

For more information about important points when using an SCS with an SCS system program number earlier than R2.03, refer to:

Appendix 4. “Compatibility between Revisions and Cautionary Notes for Upgrading” in Installation (IM 32Q01C50-31E)
Figure 5.2-2 Combination of Communication Data, FBs for Inter-SCS Safety Communication and Binding Variables

In the case of an FB for inter-SCS safety communication on the consuming side, make sure to specify fail-safe value and timeout values (reception interval timeout value and transmission delay timeout value) in addition to a binding variable.

For more information about function blocks for inter-SCS safety communication, refer to:

C4., "Function blocks for inter-SCS communication (Safety FBs)" in Safety Control Station Reference (IM 32Q03B10-31E)

## Binding Variable

There are particular rules for naming binding variables. Moreover, there are rules for binding to multiple SCSs on the consuming side for communication among SCSs.

Use the Binding List View to make settings for the binding variables.

### Binding Variable Naming Rules

- **Name of binding variable on the producing side**
  A character string in the form of Pddssxxx (dd represents the domain number of producing-side SCS, ss represents the station number of producing-side SCS, and xxx represents a 3-digit integer). "P" must be in upper case and "dd," "ss" and "xxx" must be 7 digits including 0, as in 0101001.

- **Name of binding variable on the consuming side**
  The same as the binding variable name on the producing side, except that "P" is replaced with "C" (upper case).

- A "producing variable" is a binding variable starting with "P" and a "consuming variable" is a binding variable starting with "C." The numerical values for the binding variable names must be matched.
### Binding Rules

- It is possible to bind one binding variable on the producing side with multiple binding variables on the consuming side. In effect, this is equivalent to defining multiple 1 to 1 communications.

### Binding Settings

The following items should be set for binding variables in the Binding List View.
### Table 5.2-2 Binding Setting Items

<table>
<thead>
<tr>
<th>Item</th>
<th>Setting Value</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Producing variable</td>
<td>Pddssxxx (dd: domain number, ss: station number, xxx: 3-digit integer)</td>
<td>The producing variable and consuming variable must have the same value of &quot;ddssxxx.&quot;</td>
</tr>
<tr>
<td>Consuming variable</td>
<td>Cddssxxx (dd: domain number, ss: station number, xxx: 3-digit integer)</td>
<td></td>
</tr>
<tr>
<td>Network</td>
<td>ETCP</td>
<td>Automatically set when [Producing variable] and [Consuming variable] are specified.</td>
</tr>
<tr>
<td>Communication error behavior</td>
<td>Use last value issued from binding</td>
<td></td>
</tr>
<tr>
<td>Binding parameters</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>Binding error variables</td>
<td>None</td>
<td></td>
</tr>
</tbody>
</table>

### Setting Binding Groups

Create one binding group for each SCS communicating on the producing side and consuming side.

![Diagram of Binding Groups](image)

**Figure 5.2-6 Binding Groups**

It is possible to send data from one producing side SCS to multiple consuming side SCSs. In this case, define one group on the producing side SCS for each consuming side SCS.
When sending data between the producing side SCS and consuming side SCS bi-directionally, prepare binding variables for both the producing and consuming sides. Prepare binding groups as well for both the producing and consuming sides.

**Figure 5.2-8 Bi-directional Binding**

SEE ALSO

For more information about setting up binding groups, refer to:

5.3 SCS Link Transmission Definition

The communication data for SCS Link Transmission can be defined on SCS Link Transmission Builder. This section explains how to define the SCS Link Transmission and how to use the SCS Link Transmission Builder.

**SCS Link Transmission Configuration Procedure**

SCS Link Transmission Builder and Dictionary View are used to configure SCS Link Transmission definitions.

1. On Dictionary View, define the variable names for the SCS Link Transmission I/O FBs used for SCS Link Transmission.

2. On SCS Link Transmission Builder, define receptions and transmissions between local and other stations. The communicated data through SCS Link Transmission is represented by the bit number.

3. On the SCS Link Transmission Builder, define the relations of the bit numbers of each station and the variable names of the SCS Link Transmission I/O FBs.

**Main Features of SCS Link Transmission Builder**

On the SCS Link Transmission Builder, the variables to be received and to be transmitted through SCS Link Transmission can be assigned and their connections with SCS Link Transmission I/O FBs can be wired.

Through wiring these elements, bit numbers of each station are associated with the variable names of SCS link transmission I/O FBs. The SCS Link Transmission I/O FBs that can be assigned to the bit numbers of SCS Link Transmission vary with the station type of the destined stations.

The station types of the destined Other Stations are;

- SCS
- FCS, GSGW, and APCS

Other Stations such as FCS, GSGW, and APCS are referred as FCS.

**Start SCS Link Transmission Builder**


2. Click [SCS Link Transmission Builder]. The SCS Link Transmission Builder starts.

**SCS Link Transmission Builder Window**

In the left pane of SCS Link Transmission Builder window, the following contents are listed. After selecting content from the list, the corresponding details will be displayed in the right pane.

- SCS Link Transmission Definition
- Data Wiring Definition
- Data Wiring View
Self Station Tab of SCS Link Transmission Definition

On this tab, the data reception and transmission of the local station can be defined.

- **Send**
  Whether to send data from the local station can be defined. If you want to send data from the local station, choose [1: Yes], otherwise choose [0: No]. When [1: Yes] is chosen, the related wirings on the local station need to be defined. The initial setting is "No."

**IMPORTANT**
When "No" is chosen for Send, the previously defined wiring information will be removed at the moment of switching tabs.

- **Receive**
  Whether to receive data from other stations can be defined. If you want to receive data from other stations, choose [1: Yes], otherwise choose [0: No]. When [1: Yes] is chosen, the related settings on "Other Stations" tab need to be defined. The initial setting is "No."

**IMPORTANT**
When "No" is chosen for Receive, the previously defined wiring information will be removed at the moment of switching tabs.
Other Stations Tab of SCS Link Transmission Definition

When Receive is set to [Yes] on "Self Station" tab of SCS Link Transmission Definition, the station type, the reception timeout, the transmission timeout and the pre-alarm set point need to be defined for each station.

Figure 5.3-2 "Other Stations" Tab of SCS Link Transmission Definition on SCS Link Transmission Builder

- **Type**
  
  The numbers in the "Station" column at left side are the station numbers. The type needs to be set according to each station number. For receiving the SCS Link Transmission data, the type should be set to [1: SCS], while for receiving the global switches of FCS, the type should be set to [2: FCS]. [0: No transmission] can also be set if not receiving data from that station.

**IMPORTANT**

- The type for the local station should not be set. If you set it, an error will occur during build operation.
- When "No transmission" is set for Type, the previously defined wiring information of that station will be removed at the moment of switching tabs.

- **Reception Timeout (Reception Interval Timeout Value)**
  
  The reception timeout should be set to a time between 3 and 30 seconds. This setting is required for the SCS type only. The initial setting is 3 seconds.

- **Transmission Timeout (Inter-SCS Transmission Delay Timeout Value)**
  
  The transmission timeout, i.e. the limited time from transmission to reception should be set to a time between 3 and 30 seconds. This setting is required for the SCS "Type" only. The initial setting is 3 seconds.
If the inter-SCS transmission delay check is not required, "0" should be set. However, if "0" is set, the received data cannot be used for Safety loop logic.

- **Pre-Alarms (Pre-Alarm Setting Value)**

  The pre-alarm can be initiated prior to transmission timeout alarm. The time for initiating the pre-alarm can be set to 0 or from 3 to 29 seconds. This setting is only available when you select SCS "Type" column. The pre-alarm setting value should be set if you need to detect transmission delay before the delay reaches the transmission delay timeout value (DLYT). The initial setting is "0".

---

**SEE ALSO**

For more information about defining incoming data for SCS link transmissions, refer to:

A6.1, “Overview of SCS link transmission” in Safety Control Station Reference (IM 32Q03B10-31E)

For more information about cautions regarding setting times for SCS link transmissions, refer to:

"■ Precaution for Engineering" in 2.9, “SCS Link Transmission” in Engineering Guide (IM 32Q01C10-31E)

---

### Data Wiring Definition

Wiring details for both "Self Station" and "Other Stations" need to be defined. The Data Wiring Definition of the tree view in the left pane and the tab in the right pane show the following station numbers.

- The station number of the Self Station When the setting of Send in the "Self Station" tab of SCS Link Transmission Builder is set to "Yes."
- The station numbers of the other stations When the setting of Receive in the "Self Station" tab of SCS Link Transmission Builder is set to "Yes" and the setting of Type in the "Other Stations" tab of SCS Link Transmission Builder is set to "SCS" or "FCS."

Do the following to switch the tabs from "Self Station" and "Other stations."

- Choose a station number in the tree view in the left pane.
- Select a station number in the combo box for selecting the station on the toolbar.

![Figure 5.3-3 Other Stations Tab of Data Wiring Definition on SCS Link Transmission Builder (SCS)]
Figure 5.3-4 Other Stations Tab of Data Wiring Definition on SCS Link Transmission Builder (FCS)

Figure 5.3-5 “Self Station” Tab of Data Wiring Definition on SCS Link Transmission Builder

- **Bit No. (Bit Number)**
  Shows the bit numbers in the SCS link transmission data area used for SCS Link Transmission. This number is not editable.
  For SCS, the bit numbers are in the range of 001 to 128. For FCS, the range is 001 to 256.

- **Variable Name**
  Do any of the followings to set the instance name of SCS Link Transmission input/output FB to each variable name.
  - Enter the variable name directly.
  - Double-click a variable name displayed in the "Variable Name" tab in the left pane.
  - Drag a variable name from Dictionary View and drop it into the Variable Name field.

A variable name can contain up to 69 single-byte characters.
To globally identify an internal variable that has been declared as a local variable, affix an @ character and scope name to the variable.

For accessing the internal variable of a user-defined function block, the user-defined function block itself should be assigned with an instance name on Dictionary View. Then the variable name becomes "<Instance Name>.<Internal Variable Name>." The variable can be accessed through two nests.

SCS Link Transmission Builder checks the following items:
• The variable name consists only of alphanumeric characters and ",@", ",." or ",_". If any other character is used, an error will occur.

• The variable name begins with an alphabetic character or ",_" otherwise, an error will occur.

• If the number of nests is three or more, an error will occur.
  For example, the variable name FB01.VAR3@PROG1 (Internal variable VAR3 of a user-defined function block instance FB01 in PROG1) has one nest; the instance "FB01.FB02.VAR3" (Internal variable VAR3 of a user-defined function block instance FB02 used in the user-defined function block instance FB01) has two nests.

The selectable variables vary with the station types. The SCS Link Transmission I/O FBs for the variables corresponding to the station types are as follows:

<table>
<thead>
<tr>
<th>Station Type</th>
<th>SCS Link Transmission I/O FB</th>
</tr>
</thead>
<tbody>
<tr>
<td>Self Station</td>
<td>LTSND (Link Transmission Data Output FB)</td>
</tr>
<tr>
<td>Other Station (SCS)</td>
<td>LTRCV (Safety Link Transmission Data Input FB)</td>
</tr>
<tr>
<td>Other Station (FCS)</td>
<td>LTFCS (Interference-free Link Transmission Data Input FB)</td>
</tr>
</tbody>
</table>

When setting a variable name from Dictionary View, the procedure is as follows.
Drag a variable name from Dictionary View and then drop it into the Variable Name field of Link Transmission Builder. Variable names can be specified for Link Transmission Builder. When dragging multiple variable names, they will be dropped from the beginning field. The existing variable names in the fields will be overwritten.
Figure 5.3-6 Drag and Drop from Dictionary View

- **Type**
  Displays the SCS Link Transmission I/O FB types corresponding to the station type. This item is not editable.

- **Comment**
  Displays the comment of the variable. This item is not editable.

- **Input Processing at Fault**
  When a data's status becomes BAD, a predefined value can be set to the logic data. This is valid only when "Other Stations" is selected.
  The input value to be set to the data at error occurrence is selectable from the following options, [0], [1] or [2]. The initial setting is 0.

**Table 5.3-2 Input Processing at Fault**

<table>
<thead>
<tr>
<th>Option</th>
<th>Setting Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>Set the input data to 0 when the input becomes error.</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>Set the input data to 1 when the input becomes error.</td>
</tr>
<tr>
<td>2</td>
<td>Hold</td>
<td>Hold the current value when the input becomes error.</td>
</tr>
</tbody>
</table>
### Wiring View

Shows the list of Data Wiring Definition.

In this window, the wiring definitions are displayed with the format where the Self-Station is placed at the first and followed by Other Stations sorted by bit numbers. All data of the local station and up to 1000 data of the other stations can be displayed. This window is not editable.

Double-clicking a variable name, the Data Wiring Definition window regarding the variable will be displayed.

![Figure 5.3-7 Data Wiring View on SCS Link Transmission Builder](image)

### Notes on Reusing Data Defined by SCS Link Transmission Builder

In the following operation, the settings for the SCS Link Transmission Definition and the settings for wiring must be edited.

- Importing the 'data that was set to Station A for Link Transmission' to Station B
- In the SCS Project Properties dialog box, changing the station number of the SCS project from A to B

Notes for importing data and notes for changing station number are the same. Notes for importing SCS Project are given below.

The status of the imported data after SCS Link Transmission Builder saves them is as follows:

- The content of the SCS Link Transmission Definition settings is the exported data from Station A.
- The data for 'Self Station' tab in the Wiring Definition settings exported from Station A is automatically set to the 'Self Station' tab data for Station B. The contents of other stations remain unchanged.

#### IMPORTANT

Even if the exported SCS Project has a different Station type (SCS or FCS) in the Link Transmission Definition settings from the importing SCS Project, only the message meaning 'The data being edited will be lost. OK?' appears. Note that no dialog box to confirm the change in the Station type will appear.
An example of exporting data from Station A (SCS0101) and importing it to Station B (SCS0102) is shown below.

<table>
<thead>
<tr>
<th>Data in Station A (SCS0101)</th>
<th>Data Wiring Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>SCS Link Transmission Definition</strong></td>
<td><strong>Data Wiring Definition</strong></td>
</tr>
<tr>
<td><strong>Self station</strong></td>
<td><strong>01 (self)</strong></td>
</tr>
<tr>
<td>Send Yes</td>
<td>1 snd1, LTSND,..</td>
</tr>
<tr>
<td>Receive Yes</td>
<td>n sndn, LTSND,..</td>
</tr>
<tr>
<td>Other stations</td>
<td><strong>02</strong></td>
</tr>
<tr>
<td>02 SCS, palm1, palm2</td>
<td>02 SCS, palm1, palm2</td>
</tr>
<tr>
<td>03 FCS</td>
<td>03 FCS</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Data in Station B (SCS0102)</th>
<th>Data Wiring Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>SCS Link Transmission Definition</strong></td>
<td><strong>Data Wiring Definition</strong></td>
</tr>
<tr>
<td><strong>Self station</strong></td>
<td><strong>02 (self)</strong></td>
</tr>
<tr>
<td>Send Yes</td>
<td>1 snd1, LTSND,..</td>
</tr>
<tr>
<td>Receive Yes</td>
<td>n sndn, LTSND,..</td>
</tr>
<tr>
<td>Other stations</td>
<td><strong>03</strong></td>
</tr>
<tr>
<td>03 FCS</td>
<td>03 FCS</td>
</tr>
</tbody>
</table>

**Figure 5.3-8 Example of Importing Station A (SCS0101) Data to Station B (SCS0102)**

As shown in the previous figure, the "Self Station" tab data of Station B (SCS0102) is replaced with the "Self Station" data in Wiring Definition settings of Station A (SCS0101).

If the Link Transmission Definition settings and Wiring Definition settings with Station B are made in Station A, the Link Transmission Definition settings and Wiring Definition settings in Station B will remain as "Other Station" data after the import.

If one station number is defined as both "Self Station" and "Other Station" an error is raised at a build. To avoid this, follow the steps below.

If the old Station B data is not needed,
1. After importing the Station A data to Station B, delete the Station B ("02" in the example) that is defined as "Other Station" in the SCS Link Transmission Definition settings of Station B and save the changes.
2. In the Dictionary View, delete related variables.
3. Edit the contents of the SCS Link Transmission Definition settings and Wiring Definition settings.

**Figure 5.3-9 Case where the Old Station B data is not Needed**

If the old Station B data needs to be saved,
1. After importing the Station A data to Station B, define a new station ("04" in the example) to move the Station B data that was defined as Other station ("02" in the example) in SCS Link Transmission settings to.
2. In Wiring Definition settings, copy the Station B data and paste it to the newly defined station.

Data in Station B (SCS0102)

SCS Link Transmission Definition

- Self station
  - Send Yes
  - Receive Yes

- Other stations
  - 01
    - 02 SCS, palm1, palm2
    - 03 FCS
    - 04 SCS, palm1, palm2

Data Wiring Definition

- 02 (self)
  - 1 snd1, LTSND...
  - n sndn, LTSND...

- 04
  - 1 rcv1, LTRCV...
  - n rcvn, LTRCV...

Figure 5.3-10 Data Transfer when Station B Data Needs to be Saved

3. In the SCS Link Transmission Definition settings, delete the Station B that is defined as Other station ("02" in the example) and then save the changes.

4. Edit the related variables in the Dictionary View if necessary.

5. Edit the contents of the SCS Link Transmission Definition settings and Wiring Definition settings.

Data in Station B (SCS0102)

SCS Link Transmission Definition

- Self station
  - Send Yes
  - Receive Yes

- Other stations
  - 01
    - 02 SCS, palm1, palm2
    - 03 FCS
    - 04 SCS, palm1, palm2

Data Wiring Definition

- 02 (self)
  - 1 snd1, LTSND...
  - n sndn, LTSND...

- 04
  - 1 rcv1, LTRCV...
  - n rcvn, LTRCV...

Figure 5.3-11 Structure when the Old Station B Data Needs to be Saved
5.4 Procedure after Creating Application Logic

This section describes how to create a database to be downloaded to SCS after application logic is created.

- **Building SCS Project**

  To create a database for SCS project, execute "Build." Select [Build Project/Library] from the [Project] menu of SCS Manager.

  **TIP**

  SCS project cannot be built if Integrity Analyzer and Cross Reference Analyzer have already been launched. Try building the SCS project again after closing the analyzers.

- **Executing the Safety Analyzers**

  Before downloading the application logic to an SCS, make sure to perform the acknowledgement operations for both analyzers. If acknowledgement by both analyzers has not been completed, offline download and online change download to SCS cannot be performed. It is recommended to perform the acknowledgement operation for Integrity Analyzer first and then for Cross Reference Analyzer.
6. Library Projects

It is possible to improve engineering efficiency by creating functions and function blocks commonly used in multiple SCSs as library projects and use them from SCS projects. This section explains how to create library projects and precautions on how they differ from SCS projects.

- Overview of Library Projects

**IMPORTANT**
Create an individual copy of the necessary library projects for each SCS project that uses them. Avoid using one library project from multiple SCS projects in order to prevent modification of one library project from affecting multiple SCS projects.

Library projects are a part of an SCS project. It is possible to use multiple library projects from one SCS project. When using multiple library projects, be careful so that names of functions and function blocks do not overlap.

Note that it is not possible for a library project to reference another library project.

![Diagram of Library Projects](image)

*Figure 6-1 Overview of Library Projects*
6.1 Creation of Library Projects

Create an original library project and debug it; it can be copied and used for several SCS projects.

### Creation Procedure of Library Projects

1. On SCS Manager, choose [New Project/Library] from the [File] menu, and then choose [SCS Library] from “Template” so as to create a new library project. It is recommended to create a folder called "USERLIB" immediately below the C:\RS-Pro\jects folder created at installation and place library projects there.

2. Use SCS Manager and Multi-Language Editor to define commonly used functions and function blocks.

3. Use SCS Manager and Multi-Language Editor to create a program to test the functions and function blocks defined in step 2.

4. Check that there are no programming errors in the build.

5. Execute a simulation test and confirm that functions and function blocks work as intended. Note that an actual SCS is not required at debugging. Library projects cannot be debugged using SCSs.

6. Analyze the project using Integrity Analyzer to confirm that there are no problems.

**SEE ALSO** For more information about a library project setting, refer to: “Libraries” of “Workbench” in the Workbench User's Guide

### Procedure to Copy Library Projects for Each SCS Project

1. Use SCS Manager and create an SCS project.

2. Use Windows Explorer to copy the original library project immediately below the LIBRARIES folder located in the SCS project folder.

3. Select [Add/Remove Dependencies] from the [Tools] menu of SCS Manager. The copied library is associated with the SCS project. This allows using one library only from one SCS project.

4. User-defined functions and user-defined function blocks created as part of the library can be used when creating POUs with the FBD, LD and ST languages. If the user-defined function block is used in an ST, an Integrity Analyzer warning message will be displayed to prompt for authorization.

With the procedure above, the library project will become available to access from the SCS project. If the library project is to be used in other SCS projects as well, repeat copying the library project for each SCS project.

**IMPORTANT**

Library projects are divided into the original library projects created in the C:\RS-Projects\US ER_LIB folder and those copied to the LIBRARIES folder for each SCS project. Make sure to keep the library projects updated so that the libraries in both folders maintain the same contents.
Folder Structure of Library Projects

The figure below shows the folder structure for library projects.

Example of actual folder structure:
- Copy the library project to the LIBRARIES folder of each SCS project.
- Library storage folder provided by the system.
- Original library project storage folder.
- Original library projects.

Figure 6.1-1 Folder Structure of Library Projects
## 6.2 Items Set for Library Projects

When creating user-defined functions and function blocks for library projects, it is mandatory to set certain items for projects, configuration, resources, functions and function blocks, while some items can be set arbitrarily.

### Items Set for Library Projects

The table below summarizes items that must be set to create user-defined functions and user-defined function blocks for a library project.

<table>
<thead>
<tr>
<th>Classification</th>
<th>Item</th>
<th>Setting</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project</td>
<td>Project name</td>
<td>Mandatory</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Project comment</td>
<td>Arbitrary</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Password setting</td>
<td>Arbitrary</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Project description</td>
<td>Arbitrary</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Configuration name</td>
<td>Mandatory</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Configuration comment</td>
<td>Arbitrary</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Target</td>
<td>Mandatory</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Password setting</td>
<td>Arbitrary</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Configuration description</td>
<td>Arbitrary</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Network</td>
<td>No need to specify</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Connection IP address</td>
<td>No need to specify</td>
<td></td>
</tr>
</tbody>
</table>

Continues on the next page
<table>
<thead>
<tr>
<th>Classification</th>
<th>Item</th>
<th>Setting</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Resource</strong></td>
<td>Resource name</td>
<td>Mandatory</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Resource comment</td>
<td>Arbitrary</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Resource number</td>
<td>Mandatory</td>
<td>Enter any value in the range from 1 to 4094</td>
</tr>
<tr>
<td></td>
<td>Target</td>
<td>Mandatory</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Generate debug information</td>
<td>Arbitrary</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Code for simulation</td>
<td>Mandatory</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Code generation setting</td>
<td>Mandatory</td>
<td>Specify TIC code</td>
</tr>
<tr>
<td></td>
<td>Embed Symbol Table</td>
<td>No need to specify</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Embed Zip Source</td>
<td>No need to specify</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Trigger cycles</td>
<td>Arbitrary</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Cycle Timing</td>
<td>Arbitrary</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Detect errors</td>
<td>No need to specify</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Nb of stored errors</td>
<td>No need to specify</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Cycle to cycle/Real time</td>
<td>Arbitrary</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Memory for Retain</td>
<td>No need to specify</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Password</td>
<td>Arbitrary</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Resource description</td>
<td>Arbitrary</td>
<td></td>
</tr>
<tr>
<td><strong>User-defined function</strong></td>
<td>POU name</td>
<td>Mandatory</td>
<td></td>
</tr>
<tr>
<td></td>
<td>POU comment</td>
<td>Arbitrary</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Debug information</td>
<td>Arbitrary</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Password</td>
<td>Arbitrary</td>
<td></td>
</tr>
<tr>
<td></td>
<td>POU description</td>
<td>Arbitrary</td>
<td></td>
</tr>
</tbody>
</table>
6.3 Precautions on Library Projects

Pay attention to the following points when creating and using library projects.

- How to use library projects
- Software revision of SCS project and library project
- Operations when incorporating library projects into SCS project
- Differences between SCS projects and library projects
- Operations on SCS projects and relationship with libraries
- Precautions when testing library projects
- Precautions when using Integrity Analyzer
- How to make changes to library projects

How to Use Library Projects

- With a library project, it is possible to create logic for user-defined functions and user-defined function blocks and debug them in a simulation test. Note, that unlike in the case of SCS projects, it is not possible to download them to an SCS or perform debugging using an SCS.
- In order to debug user-defined functions and user-defined function blocks, a special program for testing them is required. Create a program for testing purposes if you inspect user-defined functions and user-defined function blocks by Integrity Analyzer.

Software Revision of SCS Project and Library Project

Match the revision numbers of software for creating SCS Project and for creating Library Project.

However, even if the revision number of software for creating Library POU is later than the revision number of software for creating the SCS Project, you don't have to match the revision numbers unless the Library POU includes FB/FU that is unsupported by the SCS Project.

Operations when Incorporating Library Projects into SCS Project

User-defined functions and user-defined function blocks created in a library project have restriction as follows in an SCS project.

- They cannot be opened with Multi-Language Editor. They must be referenced using the library project.
- The logic cannot be printed out. Print the logic via the library project.

Differences Between SCS Projects and Library Projects

The table below summarizes functions that can only be used in library projects and cause errors when creating SCS projects.

<table>
<thead>
<tr>
<th>Function</th>
<th>Library project specification</th>
<th>SCS project specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Library project name, configuration name, resource name</td>
<td>Up to 64 characters including alphabets, numbers and underscore. The first letter must be an alphabet character.</td>
<td>Fixed to SCSddss</td>
</tr>
</tbody>
</table>

Continues on the next page
Table 6.3-1 Functions that can Only be Used in Library Projects (Table continued)

<table>
<thead>
<tr>
<th>Function</th>
<th>Library project specification</th>
<th>SCS project specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resource number</td>
<td>In the range from 1 to 4094</td>
<td>Fixed to ddss</td>
</tr>
</tbody>
</table>

Note that, in library projects, variable names should be kept within 18 characters and POU names (user-defined functions and user-defined function blocks) used in a library project should be kept within 16 characters, although longer names will not cause errors at building.

### Operations on SCS Projects and Relationship with Libraries

Once pasted from the original library projects into SCS projects, the libraries constitute a part of the SCS projects. Therefore, operations on the SCS projects are also applied to the pasted libraries as well.

- The data of libraries is also saved in the master database. The same rule applies to restoration as well.
- The data of libraries is saved in the version control of an SCS project. The same rule applies to restoration as well.

### Precautions when Testing Library Projects

In order to test functions and function blocks defined in a library project, it is necessary to open the original library project in SCS Manager and perform a logic simulation test. In order to perform this test, create a program for testing purposes in the original library project. In the SCS project that uses the libraries, it is possible to check the inputs and outputs of user-defined functions and user-defined function blocks from the library project, but the internal operations cannot be checked.

Note that if it is not necessary to debug functions and function blocks defined in the library project, the abovementioned test program is not required.

### Precautions when Using Integrity Analyzer

#### Test Program

When using Integrity Analyzer to analyze user-defined functions and user-defined function blocks, the original library project requires a test program that calls its functions and function blocks. This is because Integrity Analyzer analyzes functions and function blocks via the program and display warnings and errors that occur during the test. This test program is used purely for analysis by Integrity Analyzer and has nothing to do with the operation of an SCS project that uses the library.

#### "Authorize" Operation

It is possible to perform "authorize" on a library project as well. However, performing "authorize" on a library project does not mean that the SCS project that uses the library is authorized. The "authorize" of the SCS project does not become valid until the library project is incorporated in the SCS project and built using the SCS project.

#### Starting Operation of Integrity Analyzer

Integrity Analyzer is started in the same way as for an SCS project. Choose [Engineering] from [Tools] menu of SCS Manager. The Engineering launcher menu appears; select [Integrity Analyzer] to launch Integrity Analyzer.
How to Make Changes to Library Projects

To make changes to library projects, follow the procedure below.

1. Make the desired changes to an original library project and debug them.
2. Copy the original library project and paste it to the corresponding library folder of an SCS project.

It is not always necessary to make changes to an original library project, but the changes must be reflected in all the libraries including the original library project eventually.
7. **SOER Collection Definition**

Sequence of Events Recorder (SOER) is a function that collects and stores events occurred in an SCS.

The SOER collection definition defines which events to collect.

It also specifies the time synchronization method related to event collection time (time stamp).

By using SOE Viewer, it is possible to analyze collected events and save them in files. This section explains the types of objects for which events can be collected.

**SEE ALSO**

For more information about SOE Viewer, refer to:

4., “SOE Viewer” in Utilities and Maintenance Reference (IM 32Q04B20-31E)
7.1 Definition of Event Collection Objects

The setting method of event collection definition varies depending on the object. Events can be collected either from a discrete AIO/DIO module or an application logic.

Objects of Event Collection

The following types of events can be collected for SCSs.

- Signal changes of discrete input modules
  It is possible to collect events from discrete input modules according to the changes of data input from individual channels. Specify whether or not to collect events for each channel.

- Signal changes of discrete output data
  It is possible to collect events according to the changes of data output to individual discrete output channels. Specify whether or not to collect events for each channel.

- Alarms on Analog input data and Recovery
  It is possible to collect events by comparing the output values with the settings of alarm level set to the analog input block.

- Variation of Analog output data
  It is possible to collect events based on the variation of output variable. Take the settings of the output variable into SOE_R, and specify the conditions of event generation.

- Changes of internal variable of an application logic
  It is possible to collect events according to the changes of an internal variable of an application logic. Specify the object internal variable and conditions of event generation.

Event Collection Definition for Discrete Input/Output Modules

Use I/O Parameter Builder to specify whether or not to perform SOER collection for each channel of a discrete input/output module. Events are collected when the channel signal of the discrete input/output module changes.

For more information about setting items in I/O Parameter Builder, refer to:
- A4.6, “Items set for discrete inputs” in Safety Control Station Reference (IM 32Q03B10-31E)
- A4.7, “Items set for discrete outputs” in Safety Control Station Reference (IM 32Q03B10-31E)

Event Collection Definition for Application Logic

Events generated at input from an analog input and signal change in an application logic can be collected. In order to collect events, use Multi-Language Editor to add a function block for this purpose in a program or a function block. There are the following four types of function blocks that can collect events according to the target data type.

Table 7.1-1 Function Blocks that can Collect Data

<table>
<thead>
<tr>
<th>Data type</th>
<th>Function block</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BOOL</td>
<td>SOE_B</td>
<td>Records BOOL-type data values as events when a specified trigger value changes</td>
</tr>
<tr>
<td>DINT</td>
<td>SOE_I</td>
<td>Records DINT-type data values as events when a specified trigger value changes</td>
</tr>
<tr>
<td>REAL</td>
<td>SOE_R</td>
<td>Records REAL-type data values as events when a specified trigger value changes</td>
</tr>
</tbody>
</table>

Continues on the next page
### Table 7.1-1 Function Blocks that can Collect Data (Table continued)

<table>
<thead>
<tr>
<th>Data type</th>
<th>Function block</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IO_REAL</td>
<td>ANLG_S</td>
<td>Used for SOER on analog input. If an alarm is raised as the result of a data value exceeding the limit and the status continues for a specified period of time, the alarm status is recorded.</td>
</tr>
<tr>
<td></td>
<td>ANLGI</td>
<td>Used for SOER on analog input. Records data values as events when the data value gets outside the specified range.</td>
</tr>
</tbody>
</table>

**TIP**
It is necessary to append a character string to the ID terminal of a function block in order to identify events. The character string must be up to 32 characters.

**SEE ALSO**
- For more information about SOE_B, SOE_I, SOE_R, refer to: C7., “Interference-free function blocks” in Safety Control Station Reference (IM 32Q03B10-31E)
- For more information about ANLG_S, refer to: C3.7, “ANLG_S (analog input function block with data status)” in Safety Control Station Reference (IM 32Q03B10-31E)
- For more information about ANLGI, refer to: C3.8, “ANLGI (analog input)” in Safety Control Station Reference (IM 32Q03B10-31E)
7.2 Selection of Time Synchronization Method

In the case of SCSV1, the time synchronization has the following two options.

- V net time
- IRIG-B

Use SCS Constants Builder to select which method to use for synchronization. The default is V net time synchronization and the IRIG-B time synchronization is an option.

In the case of SCSP1/SCSP2, Vnet/IP time synchronization method is automatically selected.

For more information about SCS Constants Builder and time synchronization method setting, refer to:

3.1.3, “SCS Constants Builder” on page 3-8
8. Safety Analyzers

The following tools are provided for the purpose of analyzing application logic.

- Integrity Analyzer
- Cross Reference Analyzer

This section explains how to use each analyzer as well as how to check analysis results.

Roles of Integrity Analyzer and Cross Reference Analyzer

Integrity Analyzer is used to analyze application logics and detect functions whose use is not permitted in terms of safety. If unauthorized functions are used, operations for acknowledging the use are required.

Cross Reference Analyzer is used to analyze areas affected by modifications and display the test area when the application logic is modified. It is required to perform acknowledgement operation for this test area.

IMPORTANT

Make sure to perform the acknowledgement operations for both analyzers before downloading the application logic to an SCS. If acknowledgement by both analyzers has not been completed, offline download and online change download to SCS cannot be performed.

It is recommended to perform the acknowledgement operation with Integrity Analyzer first and then with Cross Reference Analyzer.
8.1 Integrity Analyzer

Integrity Analyzer analyzes application logics, detects "functions that are not allowed to be used" for the functions for safety and displays them in the window by highlighting for visual emphasis.

The user can check whether or not functions prohibited from use for safety applications are used. You can also print the analysis results.

If there is a program that intentionally makes use of functions prohibited from use for application, the user can acknowledge their use for each program upon examining the program based on the results of the analysis.

If functions prohibited from use for safety applications are used unintentionally, the application logic must be modified. Make changes to the application logic, perform a build operation and then analyze the application logic with Integrity Analyzer again.

**IMPORTANT**

- Before downloading application logic to SCS or before performing the SCS simulation test, run Integrity Analyzer and Cross Reference Analyzer, check and acknowledge the analysis results.

- It is possible to execute an application logic on a PC in logic simulation tests even if it has not been analyzed by both analyzers.

- Even when logic simulation tests are used, make sure to check that only functions whose use is permitted for safety applications and interference-free functions are used in an application logic by Integrity Analyzer at the appropriate time in order to detect errors in the application logic.

**SEE ALSO**

For more information about Cross Reference Analyzer, refer to:

8.2, "Cross Reference Analyzer" on page 8-19
8.1.1 Methods for Checking Analysis Results

This section explains how to check results of analysis by Integrity Analyzer.

- **Starting Integrity Analyzer**
  1. After a build operation, select [Engineering] from the [Tools] menu of SCS Manager. The Engineering launcher menu appears.
  2. Select [Integrity Analyzer] from the Engineering launcher menu. Integrity Analyzer starts up and analyzes the application logic in question.

**IMPORTANT**

- Start Integrity Analyzer after modifying and saving an application logic and performing a build operation. Integrity Analyzer analyzes the databases generated by the build operation.
- If Integrity Analyzer has already been started when you attempted to perform a build or download operation, a dialog box prompting to close Integrity Analyzer appears. In this case, neither the build nor the download operation is performed.

- **Procedure for Using Integrity Analyzer**
  
  The procedure for using Integrity Analyzer is explained below.
  1. Checking functions prohibited from use in terms of safety in Project Tree
     The results of analyzing the application logic with Integrity Analyzer are displayed in Project Tree. Check whether or not functions prohibited from use in terms of safety are used.
  2. Checking with analysis result report
     Check the Integrity Analysis Report showing the analysis results, either directly in a window or by printing it out.
  3. Acknowledgement of functions prohibited from use in terms of safety
     If there are programs that use interference-free functions intentionally, acknowledge the use of those functions for each program in the Acknowledge Non-Compliance dialog box upon examining the programs based on the analysis results.
     If interference-free functions are used unintentionally or prohibited functions are used, it is necessary to modify the application logic in question. Close Integrity Analyzer without approving the functions, modify the application logic, perform a build operation and then analyze the application logic by Integrity Analyzer again.
  4. Saving and printing analysis results
     Save the analysis results and print them if necessary.

- **Checking Functions Prohibited from Use in Terms of Safety in Project Tree**
  
  Project Tree allows checking whether or not functions that are prohibited from use in terms of safety exist in an application logic.
The graphical analysis results can only be viewed in the window; it cannot be printed out.

For more information about analysis results requiring your attention, refer to:
3.2, “Precautions for Engineering” in Engineering Guide (IM 32Q01C10-31E)

**How to Understand Icon Colors**

Project Tree displays SCS projects, configurations, resource and programs in a tree structure. Double-click a program icon to display icons for [Language], [Size], [Functions] and [Variables]. Analysis results are shown using colored icons placed to the left of the labels in the tree.

### Table 8.1.1-1 Meaning of Colors of Icons on the Left Side of Project Tree

<table>
<thead>
<tr>
<th>Icon color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red</td>
<td>Errors. Red icons indicate that prohibited functions are used. For example, using AND with 17 or more input parameters or using arrays in FBD or LD fall under this classification. It is necessary to modify programs for which red icons are displayed and remove the prohibited functions. It is not possible to download application logics to an SCS if they contain prohibited functions.</td>
</tr>
<tr>
<td>Yellow</td>
<td>Warnings. Yellow icons indicate that interference-free functions are used. For example, SIN and COS functions cannot be used in safety applications but can be used in other applications (control logics that do not influence safety). Check that the areas where the interference-free functions exist are outside the range of safety applications. Alternatively, check that there is no influence on safety applications. Once the use of interference-free functions is acknowledged, the applications can be downloaded to an SCS.</td>
</tr>
<tr>
<td>Green</td>
<td>No error. Green icons indicate that a program is created using only the functions for safety (safety applications are created). Though acknowledgement is not required, the acknowledgement status needs to be saved.</td>
</tr>
</tbody>
</table>

If you select an individual icon in Project Tree, detailed analysis information of items to be checked is displayed in the right pane of the window. The right pane shows analysis results of an item selected in Project Tree using one of the following icons.
### Table 8.1.1-2 Meaning of Icons in the Right Pane

<table>
<thead>
<tr>
<th>Icon</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="red" alt="red" /></td>
<td>Error. Prohibited functions are used.</td>
</tr>
<tr>
<td><img src="yellow" alt="yellow" /></td>
<td>Warning. Interference-free functions are used.</td>
</tr>
<tr>
<td><img src="green" alt="green" /></td>
<td>No error. A program is created using only the functions for safety.</td>
</tr>
</tbody>
</table>

**SEE ALSO**

For more information about how to understand analysis results of programs in Project Tree, refer to:

8.1.3, "Confirmation of Analysis Results by Project Tree" on page 8-12

### Checking with Analysis Report

The Integrity Analysis Report organizes and summarizes all the information in analysis results. It can be displayed in a window, printed or saved in a file (using RTF or TEXT format) as a report.

The Integrity Analysis Report is used mainly for the following two applications.

- It provides more detailed information than the information obtained by expanding Project Tree.
- The Integrity Analysis Report can be used as a part of operation records or application construction documentation, by printing it out or saving it to a file. The Integrity Analysis Report also includes information about whether or not acknowledgement is made in the Acknowledge Non-Compliance dialog box, along with comments. In order to record acknowledged items, print or save the report in a file after acknowledgement.
Figure 8.1.1-2 Example of Integrity Analysis Report

- **Saving and Displaying Analysis Report**

  1. Select a resource in Project Tree and select [Save Analysis] from the [File] menu. Alternatively, click "Save current analysis history" button in the toolbar; the analysis results are saved.

  2. Select [Report] from the [Analyze] menu. The saved analysis results are displayed as an analysis report.
IMPORTANT

Make sure to save the analysis results before creating an analysis report.

If the current analysis results and acknowledgement history are not saved before creating an analysis report, a message prompting you to save the history is notified. If you click [Yes] button in the message box, the current analysis results and acknowledgement history are saved, overwriting the history saved before in the process, and an analysis report is created. An analysis report is not created if you click [No] button.

Acknowledgement of Interference-free Functions

If the analyzed application logic includes programs using interference-free functions, it is necessary to acknowledge such programs one by one in the Acknowledge Non-Compliance dialog box.

![Acknowledge Non-compliance Dialog Box]

The program(s) listed below have failed one or more integrity checks. Click on the check box to acknowledge and accept them as non-hazardous.

<table>
<thead>
<tr>
<th>Program</th>
<th>Resource</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>PROG1</td>
<td>SCS0101</td>
<td>SCS0101</td>
</tr>
<tr>
<td>PROG3</td>
<td>SCS0101</td>
<td>SCS0101</td>
</tr>
<tr>
<td>PROG4</td>
<td>SCS0101</td>
<td>SCS0101</td>
</tr>
</tbody>
</table>

Comment

Use of AND(4) authorized - omitted from allowed function list

OK Cancel

Figure 8.1.1-3 Acknowledge Non-Compliance Dialog Box

Displaying the Acknowledge Non-Compliance Dialog Box

Select [Authorize] in the [Analyze] menu. Alternatively, click "Display program non-compliance dialog" button in the toolbar. The Acknowledge Non-Compliance dialog box appears.

Acknowledgement of Programs

This dialog box shows analysis results of each program with one of the following icons.
Table 8.1.1-3 Meaning of Icons

<table>
<thead>
<tr>
<th>Icon (color)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>✗ (red)</td>
<td>A program uses prohibited functions. This icon has the same meaning as the red program icon displayed in Project Tree. Modify the program and remove the prohibited functions. This program cannot be acknowledged.</td>
</tr>
<tr>
<td>! (yellow)</td>
<td>A program uses interference-free functions. This icon has the same meaning as the yellow program icon displayed in Project Tree. In order to download the programs to an SCS, it is necessary to check each check box of all the programs marked with this icon and acknowledge them.</td>
</tr>
</tbody>
</table>

Before approving, confirm that only the functions for safety are used in the safety application using Project Tree or by checking the Integrity Analysis Report.

The reasons why interference-free functions are used, results of analysis for the purpose of acknowledgement, etc., can be entered as comments. The Integrity Analysis Report includes information about whether or not acknowledgement was made along with any comments entered.
8.1.2 Integrity Analyzer Window Structure

This section explains the window structure of Integrity Analyzer.

Menu Bar

The menu bar provides the following menus.

- [File] menu
- [Analyze] menu
- [Options] menu

The menu items of each menu are explained below.

Table 8.1.2-1 File Menu

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print Report</td>
<td>Prints an analysis report saved by [Save Analysis]</td>
</tr>
<tr>
<td>Save Report</td>
<td>Creates an analysis report and saves it in a file (RTF or TEXT format)</td>
</tr>
<tr>
<td>Save Analysis</td>
<td>Saves analysis results and acknowledgement status.</td>
</tr>
<tr>
<td>Exit</td>
<td>Closes Integrity Analyzer</td>
</tr>
</tbody>
</table>

Table 8.1.2-2 Analyze Menu

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start</td>
<td>Performs analysis and compares with the results of previous warning acknowledgement and analysis. If the areas acknowledged in the previous analysis are not modified this time, it is regarded as if they have already been acknowledged.</td>
</tr>
<tr>
<td></td>
<td>Performs analysis without comparing it with results of previous acknowledgement and analysis</td>
</tr>
</tbody>
</table>

Continues on the next page
### Table 8.1.2-2 Analyze Menu (Table continued)

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report</td>
<td>Creates and displays the analysis report in the Integrity Analysis Report window</td>
</tr>
<tr>
<td>Authorize</td>
<td>Displays the Acknowledge Non-Compliance dialog box.</td>
</tr>
</tbody>
</table>

### Table 8.1.2-3 Options Menu

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Settings</td>
<td>Displays the Settings dialog box</td>
</tr>
</tbody>
</table>

**IMPORTANT**

Make sure to save the analysis results before creating an analysis report.

If the current analysis results and acknowledgement history are not saved before creating an analysis report, a message prompting you to save the history is notified. If you click [Yes] button in the message box, the current analysis results and acknowledgement history are saved, overwriting the history saved before in the process, and an analysis report is created. An analysis report is not created if you click [No] button.

### Toolbar

The toolbar provides the following buttons.

**Table 8.1.2-4 Toolbar Buttons**

<table>
<thead>
<tr>
<th>Button</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Save current analysis history" /></td>
<td>Save current analysis history</td>
<td>Saves analysis results and acknowledgement status.</td>
</tr>
<tr>
<td><img src="image" alt="Print report for a selected resource" /></td>
<td>Print report for a selected resource</td>
<td>Prints analysis reports.</td>
</tr>
<tr>
<td><img src="image" alt="Display program non-compliance dialog" /></td>
<td>Display program non-compliance dialog</td>
<td>Displays the Acknowledge Non-Compliance dialog box.</td>
</tr>
<tr>
<td><img src="image" alt="Previous non-compliance" /></td>
<td>Previous non-compliance</td>
<td>Selects the icon of the previous interference-free element or element not allowed in terms of safety relative to the currently selected icon in Project Tree (the upward direction in the tree).</td>
</tr>
<tr>
<td><img src="image" alt="Next non-compliance" /></td>
<td>Next non-compliance</td>
<td>Selects the icon of the next interference-free element or element not allowed in terms of safety in Project Tree relative to the currently selected icon (the downward direction in the tree).</td>
</tr>
</tbody>
</table>

### Project Tree

Project Tree is displayed on the left pane of the Integrity Analyzer window.

- SCS0101
- PROG1
- PROG2

**Figure 8.1.2-2 Project Tree**

Each level of Project Tree can be expanded or collapsed by double-clicking an icon or text label, or clicking the +/- button on the left edge.
Analysis results of an item selected in Project Tree are displayed in the right pane of the window.

The display arrangement of Project Tree can be defined in Settings dialog box.

- **Settings Dialog Box**

  On the [Options] menu, click [Settings]. The Settings dialog box appears.

  ![Settings Dialog Box](image)

  **Figure 8.1.2-3 Settings Dialog Box**

  - **Project Tree**
    - Sort as workbench: Contents displayed on Project Tree are sorted along with Workbench.
    - Sort by name: Contents displayed on Project Tree are sorted by names alphabetically.
  - **Keep On Top**
    Integrity Analyzer window is kept always on top.
8.1.3 Confirmation of Analysis Results by Project Tree

This section explains how to understand the detailed information displayed when the following layers below the resource (the SCS project) are selected in Project Tree.

- Resource (list of program errors and unacknowledged warnings in a resource)
- Program (program classification and analysis results)
- Language (language usage information of a program)
- Size (size information of a program)
- Functions (results of analyzing program source code and object code)
- Variables (results of analyzing variables in a program)

Displaying Analysis Results of Functions and Function Blocks

Project Tree displays analysis results of FUs and FBs as part of the summary for the program that calls the FUs and FBs.

That is, if you expand an icon of a program name, not only the analysis results of the program itself, but also the analysis results for the FUs and FBs called by the program are displayed.

Checking Resources

A list of analysis statuses of resources (SCS projects) is displayed in the right pane of the window. The list displays detected errors and unacknowledged warnings.

Figure 8.1.3-1 Analysis Results of Resource

The analysis results of the selected resource are classified into errors and unacknowledged warnings, and displayed in a tree structure in the right pane. Errors and unacknowledged warnings can be expanded or collapsed.

These graphical analysis results can only be viewed in the window; they cannot be printed out.
Checking Programs

When you select a program name in Project Tree, a list of analysis results of the program is displayed in the right pane of the window. The classification of the program and the result of analysis (Pass, Fail, Warning) are displayed.

Figure 8.1.3-2 Analysis Results of a Program for which Error Occurred

These graphical analysis results can only be viewed in the window; they cannot be printed out.

Checking Program Languages

If you select [Language] in Project Tree, the language used for the program is displayed in the right pane of the window. If the program includes user-defined FUs or user-defined FBs, the languages used for them are shown as well.

Table 8.1.3-1 Icons Displayed on the Left Side of Program Names and Meaning

<table>
<thead>
<tr>
<th>Icon (color)</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓ (green)</td>
<td>POUs are created using permitted languages</td>
</tr>
<tr>
<td>❌ (red)</td>
<td>POUs are created using languages that are not allowed (*1)</td>
</tr>
</tbody>
</table>

*1: When using ST to write a program other than FU and FB, an error will occur.

Figure 8.1.3-3 Results of Checking Languages Used in Programs

The screenshot example above shows the result of analyzing languages used in PROG1. PROG1 uses a function block called Fb2 and a function called Func2. PROG1, Fb2 and Func2 are written with permitted languages.

These graphical analysis results can only be viewed in the window; they cannot be printed out.
Checking Program Size

**IMPORTANT**

If the program size exceeds the specified limit, a warning is displayed. However, even if the warning is displayed, you can still use the program for a safety function after sufficiently confirming the validity of the program through some testing.

If you select [Size] in Project Tree, the size of the program and the specified upper limit size are displayed in the right pane of the window. If the program includes user-defined FUs or user-defined FBs, their program sizes are shown as well.

For the FB created with ST, the number of lines excluding the comment lines and blank lines as well as the maximum number of lines is displayed.

<table>
<thead>
<tr>
<th>Icon (color)</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>![yellow]</td>
<td>The program size exceeded the warning range</td>
</tr>
</tbody>
</table>

![Integrity Analyzer [Pjt:SCS0101]]

File Analyze Options

![SCS0101]

PROG1 91528 0..4000
Func2 5206 0..4000

Table 8.1.3-2 Icon Displayed on the Left Side of Program Names and Meaning

<table>
<thead>
<tr>
<th>Icon (color)</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>![yellow]</td>
<td>The program size exceeded the warning range</td>
</tr>
</tbody>
</table>

Figure 8.1.3-4 Program Size Information

These graphical analysis results can only be viewed in the window; they cannot be printed out.

Checking Program Source Code and Object Code

If you select [Functions] in Project Tree, the results of analyzing the source code and object code of the program are displayed as a list of unauthorized FUs or FBs used in the right pane of the window.

An icon displayed to the left of a function name or function block name indicates that the FU or FB is not allowed in terms of safety.

<table>
<thead>
<tr>
<th>Icon (color)</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>![red]</td>
<td>The FU or FB in question is not classified as safe or interference-free and its use caused an error</td>
</tr>
<tr>
<td>![yellow]</td>
<td>The FU or FB in question is classified as interference-free and its use in a safety program requires acknowledgement</td>
</tr>
</tbody>
</table>

Table 8.1.3-3 Icons Displayed on the Left Side of Function Names/Function Block Names and Meaning
Integrity Analyzer searches in one or multiple POUs for the functions calling the same FB instance and displays the functions as the analysis result. If the same FB instance in a POU is called by multiple functions from different locations, the related functions and POUs will be displayed with respective warning messages. The above figure illustrates the result of the analysis.

In the message displayed in the "Function" column of the preceding figure, FBDFB_A is the name of the POU and AVERAGE is the type of the FB. The instance name or parameter name is displayed in parentheses in the "Non-compliance" column.

In LD source code analysis, the existence and usage of EN inputs inside the program are also detected. An EN input refers to the first BOOL-type input that is automatically appended when the type of the first input for FUs or FBs is BOOL in LD.

If libraries are used, the source files of the libraries are also analyzed.

A number in ( ) following a function name or function block name indicates the number of inputs. However, EN inputs are not included in this number.

In case of a library, a function name is displayed as "library name.program name.function name" and a function block name is displayed as "library name.program name.function block name."

Note that the graphical view of the analysis results in the above figure is only available on the screen. The printout is text only.

If unrecognizable statements or scripts with incorrect syntax are found in ST, the following messages are displayed in the "Non-compliance" column.

Table 8.1.3-4 Non-Compliance Messages when Error or Warning Occurs

<table>
<thead>
<tr>
<th>Icon (color)</th>
<th>Message in Function(^{(1)})</th>
<th>Message in Non-Compliance</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![red]</td>
<td>ST_FB.WHILE</td>
<td>Prohibited (line xx) (^{(2)})</td>
<td>WHILE must not be used.</td>
</tr>
<tr>
<td>![red]</td>
<td>ST_FB.REPEAT</td>
<td>Prohibited (line xx) (^{(2)})</td>
<td>REPEAT must not be used.</td>
</tr>
<tr>
<td>![red]</td>
<td>ST_FB.FOR</td>
<td>Loop nesting (line xx) (^{(2)})</td>
<td>Nested loop in FOR loop must not be used.</td>
</tr>
<tr>
<td>![red]</td>
<td>ST_FB.FOR</td>
<td>Variable iteration count (line xx) (^{(2)})</td>
<td>Initial value, end condition or step number in FOR loop must use a constant.</td>
</tr>
<tr>
<td>![red]</td>
<td>ST_FB.FOR</td>
<td>Iteration counter overflow (line xx) (^{(2)})</td>
<td>FOR loop index counter range overflow.</td>
</tr>
<tr>
<td>![red]</td>
<td>ST_FB.EXIT</td>
<td>Outside loop (line xx) (^{(2)})</td>
<td>EXIT must not be used outside FOR loop.</td>
</tr>
</tbody>
</table>

Continues on the next page
Table 8.1.3-4 Non-Compliance Messages when Error or Warning Occurs (Table continued)

<table>
<thead>
<tr>
<th>Icon (color)</th>
<th>Message in Function(*1)</th>
<th>Message in Non-Compliance</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(yellow)</td>
<td>ST_FB.RET</td>
<td>Interference Free (line xx) (*2)</td>
<td>Interference-free. Due to RETURN being used.</td>
</tr>
<tr>
<td>(yellow)</td>
<td>ST_FB.FOR</td>
<td>Excessive iterations (line xx) (*2)</td>
<td>Due to the number of iterations in FOR loop exceeding 500.</td>
</tr>
<tr>
<td>(yellow)</td>
<td>ST_FB.FBD_FB</td>
<td>Function Block Call (*3)</td>
<td>Due to ST calling FB.</td>
</tr>
<tr>
<td>(yellow)</td>
<td>ST_FB.FBD_FB</td>
<td>FB Parameter Access (*4)</td>
<td>Due to ST accessing FB parameter.</td>
</tr>
<tr>
<td>(yellow)</td>
<td>ST_FB.FBD_FB.&lt;&gt;</td>
<td>Exact comparison (line xx) (*5)</td>
<td>Exact comparison should not be used to compare real numbers.</td>
</tr>
</tbody>
</table>

*1: The messages of ST_FB here are the examples of functions and function blocks. FBD_FB is a function block name example, not an instance name.
*2: xx in (line xx) will be replaced by the line number that are applicable to the message.
*3: The message will be displayed once even though the same FB is called many times by ST.
*4: The message will be displayed once even though same parameters in the same FB or different parameters in the same FB are accessed many times by ST.
*5: xx in (line xx) will be replaced by all the line numbers that are related to the ST message.

Even comparing the two real numbers using an equal operator or not equal operator in FBD or LD is classified as interference-free, and the message "Exact Comparison" will be displayed once per POU in the "Non-compliance" column.

SEE ALSO

For more information about using Structured Text language to write FU and FB, refer to:

2.5, "Structured Text" in Engineering Guide (IM 32Q01C10-31E)

Checking Analysis Results of Variables in Programs

If you select [Variables] in the project tree, variables that do not satisfy the requirements of the program, such as naming rules and data type, are displayed in the right pane of the window.

The right pane displays names of variables that may cause errors or warnings and the programs, FUs or FBs to which those variables belong. Moreover, detailed information about errors and warnings is also displayed.

![Integrity Analyzer](image)

Figure 8.1.3-6 Example of Variable Analysis Results

The Integrity Analyzer checks POUs to detect illegal writings: multiple writing to a variable within a POU or by different POUs, and writing to output variable statuses. The preceding figure illustrates the result of the analysis. In the [POU] column, names of the POUs performing the illegal writing are displayed. If a POU contains multiple writing to the same variable, a warning message will be displayed for that POU. If multiple POUs are writing to the same variable, a warning message will be displayed for each of the POUs.
TIP

- Integrity Analyzer does not detect multiple writing to the same variable in ST objects. Such usage should be checked through a code review or unit test. However, multiple writing to the same variable by a certain ST object and other POU will be detected.
- Integrity Analyzer does not detect multiple writing to arrays or array elements.

Error messages will be displayed for the POUs that are writing to the status of output variables.

- Integrity Analyzer detects writing to the .status member of the IO_BOOL or IO_REAL variables having output attribute.

For example, an error message is displayed in the following case: The value of internal variable bool1 (type BOOL) is written to the .status member of output variable DO010101 (type IO_BOOL).

```
bool1  DO010101.status
```

Figure 8.1.3-7 Example where Error Message is Displayed for POU (1)

- Integrity Analyzer detects writing to the entire IO_BOOL or IO_REAL variables having output attribute. Integrity Analyzer also detects the cases where the output (type IO_BOOL or IO_REAL) of a function block, such as B_TO_IB, is connected to an output variable.

For example, an error message is displayed in the following cases:

The value of internal variable IO_BOOL1 (type IO_BOOL) is written to the .status member of output variable DO010102 (type IO_BOOL).

```
IO_BOOL1  DO010102
```

Figure 8.1.3-8 Example where Error Message is Displayed for POU (2)

The value of Q (type IO_BOOL), which is the output of function block B_TO_IB, is written to the .status member of output variable DO010103 (type IO_BOOL).

```
bool_v  bool_sts  V  STS  Q  DO010103  B_TO_IB
```

Figure 8.1.3-9 Example where Error Message is Displayed for POU (3)

Table 8.1.3-5 Error Messages Displayed in Non-Compliance Column

<table>
<thead>
<tr>
<th>Icon (color)</th>
<th>Indication in [Variable]</th>
<th>Message in Non-Compliance</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>! (yellow)</td>
<td>gVarA (*1)</td>
<td>Multiple writes</td>
<td>Multiple writing to this variable was detected.</td>
</tr>
<tr>
<td>*2</td>
<td>Invalid write(status) (*3)</td>
<td>Writing to the status of this output variable was detected.</td>
<td></td>
</tr>
</tbody>
</table>

*1: Variable name or FB instance name plus parameter name is displayed.
*2: Variable name is displayed.
*3: In parentheses ( ), the member name (i.e. status) or type name of the variable is displayed.

Note that the graphical view of the analysis results in the above figure is only available on the screen. The printout is text only.

If prohibited variables are used in ST, the following messages will be displayed as Non-Compliances.
Table 8.1.3-6 Error Messages Displayed in Non-Compliance Column

<table>
<thead>
<tr>
<th>Icon (color)</th>
<th>Message in Variable</th>
<th>Message in Non-Compliance</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>❌ (red)</td>
<td>bArrayB[1..10000]</td>
<td>Array size</td>
<td>Number of array elements exceeds 500.</td>
</tr>
<tr>
<td>❌ (red)</td>
<td>MultiArray[1..10]</td>
<td>Array dimensions</td>
<td>Multiple dimension arrays cannot be used.</td>
</tr>
<tr>
<td>❌ (red)</td>
<td>bArrayC[10..20]</td>
<td>Array bounds</td>
<td>The array initial index must be 1.</td>
</tr>
<tr>
<td>❌ (red)</td>
<td>strArray[1..10]</td>
<td>Bad array type(TYPE)</td>
<td>Array cannot contain prohibited data type (Detail is displayed in (TYPE)).</td>
</tr>
<tr>
<td>❌ (red)</td>
<td>DO1</td>
<td>Bad type(TYPE)</td>
<td>Prohibited global variable cannot be used (Detail is displayed in (TYPE)).</td>
</tr>
<tr>
<td>❌ (red)</td>
<td>COM_BOOL1</td>
<td>Bad local type(TYPE)</td>
<td>Prohibited local variable cannot be used (Detail is displayed in (TYPE)).</td>
</tr>
<tr>
<td>❌ (red)</td>
<td>COM_BOOL2</td>
<td>Bad parameter type(TYPE)</td>
<td>Prohibited input/output parameter cannot be used (Detail is displayed in (TYPE)).</td>
</tr>
<tr>
<td>❌ (red)</td>
<td>(*)1</td>
<td>Array check error</td>
<td>The analyzer detected a defect of a mechanism which checks the access outside the range of array.</td>
</tr>
</tbody>
</table>

*1: Message cannot be displayed.

If prohibited variables are used in FBD or LD, the following messages will be displayed as Non-Compliances.

Table 8.1.3-7 Error Messages Displayed in Non-Compliance Column

<table>
<thead>
<tr>
<th>Icon (color)</th>
<th>Message in Variable</th>
<th>Message in Non-Compliance</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>❌ (red)</td>
<td>bArrayA[1..10]</td>
<td>Array not allowed</td>
<td>Array must not be used in FBD or LD.</td>
</tr>
</tbody>
</table>

These graphical analysis results can only be viewed in the window; it cannot be printed out.
8.2 Cross Reference Analyzer

Cross Reference Analyzer displays the differences between the previously downloaded application (the application currently running in an SCS) and the application to be downloaded, and the extent to which the download will affect the operation in a window by highlighting them visually, in order to limit the range of retesting caused by changes in an application logic.

You can check programs that require retesting. You can also print the analysis results.

Cross Reference Analyzer detects programs that depend on the modified program. You should retest the detected programs. A list of programs requiring retesting is displayed; they can be acknowledged upon checking the analysis results of each program.

If unintended program changes and dependencies are detected, the application logic must be modified. Modify the application logic, perform a build operation and then analyze the application logic with Cross Reference Analyzer again.

If no program is found for retesting, retesting will not be performed. However, since the modifications on a certain items may not be discovered for retesting, these modified items need to be tested accordingly.

IMPORTANT

• Before downloading application logic to SCS, run Integrity Analyzer and Cross Reference Analyzer and acknowledge.

• Cross Reference Analyzer detects the differences between the application currently running in an SCS and the application to be downloaded.

  It does not detect differences with an application running in a virtual test.

  In a virtual test, it is possible to execute and test an application logic on a PC without having to perform analysis by both analyzers.

Cross Reference Analyzer also has the function to compare an SCS database with the master database of other SCS project with the same domain number and station number. Using this function, you can verify that a project created from an existing project is exactly the same in functionality as the original project. This eliminates the need to test all the POUs when you regenerate a project.

For more information about Integrity Analyzer, refer to:

  8.1, “Integrity Analyzer” on page 8-2

For more information about the items that require retesting but not detected by Cross Reference Analyzer, refer to:

  8.2.5, “Precautions on Cross Reference Analyzer” on page 8-46
8.2.1 Methods for Checking Analysis Results

This section explains how to check results of analysis by Cross Reference Analyzer.

■ Starting Cross Reference Analyzer

1. After a build operation, select [Engineering] from the [Tools] menu of SCS Manager. The Engineering launcher menu appears.
2. Select [Cross Reference Analyzer] from the Engineering launcher menu. Cross Reference Analyzer starts up, automatically analyzes the application logic in question and displays the analysis results.

TIP
Cross Reference Analyzer displays or prints the differences between the previously downloaded application logic and the application logic to be downloaded, and the extent of the differences. If an application logic has never been downloaded, there is no equivalent to a previously downloaded application logic. In this case, Cross Reference Analyzer displays all programs as new.

IMPORTANT
If Cross Reference Analyzer has already started when you attempted to perform a build or download operation, a dialog box prompting to close Cross Reference Analyzer appears. In this case, neither the build nor the download operation is performed.

■ Procedure for Using Cross Reference Analyzer

The procedure for using Cross Reference Analyzer is explained below.

1. Checking programs in Dependency Tree
Check the results of analysis by Cross Reference Analyzer in Dependency Tree to identify the programs requiring retesting. The programs requiring retesting are those with changes and those that depend on the changed programs.

2. Checking with analysis result report
Check the Cross Reference Analysis Report showing the analysis results, either directly in a window or by printing it out.

3. Acknowledgement of differences between application logics and extent of influence
A list of programs requiring retesting is displayed in the Acknowledge Dependencies dialog box; acknowledge them upon checking the analysis results of each program.

If unintended changes and independencies are detected or the application requires modification, close Cross Reference Analyzer without approving the programs. Modify the application logic, perform a build operation and then analyze the application logic by Cross Reference Analyzer again.

4. Saving and printing analysis results
Save the analysis results and print them if necessary.

■ Checking Programs in Dependency Tree

Dependency Tree allows checking the results of comparing the application logic running on an SCS and the application logic to be downloaded, as well as programs that depend on the changes. These programs are the ones that require retesting and review.
Figure 8.2.1-1 Example of Program Analysis Result by Cross Reference Analyzer

These graphical analysis results can only be viewed in the window; they cannot be printed out.

**How to Understand Icon Colors**

Dependency Tree displays SCS projects, configurations, resources and programs in a tree structure. Double-click a program icon to display icons for [Programs], [Functions], [Function Blocks], [Variables], [Defined Words], [I/O Parameters] and [Bindings]. Analysis results are shown using colored icons placed to the left of the labels in the tree.

Table 8.2.1-1 Meaning of Colors of Icons on the Left Side of Dependency Tree

<table>
<thead>
<tr>
<th>Icon color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red</td>
<td>Red icons indicate that programs or function blocks and functions used in the program have been changed.</td>
</tr>
<tr>
<td>Yellow</td>
<td>Yellow icons indicate dependencies on changed programs. Although the programs themselves have not been changed, it is necessary to retest or examine the code in order to check that it is not affected by changes made to the dependent programs. A yellow icon may also indicate that the program name was changed. Retesting is not required in this case.</td>
</tr>
<tr>
<td>Green</td>
<td>Green icons indicate that the changes do not affect other programs. Neither retesting nor review is required.</td>
</tr>
</tbody>
</table>

If you select an individual icon in Dependency Tree, detailed analysis information of the item to be checked is displayed on the right pane of the window. The right pane shows the status of changes of the item selected in Dependency Tree and the extent of influence of the changes.

If you select an individual icon below the program layer, the following colored icons are displayed next to the corresponding program components in the right pane of the window.
Table 8.2.1-2 Meaning of Icons in the Right Pane of the Window when an Icon below the Program Icon is Selected

<table>
<thead>
<tr>
<th>Icon (color)</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Green]</td>
<td>An item in the right pane is dependent on the program selected in Dependency Tree but not affected directly by the changes.</td>
</tr>
<tr>
<td>![Red]</td>
<td>An item in the right pane is dependent on the program selected in Dependency Tree and affected by the changes. In other words, the item was directly changed or newly created, or is dependent on the changed areas.</td>
</tr>
<tr>
<td>![Green]</td>
<td>An item in the right pane used to depend on the program selected in Dependency Tree but the dependency was eliminated by the change.</td>
</tr>
</tbody>
</table>

**SEE ALSO**

For more information about how to understand analysis results of programs in Dependency Tree, refer to:

8.2.3, “Confirmation of Analysis Results by Dependency Tree” on page 8-30

### Checking with Analysis Report

The Cross Reference Analysis Report organizes and summarizes all the information in analysis results. It can be displayed in a window, printed or saved in a file (RTF or TEXT format) as a report.

The Cross Reference Analysis Report is used mainly for the following two applications.

- It provides more detailed information than the information obtained by expanding Dependency Tree.
- The Cross Reference Analysis Report can be used as a part of operation records or application construction documentation, by printing it out or saving it to a file. The Cross Reference Analysis Report also includes information about whether or not acknowledgement is made in the Acknowledge Dependencies dialog box, along with comments. In order to record acknowledged items, print or save the report in a file after acknowledgement.
Application Logic Cross Reference Analysis Report

Project : SCS0101
Configuration : SCS0101
Resource : SCS0101 (101)
Project Build Date : 12/05/2007 10:45:30 AM
Project Analysis Date : 12/05/2007 1:18:27 PM
Report Date : 12/05/2007 1:19:02 PM
User : MATSUI

Programs in previous version : 8
Programs in current version : 8
Variables in previous version : 66
Variables in current version : 66
Shared variables in previous version : 57
Shared variables in current version : 57

Modified Programs
Name                  Change
PROG2                Modified
PROG3                Deleted
PROG5                I/O Changed
PROG7                Modified I/O Changed
PROG8                Function block modified, Variable changed, Defined Word changed
WASPROG4              Renamed

Modified Functions
Name                  Change
Func4                Modified

Modified Function Blocks
Name                  Change
Func1                Modified

Modified Variables
Name                  Change
IN1                   Type Changed, Initial Changed
IN2                   Scope Changed
OUT1                  Type Changed

Modified Defined Words
defConst              Equivalent Changed

I/O Parameter Changes
Variable                  Comment
AS001                    1-3 SAV144[01] Channel
DI001                   1-5 SDV144[01] Channel
DI002                   1-5 SDV144[02] Channel
DI003                   1-5 SDV144[03] Channel
DI007                   1-5 SDV144[07] Channel

Dependency Cross Reference

Current Version Bound Variable Usage
Program                  Bound variables
PROG1                     C01001 C01002 C01003
PROG2                     C01001 C01003 CONSU2 P02002
PROG5                     C01001 P03001 P03002 P030003
PROG6                     P03001
PROG7                     LP0001@PROG7
PROG8
WASPROG4

Current Version Bound Variable Cross Reference
Bound Variable          Used
C01001                  PROG1 PROG2 PROG5
C01002                  PROG1
C01003                  PROG1(2) PROG2 Unmatched name (P02005)
CONSU2                  PROG2 Unmatched name (P02006)
LP0001@PROG7            PROG7(3)
P02002                  PROG2
P03001                  PROG5
P03002                  PROG5
P03003                  PROG5

Acknowledgement Status
Program                  Status
PROG1                    Not Modified Not acknowledged
PROG2                    Modified Not acknowledged
PROG5                    I/O Changed Not acknowledged
PROG7                    Modified I/O Changed Acknowledged by SUZUKI 12/05/2007 09:10:23
PROG8                    Function block modified, Variable changed, Defined Word changed
Not acknowledged

Number of programs requiring acknowledgement : 4

Figure 8.2.1.2 Example of Cross Reference Report (RTF Format File)
Displaying Analysis Report

1. Select a resource in Dependency Tree and select [Save Analysis] in the [File] menu. Alternatively, click [Save current analysis history] button in the toolbar; the analysis results are saved.

2. Select [Report] from the [Analyze] menu. The saved analysis results are displayed as an analysis report.

**IMPORTANT**

Make sure to save the analysis results before creating an analysis report.

If the current analysis results and acknowledgement history are not saved before creating an analysis report, a message prompting you to save the history is notified. If you click [Yes] button in the message box, the current analysis results and acknowledgement history are saved, overwriting the history saved before in the process, and an analysis report is created. An analysis report is not created if you click [No] button.

Displaying Previous Analysis Report

By running [Previous Report] in the [Analyze] menu, you can display the report of the analysis result for the previously downloaded application. The report file is saved in .rtf format. The report date of the previous analysis report is the date that the analysis report was last saved before downloading.

Acknowledgement of Program Dependencies

If the analyzed application logic contains programs requiring retesting because they were changed or depend on the changed programs, it is necessary to acknowledge these programs one by one in the Acknowledge Dependencies dialog box.
Displaying the Acknowledge Dependencies Dialog Box

Select [Authorize] in the [Analyze] menu. Alternatively, click "Display program dependency acknowledge dialog" button in the toolbar. The Acknowledge Dependencies dialog box appears.

Acknowledgement of Programs with Changes and Dependencies

The Acknowledge Dependencies dialog box displays programs indicated with red or yellow icons in Dependency Tree. In order to download the application logic to an SCS, it is necessary to acknowledge all the programs displayed in the dialog box.

The user must confirm the following items and then check the check box for each program:

- Retesting and review must be planned and executed for programs indicated by red and yellow icons.
- No unintended modifications are included.
- No unintended dependencies (e.g., unintended sharing of global variables) are included.

Authorize Download Check Box

Selecting this check box allows downloading the application logic to an SCS without acknowledging individual program dependencies.
**IMPORTANT**

- Use this check box only at the beginning of application development such as during debugging an application logic.
- While the SCS is in use for actual plant, acknowledge the dependencies of individual programs without selecting this check box.
- It is recommended to enter the reasons in the comment field when the Authorize Download check box is selected.

**Comment**

Memos related to changed areas, results of analysis for the purpose of acknowledgement, etc. can be entered as comments. The Cross Reference Analysis Report includes information about whether or not programs are acknowledged, along with comments.
8.2.2 Cross Reference Analyzer Window Structure

This section explains the window structure of Cross Reference Analyzer.

- **Menu Bar**
  
  The menu bar provides the following menus.
  - [File] menu
  - [Analyze] menu
  - [Options] menu

  The menu items of each menu are explained below.

  **Table 8.2.2-1 File Menu**

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print Report</td>
<td>Prints an analysis report saved by [Save Analysis]</td>
</tr>
<tr>
<td>Save Report</td>
<td>Creates an analysis report and saves it in a file (RTF or TEXT format)</td>
</tr>
<tr>
<td>Save Analysis</td>
<td>Saves analysis results and acknowledgement status.</td>
</tr>
<tr>
<td>Exit</td>
<td>Closes Cross Reference Analyzer</td>
</tr>
</tbody>
</table>

- **Dependency Tree**

![Cross Reference Analyzer Window Structure](image)

Figure 8.2.2-1 Cross Reference Analyzer Window Structure
Table 8.2.2-2 Analyze Menu

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start</td>
<td><strong>With History</strong> Performs analysis and compares it with the results of previous acknowledgement and analysis. If the areas acknowledged in the previous analysis are not modified this time, it is regarded as if they have already been acknowledged.</td>
</tr>
<tr>
<td></td>
<td><strong>Without History</strong> Performs analysis without comparing it with results of previous acknowledgement and analysis</td>
</tr>
<tr>
<td>Report</td>
<td>Creates and displays the analysis report in the Cross Reference Analysis Report window</td>
</tr>
<tr>
<td>Previous Report</td>
<td>Displays previous analysis report.</td>
</tr>
<tr>
<td>Authorize</td>
<td>Displays the Acknowledge Dependencies dialog box.</td>
</tr>
<tr>
<td>Compare with Original Project</td>
<td>Compares a work database with the master database of another project</td>
</tr>
</tbody>
</table>

Table 8.2.2-3 Options Menu

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Settings</td>
<td>Displays the Settings dialog box</td>
</tr>
</tbody>
</table>

**IMPORTANT**

Make sure to save the analysis results before creating an analysis report.

If the current analysis results and acknowledgement history are not saved before creating an analysis report, a message prompting you to save the history is notified. If you click [Yes] button in the message box, the current analysis results and acknowledgement history are saved, overwriting the history saved before in the process, and an analysis report is created. An analysis report is not created if you click [No] button.

**Toolbar**

The toolbar provides the following buttons.

Table 8.2.2-4 Toolbar Buttons

<table>
<thead>
<tr>
<th>Button</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Save current analysis history]</td>
<td></td>
<td>Saves analysis results and acknowledgement status.</td>
</tr>
<tr>
<td>![Print report for a selected resource]</td>
<td></td>
<td>Prints analysis reports.</td>
</tr>
<tr>
<td>![Display program dependency acknowledgement dialog]</td>
<td></td>
<td>Displays the Acknowledge Dependencies dialog box</td>
</tr>
<tr>
<td>![Previous dependency change]</td>
<td></td>
<td>Selects the icon of the previous element that was changed or affected relative to the currently selected icon in Dependency Tree (the upward direction in the tree).</td>
</tr>
<tr>
<td>![Next dependency change]</td>
<td></td>
<td>Selects the icon of the next element that was changed or affected relative to the currently selected icon in Dependency Tree (the downward direction in the tree).</td>
</tr>
</tbody>
</table>

**Dependency Tree**

Dependency Tree is displayed on the left pane of the Cross Reference Analyzer window.
Figure 8.2.2-2 Displaying Dependency Tree

Each level of Dependency Tree can be expanded or collapsed by double-clicking an icon, or text label, or clicking the +/- button on the left edge.

Analysis results of an item selected in Dependency Tree is displayed in the right pane. The display arrangement of Dependency Tree can be defined in Settings dialog box.

Settings Dialog Box

On the [Options] menu, click [Settings]. The Settings dialog box appears.

Figure 8.2.2-3 Settings Dialog Box

- Project Tree
  - Sort as workbench: the Dependency Tree is displayed in the same order as the display with Workbench.
  - Sort by name: Contents displayed on Dependency Tree are sorted by names alphabetically.
- Keep On Top
  - Cross Reference Analyzer window is kept always on top.
8.2.3 Confirmation of Analysis Results by Dependency Tree

This section explains how to understand the detailed information displayed when layers below resources (SCS projects) are selected in Dependency Tree.

- Checking Resources

If you select a resource (SCS projects) in Dependency Tree, a list of analysis results of the resource is displayed in the right pane of the window. The list displays changes related to the selected SCS project.

![Dependency Tree of Cross Reference Analyzer](image-url)

Figure 8.2.3-1 Dependency Tree of Cross Reference Analyzer

The analysis results of the selected SCS project are displayed in a tree structure in the right pane. The modifications are displayed as classified groups of modified programs, modified functions, modified function blocks and input/output parameter changes.

Each category can be expanded and collapsed by clicking the +/- button to the left of the category.

- Icon Colors and Classifications of Program Names

The following table explains icon colors of program names in Dependency Tree and classifications displayed to the right of program names in the "Modified Programs" tree.
<table>
<thead>
<tr>
<th>Icon color of program name in Dependency Tree</th>
<th>Classification</th>
<th>Description</th>
<th>Display in the right pane (*1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red</td>
<td>Modified</td>
<td>The program itself has been changed.</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Instruction modified (*2)</td>
<td>The program itself has not been changed, but the database downloaded to SCS has been changed.</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Function modified</td>
<td>The program itself has not been changed, but dependent FUs have been changed. Or user-defined FB is changed to user-defined FU.</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Function block modified</td>
<td>The program itself has not been changed, but dependent FBs have been changed. Or user-defined FU is changed to user-defined FB.</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Variable changed</td>
<td>The settings of variable or function block instance used in the POU is changed.</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Defined Word changed</td>
<td>The value of Defined word used in the POU is changed.</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>I/O changed</td>
<td>The program itself has not been changed, but dependent inputs/outputs, the settings of dependent subsystem communication I/O FBs or the settings of dependent SCS Link Transmission I/O FBs have been changed.</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>New</td>
<td>The program itself has been newly added. Programs added by importing are also regarded as being newly added.</td>
<td>Yes</td>
</tr>
<tr>
<td>Yellow</td>
<td>Not modified</td>
<td>The program became dependent as it shares variables with a program requiring code review. The program itself, dependent functions, function blocks and inputs/outputs have not been changed.</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>Renamed</td>
<td>The program name has been changed. No influence other than the name change. Program name change does not require acknowledgement on the Acknowledge Dialog box.</td>
<td>Yes</td>
</tr>
<tr>
<td>Green</td>
<td>(none)</td>
<td>The program is not affected by changes.</td>
<td>No</td>
</tr>
<tr>
<td>None (*3)</td>
<td>Deleted</td>
<td>The program has been deleted.</td>
<td>Yes</td>
</tr>
</tbody>
</table>

*1: Yes: Displayed in the right pane.<br>No: Not displayed in the right pane.<br>*2: When "Instruction modified" is displayed, please contact Yokogawa’s service department.<br>*3: The program has been deleted and the program name is not displayed in Dependency Tree.

**TIP**
If the execution order of programs is changed, or a program is inserted or deleted, all the subsequent programs are regarded as being changed. Their icons therefore become red, and retesting of the programs is required.

- **Displaying Analysis Results of Functions and Function Blocks**
  Dependency Tree displays results of analyzing FUs and FBs as part of the summary for the program that calls the FUs and FBs.
  - Dependency Tree displays only icons for program names. Icons for FUs and FBs are not displayed.
  - If you expand an icon of a program name, the analysis results for the FUs and FBs called by the program are displayed, in addition to the analysis results of the program itself.
  - If FUs and FBs have been changed, the icon of the program name that calls these FUs and FBs becomes red.
• If a program on which FUs and/or FBs are dependent has been changed, the icon of the program that calls the FUs and FBs becomes yellow even if no change has been made to the FUs and FBs themselves.
• If you select a resource (SCS project) in Dependency Tree, "Modified Functions" and "Modified Function Blocks" in the right pane display changed FUs and FBs, respectively.

Judging Dependencies Between POUs

Cross Reference Analyzer judges that there are dependencies between POUs in the following cases. If dependent POUs have been changed, retesting or review is required even if the program itself has not been changed.

• **Shared Global Variables**

POUs that share global variables are dependent on each other. POUs are considered to be sharing global variables in the following cases.

- POUs are reading and writing directly to/from global variables.
- POUs are reading and writing to/from global variables within called FBs.

If multiple POUs satisfy one of the two conditions above for the same global variable, the POUs are dependent on each other.

The relationship between the global variables and program is displayed in the Current Version Shared Variable Changes Cross Reference item of the Cross Reference Analysis Report. If FBs read and write to/from the same global variables, only the name of the program that uses those FBs is displayed; the names of the FBs are not displayed.

• **Use of Functions or Function Blocks**

If a program calls FUs or FBs, there is a dependency between the calling side and the called side. For example, if A calls B and B calls C, not only A and B, and B and C that have direct calling relations, but also A and C, which only have an indirect calling relation, are considered to be dependent on each other.

Checking Programs (POU)

When you select a program name in Dependency Tree, a list of program statuses is displayed in the right pane of the window. The list displays the cross reference status (e.g. New, Modified, Binding Error, Function modified, Function block modified) and acknowledgement status of the program.
Table 8.2.3-2 Meaning of Icons Displayed on the Left Side of Program Names

<table>
<thead>
<tr>
<th>Icon color</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red</td>
<td>The program itself or items that are directly depending on it (FU, FB, input/output) have been changed.</td>
</tr>
<tr>
<td>Yellow</td>
<td>Dependencies requiring review are present in the program (the program has not been changed).</td>
</tr>
<tr>
<td>Green</td>
<td>The program has not been affected by changes.</td>
</tr>
</tbody>
</table>

### Checking Programs

If you select [Programs] in the Dependency Tree, programs dependent on the selected program are displayed in a column in the right pane of the window. If multiple variables are shared among programs, all the variables shared in the programs are displayed in the "Variable" column.

Check to see if there is any unintended dependencies. For example, if global variables are shared unintentionally, modify the program to eliminate the dependencies. The programs that have dependencies but not have been changed are displayed with green icons. It is necessary to check programs displayed with green icons as well.

### Checking Functions

If you select [Functions] in the Dependency Tree, FUs and library FUs directly changed or indirectly affected by changes are displayed in the right pane of the window.

Note that simply changing the order of FUs is irrelevant for the analysis.
The preceding figure indicates that PROG2 uses Func4 and Func1 defined in library Lib1. Func4 has been changed, while Lib1.Func1 has not been changed.

**TIP**

FUs of libraries are displayed using the format "library name.function name."

### Checking Function Blocks

If you select [Function Blocks] in the Dependency Tree, FBs and library FBs directly changed or indirectly affected by changes are displayed in the right pane of the window.

Note that simply changing the order of FBs is irrelevant for the analysis.
The preceding figure indicates that PROG2 used the FbOld function block before, but does not use it any longer.

**TIP**

FBs of libraries are displayed using the format "library name.function block name."

---

### Checking Variables

When [Variables] is selected in the Dependency Tree, variables and FB instances whose settings have changed are displayed in the right pane of the window.

These variables and FB instances are used in the selected program (PROG2 in the following figure), or in FU or FB called by the program.

#### Figure 8.2.3-6 Result of Analyzing Variables

In the previous figure, IN1 indicates that Type and Initial value were changed.

The following table shows whether a change to the variable or FB instance is detected or not.

#### Table 8.2.3-3 Changes to Variables or FB instances and Detection

<table>
<thead>
<tr>
<th>Item</th>
<th>Detected(*1)</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>No</td>
<td>Changed names are regarded as added variables.</td>
</tr>
<tr>
<td>Alias</td>
<td>No</td>
<td>-</td>
</tr>
<tr>
<td>Type</td>
<td>Yes</td>
<td>Changes to Type of FB instances included.</td>
</tr>
<tr>
<td>() [Specify the number of characters in a STRING variable]</td>
<td>Yes</td>
<td>STRING variables are not allowed to use.</td>
</tr>
<tr>
<td>Init. value</td>
<td>Yes</td>
<td>-</td>
</tr>
<tr>
<td>Dimension [The extent of index of array]</td>
<td>Yes</td>
<td>Arrays should not be used in FBD and LD.</td>
</tr>
<tr>
<td>Group</td>
<td>No</td>
<td>-</td>
</tr>
<tr>
<td>Attribute [Read/Write/Free]</td>
<td>Yes</td>
<td>-</td>
</tr>
<tr>
<td>Scope</td>
<td>Yes</td>
<td>-</td>
</tr>
<tr>
<td>Direction [Input/Output/Internal]</td>
<td>Yes</td>
<td>-</td>
</tr>
</tbody>
</table>

Continues on the next page
Table 8.2.3-3 Changes to Variables or FB instances and Detection (Table continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Detected(*1)</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retain [Yes/No]</td>
<td>No</td>
<td>-</td>
</tr>
<tr>
<td>Wiring</td>
<td>No</td>
<td>Changed wiring is categorized as &quot;I/O changed.&quot;</td>
</tr>
<tr>
<td>Address</td>
<td>No</td>
<td>-</td>
</tr>
<tr>
<td>Comment</td>
<td>No</td>
<td>-</td>
</tr>
</tbody>
</table>

*1: Yes: Detected as change
No: Not detected as change

### Checking Defined Word

If you select [Defined Words] in the Dependency Tree, the changed defined words are displayed in the right pane of the window.

These defined words are used in the selected program (PROG2 in the following figure), or in FUs or FBs called by the program.

The preceding figure shows that the value of DEFCONST was changed. The following table shows whether a change to the Defined word is detected or not.

Table 8.2.3-4 Changes to Defined Word and Detection

<table>
<thead>
<tr>
<th>Item</th>
<th>Detected (*1)</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Word</td>
<td>No</td>
<td>Changed names are regarded as added Word.</td>
</tr>
<tr>
<td>Equivalent</td>
<td>Yes</td>
<td>-</td>
</tr>
<tr>
<td>Comment</td>
<td>No</td>
<td>-</td>
</tr>
</tbody>
</table>

*1: Yes: Detected as change
No: Not detected as change
## Checking Input/Output Parameters

If you select [I/O Parameters] in the Dependency Tree, a list of input/output variables with changed input/output module or input/output channel parameters is displayed in the right pane of the window.

These input/output variables are used in the selected program (PROG2 in the figure below) or FUs and FBs called by the program.

![Cross Reference Analyzer](image)

**Figure 8.2.3-8 Results of Analyzing Input/Output Parameters**

The preceding figure shows the following.

- PROG2 uses the variable DI0003.
- The input/output parameters related to DI0003 have been changed.

![I/O Parameter Change Dependencies](image)

### Explanation of Entries in the Comments Column

The format of the entries in the Comments column is explained below.

- **<Node number>-<slot number>-<module model>-[<channel number>]-<wiring information>-<parameter information>**

**Wiring information (omitted if there are no changes)**

- New addition: Wiring-Added
- Change: Wiring-Changed

**Parameter information (omitted if there are no changes)**

- Parameters common to modules have been changed: Module
- Channel parameters have been changed: Channel
- Both are changed: Module Channel

**SEE ALSO**

For more information about how to check input/output parameters, refer to:

- "Checking when Input/Output Parameters have been Changed" on page 8-40
Extent of Influence of Input/Output Parameter Changes

The table below shows the influence that changes made to input/output parameters have on an application logic.

Table 8.2.3-5 Influence of I/O Parameters

<table>
<thead>
<tr>
<th>Classification</th>
<th>Example</th>
<th>Influence on application logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>Changes affecting data</td>
<td>Specification of Input Processing at Fault</td>
<td>Member v of the IO_BOOL and IO_REAL structure of input/output variables is influenced.</td>
</tr>
<tr>
<td>Changes affecting data status</td>
<td>Specification of disconnection detection</td>
<td>Member status of the IO_BOOL and IO_REAL structure of input/output variables, or the system FB notifying the status of an inputs and outputs is influenced.</td>
</tr>
<tr>
<td></td>
<td>Specification of short-circuit detection</td>
<td></td>
</tr>
<tr>
<td>Changes not affecting application logic</td>
<td>Comment</td>
<td>No influence on an application logic</td>
</tr>
</tbody>
</table>

SEE ALSO

For more information about influence on system FBs notifying the status of inputs and outputs, refer to:

* Influence of Input/Output Changes * on page 8-46

Changing Scan Period

If you change the scan period of an application logic, the system automatically changes all internal parameters of the input/output module common area of an SCS. As a result, the analysis results of Cross Reference Analyzer become as follows.

- The analysis results of all programs accessing the input/output variables become "I/O Changed" and the color of the corresponding program icons becomes red.
- "I/O Parameter changes" in the right pane of the window and the "Current Version I/O Parameter Changes Cross Reference" item of the Cross Reference Analysis Report display "Module" indicating changes for all input/output variables (input/output module common area).

Checking Binding Variables

If you select [Bindings] in the Dependency Tree, binding variables depending on the selected program (PROG2 in the following figure) are displayed in the right pane of the window. These binding variables are used by the program or FBs called by the program.
Figure 8.2.3-9 Results of Analyzing Bindings

The preceding figure shows the following.

- Four variables are used in PROG2 for inter-SCS safety communication.
- Binding is set properly for C0101001 and C0101003.
- For CONSU2 and P0102002, binding is set with variables that do not match the specified names.
8.2.4 Checking with Analysis Report

An analysis report displays analysis results in the same order as in Dependency Tree. It also displays the acknowledgement status set in the Acknowledge Dependencies dialog box. An analysis report can also be printed.

This section explains the following items related to checking dependencies.

- Whether or not input/output parameters have been changed
- Whether or not the settings of subsystem communication I/O FBs are changed
- Whether or not the settings of SCS Link Transmission are changed
- Whether or not inter-SCS safety communication is used

### Checking when Input/Output Parameters have been Changed

The results of analysis when input/output parameters have been changed are displayed in the "Current Version I/O Parameter Changes Cross Reference" item of the Cross Reference Analysis Report as a dependency between the input/output variables whose parameters were changed and programs.

An example of a case where input/output parameters have been changed is shown below.

**Example:**
DO modules (SDV531) are mounted on slots 3 and 5 of node 2 of an SCS

1. Parameters in the module common area of slot 3 are changed
2. Channel parameters of channel 5 of slot 3 and channel 7 of slot 3 are changed
3. Wiring is added for channel 2 of slot 3 and channel 1 of slot 5
4. Wiring is changed for channel 3 of slot 3 and channel 2 of slot 5

Assuming the changes outlined in (1) to (4) are made, the Cross Reference Analysis Report displays as follows:

**Current Version I/O Parameter Changes Cross Reference**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>V020301</td>
<td>2-3 SDV531 [01] Module PROG5 .................(1)</td>
</tr>
<tr>
<td>V020302</td>
<td>2-3 SDV531 [02] Wiring-Added Module PROG5 .................(3)+(1)</td>
</tr>
<tr>
<td>V020303</td>
<td>2-3 SDV531 [03] Wiring-Changed Module PROG5 .................(4)+(1)</td>
</tr>
<tr>
<td>V020304</td>
<td>2-3 SDV531 [04] Module PROG5 PROG6 ..........(1)</td>
</tr>
<tr>
<td>V020305</td>
<td>2-3 SDV531 [05] Module Channel PROG6 .................(2)+(1)</td>
</tr>
<tr>
<td>V020306</td>
<td>2-3 SDV531 [06] Module PROG6 .................(1)</td>
</tr>
<tr>
<td>V020307</td>
<td>2-3 SDV531 [07] Module PROG6 .................(1)</td>
</tr>
<tr>
<td>V020308</td>
<td>2-3 SDV531 [08] Module PROG5 PROG6 .............(1)</td>
</tr>
<tr>
<td>V020501</td>
<td>2-5 SDV531 [01] Wiring-Added PROG7 .................(3)</td>
</tr>
<tr>
<td>V020502</td>
<td>2-5 SDV531 [02] Wiring-Changed PROG7 .................(4)</td>
</tr>
<tr>
<td>V020507</td>
<td>2-5 SDV531 [07] Channel PROG7 .................(2)</td>
</tr>
</tbody>
</table>

- **Variable column**
  - Names of input/output variables.
- **Comments column**
  - The format of the entries in the Comments column is explained below.
Wiring information (omitted if there are no changes)
- New addition: Wiring-Added
- Change: Wiring-Changed

Parameter information (omitted if there are no changes)
- Parameters common to modules have been changed: Module
- Channel parameters have been changed: Channel
- Both have been changed: Module Channel

Used column
Displays names of programs accessing relevant input/output variables. If FBs are reading or writing to/from the input/output variables, only the names of programs using the FBs are displayed and the names of the FBs are not displayed.

### Checking when the Settings of Subsystem Communication I/O FBs have been Changed

After analyzing the changed settings which are relevant to the subsystem communication I/O FBs, the changed settings and their crossed references with programs will be displayed in a section of "Current Version I/O Parameter Changes Cross Reference" in the "Cross Reference Analysis Report."

**Example:**

If a communication module (ALR111M) is located at Node1-Slot3, and on SCS Link Transmission Builder, the variables with the following variable names are set in Station 2.

- Definition 1: SCI_B01 - SCI_B04
- Definition 2: SCO_B01 - SCO_B03
- Definition 3: SCO_I01 - SCO_I04

In this case, implement the following changes.

1. Parameters for definition 1 are changed (Node1-Slot3).
2. A wiring for SCO_B04 is added to definition 2 (Node1-Slot3).
3. A wiring for SCO_I01 of definition 3 is changed (Node1-Slot3).
4. A new communication module (ALR111M) is added to Node2-Slot4 with a new definition and wiring SCO_R01 added.

After (1) to (4) are implemented, the Cross Reference Analysis Report display will be as follows.

<table>
<thead>
<tr>
<th>Current Version I/O Parameter Changes Cross Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variable</td>
</tr>
<tr>
<td>-----------------</td>
</tr>
<tr>
<td>SCI_B01</td>
</tr>
<tr>
<td>SCI_B02</td>
</tr>
<tr>
<td>SCI_B03</td>
</tr>
<tr>
<td>SCI_B04</td>
</tr>
<tr>
<td>SCO_B04</td>
</tr>
<tr>
<td>SCO_I01</td>
</tr>
</tbody>
</table>
SCO_R01 2-4 ALR111M Wiring-Added Module
Comm.Def

- Variable column
  Variable names of subsystem communication I/O FBs

- Comments column
  The format of the entries in the Comments column is explained below.
  <Node Number> - <Slot Number> <Module Model> <Wiring Information> <Parameter Information>

  Wiring information (omitted if there are no changes)
  - New addition: Wiring-Added
  - Change: Wiring-Changed

  Parameter information (omitted if there are no changes)
  - Communication parameters have been changed: Comm.def
  - Module parameters have been changed: Module (*1)

  *1: For newly added subsystem communication module, besides Module, Comm.def is also displayed

  The wiring information and parameter information regarding the changes are indicated as follows:

  Table 8.2.4-1 Wiring Information and Parameter Information Regarding the Changes

<table>
<thead>
<tr>
<th>Changes</th>
<th>Wiring Information</th>
<th>Parameter Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>A subsystem communication module is added (and add the communication definition wired to the subsystem communication I/O FBs, then use them in POU.)</td>
<td>Wiring-Added</td>
<td>Module Comm.Def</td>
</tr>
<tr>
<td>Settings for transmission are changed.</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>A communication definition is added (and wired to the subsystem communication I/O FBs, then use them in POU.)</td>
<td>Wiring-Added</td>
<td>Comm.Def</td>
</tr>
<tr>
<td>A communication definition is deleted.</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>A communication definition is changed.</td>
<td>-</td>
<td>Comm.Def</td>
</tr>
<tr>
<td>A subsystem communication I/O FB is added.</td>
<td>Wiring-Added</td>
<td>- (*1)</td>
</tr>
<tr>
<td>Wiring of a subsystem communication I/O FB is changed.</td>
<td>Wiring-Changed</td>
<td>- (*1)</td>
</tr>
<tr>
<td>A subsystem communication I/O FB is deleted.</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

  *1: Comm.def will be displayed if communication definition is changed.

- Used column
  Displays names of programs accessing the variable of the subsystem communication I/O FB. If FBs are reading or writing to/from the variable of the subsystem communication I/O FB, only the names of programs using the FBs are displayed and the names of the FBs are not displayed.

### Checking when the Settings of SCS Link Transmission have been Changed

The results of analysis when settings of SCS Link Transmission have been changed are displayed in the "Current Version I/O Parameter Changes Cross Reference" item of the Cross Reference Analysis Report as a dependency between the SCS Link Transmission I/O FBs whose parameters were changed and programs.

**Example:**
In SCS Link Transmission Builder, the variables with the following variable names are defined in Station 2.

- LTSND02001 for the first bit, LTSND02002 for the second bit of Station 2 (Self Station)
- LTRCV04001 for the first bit, LTRCV04002 for the second bit, LTRCV04003 for the third bit of Station 4 (SCS)
- LTRCV05001 for the first bit of Station 5 (SCS)
- LTFCS06001 for the first bit, LTFCS06002 for the second bit of Station 6 (FCS)

In this case, implement the following changes.

1. Add wiring definition (LTSND02003) for the third bit of Station 2.
2. Change reception timeout of Station 4.
3. Change input processing at fault in wiring definition (LTRCV04002) for the second bit of Station 4.
4. Move wiring definition (LTRCV04003) for the third bit of Station 4 to the fourth bit.
5. Add definition (LTFCSXX04003) for the third bit of Station 4.
6. Change input processing at fault in wiring definition (LTRCV05001) for the first bit of Station 5.
7. Move wiring definition (LTFCS06002) for the second bit of Station 6 to the third bit.
8. Add Station 7 (SCS), add wiring definition LTRCV07001 and LTRCV07002 for the first bit and the second bit of Station 7.

After (1) to (8) are implemented, the Cross Reference Analysis Report display will be as follows.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Comments</th>
<th>Used</th>
</tr>
</thead>
<tbody>
<tr>
<td>LTSND02003</td>
<td>LT02-003 Wiring-Added</td>
<td>PROG7...(1)</td>
</tr>
<tr>
<td>LTRCV04001</td>
<td>LT04-001 Station</td>
<td>PROG4...(2)</td>
</tr>
<tr>
<td>LTRCV04002</td>
<td>LT04-002 Station LinkTrans.Def</td>
<td>PROG4...(2) + (3)</td>
</tr>
<tr>
<td>LTFCSXX04003</td>
<td>LT04-003 Wiring-Added Station</td>
<td>PROG4...(2) + (5)</td>
</tr>
<tr>
<td>LTRCV04003</td>
<td>LT04-004 Wiring-Changed Station</td>
<td>PROG4...(2) + (4)</td>
</tr>
<tr>
<td>LTRCV05001</td>
<td>LT05-001 LinkTrans.Def</td>
<td>PROG6...(6)</td>
</tr>
<tr>
<td>LTFCS06002</td>
<td>LT06-003 Wiring-Changed</td>
<td>PROG2...(7)</td>
</tr>
<tr>
<td>LTRCV07001</td>
<td>LT07-001 Wiring-Added Station</td>
<td>PROG3...(8)</td>
</tr>
<tr>
<td>LTRCV07002</td>
<td>LT07-002 Wiring-Added Station</td>
<td>PROG3...(8)</td>
</tr>
</tbody>
</table>

- Variable column
  Variable names of SCS Link Transmission I/O FBs
- Comments column
  The notational convention in the Comments column is explained below.
  LT<SCS Station Number (2 digits)> - <Bit Number (3 digits)> <Wiring Information> <Parameter Information>

  Wiring information (omitted if there are no changes)
  - New addition: Wiring-Added
  - Change: Wiring-Changed
Parameter information (omitted if there are no changes)
- Change of reception timeout, transmission timeout or pre-alarm set point: Station
- Change of input processing at fault: LinkTrans.Def
- Both: Station LinkTrans.Def

The wiring information and parameter information regarding the changes are indicated as follows:

Table 8.2.4-2 Wiring Information and Parameter Information Regarding the Changes

<table>
<thead>
<tr>
<th>Change</th>
<th>Wiring</th>
<th>Parameter</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Station</td>
<td>Wiring-Added</td>
<td>Station</td>
<td>Detect when wired FB is used in POU</td>
</tr>
<tr>
<td>Delete Station</td>
<td>-</td>
<td>-</td>
<td>Do not detect</td>
</tr>
<tr>
<td>Change Station Type</td>
<td>Wiring-Added</td>
<td>Station</td>
<td>Detect when wired FB is used in POU</td>
</tr>
<tr>
<td>Change Station Parameter</td>
<td>-</td>
<td>Station</td>
<td>Change of reception timeout, transmission timeout or pre-alarm set point</td>
</tr>
<tr>
<td>Add SCS Link Transmission I/O FB variables to Wiring Definition</td>
<td>Wiring-Added</td>
<td>Statement (*1)</td>
<td>Detect when wired FB is used in POU</td>
</tr>
<tr>
<td>Delete SCS Link Transmission I/O FB variables from Wiring Definition</td>
<td>-</td>
<td>-</td>
<td>Do not detect</td>
</tr>
<tr>
<td>Move SCS Link Transmission I/O FB variables of Wiring Definition</td>
<td>Wiring-Changed</td>
<td>Statement (*1)</td>
<td>Change of reception timeout, transmission timeout or pre-alarm set point</td>
</tr>
<tr>
<td>Change Wiring Parameter</td>
<td>-</td>
<td>LinkTrans.Def</td>
<td>Change of input processing at fault</td>
</tr>
</tbody>
</table>

*1: When adding a wiring, changing a wiring or changing the input processing at fault, LinkTrans.Def will be omitted.

- Used column
Displays names of the programs accessing the variables of SCS Link Transmission I/O FBs. When accessing the SCS Link Transmission I/O FBs from FU or FB, only the names of programs using the FUs or FBs are displayed and the names of the FUs or FBs are not displayed.

Identification of Programs when inter-SCS Safety Communication is Used

Inter-SCS safety communication is implemented using FBs for communication and binding functions. In a communication configuration, the SCS sending data is called the producing side and the SCS receiving data is referred to as the consuming side.

Figure 8.2.4-1 Inter-SCS Communication (Example of BOOL-type Variable)
The producing side and the consuming side share data using inter-SCS safety communication; they are thus dependent on each other. For this reason, if a program on the producing side has been changed, it is necessary to perform retesting or review of programs on the consuming side.

The procedure for identifying programs that may be affected is shown below.

1. Check programs displayed with red or yellow icons in Dependency Tree on the producing side.
2. Check variables for inter-SCS safety communication used in these programs.
   
   The "Current Version Bound Variable Usage" item of the Cross Reference Analysis Report shows binding variables used in each program. Variables starting with the letter P are variables on the producing side.

3. Check whether or not specified data has been changed for variables starting with the letter P in each program.
   
   If there are no changes in the specified data, the review of binding variables is finished.

4. Variables on the consuming side corresponding to binding variables whose data has been changed (variables starting with the letter P) have the same names as the binding variables, except that P is replaced with C.

5. Check the programs starting with the letter C that use the binding variables explained in step 4 in the "Current Version Bound Variable Usage" item of the Cross Reference Analysis Report.
   
   These programs and dependent programs are the targets of retesting or review.

6. Dependent programs are displayed in Dependency Tree by expanding the [Programs].

---

### Current Version Bound Variable Usage

<table>
<thead>
<tr>
<th>Program</th>
<th>Bound variables</th>
</tr>
</thead>
<tbody>
<tr>
<td>PROG1</td>
<td>P0101001</td>
</tr>
<tr>
<td>PROG2</td>
<td>P0101002 P0101003</td>
</tr>
<tr>
<td>PROG5</td>
<td></td>
</tr>
<tr>
<td>PROG6</td>
<td></td>
</tr>
<tr>
<td>PROG7</td>
<td>P0101004</td>
</tr>
<tr>
<td>PROG8</td>
<td></td>
</tr>
</tbody>
</table>

**Figure 8.2.4-2 Current Version Bound Variable Usage of Cross Reference Analysis Report (Example of Producing Side)**

### Current Version Bound Variable Cross Reference

<table>
<thead>
<tr>
<th>Bound variables</th>
<th>Used</th>
</tr>
</thead>
<tbody>
<tr>
<td>C0101001</td>
<td>PROGA</td>
</tr>
<tr>
<td>C0101002</td>
<td>PROGA</td>
</tr>
<tr>
<td>C0101003</td>
<td>PROGB</td>
</tr>
<tr>
<td>C0101004</td>
<td>PROGC</td>
</tr>
</tbody>
</table>

**Figure 8.2.4-3 "Current Version Bound Variable Cross-Reference" Item of Cross Reference Analysis Report (Example of Consuming Side)**
8.2.5 Precautions on Cross Reference Analyzer

Cross Reference Analyzer cannot detect certain changes. This section explains changes that are not detected by Cross Reference Analyzer and actions to be taken, and shows examples of procedures for checking such changes.

The user must check the following for SCS projects.

• Influence of input/output changes
• Change in tag name defined to allow manipulation from HIS
• Other changes not detectable by Cross Reference Analyzer

If library projects have been changed, it must be checked whether or not there are changes for the library projects as well.

Influence of Input/Output Changes

Cross Reference Analyzer detects changes of input/output parameters and shows dependencies related to input/output variables.

However, it does not detect dependencies between inputs/outputs and system FBs that indicate input/output status.

These system FBs show states of inputs/outputs corresponding to the node numbers, slot numbers and channel numbers specified for input/output variables.

Table 8.2.5-1 System Function Blocks Related to Inputs/Outputs

<table>
<thead>
<tr>
<th>Type name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SYS_NODEST</td>
<td>Detects fault in all I/O channels in node</td>
</tr>
<tr>
<td>SYS_NODEINF</td>
<td>Outputs node status</td>
</tr>
<tr>
<td>SYS_OUTST, SYS_OUTST16</td>
<td>Detects fault in output module channels</td>
</tr>
<tr>
<td>SYS_INST</td>
<td>Detects fault in input module channels</td>
</tr>
<tr>
<td>SYS_CHST</td>
<td>Detects fault in channels</td>
</tr>
<tr>
<td>SYS_IOSD</td>
<td>Shuts down module output</td>
</tr>
<tr>
<td>SYS_OUTEN</td>
<td>Indicates output module output status</td>
</tr>
<tr>
<td>SYS_IOMDSP</td>
<td>Outputs the IOM status</td>
</tr>
<tr>
<td>SYS_ALRDSP</td>
<td>Outputs status of subsystem communication modules</td>
</tr>
<tr>
<td>SYS_LTSTS</td>
<td>Indicates SCS Link Transmission reception status (*1)</td>
</tr>
</tbody>
</table>

*1: SYS_LTSTS will be affected by the setting change of SCS Link Transmission definition instead of the setting change of I/O.

If you change input/output parameters, the status of the inputs/outputs may change, which means that the output of these system FBs may change. In other words, such inputs/outputs and system FBs are dependent on each other.

Cross Reference Analyzer is unable to show dependencies between changes to input/output parameters and system FBs. If you are going to change input/output parameters, check whether or not performing such changes to input/output parameters affect other system components before downloading them to an SCS. An example of checking procedure is shown below.

1. Select a resource (SCS project) name in Dependency Tree of Cross Reference Analyzer.
2. Check "I/O Parameter Changes" displayed in the right pane of the window.
   If no input/output variables are changed, checking is finished.
3. If there are input/output variables that have been changed, check programs that use system FBs related to the inputs/outputs, and then judge whether the changes of the input/
output parameters affect them. If it is judged that the FBs are affected, check the programs depending on the program in question by expanding relevant [Programs] in Dependency Tree and retest the programs depending on the program in question.

### Change in Tag Name Defined to Allow for Manipulation from HIS

From HIS instrument faceplates for "Override FB", "Grouping Override FB", "Password FB" and "Manual operation FB", you can change the variables in the application logic.

To allow manipulation from HIS, tag names for those FBs are set by Tag Name Builder. Even if a user changes the tag name, the change is not detected by Cross Reference Analyzer. Check whether or not tag names have been changed. Whether or not tag names have been changed can be checked by comparing the modified project data to the master database by means of Project Comparing Tool. Check can also be made by using output of self-documentation. An example of checking procedure by using output of self-documentation is shown below.

#### Preparation

Prepare the information before changes are made; that is, printout of the tag names of override FBs, grouping override FBs, password FBs, manual operation FBs and their corresponding internal variables (including POU names), which was printed by using the self-documentation function.

#### Checking Procedure at Online Change Download

1. If you change a tag name, a diagnostic information message is displayed to notify the tag name change at online change download. Check whether or not messages indicating tag name changes are displayed in the Diagnostic Information window of SCS Maintenance Support Tool.
   - If no diagnostic information messages notifying tag name changes are displayed, no tag names have been changed. Checking is finished.
2. If diagnostic information messages notifying tag name changes are displayed, check that the tag names in the messages match with the intended changes.
3. Check programs of the application logic corresponding to the changed tag names in Dictionary View of SCS Manager. Test the checked program, as well as the programs that depend on the checked program. Check dependent programs by expanding the relevant [Programs] in Dependency Tree of Cross Reference Analyzer.
4. Print and store the printed documents for the next offline download.

#### Checking Procedure at Offline Download

In case of offline download, compare the printed and saved list of tag names using the self-documentation function and the current status, and check the differences.

1. Display the current list of tag names in Tag Name Builder, or print the list using the self-documentation function.
2. Compare the current tag names with the tag names printed and saved in advance.
   - If there are no differences, checking is finished.
3. If there are differences, check programs of the application logic corresponding to the changed tag names in Dictionary View of SCS Manager. Test the checked program, as well as the programs that depend on the checked program. Check dependent programs by expanding the relevant [Programs] in Dependency Tree of Cross Reference Analyzer.
4. Print and store the printed documents for the next offline download.
Other Changes Not Detectable by Cross Reference Analyzer

Cross Reference Analyzer does not detect differences in items other than the definitions of the application logic. So, you need to check for changes using Project Comparing Tool or the output of self-documentation. Especially for the following definitions that are significant on safety, the user must check for changes before downloading to an SCS.

- Scan period for the application logic execution functions (defined in the Settings tab of Resources Properties in Link Architecture View)
- Use of optical ESB bus repeaters and their maximum extension distance (defined on SCS Constants Builder and I/O Parameter Builder)
- Extend scan period automatically (defined on SCS Constants Builder)
- Locking of internal variables (defined for SCSP2 on SCS Constants Builder)
- Behavior at abnormal calculation (defined on SCS Constants Builder)
- Automatic IOM download (defined on SCS Constants Builder)

An example of checking procedure by using the output of self-documentation is shown below.

- **Preparation**
  
  Prepare the information before changes are made; that is, printout of the settings of Resources Properties in Link Architecture View and definitions made on SCS Constants Builder, which was printed using the self-documentation function.

- **Procedure Before Download**
  
  1. On SCS Manager, open Resources Properties in Link Architecture View and click the [Settings] tab. The scan period (cycle time) is shown in the tab page; so compare it with the scan period in the printout you kept to see if there is difference.
  2. Open SCS Constants Builder. In the [SCS] tab page, the above mentioned definitions are shown. Compare them with those in the printout you kept and check for difference.
  3. To be prepared for the next time, use the self-documentation function to print out the SCS project properties and definitions made on SCS Constants Builder and keep it.
8.2.6 Comparison with the Original Project

Cross Reference Analyzer has the function to compare the work database with the master database of another SCS project, which allows you to verify that there is no difference between the regenerated SCS project and the original project.

This function eliminates the need to retest all the POUs in the case, for example, when an existing project is recreated in order to add a newly supported input/output module to it.

Place the original project at a location that is accessible by the SENG and specify it as the project to be compared; then run the analysis by Cross Reference Analyzer. You don't need to open the original project on SCS Manager or re-set the paths to the libraries.

An example of the comparison procedure is shown below.

### Procedure for Comparison with the Original Project

From the [Analyze] menu of the Cross Reference Analyzer, select [Compare with Original Project]. When Compare with Original Project starts up, a dialog box appears, prompting you to specify the top path to the SCS project which you want to compare. Specifying the path to the SCS project and clicking [OK] starts the comparison. The work database of the project you are working with on SCS Manager is compared with the master database of the project you have specified.

![Figure 8.2.6-1 Dialog Box for Selecting the Path to the Original Project](image)

However, note that the comparison is performed only when the target names (SCS_TARGET/SCS_SIMULATOR) match between the project you are working with on SCS Manager and the project specified for comparison. If the target names do not match, Cross Reference Analyzer regards it as an error and the analysis fails. When all POUs have been acknowledged through comparison with the original project, you can download the project to an SCS. After downloading is completed, if you display the analysis results using the previous analysis result displaying function of Cross Reference Analyzer, the results of comparison with the original project will be shown.

### Indication on Cross Reference Analyzer

If you have run the analysis by using the [Compare with Original Project] command, the indication on the Cross Reference Analyzer window and the printout of the analysis report will be as shown below. You can identify the original project that is used for comparison from these indications.
Notes on Comparison

If you add or delete programs after you creating a new project and importing data to it, all the programs following the added or deleted program will be regarded as changed programs during comparison with other project. When you create a new project and import data to it, use Cross Reference Analyzer to compare the created project with the original project and download it to the SCS before you make any further changes.

Checking the Regenerated Project

Use Cross Reference Analyzer to verify the equivalence between the regenerated project and the original project. For the data that cannot be verified by Cross Reference Analyzer, you need to check that the regenerated SCS project and the original SCS project are the same by means of Project Comparing Tool. If you have made further changes to the regenerated project, perform checking using Cross Reference Analyzer and self-documentation output to make sure the range of retesting, as should be done with the earlier revisions.

SEE ALSO
For more information about how to check a regenerated project and the definition items of the project that need checking, refer to:

- 8.2.5, “Precautions on Cross Reference Analyzer” on page 8-46
- 2.20.4, “Data Transfer Procedure During SCS Project Regeneration” in Engineering Guide (IM 32Q01C10-31E)
9. Types of Downloading

The downloading functions transfer SCS execution data which contain application logics to an SCS.

The SCS database is saved as the master database in the SENG and the same data as in the SCS is maintained at all times. There is no function to upload the SCS execution data to the SENG because the SCS execution data is saved in the SENG as the master database.

Overview and Types of Downloading

- **Offline Download**
  This function downloads a database generated from application logic created in the SENG. During download, the functions running on the SCS stop and resume operation after the completion of downloading.

- **Online Change Download**
  This function downloads only a portion of database generated from application logic, created in the SENG, that have been updated since the last download. The functions running on the SCS keep operating during the download as well. Note that online change download may not be possible depending on the content of the updates.

- **Master Database Offline Download**
  This function downloads the execution data that was active in an SCS again after replacing a CPU module. The SCS database saved in the master database on the SENG is downloaded. This download is performed when replacing hardware. In case of a redundant CPU module, this download is not required if only one module is replaced.

**TIP**

Close the I/O lock window when performing the following operations. Otherwise, an error message will be displayed and the downloading will be stopped.

- Online change downloading
- Offline downloading
- Master database offline downloading

- **IOM Download**
  This function downloads the execution data that was active in an input/output module to a new input/output module after replacing it. The data of the input/output module (part of the SCS database) saved in the master database on the SENG is downloaded.

  This download can only be performed when replacing hardware of input/output modules.

**SEE ALSO**

For more information about IOM download, refer to:

3.1.7, “IOM Download Tool” in Utilities and Maintenance Reference (IM 32Q04B20-31E)

- **Save and Download Operation Marks**
  The operation marks set on the HIS can be saved in SENG.
  The saved operation marks can be downloaded to the SCS.

**SEE ALSO**

For more information about save and download operation marks, refer to:

2.1, “Engineering on the SENG side” in Integration with CENTUM VP/CS 3000 (IM 32Q01E10-31E)
Relationship Between Downloading Functions and Databases

The destination database for saving varies depending on the type of downloading. The relationship between different types of downloading and databases is explained below.

- **Offline Download**
  The work database generated by building is downloaded to an SCS. The master database is overwritten by the work database.

- **Online Change Download**
  Only differences between the work database generated by building and the master database are downloaded to an SCS. The master database is overwritten by the work database.

- **Master Database Offline Download**
  The master database is downloaded to an SCS.

- **IOM Download**
  Only data in the master database related to input/output modules is downloaded to an SCS.

---

**TIP**
Master Database Restoring Function is provided in order to copy the master database to the work database in case a recovery is needed. Do not edit the master database using Windows explorer.

---

Figure 9-1 Relationship Between Downloading Functions and Databases
Relationship Between Downloading Functions and SCS Security Levels

Since the downloading functions attempt to write data to an SCS, download operations may not be allowed depending on the SCS security level. Before performing the downloading functions, it is necessary to use the SCS security level operation function and change the security level of the SCS.

The table below shows whether or not each type of download is allowed according to the security level.

Table 9-1 Relationship Between Downloading Functions and SCS Security Levels

<table>
<thead>
<tr>
<th>Security level</th>
<th>Offline download</th>
<th>Online change download</th>
<th>Master database offline download</th>
<th>IOM download</th>
<th>Save and Download Operation Marks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Level 2</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>Yes (only for failing input/output modules)</td>
<td>Yes</td>
</tr>
<tr>
<td>Level 1</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>Yes (only for failing input/output modules)</td>
<td>Yes</td>
</tr>
<tr>
<td>Level 0</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes (only for failing input/output modules)</td>
<td>Yes</td>
</tr>
</tbody>
</table>

For more information about the SCS security level operation functions, refer to:

9.1 Offline Download

During offline download, the SCS database, which contains all the information required for operation of an SCS, is transmitted from the SENG to the SCS; meanwhile, the SCS functions are stopped. The SCS database is downloaded via the control bus and stored in the flash memory of the SCS and the non-volatile memory of input/output modules. The SCS database downloaded to the SCS is saved as the master database together with the source files in the SENG.

Downloaded Items

- SCS system programs
- Application database
  The application database created by the Safety application definition function and CENTUM integration function is downloaded to the CPU module.
- I/O configuration information
  The parts of the database created by the I/O definition function related to input/output modules are downloaded to the input/output modules.

![Figure 9.1-1 Offline Download](image-url)
WARNING
Following operations are performed if you execute offline download. Preventive actions to prevent false trip are required before executing offline download.

- Functions that run on the SCS stop and all the output modules output the fail-safe value specified in I/O Parameter Builder.
- Inter-SCS safety communication is disconnected.
- The forcing function is cancelled.
- Override from the HIS is cancelled.
- Break points set by the target test function are cancelled.
- SOEs and diagnostic information collected so far in the SCS are deleted (they are saved in the battery backup memory, though).
- Password for changing the SCS security level is deleted.

Procedure for Offline Download
This section describes procedures from building an application logic to storing SCS project after an offline download.

What to Do Before Offline Download
Build an application logic and run Integrity Analyzer and Cross Reference Analyzer.

TIP
User should check the items that may require retesting but not detected by Cross Reference Analyzer.

Use the SCS security level operation function to set the SCS security level to Level 0.

For more information about the building operation, refer to:

- Building SCS Project” on page 5-21

For more information about Integrity Analyzer, refer to:

- 8.1, “Integrity Analyzer” on page 8-2

For more information about Cross Reference Analyzer, refer to:

- 8.2, “Cross Reference Analyzer” on page 8-19

For more information about items that require retesting but not detected by Cross Reference Analyzer, refer to:

- 8.2.5, “Precautions on Cross Reference Analyzer” on page 8-46

For more information about the SCS security level operation functions, refer to:


Start the Offline Download

1. From the [Debug] menu of SCS Manager, select [Download].
   On the CENTUM Integration, a dialog box asking you if you want to save Operation Mark or not appears.

2. Save Operation Mark if necessary.
3. A dialog box asking you if you are sure to start an offline download appears. Click [OK]. A dialog box for setting a password for changing the SCS security level appears. After that, a dialog box prompting you to manage versions of the SCS project appears. When an offline download completes, SCS is restarted. The SCS database offline downloaded to the SCS is automatically stored in SENG as a master database together with source files.

4. On the CENTUM Integration, download the database of the CENTUM project also.

SEE ALSO
For more information about engineering work for integrating with CENTUM, refer to:
2., “Engineering for CENTUM integration” in Integration with CENTUM VP/CS 3000 (IM 32Q01E10-31E)

- **Second and Subsequent Offline Download**

With R2.03 or later, the system checks to see if there is possibility that the online change variables area in the database has been used before executing the offline download. If the online change variables area is used, a confirmation dialog box appears. This situation can be solved by performing a clean project and a build.
In the confirmation dialog box, select [Cancel] to terminate the offline download processing. Perform a clean project and a build, and then execute offline download. The offline download starts when you click [OK] in the confirmation dialog box.

SEE ALSO
For more information about clean project, refer to:
"Clean project" in "Build" of "Code Generator" of "Workbench" of the Workbench User's Guide

- **End the Offline Download**

Set the passwords used when changing the SCS security level. After that, save the SCS project using the Version Control Tool.

SEE ALSO
For more information about the version control, refer to:
13., “Version Control” on page 13-1
For more information about the SCS security level operation functions, refer to:
9.2 Online Change Download

Online change download changes a part of an application without interrupting SCS functions. In SCS, the data stored in main memory of the CPU module is updated and changes are stored in flash memory of the CPU module as well. When performing online change download of I/O definitions, changes are also reflected in the non-volatile memory of the input/output modules. Data downloaded to an SCS is also saved in the master database on the SENG.

TIP
The SCS operating mode will not be changed when online-change downloading is performed.

SEE ALSO
For more information about precautions for Online Change downloads, refer to:

5.3, "Precautions for Online Change" in Engineering Guide (IM 32Q01C10-31E)

■ Items for which Online Change Download is Allowed

SCS engineering tasks may include items for which online change download is allowed and items for which offline download is necessary.

IMPORTANT

- Builders allow generating parts of database where online change download is not allowed.
  If you make changes exceeding the range where online change is possible, the feasibility of online change download is notified after the download operation.
  If it is notified that online change download is not possible, close SCS Manager once and use Master Database Restoring Function to revert the modified data to the same status as the data in the SCS.
- When modifying the logic, the related output channels should be locked-out on the I/O Lock Window.
- When performing online changes for POU, make sure to consider the items related to "Miscellaneous limitations" of the "Online changes" description in the "Debug" section of the "Workbench" chapter in the Workbench User's Guide.

SEE ALSO
For more information about Master Database Restoring Function, refer to:

12., "Master Database Restoring Function" on page 12-1
For more information about Online-Change downloadable items, refer to:

5.2, "List of Applicable Items for Online Change" in Engineering Guide (IM 32Q01C10-31E)
For more information about whether to lock or unlock the inputs or outputs, refer to:

For more information about online changes for POU, refer to:

"Online changes" of "Debug" of "Workbench" of the Workbench User's Guide

■ Procedure for Online Change Download

This section describes procedures from building application logic to storing SCS project after an online change download.
What to Do Before Online Change Download

Build an application logic and run Integrity Analyzer and Cross Reference Analyzer.

TIP
User should check the items that may require retesting but not detected by Cross Reference Analyzer.

Use the SCS security level operation function to set the SCS security level to Level 1. After that, open the I/O Lock window and lock the input and output modules to be affected by online change.

Start the Online Change Download

1. From the [Debug] menu in SCS Manager, select [Online Change: Download]. Alternatively, click the [Online change download] button on the toolbar. The Online Change Download Confirmation dialog box appears.

TIP
- If Integrity Analyzer or Cross Reference Analyzer has already been launched when you start online download, a message prompting to close the analyzer is notified and the download ends with an error.
- If the SCS security level is set to Level 2 when the online change download starts, a message prompting you to change the security level appears and the program aborts. Set the security level to Level 1 and start an online change download.
- If the I/O Lock window or Inter-SCS Communication Lock window is left open when you start online change download, an error message appears and the download processing stops.

2. Click [OK]. A dialog box prompting to confirm the version control appears.
When the Scan Period of the Application Logic is Changed

If the scan period of the application logic has been changed, a confirmation dialog box appears when you start online change download. If there are any changes that take long time in downloading, another confirmation dialog box appears.

Check the Application logic and End Online Change Download

Using SCS Manager, change the SCS mode to Target test mode and test the changes you made. After the test, unlock the input and output modules which were previously locked using the I/O Lock window. And perform the output enable operation.

From the Set SCS Security Level dialog box, change the security level to Level 2. After that, save the SCS project using the Version Control Tool.

SEE ALSO

For more information about the version control, refer to:

13., "Version Control" on page 13-1

For more information about test operation, refer to:

4.3, “Target test operation (in case online change download is possible)” in ProSafe-RS System Test Reference (IM 32Q04B30-31E)

For more information about the I/O Lock window, refer to:

2.1, “I/O Lock Window” in Utilities and Maintenance Reference (IM 32Q04B20-31E)

For more information about the output enable operation, refer to:

3.1.6, “Output Enable Operation” in Utilities and Maintenance Reference (IM 32Q04B20-31E)

For more information about the SCS security level operation function, refer to:


For more information about online change of scan period of the application logic execution function, refer to:

A3.1.3, “Online change of scan period of the application logic execution function” in Safety Control Station Reference (IM 32Q03B10-31E)
9.3 Master Database Offline Download

During master database offline download, the master database stored in the SENG is loaded to an SCS. Since the downloaded SCS database is identical to the master database, it is possible to download the information downloaded previously to the SCS even while changing the work database of an SCS project.

Use this download function to once again download the database that was previously downloaded; in the case, for example, when the CPU module of an SCS is replaced. This download is not required when one of a pair of redundant CPU modules is replaced.

For more information about the master database, refer to:

* SCS Projects” on page 2-1

Procedure for Master Database Offline Download

- **What to Do Before Master Database Offline Download**
  
  Use the SCS security level operation function to set the SCS security level to Level 0.

- **Start the Master Database Offline Download**
  
     The [Controller] launcher menu appears.
  
  2. From the Controller Launcher menu, select [Reset SCS] > [Master Database Offline Download].
     The master database offline download confirmation dialog box appears.

  **TIP**
  
  - If the SCS security level is Level 1 or Level 2, a message prompting to set the security level to Level 0 is notified and the download ends with an error. Set the security level to Level 0, and start the master database offline download.
  
  - If the I/O Lock window or Inter-SCS Communication Lock window is left open when you start master database offline download, an error message appears and the download processing ends.

  3. Click [OK].
  
  4. Set a new password for changing the SCS security level.

For more information about the SCS security level operation functions, refer to:

10. Self-documentation

Self-documentation is a function that allows printing applications out as documents. Use Document Generator to print documents.

**TIP**
In ProSafe-RS R2.02, self-documentation related behavior has been changed. If compatibility is important, you can choose the behavior before R2.02. In this document, the behavior before R2.02 is called "backward-compatible mode" and described separately.

**SEE ALSO**
For more information about the behavior in backward-compatible mode, refer to:

10.5, “Customizing Print Settings (Backward-Compatible Mode)” on page 10-29

### Purposes of Self-documentation

In order to compare the application logic prior to modification and the application logic after the modification, the applications can be printed out with self-documentation. The consistency between the contents displayed on the windows and the contents in the printouts can also be confirmed. The self-documentation function is independent of SCS Manager and each builder; it is thus possible to double-check that the applications have been created as intended.

By comparing the printout prior modification and the printout after modification, the result of the modification can be checked to confirm that the modification is properly performed.

#### Printing Objects

Self-documentation prints out the source files of the work database in an SCS project. It is possible to select all the definitions or any part of them.

The printed objects are shown below.

- SCS project information (*1)
- SCS constants
- I/O parameters
- Communication I/O (*2)
- SCS Link Transmission
- Modbus address (*3)
- DNP3 communication
- Tag name (*4)
- Alarm priority (*4)
- Alarm processing table (*4)
- Variables cross reference index (*5)
- POU

*1: Including information related to integration with CENTUM
*2: Information related to connection with subsystems
*3: Information related to Modbus slave communication
*4: Information related to integration with CENTUM
*5: Not printed in backward-compatible mode
Customizing Print Settings

The contents that are printed by using the Self-documentation function can be customized for each SCS project. The customization function of R2.02 or later is different from that of a revision before R2.02.

IMPORTANT

The most preferable paper setting for printing the self-documentations is A3 size paper with landscape orientation. Therefore, you need to set the paper size to A3 and change the orientation to Landscape.

The printed information can be customized as follows.

- A cover page can be added
- A header or footer can be printed
- A page number can be printed
- Margin setting
- Font can be specified
- The printing orientation of the FBD and the LD (portrait or landscape) can be specified (*1)

*1: If the printer settings are already the A3 size paper with landscape orientation, these settings are not necessary.

Checking Print Preview

It is possible to check the printed image in advance.

Print Target Printer

It is possible to print out to a printer directly connected to the SENG or a printer connected via a network.

Relationship with SCS Manager and Builders

The relationship between self-documentation function and engineering functions (SCS Manager and builders) is illustrated below.
Figure 10-1 Relationship Between the Self-documentation Function and Engineering Functions

The self-documentation function is launched from SCS Manager or from any of the builders. It allows printing definitions of SCS projects edited and saved in SCS Manager or each builder as documents.

**TIP**
Definitions of CENTUM projects should be printed out with the self-documentation function of CENTUM.

### Selecting Printing Mode

You can select the mode of printing by selecting the [Enhanced printing style] check box in the Customize dialog box, which is opened from the [Option] menu of SCS Manager. If the check box is cleared, self-documentation runs in backward-compatible mode and behaves the same as before R2.02.
Figure 10-2 Customize Dialog Box
10.1 Document Generator

Document Generator is the user interface of the self-documentation tool.

How to Launch Document Generator

Document Generator can be launched by either one of the following operations.

- From the SCS Manager menu bar, select [File] > [Print], or click the "Print" button on the toolbar.
- From the menu bar of each builder, select [File] > [Print], or click the "Print" button on the toolbar.

Document Generator Window Structure

![Document Generator Window](image)

Figure 10.1-1 Document Generator Window

- **Tabs**
  - The window is composed of the following three tabs.
    - "Table" tab: Select printing target
• "Options" tab: Customize print settings
• "Preview" tab: Preview printed information

If you click [Print] button in the Document Generator window, the Print dialog box appears. Select a printer and specify page settings such as paper size in the Print dialog box; then click [OK] button to start printing.

On Print dialog box, the range of pages to be printed can be set on [Page Range].

The relationship between the displayed tab and the specification method of page ranges that can be specified is shown below.

Table 10.1-1 Relationship Between Tabs and Page Ranges that can be Specified

<table>
<thead>
<tr>
<th>Tabs</th>
<th>[All]</th>
<th>[Current page]</th>
<th>[Pages] (*1)</th>
<th>[Sections] (*2)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Specification allowed</td>
<td></td>
<td>Specification allowed</td>
<td>Specification allowed</td>
</tr>
<tr>
<td>Options</td>
<td>Specification allowed</td>
<td></td>
<td>Specification allowed</td>
<td>Specification allowed</td>
</tr>
<tr>
<td>Preview</td>
<td>Specification allowed</td>
<td></td>
<td>Specification allowed</td>
<td>Specification allowed</td>
</tr>
</tbody>
</table>

(*1): The printout page range can be specified with hyphen (-) or the pages can be separated by commas (,).
(*2): The printout section range can be specified with hyphen (-) or the sections can be separated by commas (,).

For more information about the "Table" tab, refer to:
10.2, "Selection of Printing Targets" on page 10-8
For more information about the "Options" tab, refer to:
10.3, "Customizing Print Settings" on page 10-13
For more information about the "Preview" tab, refer to:
10.6, "Confirmation by Print Preview" on page 10-33

Procedure of Printing Operations

The procedure of printing operations when using Document Generator is explained below.
1. Specify the printing targets in the "Table" tab.
2. Customize the print settings in the "Options" tab.
3. Click [Page Setup] and make printer settings in the Page Setup dialog box.
4. Display a print preview and check the printed information in the "Preview" tab.
5. Click [Print] button to print.

Page Setup Dialog Box

When you print using Document Generator, you can make printer settings in the Page Setup dialog box started from [Page Setup] on the [File] menu of SCS Manager. However, you cannot use the Page Setup dialog box in backward-compatible mode. The settings you have made in the Page Setup dialog box are reflected in the initial settings of Print dialog box of Document Generator. You can preview the image of the printout based on the settings of the Page Setup dialog box. Therefore, if you specify the printer usually used for printing in the Page Setup dialog box beforehand, the preview and printed results match. The settings in the Page Setup dialog box can be made for each computer. However, in the Page Setup dialog box, you cannot set Page Range.
Figure 10.1-2 Page Setup Dialog Box
10.2 Selection of Printing Targets

Select the printing targets in the "Table" tab of Document Generator.

"Table" Tab

Figure 10.2-1 "Table" Tab of Document Generator

Selecting Printing Targets in the "Table" Tab

In the "Table" tab, you can select the definition items to be printed by Document Generator. Click the +/- buttons placed at the left edge of each item displayed in the tree view to display definition items and select the check boxes next to each definition you wish to print. For definition items that are selected in their check boxes, their data in the following table are printed.

Table 10.2-1 Printing Objects

<table>
<thead>
<tr>
<th>Chapter/section Number (&quot;1&quot;)</th>
<th>Definition item name in tree (&quot;2&quot;)</th>
<th>Printed data</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cover Page</td>
<td>Cover page</td>
<td></td>
<td>-</td>
</tr>
</tbody>
</table>

Continues on the next page
Table 10.2-1 Printing Objects (Table continued)

<table>
<thead>
<tr>
<th>Chapter/section Number (*1)</th>
<th>Definition item name in tree (*2)</th>
<th>Printed data</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Table of contents</td>
<td>Table of contents</td>
<td>-</td>
</tr>
<tr>
<td>1</td>
<td>(Project name)</td>
<td>SCS project name</td>
<td>-</td>
</tr>
<tr>
<td>1.X</td>
<td>Project description</td>
<td>Comment for SCS project</td>
<td>-</td>
</tr>
<tr>
<td>1.X</td>
<td>Defined words</td>
<td>Defined words</td>
<td>-</td>
</tr>
<tr>
<td>2</td>
<td>(Configuration name)</td>
<td>Configuration name and comment</td>
<td>-</td>
</tr>
<tr>
<td>2.X</td>
<td>Description</td>
<td>Description for configuration</td>
<td>-</td>
</tr>
<tr>
<td>2.X</td>
<td>SCS project information</td>
<td>SCS project information</td>
<td>The CENTUM project top folder is printed when CENTUM is connected to the system. For a library project, only the version number is printed.</td>
</tr>
<tr>
<td>2.X</td>
<td>SCS constants</td>
<td>SCS constant definition</td>
<td>(*3)</td>
</tr>
<tr>
<td>3</td>
<td>(Resource name)</td>
<td>Resource name and comment</td>
<td>-</td>
</tr>
<tr>
<td>3.X</td>
<td>Description and Properties</td>
<td>Description for resource</td>
<td>-</td>
</tr>
<tr>
<td>3.X</td>
<td>Global Variables</td>
<td>List of global variables</td>
<td>-</td>
</tr>
<tr>
<td>3.X</td>
<td>I/O Modules</td>
<td>Node and input/output module information</td>
<td>(*3)</td>
</tr>
<tr>
<td>3.X</td>
<td>I/O Parameters</td>
<td>Input/output module information (wiring information and parameters)</td>
<td>(*3)</td>
</tr>
<tr>
<td>3.X</td>
<td>Comm. I/O definition</td>
<td>Subsystem communication I/Os</td>
<td>(*3)</td>
</tr>
<tr>
<td>3.X</td>
<td>Comm. I/O wiring</td>
<td>Subsystem communication I/O wirings</td>
<td>(*3)</td>
</tr>
<tr>
<td>3.X</td>
<td>Modbus address (Coil)</td>
<td>Modbus address information</td>
<td>(*3)</td>
</tr>
<tr>
<td>3.X</td>
<td>Modbus address (Input relay)</td>
<td>Modbus address information</td>
<td>(*3)</td>
</tr>
<tr>
<td>3.X</td>
<td>Modbus address (Input registers)</td>
<td>Modbus address information</td>
<td>(*3)</td>
</tr>
<tr>
<td>3.X</td>
<td>Modbus address (Holding registers)</td>
<td>Modbus address information</td>
<td>(*3)</td>
</tr>
<tr>
<td>3.X</td>
<td>DNP3 communication (Parameters)</td>
<td>DNP3 communication</td>
<td>It can be printed for the SCS projects of SCSU1 that are created by the software version R3.02.20 or later.</td>
</tr>
<tr>
<td>3.X</td>
<td>DNP3 communication (Binary Input)</td>
<td>DNP3 communication</td>
<td></td>
</tr>
<tr>
<td>3.X</td>
<td>DNP3 communication (Binary Output)</td>
<td>DNP3 communication</td>
<td></td>
</tr>
<tr>
<td>3.X</td>
<td>DNP3 communication (Binary Counter)</td>
<td>DNP3 communication</td>
<td></td>
</tr>
<tr>
<td>3.X</td>
<td>DNP3 communication (Analog Input)</td>
<td>DNP3 communication</td>
<td></td>
</tr>
<tr>
<td>3.X</td>
<td>DNP3 communication (Analog Output)</td>
<td>DNP3 communication</td>
<td></td>
</tr>
<tr>
<td>3.X</td>
<td>SCS Link Transmission</td>
<td>SCS Link Transmission definition</td>
<td>(*3)</td>
</tr>
<tr>
<td>3.X</td>
<td>SCS Link Transmission Wiring</td>
<td>SCS Link Transmission wirings</td>
<td>(*3)</td>
</tr>
<tr>
<td>Chapter/section Number (*1)</td>
<td>Definition item name in tree (*2)</td>
<td>Printed data</td>
<td>Remarks</td>
</tr>
<tr>
<td>----------------------------</td>
<td>---------------------------------</td>
<td>--------------</td>
<td>---------</td>
</tr>
<tr>
<td>3.X</td>
<td>Detailed binding</td>
<td>Binding information</td>
<td>(*3)</td>
</tr>
<tr>
<td>3.X</td>
<td>Tag name definition (BOOL/ECW_B)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3.X</td>
<td>Tag name definition (DINT/REAL/ECW_I/ECW_R)</td>
<td>Tag name definition</td>
<td>(*3)</td>
</tr>
<tr>
<td>3.X</td>
<td>Tag name definition (ANLGI/ANLG_S)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3.X</td>
<td>Tag name definition (VEL)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3.X</td>
<td>Tag name definition (ANN)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3.X</td>
<td>Tag name definition (IO_REAL)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3.X</td>
<td>Tag name definition (IO_BOOL)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3.X</td>
<td>Tag name definition (GOV_B/GOV_IB/OVR_B/OVR_IB)</td>
<td>Tag name definition</td>
<td>(*3)</td>
</tr>
<tr>
<td>3.X</td>
<td>Tag name definition (OVR_I/OVR_R/OVR_IR)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3.X</td>
<td>Tag name definition (PASSWD)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3.X</td>
<td>Tag name definition (SCI_B/SCI_I/SCI_R/SCO_B)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3.X</td>
<td>Tag name definition (SCI/I/SCI_R/SCI_I/SCI_R/SCO_R)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3.X</td>
<td>Tag name definition (MOB_11/MOB_21)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3.X</td>
<td>Tag name definition (MOB_RS)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3.X</td>
<td>Tag name definition (MOA)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3.X</td>
<td>Alarm priority</td>
<td>Alarm priority</td>
<td></td>
</tr>
<tr>
<td>3.X</td>
<td>Alarm processing table</td>
<td>Alarm processing table</td>
<td></td>
</tr>
<tr>
<td>3.X</td>
<td>Resource content</td>
<td>POU list (*5)</td>
<td>-</td>
</tr>
<tr>
<td>3.X</td>
<td>Local Variables + Parameters</td>
<td>List of local variables and parameters</td>
<td>-</td>
</tr>
<tr>
<td>4</td>
<td>POU</td>
<td>(Title only)</td>
<td>-</td>
</tr>
<tr>
<td>4.X</td>
<td>(POU)</td>
<td>POU name</td>
<td>One POU corresponds to one section.</td>
</tr>
<tr>
<td>5</td>
<td>Variables cross reference index</td>
<td>Variables cross reference index (Titles only)</td>
<td>(*3)</td>
</tr>
<tr>
<td>5.X</td>
<td>Hardware I/O</td>
<td>I/O variables cross reference index</td>
<td>(*3)</td>
</tr>
<tr>
<td>5.X</td>
<td>Global Variables</td>
<td>Global variables cross reference index</td>
<td>(*3)</td>
</tr>
<tr>
<td>5.X</td>
<td>Tag names</td>
<td>Tagged variables cross reference index</td>
<td>(*3)</td>
</tr>
</tbody>
</table>

*1: Chapter and section numbers vary depending on the selected printing objects. If the item selected as printing object contains no content, nothing is printed. X means a serial number starting at 1. The start page for print can be changed.

*2: Definition item names in tree are printed as the title character strings of chapters and sections (except for the cover page).

*3: For library project, the tree view is not displayed. Moreover, the Print command is not valid.

*4: Displayed in the tree view if the PC has a license for CENTUM VP/CS 3000 Integration Engineering Package.

*5: For library project, the tree view is not displayed. Moreover, the Print command is not valid.
Outputting Variables Cross Reference Index

To print variables cross reference information, click the [Table] tab in Document Generator, and select [Variable cross reference index] or select from among the individual items of [Hardware I/O], [Global Variables], [Tag Names] that are shown under [Variable cross reference index].

In variables cross reference index, information on which variables are used by which POU is listed. The following information can be output.

Table 10.2-2 Information Output as Variables Cross Reference Index

<table>
<thead>
<tr>
<th>Definition item name in tree</th>
<th>Global variables (instance)</th>
<th>Local variables</th>
<th>FB parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hardware I/O (I/O variables in IO_BOOL and IO_REAL)</td>
<td>Output</td>
<td>Output</td>
<td>Not output</td>
</tr>
<tr>
<td>Global variables (in BOOL/DINT/REAL)</td>
<td>Output</td>
<td>Not output</td>
<td>Not output</td>
</tr>
<tr>
<td>Tag Names (*1)</td>
<td>Output</td>
<td>Output</td>
<td>Output</td>
</tr>
</tbody>
</table>

*1: All the variables, FB instances, and parameters to which a tag name is assigned are output. However, ANNs are output even if tag names are not assigned.

Each report contains the following data.

- **Name:**
  For parameters, name is output with the FB instance name. For example, "FB1.Param." If the scope of a variable is set to Local, name is output with the POU name. For example, "Var1@POU" is output.

- **Type:**
  Type name such as ANN and BOOL is output.

- **Direction:**
  Input, Output or Internal is output.

- **Tag Name:**
  For ANN, %AN element name is also output.

- **Sheet Number:**
  Sheet number is output in the format "POU name - page number."

**TIP**
No matter whether you have selected POU as the data to be printed or not, cross reference information is printed for all POUs. Regardless of the actual setting of [New page for each item] in the [Options] tab of Document Generator, documents are printed with a page break inserted at the end of each POU.
Figure 10.2-2 Variable Cross Reference Index Window
10.3 Customizing Print Settings

You can customize the information to be printed in the Options tab of Document Generator.
10.3.1 Customizable Print Settings

To customize, click a button in each group box in the Options tab of Document Generator.

"Options" Tab

Figure 10.3.1-1 Options Tab Page

The components of the tab are explained in the following sections.

- **New Page for Each Item**

  Select this check box to start a new page for each printed item. If [Landscape] is selected at "Print Diagram orientation", FBD and LD begin on a new page even if the [New page for each item] check box is not selected.

**IMPORTANT**

If you print after you change print settings in either the Options tab in Document Generator or the Print dialog box shown when you click the Print button in Document Generator, page breaks may be inserted in places different from those that you see on the screen.

• **Print Diagram Orientation**

  Select one of the three options, and the documents will be printed as specified.

  - Page Setup Settings
    FBD and LD are also printed according to the settings in the Page Setup dialog box or Print dialog box.
  - Landscape
FBD and LD are printed in landscape orientation regardless of the settings in the Page Setup dialog box or Print dialog box. Other print items are printed according to the settings in the Page Setup dialog box or Print dialog box.

- Portrait

FBD and LD are printed in portrait orientation regardless of the settings in the Page Setup dialog box or Print dialog box. Other print items are printed according to the settings in the Page Setup dialog box or Print dialog box.

### Header/Footer

You can make settings for a header or footer. You can select to print a header (at the top of the page) or a footer (at the bottom of the page) or not to print any of them. Click [Edit] button and the dialog box for editing Header/Footer appears.

![Figure 10.3.1-2 Dialog Box for Editing Header/Footer](image)

In the dialog box for editing Header/Footer, you can customize the following.

- Select a Header/Footer template.
- Change print properties of a Header/Footer template.

**SEE ALSO**

For more information about customizing Header/Footer, refer to:

- 10.3.2, “Editing Header and Footer” on page 10-18

### Page Numbering

Specify the format of the page numbers printed in the header or footer, and the page number for the first page.

Use either of the following page number formats.

- [#]
  - Page numbers are printed using the format of "Page 'page number'" (serial number). Serial numbers are assigned to pages starting from the first page. Specify the page number from which printing is to be started by entering it in [Start Page:].

- [#.#.#.#.#]
  - Page numbers are printed using the format of "Page 'section/chapter number' - 'page number'" (section format). Serial numbers are assigned to pages starting from the first page for each chapter/section. Specify the section number from which printing is to be started by entering it in [Start Section:]. Note that the cover page and the table of contents are always numbered from page 1 (i).

  - The page numbers for the cover page and table of contents are printed using Roman numerals (i, ii, iii, iv, ...).
  - Each chapter after that (project data, configuration data, resource data, POU data, variable cross reference index data) is numbered in the format "Chapter- page number" or "Chapter. Section- page number."
TIP
If you want to reprint a part of the project so as to replace the old printouts after the contents of the whole SCS project were printed out, follow the procedure below:

1. In the Table tab, choose the items to be printed.
2. In the Options tab, choose [#.#.#.#.] at Page Numbering.
3. In [Start Section], specify the chapter and section numbers for the items you want to reprint.
4. Click [Print]. The Print dialog box appears.
5. In the Print dialog box, select [All] for [Page Range:]. Then only the specified part of the project will be printed out.

• **Cover Page**
  Specify the format of the cover page.
  If you check the [Header/Footer on cover page], header or footer is printed on the cover page in the format specified in the [Header/Footer] section.

• **Margins**
  Specify the printing margins of each page. The printing margins are the offsets at the top/bottom/left/right sides of the page from the perimeter of the maximum printable area.
  - "Visible Margins"
    Specify whether or not to print the printing margin frame. If you select the check box, a frame showing the printing margins is printed on each page.
  - "Top", "Bottom", "Left", "Right"
    Specify the margin width for the top, bottom, left and right margins in units of mm, respectively.

• **Fonts**
  Specify the font used in printing. The specified font is used for texts except for those shown in FBD and LD windows.
  - [Text font] button
    Click the [Text font] button to show the Text Font dialog box. The font selected in this dialog box is used for texts except for those shown in FBD and LD windows (including table of contents and chapter titles and section titles).
  - [Title font] button
    Click the [Title font] button to show the Title Font dialog box. The font selected in this dialog box is used for the cover page.
Figure 10.3.1-3 Text Font Dialog Box

[Font style], [Effects] and [Script] settings are invalid.

IMPORTANT

The self-documentation function prints data in the files saved by SCS Manager and builders. For this reason, if you attempt to save files while the self-documentation is running, incorrect information may be printed or the printing process may fail. In such cases, run the self-documentation again after completing saving the files.
10.3.2 Editing Header and Footer

To customize Header/Footer, start the Header/Footer dialog box by clicking the [Edit] button in the [Header/Footer] group box in the [Options] tab in Document Generator.

Selecting a Header/Footer Template

The following 8 types of Header/Footer templates are provided. You can select the one you like.

<table>
<thead>
<tr>
<th>Template</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default</td>
<td>Default template</td>
</tr>
<tr>
<td>Template_1</td>
<td>-</td>
</tr>
<tr>
<td>Template_2</td>
<td>-</td>
</tr>
<tr>
<td>Template_3</td>
<td>-</td>
</tr>
<tr>
<td>Template_4</td>
<td>-</td>
</tr>
<tr>
<td>Template_5</td>
<td>-</td>
</tr>
<tr>
<td>Template_A</td>
<td>Equivalent to Format A in backward-compatible mode</td>
</tr>
<tr>
<td>Template_B</td>
<td>Equivalent to Format B in backward-compatible mode</td>
</tr>
</tbody>
</table>

Follow the steps below to select a Header/Footer template.

1. In the Header/Footer dialog box, click the [Change Template] button to open the Template selection dialog box.
2. In the list box in the Template selection dialog box, select a template you want to use. A preview of the selected template appears.
3. In the Template selection dialog box, click the [OK] button and the selected template is applied. Click [Cancel] to cancel your selection and the Template selection dialog box closes. Name of the selected template appears in the Header/Footer dialog box, and a preview of the template is shown.
4. In Header/Footer dialog box, click the [OK] button and the Header/Footer of the selected template is used in printing. If you click the [Cancel] button, Header/Footer is not changed. The [OK] button in the Header/Footer dialog box becomes valid only after you click the [OK] button in the Template selection dialog box in step 3.
Editing Header/Footer Properties

To edit Header/Footer print properties, open the Change Print Items dialog box and follow the steps below.

1. In the Header/Footer dialog box, click the [Edit] button to show the Change Print Items dialog box.
2. In the Change Print Items dialog box, edit Header/Footer properties.
3. Click the [OK] button in the Change Print Items dialog box, and the changes you make in the dialog box are applied.
   If you want to cancel the changes, click the [Cancel] button.
   Result of your editing is shown in a preview in the Header/Footer dialog box. In the area where nothing is to be printed, the area number is shown.
4. In the Header/Footer dialog box, click the [OK] button, and the edited Header/Footer are used in printing.
   If you click the [Cancel] button, Header/Footer is not changed. The [OK] button in the Change Print Items dialog box becomes valid only after you click the [OK] button in the Change Print Items dialog box in step 3.

IMPORTANT

If you re-select a template after changing Header/Footer print properties, the changes are undone.

Change Print Items Dialog Box

To change the Header/Footer print properties, use the Change Print Items dialog box. One of the following is printable in the template Header/Footer area.

- Macro
- Fixed character strings (blank strings are allowed)
- Combination of macro and fixed character strings
- Bitmaps

If character strings are printed, you can specify font size (4 point to 72 point) of the character strings. Font is fixed to the one specified in [Title font] in the Options tab in Document Generator.
The following section describes components of the Change Print Items dialog box.

- **No.**
  Shows the area number for a print item in a template. If no print item is specified, this number is shown in a preview.

- **Type**
  Shows the type of a print item.
  - S: character string (Macro, fixed character strings, or combination of both)
  - B: Bitmap

- **Print Item**
  Specify the details for a print item. Settings are different depending on whether the "type" is S (character string) or B (bitmap).
  When "type" is S (string): Displays the character string to be printed (macro, fixed string, or a combination of these).
  - Click on a line with the left-button of your mouse and you can edit the character string in it.
  - Select a line and right-click your mouse, and the following pop-up menu appears.
    - Cut : cuts the selected character string.
    - Copy : copies the selected character string.
    - Paste : pastes the cut or copied character string.
    - Delete : deletes the selected character string.
  If you select $FOLDER( ) or one of the commands listed below it, the corresponding macro is inserted at the point where the mouse cursor is blinking. After inserting, you can edit the character string.
When "type" is B (bitmap): Bitmap file name. Specify a .bmp file under the following folder.

{Project folder}\YOKOGAWA_SCS\SELDOC\n
- Click a file name with the left button on your mouse, and you can edit it.
- Left-click the mouse and click the [...] button that appears, and a file selection dialog box appears. Select a file.

**Size**

Font size (point) of character strings for an item of Type S (character string). Type an integer from 4 to 72 or select a size from the combo box.

**Template**

The name of the currently selected template is shown.

### Editing Header/Footer

You can edit the Header/Footer of the selected template. The items that can be printed in the Header/Footer are macro (character string), fixed character strings, and a combination of macro and fixed character strings, and bitmap.

For example, if you specify "$PROJECT_NAME()," the actual SCS project name (or library name) is printed.

If you specify the combination of a fixed character string "Page" and macro "$PAGE" by entering "Page$PAGE()," page number will be printed in the format such as "Page 4.1-1."

If you specify one of the macros listed below or one of these macros combined with a fixed character string, the printing will come out only on the POU source pages. On the other pages, nothing is printed.

"$POU_COMMENT( )", "$POU_DESCRIPTION( )", "$POU_REVISION( )", "$POU_LASTSAVE(format)", "$SHEET_NUMBER( )"

### $POU_COMMENT( )

Comment of the POU shown in the page

**Example:**

- First Comment
$POU_DESCRIPTION( )
Description of POU shown in the page
Example:
First description

$POU_REVISION( )
Revision comment of the POU shown in the page
POU revision comment is entered and displayed in the POU Properties dialog box. The entered comment is printed as the POU revision comment in the position where this macro is specified.
Example:
First Revision

SEE ALSO
For more information about entering and showing POU revision comments, refer to:
"Creating POUs" of "POUs (Program Organization Units)" of "Link Architecture View" of "Workbench" in the Workbench User's Guide

$POU_LASTSAVE(format)
Date when the shown POU is last saved or imported. Same as the "Date Modified" shown in Windows Explorer. You can specify the output format of the date by entering the format in the parenthesis of this macro as shown below.
- The following alphabets in the format stand for Year/Month/date.
- Characters other than the alphabets that stand for Year/Month/date are output as they are.
- If you want to output the alphabets that stand for Year/Month/date, enclose them with single quotation marks (').

Table 10.3.2-2 Rules for Date Format Specification

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>d</td>
<td>date</td>
</tr>
<tr>
<td>dd</td>
<td>date. For one digit number, 0 is filled in the tenths place.</td>
</tr>
<tr>
<td>M</td>
<td>Month (numeral)</td>
</tr>
<tr>
<td>MM</td>
<td>Month (numeral). For one digit number, 0 is filled in the tenths place.</td>
</tr>
<tr>
<td>MMM</td>
<td>Month (abbreviated character string). Example: Jan</td>
</tr>
<tr>
<td>MMMM</td>
<td>Month (character string). Example: January</td>
</tr>
<tr>
<td>y</td>
<td>year (last two digits). The zero for the tens place is not output.</td>
</tr>
<tr>
<td>yy</td>
<td>year (last two digits). The zero for the tens place is output.</td>
</tr>
<tr>
<td>yyyy</td>
<td>Year (western calendar)</td>
</tr>
</tbody>
</table>

Example format
$POU_LASTSAVE(MMM-d) Apr-6

$SHEET_NUMBER( )
Sheet number. It consists of POU name and POU page number ("POU name - page number"). If a diagram is printed over two pages or more, the first page has the page number 1, the second page, 2 and so on.
Example:
**$PROJECT_DATE(format)**

Project date.

Project date is entered and displayed in the Project Properties dialog box. The entered value is printed in the position where this macro is specified as the project date. Like the $POU_LASTSAVE, you can specify the format.

**SEE ALSO**

For more information about entering and viewing Project date, refer to:

*“Adding date stamp of a project” of “POUs (Program Organization Units)” of “Working with projects” of “Workbench” in the Workbench User’s Guide*

**$PRINT_DATE(format)**

Date of printing. The date when the document is printed. Like the $POU_LASTSAVE, you can specify the format.

**$PAGE()**

Page number or page number with section number. Page numbers are printed according to the setting of [Page Numbering] in Document Generator.

- If [#] (serial number format) is specified for [Page Numbering], serial number is used for page number.
  
  **Example:**
  
  7

- If [#.#.#.#.#] (section format) is specified for [Page Numbering], the page number is a combination of section number and page number within the section.
  
  **Example:**
  
  4.1-1

**$TOTAL_PAGE()**

Total number of pages to be printed. Same as the total number of pages that is printed when [# total number of pages] is selected for [Page Numbering] in Document Generator in backward-compatible mode (that is, [Enhanced printing style] in the Customize dialog box is set to OFF).

**Example:**

23

**$PROJECT_NAME()**

SCS project name or library name

**Example:**

SCS0101 or LIBRARY1

**$FOLDER()**

Folder name (=RS Project name) where the project is stored.

**Example:**

MYRSPJT
The character string "Project" for a chapter on Project. The character string "Configuration" for a chapter on configuration. The character string "Resource" for a section on Resource. The character string "POU" for a section on POU.

**Example:**
Configuration

### Importing Header/Footer from another project

In the Change Print Items dialog box, the Header/Footer of another project can be imported. You can use the same Header/Footer as that used in another project in a new project by using Import function.

1. Select in advance, the same template as the Header/Footer of another project you want to import.
2. Click the [Import...] button. Folder selection dialog box appears.
3. Select SCS project or library folder, and click the [OK] button. The print properties of the project are reflected to the selected template of the new project. If bitmaps are included in the Header/Footer template of the selected project, the bitmap file is copied in the predefined folder of the new project (`{Project folder\YOKOGAWA_SCS\SELDOC\}`)

**IMPORTANT**

- If the Header/Footer template of the selected project does not exist or the template in the new project is different, a message box appears and import is not executed. If the template of the new project differs from that of the selected project, the name of the template specified in the project the system failed to import is shown, select the same template for the new project and import again.

- If a bitmap file of the same name already exists in the folder of the new project (`{Project folder\YOKOGAWA_SCS\SELDOC\}`), a dialog box appears asking you if it is all right to overwrite the bitmap file. If you click the [OK] button for all bitmap files to be imported, the import proceeds. If you click the [Cancel] button for any of them, import is not executed.
10.4 Selection of Printing Targets (Backward-Compatible Mode)

Select the printing targets in the "Table" tab of Document Generator.

- "Table" Tab

![Figure 10.4-1 "Table" Tab of Document Generator](image)

- Selecting Printing Targets in the "Table" Tab

In the "Table" tab, you can select the definition items to be printed by Document Generator. Click the +/- buttons placed at the left edge of each item displayed in the tree view to display definition items and select the check boxes next to each definition you wish to print. For definition items that are selected in their check boxes, their data in the following table are printed.
<table>
<thead>
<tr>
<th>Chapter/section Number (*1)</th>
<th>Definition item name in tree (*2)</th>
<th>Printed data</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Cover Page</td>
<td>Cover page</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>Table of contents</td>
<td>Table of contents</td>
<td>-</td>
</tr>
<tr>
<td>1</td>
<td>(Project name)</td>
<td>SCS project name</td>
<td>-</td>
</tr>
<tr>
<td>1.1</td>
<td>Project description</td>
<td>Comment for SCS project</td>
<td>-</td>
</tr>
<tr>
<td>1.2</td>
<td>Defined words</td>
<td>Defined words</td>
<td>-</td>
</tr>
<tr>
<td>1.3</td>
<td>(Configuration name)</td>
<td>Configuration name and comment</td>
<td>-</td>
</tr>
<tr>
<td>1.3.1</td>
<td>Description</td>
<td>Description for configuration</td>
<td>-</td>
</tr>
<tr>
<td>1.3.2</td>
<td>SCS project information</td>
<td>SCS project information</td>
<td>The CENTUM project top folder is printed when CENTUM is connected to the system. For a library project, only the version number is printed.</td>
</tr>
<tr>
<td>1.3.3</td>
<td>SCS constants</td>
<td>SCS constant definition</td>
<td>(*3)</td>
</tr>
<tr>
<td>1.3.4</td>
<td>(Resource name)</td>
<td>Resource name and comment</td>
<td>-</td>
</tr>
<tr>
<td>1.3.4.X</td>
<td>Description and Properties</td>
<td>Description for resource</td>
<td>-</td>
</tr>
<tr>
<td>1.3.4.X</td>
<td>I/O Modules</td>
<td>Node and input/output module information</td>
<td>(*3)</td>
</tr>
<tr>
<td>1.3.4.X</td>
<td>I/O Parameters</td>
<td>Input/output module information (wiring information and parameters)</td>
<td>(*3)</td>
</tr>
<tr>
<td>1.3.4.X</td>
<td>Comm. I/O definition</td>
<td>Subsystem communication I/Os</td>
<td>(*3)</td>
</tr>
<tr>
<td>1.3.4.X</td>
<td>Comm. I/O wiring</td>
<td>Subsystem communication I/O wirings</td>
<td>(*3)</td>
</tr>
<tr>
<td>1.3.4.X</td>
<td>SCS Link Transmission</td>
<td>SCS Link Transmission definition</td>
<td>(*3)</td>
</tr>
<tr>
<td>1.3.4.X</td>
<td>SCS Link Transmission Wiring</td>
<td>SCS Link Transmission data wirings</td>
<td>(*3)</td>
</tr>
<tr>
<td>1.3.4.X</td>
<td>Global Variables</td>
<td>List of global variables</td>
<td></td>
</tr>
<tr>
<td>1.3.4.X</td>
<td>Detailed binding</td>
<td>Binding information</td>
<td>(*3)</td>
</tr>
<tr>
<td>1.3.4.X</td>
<td>Modbus address (Coil)</td>
<td>Modbus address information</td>
<td>(*3)</td>
</tr>
<tr>
<td>1.3.4.X</td>
<td>Modbus address (Input relay)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.3.4.X</td>
<td>Modbus address (Input registers)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.3.4.X</td>
<td>Modbus address (Holding registers)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Continues on the next page
<table>
<thead>
<tr>
<th>Chapter/section Number (*1)</th>
<th>Definition item name in tree (*2)</th>
<th>Printed data</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.3.4.X</td>
<td>DNP3 communication (Parameters)</td>
<td>DNP3 communication</td>
<td>It can be printed for the SCS projects of SCSU1 that are created by the software version R3.02.20 or later.</td>
</tr>
<tr>
<td>1.3.4.X</td>
<td>DNP3 communication (Binary Input)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.3.4.X</td>
<td>DNP3 communication (Binary Output)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.3.4.X</td>
<td>DNP3 communication (Binary Counter)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.3.4.X</td>
<td>DNP3 communication (Analog Input)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.3.4.X</td>
<td>DNP3 communication (Analog Output)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.3.4.X</td>
<td>Tag name definition (BOOL/ECW_B)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.3.4.X</td>
<td>Tag name definition (DINT/REAL/ECW_I/ECW_R)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.3.4.X</td>
<td>Tag name definition (ANLGI/ANLG_S)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.3.4.X</td>
<td>Tag name definition (VEL)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.3.4.X</td>
<td>Tag name definition (ANN)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.3.4.X</td>
<td>Tag name definition (IO_REAL)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.3.4.X</td>
<td>Tag name definition (IO_BOOL)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.3.4.X</td>
<td>Tag name definition (GOV_B/GOV_IB/OVR_B/OVR_IB)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.3.4.X</td>
<td>Tag name definition (OVR_I/OVR_R/OVR_IR)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.3.4.X</td>
<td>Tag name definition (PASSWD)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.3.4.X</td>
<td>Tag name definition (SCI_B/SCO_B)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.3.4.X</td>
<td>Tag name definition (SCI_I/SCI_R/SCI_R/SCO_R)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.3.4.X</td>
<td>Tag name definition (MOB_11/MOB_21)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.3.4.X</td>
<td>Tag name definition (MOB_RS)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.3.4.X</td>
<td>Tag name definition (MOA)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.3.4.X</td>
<td>Alarm priority</td>
<td>Alarm priority</td>
<td><em>(3)</em> It can only be printed for a system with CENTUM integration structure. <em>(4)</em></td>
</tr>
<tr>
<td>1.3.4.X</td>
<td>Alarm processing table</td>
<td>Alarm processing table</td>
<td></td>
</tr>
<tr>
<td>1.3.4.X</td>
<td>Resource content</td>
<td>POU list</td>
<td>-</td>
</tr>
<tr>
<td>1.3.4.X</td>
<td>(POU)</td>
<td>POU name</td>
<td>One POU corresponds to one item.</td>
</tr>
<tr>
<td>1.3.4.X</td>
<td>Description</td>
<td>Description for POU</td>
<td>-</td>
</tr>
</tbody>
</table>

* Continues on the next page
### Table 10.4-1 Printing Objects (for compatible mode) (Table continued)

<table>
<thead>
<tr>
<th>Chapter/section Number (*1)</th>
<th>Definition item name in tree (*2)</th>
<th>Printed data</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.3.4.X.X</td>
<td>Source</td>
<td>FBD/LD/ST</td>
<td>-</td>
</tr>
<tr>
<td>1.3.4.X.X</td>
<td>Local Variables + Parameters</td>
<td>List of local variables and parameters</td>
<td>-</td>
</tr>
</tbody>
</table>

*1: Chapter and section numbers vary depending on the selected printing objects. If the item selected as printing object contains no content, nothing is printed. X means a serial number starting at 1. The start page for print can be changed.

*2: Definition item names in tree are printed as the title character strings of chapters and sections (except for the cover page).

*3: For library project, the tree view is not displayed. Moreover, the Print command is not valid.

*4: Not displayed in the tree view if the PC does not have a license for CENTUM VP/CS 3000 Integration Engineering Package.

For more information about the method for changing the start page for print, refer to:

"Page Numbering" on page 10-31
10.5 Customizing Print Settings (Backward-Compatible Mode)

You can customize the information to be printed in the Options tab of Document Generator.

In ProSafe-RS R2.02, self-documentation related behavior has been changed. If compatibility is important, you can choose the behavior in before R2.02. In this document, the behavior in before R2.02 is called "backward-compatible mode."

"Options" Tab

This section explains how to customize printing in backwards-compatible mode.

![Figure 10.5-1 "Options" Tab of Document Generator](image)

The components of the tab are explained in the following sections.

- **New Page for Each Item**
  Select this check box to start a new page for each printed item. If the [Print Diagram in landscape orientation] check box is selected, the FBD and the LD begin on a new page even if the [New page for each item] check box is not selected.

- **Print Diagram in Landscape Orientation**
  If you select this check box, the FBD and the LD are printed in horizontal (landscape) orientation regardless of the default setting of the printer and specification in the Print dialog box. Other printing items follow the default settings of the printer and specifications in the Print dialog box.
Header/Footer

You can make settings for a header or footer. Select to print either the header (at the top of the page) or footer (at the bottom of the page) or not to print both. Click [Edit] button. The following dialog box appears, where you can edit the header or footer.

![Header / Footer Dialog Box (Format A)](image)

**Figure 10.5-2 Header/Footer Dialog Box (Format A)**

![Header / Footer Dialog Box (Format B)](image)

**Figure 10.5-3 Header/Footer Dialog Box (Format B)**

In the Header/Footer dialog box, check the header or footer and click [OK] button. Set the specified header or footer to be printed on each page.

There are two types of formats for the header or footer. Specify either [Format A] or [Format B].

Specify the printed items as shown below.

- **Bitmap (formats A and B)**
  Specify the path name of the bitmap file you want to use in the [Bitmap file:] field. It is also possible to click [...] button to select a path name using the “Open” dialog box.

- **Arbitrary character strings (only for format A)**
  It is possible to enter a character string directly in each of the three lines. The character strings entered are printed in the header or footer.

- **Title (only for format A)**
  This is the same character string as the title string. The following information is printed. These strings are also printed on the cover page.
  - First line: Cannot be edited (RS project name)
  - Second line: Can be edited (default: SCS project name)
  - Third line: Can be edited (default: explanation of the project)

- **Date (formats A and B)**
The date on which the printing was done is printed out. The date format follows the de-
fault format of the locale selected in "Regional Options" of the Windows.

- Page numbers (formats A and B)
  The page numbers are printed. The format of page numbers used is the format selected
  in the "Options" tab.

**Page Numbering**

Specify the format of the page numbers printed in the header or footer, and the page number
for the first page.

Use either of the following page number formats.

- [# / total number of pages]
  Page numbers are printed using the format of "page number/total number of pages" (seri-
al number along with the total number of pages). Serial numbers are assigned to pages
  starting from the first page.

- [#]
  Page numbers are printed using the format of "Page 'page number'" (serial number). Seri-
al numbers are assigned to pages starting from the first page. Specify the page number
  from which printing is to be started by entering it in [Start Page:].

- [#.#.#.#.#]
  Page numbers are printed using the format of "chapter number.section number.page
  number" (section format). Serial numbers are assigned to pages starting from the first
  page for each chapter/section. Specify the section number from which printing is to be
  started by entering it in [Start Section:]. Note that the cover page and the table of con-
tents are always numbered from page 1 (i).

  - The page numbers for the cover page and table of contents are printed using Roman
    numerals (i, ii, iii, iv, ...).
  
  - The project information is printed using the "9.9" format.
  
  - The configuration information is printed using the "9.9.9" format.
  
  - The resource information is printed using the "9.9.9.9" format.
  
  - The POU information is printed using the "9.9.9.9.9" format.

  - The information in lower hierarchy than POU is printed using the "9.9.9.9.9.9" format.

**TIP**

If you want to reprint a part of the project so as to replace the old printouts after the contents of the whole
SCS project were printed out, follow the procedure below:

1. In the Table tab, choose the items to be printed.
2. In the Options tab, choose [#.#.#.#.#.] at Page Numbering.
3. In [Start Section], specify the chapter and section numbers for the items you want to reprint.
4. Click [Print]. The Print dialog box appears.
5. In the Print dialog box, select [All] for [Page Range: ]. Then only the specified part of the project will be
  printed out.

**Cover Page**

Specify the format of the cover page.

If you check the [Header/Footer on cover page], header or footer is printed on the cover page
in the format specified in the [Header/Footer] section.

**Margins**

Specify the printing margins of each page. The printing margins are the offsets at the top/
bottom/left/right sides of the page from the perimeter of the maximum printable area.
• "Visible Margins"
  Specify whether or not to print the printing margin frame. If you select the check box, a frame showing the printing margins is printed on each page.

• "Top", "Bottom", "Left", "Right"
  Specify the margin width for the top, bottom, left and right margin in units of mm, respectively.

- **Fonts**

  Specify the font used in printing. The font specification applies to text used for information displayed except for the FBD, the LD and the ST of Multi-Language Editor.

  • "Text font"
    Click [Text font] button to display the Text font dialog box. The font selected in this dialog box is used as the font for the table of contents and titles of chapters and sections.

  • "Title font"
    Click [Title font] button to display the Title font dialog box. The font selected in this dialog box is used as the font for the cover page.

  ![Text Font Dialog Box](image)

  **Figure 10.5-4 Text Font Dialog Box**

  **TIP**

  [Font style], [Effects] and [Script] settings are invalid.

  **IMPORTANT**

  The self-documentation function prints data in the files saved by SCS Manager and builders. For this reason, if you attempt to save files while the self-documentation is running, incorrect information may be printed or the printing process may fail. In such cases, run the self-documentation again after completing saving the files.
10.6 Confirmation by Print Preview

A preview of the information to be printed can be displayed in the "Preview" tab of Document Generator. All the pages selected as printing targets in the "Table" tab are displayed in the "Preview" tab reflecting the result of customization in the "Options" tab. Each page of the printing results can be displayed by scrolling through the pages.

TIP
When you print using Document Generator, you can make print settings in the Page Setup dialog box started from File menu in SCS Manager. However, you cannot use the Page Setup dialog box in backward-compatible mode. A preview is shown with the printer settings made here. Therefore, if you specify the printer usually used for printing in the Page Setup dialog box beforehand, the preview and printed results match. The settings in the Page Setup dialog box can be made for each computer. However, in the Page Setup dialog box, you cannot set Page Range.
11. Database Validity Check Tool

Database Validity Check Tool checks the mutual validity of the work database, the master database and the SCS database in the SCS. It checks whether or not the generation time and CRC (Cyclic Redundancy Checksum) of the databases match.

This chapter explains the window functions and operations of Database Validity Check Tool.

### Relationship among Inter-Database Checks

The figure below illustrates the relationship of mutual validation of the work database, the master database and the SCS database within an SCS.

![Relationship among Inter-Database Checks Diagram]

**Figure 11-1 Inter-database Check**

The generation time and CRC information are acquired for each of the following databases from the work database, the master database and the SCS database within an SCS:

- POU DB
- Variable DB
- System DB (database for safety system)
- Integration DB (database for connecting CENTUM and external devices)

**TIP**
The source files of the work database and the source files of the master database are not compared.

### Repair database

If an online change download is interrupted or discontinued, database mismatch often occurs between SCS and SENG. While the database does not match between SCS and SENG, online change download attempts fail.

The database repairing function makes the database match between SCS and SENG, enabling you to run the discontinued online change download again.

Database Validity Check Tool of R3.02.10 or later provides the database repairing function. You can use the database repairing function only when the database does not match between SCS and SENG.
An example case of database repair is as follows:

1. If a communication error occurs during offline download or online change download, the master database on the SENG may fail to be updated although the database on the SCS is updated. As a result, the database does not match between the SCS and SENG after the communication error and online change download is discontinued. With non-matching databases between SCS and SENG, online change download attempts fail.

2. The database repairing function overwrites the master database with the contents of the work database to match the database between SCS and SENG. When the master database is repaired successfully, the display in the Check Result List is refreshed.

**TIP**

Until the master database is repaired, the SCS project remains read only and cannot be edited or built. Restoration of the master database and master database offline download are also disabled.

3. After the master database is repaired, you can run the interrupted online change download and master database offline download again. You can read/write, edit, and build the SCS project. You can also use the Master Database Restoring Function.

**SEE ALSO**

For more information about master database offline download, refer to:

9.3, “Master Database Offline Download” on page 9-10

For more information about the master database restoring function, refer to:

12., “Master Database Restoring Function” on page 12-1

### Launching Database Validity Check Tool


2. Select [Database Validity Check] from the Engineering launcher menu. Database Validity Check Tool launches and the Database Validity Check Tool window appears.
Database Validity Check Tool Window Structure

The components of the window are explained in the following sections.

Station Name

The station name of the SCS in question is displayed.

Check Result List

The results of checking the database validity are displayed in a list.

Items displayed in the check result list are explained below.

<table>
<thead>
<tr>
<th>Item name</th>
<th>Display</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database</td>
<td>Displays an icon indicating the results of checking the database validity along with the database name (POU DB, Variable DB, System DB, Integration DB)</td>
</tr>
</tbody>
</table>
### Table 11-1 Items Displayed in Check Result List (Table continued)

<table>
<thead>
<tr>
<th>Item name</th>
<th>Display</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check Item</td>
<td>Displays whether the validity is checked based on the generation time or CRC</td>
</tr>
<tr>
<td>Work</td>
<td>Displays the generation time and CRC of the work database</td>
</tr>
<tr>
<td>Master</td>
<td>Displays the generation time and CRC of the master database. The master database is generated and the master information is displayed when you download the work database to the SCS.</td>
</tr>
<tr>
<td>SCS</td>
<td>Displays the generation time and CRC of the SCS database within the SCS. Displayed when the SCS is connected.</td>
</tr>
</tbody>
</table>

### Types of Icons

The following three colors are used for the icons displayed in the [Database] column, depending on whether the SCS database matches the work database and master database or not.

<table>
<thead>
<tr>
<th>Icon (color)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓ (green)</td>
<td>The work database, the master database and the SCS database all match.</td>
</tr>
<tr>
<td>✓ (blue)</td>
<td>The contents of the work database, the master database and the SCS database all match.</td>
</tr>
<tr>
<td>! (yellow)</td>
<td>The work database and the master database do not match. This result occurs if you performed a build operation to generate the work database but have not performed download. When required, you can perform online change download or offline download to download the work database to the SCS. If you want discard the work database, you can use Master Database Restoring Function to duplicate the master database into the work database.</td>
</tr>
<tr>
<td>✗ (red)</td>
<td>The master database and the SCS database do not match. Online change download cannot be performed. Perform either offline download or master database offline download to update the SCS database so that it matches with the master database.</td>
</tr>
</tbody>
</table>

### IMPORTANT

With the software R1.02.00 or higher versions, if an application with no change to its contents of variables is online change downloaded, the Variable DB is not downloaded to SCS, causing inconsistency in the "Time" and "CRC" for the Variable DB shown in the Database Validity Check Tool window between the "Work" column and the "Master and SCS" columns. If this happens, the icon indicating the check result is shown in blue and the following message appears.

**Example:**

The content of the definition is corresponding though the time and CRC of Variable DB is not corresponding between work and master.
Checking Database Validity

- Click the [Check Start] button in the Database Validity Check Tool window. Database validity check starts.
- During the check, the progress is displayed in the progress bar at the bottom of the window.

Execution Messages

Execution messages generated during checking are displayed.

The information shown in the execution message area can be copied and used as information for reports.

There are following three types of operation messages.

- Error messages notifying processing errors
- Information acquired during checking
- Checking result

Example of Error Messages Notifying Processing Errors and Action to Take

If you start database validity check while the target SCS project is being built or downloaded, an error message like the one shown in the following figure is displayed. Wait until the build or downloading is completed and start the check again.

Figure 11-3 Example of error messages
Example of Information Acquired during Checking

The generation time and CRC information are displayed for the work database, the master database and the SCS database within the SCS.

Example of Checking Result and Displayed Contents

The result after comparing the SCS database in SCS, the work database and the master database will be displayed.

- Comparing the generation time and CRC of the databases.
- If CRC discrepancies are found among the POUs of databases, the POU name and the resource configuration file name (<SCSProjectName>_Conf) will be displayed.
- "IMPORTANT" indicates the discrepancy between the SCS settings in SCS and in the master database corresponding to the red icons in the check result list.
- "CAUTION" indicates the discrepancy between the SCS settings in work database and in the master database corresponding to the yellow icons in the check result list.
- Indicates the number of compared POUs.

Repairing the Database That Does Not Match

- Click the [Repair Database] button in the Database Validity Check Tool window.
The master database is overwritten with the contents of the work database. "Check Result List" indicates that the master database and the SCS database match.

Figure 11-6 Database Validity Check Tool Window

- Exiting Database Validity Check Tool
  - Click the [Close] button in the Database Validity Check Tool window. The button is disabled during checking.
  - The Database Validity Check Tool is exited.
12. Master Database Restoring Function

Master Database Restoring function is a tool to restore the edited SCS project to the last downloaded state. This function may be used mainly under the circumstance when you modified a project but later you found that the contents you changed are not allowed for online downloading. Using this function, you can restore the SCS project to the previously downloaded state so as to revert your changed contents. And then you can continue to perform the modification to the contents that are allowed for online downloading.

This section explains the operations involved in restoring the master database.

Overview of Master Database Restoring Function

The engineering data required for operating ProSafe-RS is stored as the work database of an SCS project in the SENG, and the SCS database within this work database is subsequently downloaded to the SCS by user operation. Once downloaded, the work database is stored as the master database.

The information of an SCS project includes the work database in the SENG, the master database in the same SENG and the SCS database within the SCS. Immediately after downloading, the two source files and three SCS databases contain the same data; that is, the source files and SCS databases are consistent.

Figure 12-1 Database Configuration

If you do not perform download after engineering (saving data created in a builder in the work database), the data in the work database and other databases will not match.

Master Database Restoring Function is a tool to discard the information in the work database and restore the work database with the information in the master database. So that the engineering data (in the work database) can match the engineering data in the master database.

Note that Database Validity Check Tool is used to check that the data in each database matches.
Work Database Restoration Timing

It is possible to use Master Database Restoring Function to restore the data of the master database in the work database at any time. However, the SCS project that has been opened by the SCS Manager or the Multi-Language Editor cannot be restored. Likewise, when the Master Database Restoring Function is used, the SCS Manager and Multi-Language Editor cannot be used.

- Restoration Target File

The master database of an SCS is stored in located below the top folder of each SCS project. It is possible to use Master Database Restoring Function to restore the work database based on all the files.

**IMPORTANT**

Do not add, delete or change folders and files in layers below the top folder of the SCS project using Windows Explorer.

How to Launch Master Database Restoring Function

From the [Start] menu of Windows, select [All Programs] > [YOKOGAWA ProSafe] > [Maintenance] > [SCS master DB recover]. Master Database Restoring Function launches.

Master Database Restoring Function Window Structure

![Figure 12-2 Master Database Restoring Function Window](image)

The components of the window are explained in the following sections.

- **Top Folder Display Area**

  The path to the top folder of the SCS project, which is the restoration destination of the master database, is displayed in this field.

  To change the target project, enter the path to the desired project folder directly in the field of the top folder display area, or select a folder in the folder selection dialog box displayed by clicking [Browse] button.
**SCS Project Information Display Area**
This area displays information about the target SCS project.

**Master Database Restoration Operation**

1. Specify the path to the top folder of the SCS project, which is the restoration destination of the master database, in the top folder display area.
2. Check the information displayed in the SCS project information display area.
3. Click [Restore] button.
   A confirmation dialog box appears.
   Click [OK] to display the Status Display dialog box; the restoration processing starts.

![Status Display Dialog Box](image)

The following information is displayed in the Status Display dialog box.

- Restoration start date/time
- Restoration completion date/time
- Warnings and errors
- Numbers of warnings and errors

4. Click [Close] button when Restore is completed.
   The Status Display dialog box is closed.
5. Click [Close] button on Master Database Restoring Function window so as to close it.

**TIP**

- In order to stop the restoration during the processing, click [Abort] button. The restoration processing that has been carried out so far is discarded and the work database returns to the status before the restoration processing operation.
- To select information displayed in the Status Display dialog box, select [Select All] from the pop-up menu opened by right-clicking. Select [Copy] to copy the information.
13. Version Control

The Version Control Tool manages the history of changes of SCS projects and assists the user with system updating tasks. This section describes how to use the Version Control Tool.

SEE ALSO
For more information about an overview of the Version Control Tool, refer to:
2.19, “Version Control” in Engineering Guide (IM 32Q01C10-31E)

Purposes of Version Control Tool

Version Control Tool is used for the following purposes.

- **Version Control of Project Data**
  Save engineering data at a project milestone or at the end of engineering in different hard disks (check-in).

- **Backing up Project Data**
  Checked-in data can be used as backup data. Checked-in project data can be checked out and restored.

- **Engineering and Replacing the Revised Project with Large-scale Changes**
  When making large-scale changes to an SCS project, it is a good idea to perform engineering tasks on temporarily copied project data, rather than editing the active project data directly; this way, the active project data can be replaced with the new project data at the end of engineering.
13.1 Main Window of Version Control Tool

This section explains the components of the main window of Version Control Tool.

- **How to Launch Version Control Tool**
  From the [Start] menu of Windows, select [All Programs] > [YOKOGAWA ProSafe] > [Version Control Tool]. Version Control Tool launches.

  **TIP**
  If a check-in folder has not been specified, the Select Checkin Folder dialog box appears automatically.

  **SEE ALSO**
  For more information about how to specify the check-in folder, refer to:
  13.3, “Checking in Project Data” on page 13-9

- **Version Control Tool Window**

  ![Version Control Tool Window](image)

  The components of the window are explained in the following sections.

  - **Menu Bar**
    The menu bar provides the following menus.
    - [File] menu
    - [Edit] menu
    - [View] menu
    - [Tool] menu

    The menu items of each menu are explained below.
Table 13.1-1 File Menu

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Regist Project</td>
<td>Starts new version control of an SCS project</td>
</tr>
<tr>
<td>Delete Version/Project</td>
<td>Deletes specified versions, SCS projects or RS projects from the check-in folder</td>
</tr>
<tr>
<td>Print Preview</td>
<td>Displays print preview.</td>
</tr>
<tr>
<td>Print</td>
<td>Displays the print dialog box for printing purposes.</td>
</tr>
<tr>
<td>Exit Version Control Tool</td>
<td>Closes Version Control Tool</td>
</tr>
</tbody>
</table>

Table 13.1-2 Edit Menu

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Checkin</td>
<td>Checks in the selected SCS project to the specified check-in folder</td>
</tr>
<tr>
<td>Checkout</td>
<td>Checks out the selected version to the specified folder</td>
</tr>
<tr>
<td>Abort</td>
<td>Stops a check-out or check-in operation in progress</td>
</tr>
<tr>
<td>Select All</td>
<td>Selects all versions</td>
</tr>
<tr>
<td>Deselect All</td>
<td>Deselects all versions</td>
</tr>
</tbody>
</table>

Table 13.1-3 View Menu

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Detail</td>
<td>Displays a dialog box that displays detailed information of the selected version</td>
</tr>
<tr>
<td>Order of Display</td>
<td>Selects a display order for the version list display area. The selectable display orders are in order of version, date and engineer name.</td>
</tr>
<tr>
<td>Toolbar</td>
<td>Specifies whether or not to show the tool bar</td>
</tr>
<tr>
<td>Status Bar</td>
<td>Determines whether or not to display the status bar</td>
</tr>
<tr>
<td>Message Display Area</td>
<td>Specifies whether or not to show the message display area</td>
</tr>
</tbody>
</table>

Table 13.1-4 Tool Menu

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Checkin Folder</td>
<td>Displays a dialog box for changing the top path of the check-in folder</td>
</tr>
<tr>
<td>Change Target Project Folder</td>
<td>Changes the top path of an SCS project to be the target of version control. This menu item can only be selected when an SCS project is selected in the version control DB display area.</td>
</tr>
<tr>
<td>Option</td>
<td>Sets the operating environment of the tool and displays the option dialog box.</td>
</tr>
</tbody>
</table>

● Toolbar

The toolbar provides the following buttons.

Table 13.1-5 Toolbar Buttons

<table>
<thead>
<tr>
<th>Button</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Regist SCS Project</td>
<td>Same as [Regist Project] in the [File] menu</td>
</tr>
<tr>
<td></td>
<td>Delete Version/Project</td>
<td>Same as [Delete Version/Project] in the [File] menu</td>
</tr>
<tr>
<td></td>
<td>Checkin</td>
<td>Same as [Checkin] in the [Edit] menu</td>
</tr>
<tr>
<td></td>
<td>Checkout</td>
<td>Same as [Checkout] in the [Edit] menu</td>
</tr>
</tbody>
</table>

Continues on the next page
Table 13.1-5 Toolbar Buttons (Table continued)

<table>
<thead>
<tr>
<th>Button</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="Abort" alt="Abort" /></td>
<td>Abort</td>
<td>Same as [Abort] in the [Edit] menu</td>
</tr>
<tr>
<td><img src="Detail" alt="Detail" /></td>
<td>Detail</td>
<td>Same as [Detail] in the [View] menu</td>
</tr>
</tbody>
</table>

Version Control DB Display Area

The version control DB display area displays RS projects and SCS projects in the check-in folders specified by engineers in a tree structure.

The displayed folder structure is limited down to the level of SCS projects; folders in lower layers are not displayed.

SCS Project Path Display Area

If you select an SCS project in the version control DB display area, the path to the top folder of the SCS project to be checked-in is displayed in this area.

Check-in Destination Folder Path Display Area

This area displays the folder path of the check-in destination (check-in folder) for the SCS project selected in the version control DB display area.

Version List Display Area

This area displays a list of versions corresponding to the SCS project selected in the version control DB display area. It is possible to select multiple versions.

If you double-click a version, the Detail dialog box appears and shows the detailed information about the selected version.

The following information is displayed in the version list display area.

- Version
- Date (Check-in time and date)
- Engineer
- Comment

If you click a column title other than Comment once, the list is sorted according to the selected item in the ascending order. If you click once again, the list is sorted in the descending order.

An icon indicating the version is displayed at the left edge of the list. The icon for the latest version has a different shape than other icons. Note that the latest version is judged from the check-in date, rather than the version number, and the icon is displayed accordingly.

For more information about Detail dialog box, refer to:

“Display of Information Related to Versions” on page 13-16

Message Display Area

Message

12/05/2007 13:45:15 started to checkin.
12/05/2007 13:45:20 Checkin completed.
-- Error=0 Warning=0 --

Figure 13.1-2 Message Display Area
The message display area displays messages generated at check-in, check-out, deletion, etc.

**TIP**
Right click the mouse to show a pop-up menu. Choosing [Copy] from the menu may copy the messages.

### Status Bar

- **Progress bar**
  At check-in, check-out and deletion, the progress bar appears and displays the processing percentage. If the progress bar is not displayed, hints for the tool appear according to the mouse cursor position.

- **Display order display area**
  This area displays the display order chosen in the version list display area.

- **Total number of versions display area**
  This area displays the total number of displayed versions.

Figure 13.1-3 Status Bar
13.2 Registration of SCS Projects for Version Control

If version control is performed for an SCS project for the first time, the project must be registered. Once registered, the project is displayed and can be selected in the tree list of the version control DB display area.


2. Specify the top folder of the SCS project for which you want to perform version control. In order to change the top folder, enter the path to the desired folder directly in the field or select it in the folder selection dialog box displayed by clicking [Browse] button.

3. Click [OK]. The top folder of the SCS project is displayed in the SCS project path display area.

IMPORTANT

You can specify the top folder path to SCS project in the format for local drives, not necessarily in the Universal Naming Convention (UNC). But before you use the local drive format, you must specify "Folder sharing" as a user with administrator privilege. "Folder sharing" enables you to check-in folders to local drives.

TIP

An error dialog box appears if the specified folder does not exist, the top folder of an SCS project that is already registered for version control is specified, or a folder that is not the top folder of an SCS project is specified.

Folder Sharing

When a SCS project is registered, the upper level folder of the RS project folder needs to be specified as a shared folder.

An example below shows how to specify a folder as a shared folder. In this example, the folder named RS-Projects is specified as the shared folder.

```
C:\RS-Projects\MYRSPJT\SCS0101
```

Figure 13.2-2 Example of Shared Folder Specification

1. Open Windows Explorer, right click on RS-Projects folder and then choose [Properties] from the pop-up menu. The Properties dialog box will be displayed.

2. Display "Sharing" tab and click [Advanced Sharing].
3. Check the [Share this Folder] option and click [Permissions] button.

4. Check all the check boxes in [Allow] column of "Permissions for Everyone" and then click [OK].
Figure 13.2-5 Permissions Dialog Box

RS-Projects folder becomes a shared folder.
### 13.3 Checking in Project Data

When you check in an SCS project, the project data of the SCS project is saved in the check-in folder. At this point, a version number is assigned to the project data and the data is controlled according to this number.

#### Check-in Timing

Project data can be checked in at any point.

When an SCS project to be checked in is being edited in the SCS Manager, Multi-Language Editor or any of the builders, it cannot be checked in or out with Version Control Tool. SCS project cannot be edited with the SCS Manager, Multi-Language Editor or any of the builders while Version Control Tool is performing the check-in and check-out operation.

#### Structure of Check-in Destination Folder

The user can select any location for the top folder of the check-in destination, but the folder structure below the top folder is determined automatically.

---

**IMPORTANT**

- Do not use Windows Explorer to add, delete or modify the folders or files under the SCS project top folder, except for coping the library.
- Do not edit checked-in project data directly with SCS Manager.
- Do not operate on checked-in project data with Master Database Restoring Function.

Note that, in advance, the top folder of the check-in destination must be given a shared name "RS-Share" and its security must be strengthened by running the IT Security Tool.

---

**SEE ALSO**

For more information about strengthening the security of the check-in destination folder on an SENG PC, refer to:

B4.2, “Settings of Project Database Folder” in Installation (IM 32Q01C50-31E)

For more information about strengthening the security of the check-in destination folder on a file server, refer to:

A2.2.3, “Setup Procedure for a File Server” in Installation (IM 32Q01C50-31E)

---

#### Specification of Check-in Destination Folder

1. Select [All Programs] > [YOKOGAWA ProSafe] > [Version Control Tool] from the [Start] menu of Windows.
   If a check-in folder has not been specified, the Select Checkin Folder dialog box appears automatically.

2. Specify a check-in folder.
In order to change the check-in folder, enter the path to the desired folder directly in the field or select it in the folder selection dialog box displayed by clicking [Browse] button.

**IMPORTANT**

To prevent from the hardware abnormality, it is recommended to specify a folder in a disk different from the disk where SCS projects are saved.

3. Click [OK].
   The check-in folder is specified and the focus is returned to the window of Version Control Tool.
   The structure of the specified folder is displayed in the version control DB display area.

**Check-in Operation**

It is possible to check in project data at any point.

1. Select an SCS project to be checked-in in the version control DB display area.

   **TIP**

   If the SCS project you want to check in is not displayed, register the SCS project for version control in advance following the procedure in "Registration of SCS Projects for Version Control."

2. Click [Checkin] button in the toolbar of the Version Control Tool window or select [Check-in] from the [Edit] menu; the Checkin dialog box appears.

   ![Checkin Dialog Box](image)

   **Figure 13.3-2 Checkin Dialog Box**

3. Set version information and other items recorded in the version information file.
   The items that should be set in the Checkin dialog box are shown below.

<table>
<thead>
<tr>
<th>Item displayed</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Version</td>
<td>Version number. Enter the number directly or select it with the spin box. The version number cannot be changed after check-in (*1)</td>
</tr>
<tr>
<td>Engineer</td>
<td>Enter the name of an engineer who performs check-in within 16 uppercase alphanumeric characters. An error dialog box appears if the field is left blank.</td>
</tr>
<tr>
<td>Comment</td>
<td>Enter any comment using up to 64 characters.</td>
</tr>
<tr>
<td>Note</td>
<td>Enter a more detailed description than in [Comment].</td>
</tr>
</tbody>
</table>

*1: If it is absolutely necessary to change the version number after check-in, delete the version you checked in and check in the data again with the correct version number. Note that the check-in date/time changes.
The rules for setting version numbers are explained below.

Table 13.3-2 Version Input Rules

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Format</td>
<td>Up to 8 characters and 2 decimal points can be entered. A minus sign can also be specified. Example: 1, 1.0, 1.01, -1.0, -1.01, -1.10</td>
</tr>
<tr>
<td>Default value</td>
<td>1.0 for the first check-in. The least significant digit of the latest version is incremented for 2nd check-in and onward. Example: 2 if the latest version is 1 Example: 1.1 if the latest version is 1.0 Example: 1.02 if the latest version is 1.01 Example: 1.11 if the latest version is 1.10 Example: -2 if the latest version is -1</td>
</tr>
<tr>
<td>Input check</td>
<td>An error dialog box appears in the following cases. If the format is erroneous If the version number already exists If the number is smaller than the latest version number of the existing version (*1), a warning dialog box appears.</td>
</tr>
</tbody>
</table>

*1: In case of version numbers with minus signs, the absolute value of the input is checked, i.e., excluding the minus sign. For example, a warning dialog box appears if you enter -1 after -2.

4. Click [Checkin] button.
The saving processing starts. At this point, a message indicating the saving status is displayed in the message display area and the saving status is shown in the progress bar.
The following information is displayed in the message display area.
- Check-in start date/time
- Check-in completion date/time
- Warnings and errors
- Numbers of warnings and errors

**TIP**
During the check-in processing, [Abort] of the [Edit] menu and the [Abort] button of the toolbar are enabled; by selecting either of these, it is possible to stop the processing in the middle. If you select this menu item or button, the check-in processing is stopped and the files checked out until then are discarded.
13.4 Checking out Project Data

The checked-in project data can be retrieved (checked out) to a folder under the top folder of the SCS project or any other folder. The checked-out folders and files can be edited.

**IMPORTANT**

If you check out project data immediately below the SCS project top folder, the existing SCS project is cleared and the project data is replaced with the new version.

**Check-out Operation**

Checked-in project data can be checked out at any point.

1. Select the SCS project to be checked out and the version from the version control DB display area and the version list display area, respectively.
2. Click "Checkout" button in the tool bar or select [Checkout] from the [Edit] menu; the Checkout dialog box appears.

![Checkout Dialog Box](image-url)

3. Select the location where the data should be checked out to, immediately below the top folder of the registered SCS project folder, or any other folder.
   - To specify the SCS project top folder, select [Project folder]. The path name of the SCS project top folder cannot be changed.
   - To specify any other folder, select [Other folder]. Enter the path to the desired folder directly or select it from the folder selection dialog box displayed by clicking [Browse] button.

**IMPORTANT**

If the folder for the checked-out data is UNC type, the folder should not be a shared folder. Create a new folder under the shared folder. Specify the newly created folder as the destination for check out. It is recommended to set the folder one level upper than the RS project folder as the shared folder.

The check-out processing is different depending on whether the check-out destination is set to the SCS project top folder or any other folder. The differences in processing are explained below.

- **Project folder**
  - All the files below the specified folder are cleared before check-out processing when the user clicks [Yes] button in the confirmation dialog box.
  - The structure of the folders under the SCS project top folder should match the structure of the checked-in folders. Moreover, the structure of the files after checking-out should be the same as the structure of the checked-in files.
• Other folder
  Files below the specified folder are not cleared before check-out. This causes the folder structure at the specified folder and below to be merged with the checked-in folder structure. Moreover, the file structure after check-out is also merged with the checked-in file structure; files with the same names are overwritten.

However, if a user-defined folder is used as the SCS project folder, it behaves the same as for the SCS project top folder.

TIP
  • An error dialog box appears if you specify the SCS project top folder and the specified folder does not exist.
  • If you specify the project folder, it is checked that the specified folder is an SCS project folder. If it is not, an error dialog box appears.
  • If you select any other folder and the specified path does not exist, a confirmation dialog box appears and asks whether or not to create it. If you click [OK], a new folder is created. In this case, the created folder remains even if you abort check-out processing in the middle.

4. Click [OK] button.
   A confirmation dialog box appears.

5. Click [Yes] button in the confirmation dialog box.
   Check-out processing is performed and the target folder and all files below the target folder are copied to the destination. At this point, the message display area displays the check-out status. The status bar displays the progress status with the progress bar.

   The following information is displayed in the message display area.
   • Check-out start date/time
   • Check-out completion date/time
   • Warnings and errors
   • Numbers of warnings and errors

TIP
   During the check-out processing, [Abort] of the [Edit] menu and the "Abort" button of the toolbar are enabled; by selecting either of these, it is possible to stop the processing in the middle. If you select this menu item or button, check-out processing is stopped and the files checked out until then are discarded.
13.5 Deleting of Versions

Checked-in projects data can be deleted at any point. It is also possible to delete multiple versions at one time. Be aware, however, that the project data of a once deleted version cannot be restored.

Version Deletion Operation

Checked-in project data can be deleted at any point.

1. Select the target version in the version list display area. Multiple versions can be selected at the same time.

2. Click "Delete Version/Project" button of the toolbar or select [Delete Version/Project] from the [File] menu; the Version Control tool dialog box appears.

3. Click [OK].

   All the target folders and files below the folders are deleted. At this point, the deletion status is displayed in the message display area and the processing status is displayed in the status bar with the progress bar.

   The deleted versions are no longer displayed in the version list display area.

   The following information is displayed in the message display area.
   - Deletion start date/time
   - Deletion completion date/time
   - Warnings and errors
   - Numbers of warnings and errors
13.6 Deleting all Check-in Data Related to a Project

Checked-in projects data stored in the version control database is deleted for each SCS project or RS project.

Check-in Data Project Deletion

Check-in project data stored in the version control database is deleted for each SCS project or RS project.

1. Select an SCS project or RS project in the version control DB display area.
2. Click [Delete Version/Project] button in the toolbar or select [Delete Version/Project] in the [File] menu; the Version Control tool dialog box appears.

3. Click [OK] button.
   The deletion process is executed and the entire folder of the corresponding SCS project or RS project is deleted from the version control database. At this point, the deletion status is displayed in the message display area and the processing status is displayed in the status bar with the progress bar.
   The deleted project is no longer displayed in the version control DB display area.
   The following information is displayed in the message display area.
   - Deletion start date/time
   - Deletion completion date/time
   - Warnings and errors
   - Numbers of warnings and errors
13.7 Viewing Version Information

At check-in, not only the version number, but also comments and other kinds of version information are recorded together with the data to be checked in. The version information can be viewed in the Detail dialog box.

Moreover, check-in states in the past are displayed in the version list display area. It is possible to change the sorting order and filter versions to be displayed in the version list display area.

For more information about changing sorting order in the version list display area, refer to:

"Version Control Tool Window" on page 13-2

Display of Information Related to Versions

Detailed information of the selected version is displayed in the Detail dialog box.

Displaying the Detail Dialog Box

The Detail dialog box is displayed by performing either one of the following operations.

- Select [Detail] in the [View] menu.
- Select the [Detail] button in the tool bar.
- Select [Detail] in the pop-up menu displayed by clicking the right mouse button in the version list display area.
- Double-click in the version list display area.

![Figure 13.7-1 Detail Dialog Box](image)

The Detail dialog box shows the following information items related to the selected version.

Table 13.7-1 Information Displayed in the Detail Dialog Box

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Version</td>
<td>Version number</td>
</tr>
<tr>
<td>Date</td>
<td>Date and time</td>
</tr>
<tr>
<td>Engineer</td>
<td>Engineer name</td>
</tr>
<tr>
<td>Logon user</td>
<td>Logon user name</td>
</tr>
</tbody>
</table>
### Filtering Version List

Every time data is checked in, new check-in information is added; the version list may eventually contain too many lines. In this case, it is possible to filter the list such that versions that do not need to be viewed are not listed. The filtering settings are made in the Option dialog box.

#### Displaying the Option Dialog Box

Select [Option] from the [Tool] menu. The Option dialog box appears.

![Option Dialog Box](image)

#### Specification of Filtering Items

The following filtering items can be specified in the Option dialog box. When filtering items are set, the list only displays project data satisfying all the conditions below.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Version Number</td>
<td>The specified version number and onwards can be displayed. Select a version number in the spin box or enter the version number directly.</td>
</tr>
<tr>
<td>Date</td>
<td>Only versions that were checked-in during a certain period can be displayed. In order to specify this item, select a period to be displayed in the calendar control and spin box or enter the period directly.</td>
</tr>
<tr>
<td>Engineer</td>
<td>Only versions checked in by a specific engineer can be displayed. In order to specify this item, enter an engineer name directly in the text box.</td>
</tr>
</tbody>
</table>

Specify filtering items and click [OK] button. The version list display area is updated and the list is shown according to the specified filtering conditions.
13.8 Printing Version Information

It is possible to print the version information of the SCS project displayed in the version list display area.

The version list displayed in the version list display area can be sorted or filtered. The version information is printed in the landscape orientation on A3 size paper according to the display in the version list display area.

■ Printing Example

Choose [Print] from [File] menu. The SCS Project Version Information can be printed out. A sample of printout is shown as follows:

![Version information table]

Figure 13.8-1 Printing Example
13.9 Changing the Top Path of a Check-in Folder

If the capacity of the disk used for version control becomes insufficient or the disk crashes, secure new disk space for version control in a new disk location.

At this point, it is necessary to change the check-in path maintained in each SENG to the path of the newly set disk space. The top path of a check-in folder is changed in the Select Check-in Folder dialog box.

Changing Check-in Folder Top Path

1. Select [Change Checkin Folder] from the [Tool] menu
   The Select Checkin Folder dialog box appears.

   ![Select Checkin Folder Dialog Box](image)

   Figure 13.9-1 Select Checkin Folder Dialog Box

2. Specify the check-in folder.
   To change the check-in folder, enter the path to the folder directly or select it from the folder selection dialog box displayed by clicking [Browse] button.

   **TIP**
   An error dialog box appears if the specified folder does not exist.

3. Click [OK].
   The check-in folder is specified. The structure of the specified folder is displayed in the version control DB display area.
14. Import/Export

[Export] exports 'application data in SCS Project' to an external file, and [Import] imports the 'exported data to the external file'. Some builders enable you to export to and import from external files.

This chapter describes importable and exportable files, and whether the 'Online change download' is allowed to execute on the imported files or not.

SEE ALSO
For more information about how to backup RS project, refer to:

- "Backing up RS Projects" on page 2-3

For more information about how to backup SCS project, refer to:

- "Version Control" on page 13-1

For more information about procedures and notes for Import/Export, refer to:

- 2.20, "Import/Export Function" in Engineering Guide (IM 32Q01C10-31E)

SCS Project Application Data Exportable By SCS Manager

The units of application data of an SCS project that can be exported by the SCS Manager and the menu item names displayed under [Export] of the [File] menu are as follows.

Table 14-1 Specifying Export Data and [Export] Menu Items

<table>
<thead>
<tr>
<th>Specifiable export data</th>
<th>Menu item</th>
<th>Detailed menu item</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project</td>
<td>Entire SCS project</td>
<td>Project</td>
</tr>
<tr>
<td></td>
<td>Defined words</td>
<td></td>
</tr>
<tr>
<td>Resource</td>
<td>Resource properties</td>
<td>Resource</td>
</tr>
<tr>
<td></td>
<td>I/O device instances</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Global variables</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Wiring variables (*2)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>External bindings (*3)</td>
<td></td>
</tr>
<tr>
<td>POU</td>
<td>POU</td>
<td></td>
</tr>
<tr>
<td>Variables</td>
<td>Variables</td>
<td></td>
</tr>
<tr>
<td>Defined words</td>
<td>Defined words</td>
<td></td>
</tr>
<tr>
<td>SCS Project Properties</td>
<td>- (*4)</td>
<td></td>
</tr>
</tbody>
</table>

*1: If you select this item, all the data shown in the table other than SCS project properties are exported.
*2: Only wired variables among global and local variables are exportable.
*3: Only binding variables among global variables and binding groups are exportable.
*4: You cannot use the [File] menu to export SCS Project Properties. To export SCS Project Properties, start the Engineering Launcher in SCS Manager, and use the [Export] button in the SCS Project Properties dialog box.

Application Data Imported By SCS Manager

When you import data from data files of an SCS project using SCS Manager, you can import all of the exported data as a whole or selectively import data by specifying only the lower-level data units you want to import. When you import data from other data files, all of their exported data will be imported. However, if any of the project name, configuration name or resource name in the data file for import do not match their counterparts in the destination project, an error dialog box appears and the import ends up in a failure.
### Table 14-2 Application Data Selectable for Import

<table>
<thead>
<tr>
<th>File format</th>
<th>Exported data file</th>
<th>Data unit selectable for import</th>
</tr>
</thead>
<tbody>
<tr>
<td>Binary (PXF format)</td>
<td>Entire SCS project</td>
<td>Project</td>
</tr>
<tr>
<td></td>
<td>Defined words</td>
<td>POU (you can select multiple POUs)</td>
</tr>
<tr>
<td></td>
<td>Resource properties</td>
<td>Resource properties</td>
</tr>
<tr>
<td></td>
<td>I/O device instances</td>
<td>I/O device instances</td>
</tr>
<tr>
<td></td>
<td>Global variables</td>
<td>Global variables</td>
</tr>
<tr>
<td></td>
<td>Wiring variables</td>
<td>Wiring variables</td>
</tr>
<tr>
<td></td>
<td>External bindings</td>
<td>External bindings</td>
</tr>
<tr>
<td></td>
<td>POU</td>
<td>POU</td>
</tr>
<tr>
<td>Text (CSV format)</td>
<td>Variables</td>
<td>Variables</td>
</tr>
<tr>
<td></td>
<td>Defined words</td>
<td>Defined words</td>
</tr>
<tr>
<td></td>
<td>SCS Project Properties (*1)</td>
<td>SCS Project Properties</td>
</tr>
</tbody>
</table>

*1: The operations to import SCS Project Properties differ from those for other data. Import using the [Import] button of the SCS Project Properties dialog box.

---

**IMPORTANT**

The files with the same revision number as the SENG software revision number are importable. Even with an SCS Project created in an older software version of SENG, if you first open it with the SENG in R1.03 or later and then export, the SCS Project file becomes importable.

Whether the 'Online change download' is applicable to the imported application data or not is determined by the items of its source data. If the source data before import is online-changeable, the imported data is also online-changeable.

SEE ALSO

For more information about procedures for importing and exporting entire SCS project, defined words, resources, and POUs of binary data file, refer to:

"Importing and exporting workbench elements" of "Workbench" of the Workbench User's Guide

For more information about procedures for importing and exporting variables or Defined words of text data file, refer to:

"Importing or Exporting Variables and Defined Words" in "Link Architecture View" of "Workbench" of the Workbench User's Guide

For more information about online-changeability of the modified application data that was imported, refer to:

5.2, "List of Applicable Items for Online Change" in Engineering Guide (IM 32Q01C10-31E)

### Builders Supporting Import/Export

The table below shows a list of builders that support Import/Export and whether the 'online change download' is allowed for the imported builder files.

**Table 14-3 Builders Supporting Import/Export and Online-changeability of Their Files**

<table>
<thead>
<tr>
<th>Builders supporting Import/Export</th>
<th>Online change download (*1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SCS Constants Builder</td>
<td>No (*2)</td>
</tr>
<tr>
<td>I/O Parameter Builder</td>
<td>Yes</td>
</tr>
<tr>
<td>Communication I/O Builder</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Continues on the next page
Table 14-3 Builders Supporting Import/Export and Online-changeability of Their Files (Table continued)

<table>
<thead>
<tr>
<th>Builders supporting Import/Export</th>
<th>Online change download (*1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SCS Link Transmission Builder</td>
<td>Yes</td>
</tr>
<tr>
<td>Modbus Address Builder</td>
<td>Yes</td>
</tr>
<tr>
<td>DNP3 Communication Builder (*3)</td>
<td>No (*4)</td>
</tr>
<tr>
<td>Tag Name Builder</td>
<td>Yes</td>
</tr>
<tr>
<td>Alarm Priority Builder</td>
<td>No</td>
</tr>
<tr>
<td>Alarm Processing Table Builder</td>
<td>No</td>
</tr>
</tbody>
</table>

*1: Yes: Online change downloading possible  
No: Online change downloading not possible  
*2: Among the setting items of the SCS Constants Builder, Extend Scan Period Automatically, locking of internal variables  
(SCSP2 only), Behavior at Abnormal Calculation, and automatic IOM download are changeable by online change download.  
*3: Export/Import is possible only for the SCS projects of SCSU1 that are created by the software version R3.02.20 or later.  
*4: Among the items that are set by DNP3 Communication Builder, DNP3 slave station address, DNP3 master station address,  
Timeout value for Select Before Operate [sec.], Event to be removed when event buffer overflows, Generate an event when Freeze and Clear command changes data values, Include Frozen Counters in Class 0 response, and Type of response mes- 
 sage fragmentation are changeable by online change download.  

**IMPORTANT**

If you import text files that were exported from builders, do not edit the exported files before you import them. Only the text files that were exported from builders are importable; do not import other files.

Exporting a Builder file: On the [File] menu, click [External File] and then click [Export]. The data of the Builder file of the currently opened Builder is exported to an external file.

Importing a Builder file: On the [File] menu, click [External File] and then click [Import]. The data that was exported to the external file is imported and the data of the imported Builder file is shown in the currently opened builder window.

For more information about cautionary notes on reusing the settings of the SCS Link Transmission Builder, refer to:

* "Notes on Reusing Data Defined by SCS Link Transmission Builder" on page 5-18
15. Project Comparing Tool

The Project Comparing Tool is a tool for detecting, displaying and printing differences between two specified SCS projects.
15.1 Overview of Project Comparison

Using the Project Comparing Tool, you can check the differences between two projects, which is useful in such a case when you have created a similar project using the data of an existing SCS project. It is recommended to print the detected differences and use them for checking at your desk. If no differences were detected, it can be considered that the two projects are the same.

For more information about using the Project Comparing Tool in engineering tasks, refer to:

- 2.20, “Import/Export Function” in Engineering Guide (IM 32Q01C10-31E)
- “Checking Copied Projects” in Appendix 2, “Reuse of SCS Project Databases” in Engineering Guide (IM 32Q01C10-31E)

![Comparable Project Data](image)

**Comparable Project Data**

With the Project Comparing Tool, the data of any two SCS projects can be compared. The following three types of project data are comparable, and you can specify any combination of these project data.

- Project work database
- Project master database
- Project saved by version control tool (work database and master database)

![Figure 15.1-1 Comparison of Project Data by Project Comparing Tool](image)
15.2 Window Configuration of Project Comparing Tool

This section describes the window configuration of the Project Comparing Tool. The following figure shows an example of the display after project comparison is executed.

![Figure 15.2-1 Window of Project Comparing Tool](image)

- **Compared Items List Display**

  When two projects that you wish to compare are specified, the data items of each project are displayed in a tree view in the left and right panes. Above each tree, the path of the project is displayed. When comparison is executed, data of the items with their check box selected are compared, and the items where any difference was detected are marked with yellow (Project 1) and cyan (Project 2).

  Also, among the items where any difference was detected, those items for which detailed information is to be displayed or printed may also be selected by check boxes.

  The following table lists the data items compared by the Project Comparing Tool.
Table 15.2-1 Compared Items List

<table>
<thead>
<tr>
<th>Item</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Station</td>
<td>Project description -</td>
</tr>
<tr>
<td></td>
<td>Defined words -</td>
</tr>
<tr>
<td>Configuration</td>
<td>Description -</td>
</tr>
<tr>
<td></td>
<td>SCS project information -</td>
</tr>
<tr>
<td></td>
<td>SCS constants - Items set in SCS Constants Builder</td>
</tr>
<tr>
<td>Resource</td>
<td>Description and properties -</td>
</tr>
<tr>
<td></td>
<td>Global variables - Among the variables defined in the dictionary, those that are global</td>
</tr>
<tr>
<td></td>
<td>I/O modules -</td>
</tr>
<tr>
<td></td>
<td>I/O parameters - Items set in the I/O Parameter Builder</td>
</tr>
<tr>
<td></td>
<td>Comm. I/O - Items set in the Communication I/O Builder</td>
</tr>
<tr>
<td></td>
<td>Modbus address - Items set in the Modbus Address Builder</td>
</tr>
<tr>
<td></td>
<td>DNP3 communication - Items set in DNP3 Communication Builder</td>
</tr>
<tr>
<td></td>
<td>SCS Link Transmission - Items set in the SCS Link Transmission Builder</td>
</tr>
<tr>
<td></td>
<td>Detailed binding -</td>
</tr>
<tr>
<td></td>
<td>Tag name definition - Items set in the Tag Name Builder</td>
</tr>
<tr>
<td></td>
<td>Alarm priority - Items set in the Alarm Priority Builder</td>
</tr>
<tr>
<td></td>
<td>Alarm processing table - Items displayed in the Alarm Processing Table Builder</td>
</tr>
<tr>
<td></td>
<td>Resource content - List of user-defined groups and POUss</td>
</tr>
<tr>
<td></td>
<td>Local variables + parameters - Among the variables defined in the dictionary, local variables of the POU</td>
</tr>
<tr>
<td>POU</td>
<td>POU name - Logic defined in Multi-language Editor</td>
</tr>
</tbody>
</table>

For items other than POUs, the same items are displayed in the left and right panes.

The POU display order is as follows.

- Project 1: The order of execution.
- Project 2: The order in which matches with a POU name of Project 1 are found. However, POUs that do not exist in Project 1 are added at the end.

**Menu Bar**

The menu bar provides the following menus

- [File] menu
- [View] menu
- [Tool] menu

The menu items of each menu are explained below.

Table 15.2-2 File Menu

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compare Projects</td>
<td>Start comparison of the items for which the check box is selected.</td>
</tr>
<tr>
<td>Select Projects Paths</td>
<td>Call the dialog box for setting the paths of SCS projects to be compared.</td>
</tr>
</tbody>
</table>

Continues on the next page
### Table 15.2-2 File Menu (Table continued)

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print Summary</td>
<td>Print a summary of the comparison results.</td>
</tr>
<tr>
<td>Print</td>
<td>Print the detailed differences of the items for which the check box is selected.</td>
</tr>
<tr>
<td>Exit Project Comparing Tool</td>
<td>Close the Project Comparing Tool.</td>
</tr>
</tbody>
</table>

### Table 15.2-3 View Menu

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toolbar</td>
<td>Switch between show and hide the toolbar.</td>
</tr>
<tr>
<td>Status Bar</td>
<td>Switch between show and hide the status bar.</td>
</tr>
</tbody>
</table>

### Table 15.2-4 Tool Menu

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Details</td>
<td>Display the detailed differences of the items for which the check box is selected.</td>
</tr>
<tr>
<td>Select Items</td>
<td>Call the dialog box for batch selection of check boxes.</td>
</tr>
</tbody>
</table>

## Toolbar

The toolbar provides the following buttons.

### Table 15.2-5 Toolbar Buttons

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compare Projects</td>
<td>Start comparison of the items for which the check box is selected.</td>
</tr>
<tr>
<td>Show details</td>
<td>Display the detailed differences of the items for which the check box is selected.</td>
</tr>
<tr>
<td>Print summary</td>
<td>Print a summary of the comparison results.</td>
</tr>
<tr>
<td>Print</td>
<td>Print the detailed differences of the items for which the check box is selected.</td>
</tr>
</tbody>
</table>
15.3 Comparing Two SCS Projects

This section describes the procedure for comparing two specified SCS projects and the procedure for printing a summary of the comparison results.

■ About Designation of Projects

To designate two SCS projects for comparison, you need to specify the path to the top folder of the SCS projects. If you want to specify the master database of the SCS project, you can specify by selecting the "Master" check box.

To specify a version-controlled project, you need to specify the path to the folder of the version number under the check-in folder. In this case as well, by selecting the "Master" check box, the master database of the specified project will be the target of comparison.

Example:

To compare the data of version number 1.3 of the SCS project SCS0101 which is saved in the check-in folder \SENG_DB_PC\VER\MYRSPJT, specify the path as follows.
\SENG_DB_PC\VER\MYRSPJT\SCS0101\1.3

SEE ALSO
For more information about the version-controlled project databases, refer to:
13., “Version Control” on page 13-1

■ Comparing Projects

IMPORTANT

• Before using the Project Comparing Tool, close SCS Manager. The Project Comparing Tool and the SCS Manager cannot be used at the same time.

• An SCS project that is opened by the SCS Manager on another SENG cannot be compared.

To compare projects, perform the following procedure.

1. From the Start menu, select [All Programs] > [YOKOGAWA ProSafe] > [Project Comparing Tool].
   The Project Comparing Tool starts, and a dialog box for specifying the top paths of the two SCS projects appears.

Figure 15.3-1 Select SCS Project Dialog Box

In the dialog box, the contents specified in the previous project comparison are displayed.
2. For Project 1 Top and Project 2 Top, specify the path to the top folder of each SCS project.
   a. Click [Browse] and select the top folder of the SCS project, or enter the path directly.
   b. When specifying the master database of the specified SCS project, select the "Master" check box. When specifying a work database, leave the "Master" check box clear.
3. Click [OK].
   If a password has been set in the project, a dialog box for entering the password appears.
4. Enter the password, and click [OK].

![Password Input Dialog Box](image)

Figure 15.3-2 Project Password Input Dialog Box (Project 1)

A list of defined items of the two projects appears. All of the check boxes of the items are clear.

![Project Comparing Tool](image)

Figure 15.3-3 Project Comparing Tool (at Start-up)

TIP
An error message appears in the following cases.
- The specified folder is not an SCS project folder.
- The specified path does not exist.
- The specified SCS project is opened on the SCS Manager of another SENG.
- The password entered is not correct.

Note that if the wrong password is entered three times consecutively, the process is discontinued, and it returns to the Select SCS Project dialog box.

5. Select the check boxes of items in which you want to detect differences.
When a check box is selected on the tree on either the left or right, the check box of the same item is selected on the other tree.

**TIP**
- You can select all items at once in this way: From the menu bar, select [Tool] > [Select items] In the dialog box that appears, select "Select All."

![Figure 15.3-4 Select Items Dialog Box](image)

- Check boxes of the items that exist in only one of the projects are displayed in gray and cannot be selected for comparison.

6. From the menu bar, select [File] > [Compare Projects] to start the project comparison. A progress bar is displayed during difference detection.

When the comparison is finished, difference-detected items are marked in yellow on Project 1 and in cyan on Project 2. For items in which any difference was detected, the top-level item name is also marked, so that it is easy to see where there are differences even when the tree is collapsed.

**Executing Project Comparison for the Second Time and Thereafter**

To perform another SCS project comparison after a project comparison was executed after the Project Comparing Tool was started up, perform the following procedure.

1. From the menu bar, select [File] > [Select projects paths].
   The Select SCS Project dialog box appears.

2. Specify the paths to the SCS projects to be compared, and perform the compare operation.

**Printing a Project Comparison Results Summary**

A summary of the differences detected by executing a project comparison can be printed.

To print a summary of project comparison results, perform the following procedure.

1. With the comparison results displayed in the window of the Project Comparing Tool, select [File] > [Print summary] from the menu bar.
   The comparison results are printed.

An example of a printed summary of project comparison results is shown in the following figure.
### Project Compare Result Summary

**Project1**: C:\RS-Projects\Ti\ToolCompare\RSPJT1\SCS1105  Ver:0.1  ProjectDate:2015/02/11  
**Project2**: C:\RS-Projects\Ti\ToolCompare\RSPJT3\SCS1105\{Master\}  Ver:1.0  ProjectDate:2015/02/17

<table>
<thead>
<tr>
<th>Item</th>
<th>Project1</th>
<th>Project2</th>
</tr>
</thead>
<tbody>
<tr>
<td>* Project description</td>
<td>Not Changed</td>
<td>Project description</td>
</tr>
<tr>
<td>* Defined words</td>
<td>Not Changed</td>
<td>* Defined words</td>
</tr>
<tr>
<td>* Configuration 1:SCS1105</td>
<td>Not Changed</td>
<td>* Configuration 1:SCS1105</td>
</tr>
<tr>
<td>* Description</td>
<td>Not Changed</td>
<td>* Description</td>
</tr>
<tr>
<td>* SCS project information</td>
<td>Not Changed</td>
<td>* SCS project information</td>
</tr>
<tr>
<td>* SCS constants</td>
<td>Not Changed</td>
<td>* SCS constants</td>
</tr>
<tr>
<td>* Resource 1105: SCS1105</td>
<td>Not Changed</td>
<td>* Resource 1105: SCS1105</td>
</tr>
<tr>
<td>* Description and properties</td>
<td>Changed</td>
<td>* Description and properties</td>
</tr>
<tr>
<td>* Global variables</td>
<td>Changed</td>
<td>* Global variables</td>
</tr>
<tr>
<td>* I/O modules</td>
<td>Changed</td>
<td>* I/O modules</td>
</tr>
<tr>
<td>* I/O parameters</td>
<td>Changed</td>
<td>* I/O parameters</td>
</tr>
<tr>
<td>* Comm. 1/O</td>
<td>Not Changed</td>
<td>* Comm. 1/O</td>
</tr>
<tr>
<td>Modbus address</td>
<td>----------</td>
<td>Modbus address</td>
</tr>
<tr>
<td>DNP3 communication</td>
<td>----------</td>
<td>DNP3 communication</td>
</tr>
<tr>
<td>* SCS link transmission</td>
<td>Not Changed</td>
<td>* SCS link transmission</td>
</tr>
<tr>
<td>* Detailed binding</td>
<td>Not Changed</td>
<td>* Detailed binding</td>
</tr>
<tr>
<td>* Tag name definition</td>
<td>Not Changed</td>
<td>* Tag name definition</td>
</tr>
<tr>
<td>* Alarm priority</td>
<td>Not Changed</td>
<td>* Alarm priority</td>
</tr>
<tr>
<td>* Alarm processing table</td>
<td>Not Changed</td>
<td>* Alarm processing table</td>
</tr>
<tr>
<td>* Resource content</td>
<td>Not Changed</td>
<td>* Resource content</td>
</tr>
<tr>
<td>* Local variables + parameters</td>
<td>Not Changed</td>
<td>* Local variables + parameters</td>
</tr>
<tr>
<td>* POU</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Prog01</td>
<td>Not Changed</td>
<td>Prog01</td>
</tr>
<tr>
<td>Prog02</td>
<td>Deleted</td>
<td></td>
</tr>
<tr>
<td>Prog03</td>
<td>Changed</td>
<td>Prog03</td>
</tr>
<tr>
<td>FB01</td>
<td>Changed</td>
<td>FB01</td>
</tr>
<tr>
<td>FU01</td>
<td>----------</td>
<td>FU01</td>
</tr>
<tr>
<td>-</td>
<td>Added</td>
<td>Prog04</td>
</tr>
<tr>
<td>-</td>
<td>Added</td>
<td>FU02</td>
</tr>
</tbody>
</table>

Figure 15.3-5 Example Of Printed Summary Of Comparison Results

#### Information Printed in Project Comparison Results Summary

The information printed in the project comparison results summary is as follows.

**Header**

- **Time**: Time that summary was printed
- **Project 1, Project 2**: Paths to compared project data
- **Ver**: Version number
- **Project Date**: Project date (date set in project properties)

For the items that were compared, an asterisk (*) is printed, and the following information is printed in the center column.
• Changed: There is a difference
• Not Changed: There is no difference
• Deleted: Item that exists only in Project 1
• Added: Item that exists only in Project 2
• -----------: Item that was not compared
15.4 Checking Contents of Detected Differences

After project data comparison has been executed, the detailed contents of detected differences can be displayed and printed.

If a password is set for POUs, password input is required.
15.4.1 Displaying Detailed Differences

Differences are displayed in a Difference Display window for each selected item. Although multiple windows can be displayed at a time, only one POU Difference Display window can be displayed. For this reason, if another POU is selected while a certain POU’s differences are displayed, the previously opened window will close.

Display Procedure for Items Other Than POUs for Which a Password is Set

To display detailed differences, perform the following procedure.

1. From the tree view where project comparison results are displayed, click one item name for which you wish to see the detailed differences.
2. From the menu bar, select [Tool] > [Show details].

The Difference Display window of the selected item appears.

Display Procedure for POUs for Which a Password is Set

Password input is required when displaying the detailed differences of a POU for which a password is set. The input POU password is stored, and is saved until the path to the project is changed in the Select Project dialog box. For this reason, password input is not required when displaying the detailed differences of a certain POU after displaying the detailed differences of the same POU using the correct password.

To display the detailed differences of a POU for which a password was set, perform the following procedure.

1. From the project comparison results display, click the POU name for which you wish to see the detailed differences.
2. From the menu bar, select [Tool] > [Show details].

A dialog box for entering the POU password of Project 1 appears.

3. Enter the POU password.
4. Click [OK].
   If release of password protection is successful, a dialog for entering the POU password of Project 2 appears.
   If the wrong password is entered three times consecutively, the process is discontinued.

TIP

- After the process is discontinued, if that POU is selected again and the [Show details] command is executed, the password input dialog box appears.
- When [Cancel] or [Skip] is clicked in the Password Input dialog box, the display of detailed differences is discontinued.

5. Similarly, input the POU password for Project 2 and click [OK].
   If release of password protection is successful, the Difference Display window of the selected POU appears.
**Difference Display Window**

Differences are displayed in a window of the engineering function, such as builders, that is started up in "viewer mode." Only browsing is enabled in this window. The definitions cannot be edited or downloaded.

In the Difference Display window, the definitions of Project 1 are displayed on the top pane and those of Project 2 are displayed on the bottom pane, with the differences displayed in red. The toolbar has "Find Next" and "Find Previous" buttons. When either button is clicked, a difference is selected and highlighted. The highlight moves to the next or previous difference each time a button is clicked.

The following figure is an example of the display when a POU is selected.

Differences in the positions or shapes of graphics in POU diagrams are also displayed as differences.

The following figure is an example of the display when an item other than a POU is selected.
Figure 15.4.1-3 Example of Detailed Difference Display When an Item Other Than a POU is Selected
15.4.2 Printing Detailed Differences

This section describes the procedure for printing the details of detected differences after a project comparison. Password input is required when printing the information for a POU that has a password.

Perform the following procedure to print detailed differences.

1. From the project comparison results display, select the check box of the item for which you wish to print the detailed differences.
   To select all the check boxes of the items where differences were detected, select [Tool] > [Select Items] from the menu bar; in the displayed dialog box, select "Select difference-detected items."

2. From the menu bar, select [File] > [Print]. The Start Print dialog box appears.

3. Click [OK] to start printing.
   • When password-set POUs are not selected, differences are printed for all selected items, and the process ends.
   • If any password-set POU is selected, a dialog box for entering the POU password appears. Proceed with the following procedure.

4. Perform any of the following operations in the dialog box for entering the POU password.
   • To print, enter the POU password and click [OK].
   • To print the next POU without printing the current POU, click [Skip].
   • To discontinue the printing process, click [Cancel].

5. Enter the POU password for Project 2.
   The differences of the POU are printed.
   When the differences of all selected items have been printed, the process ends.

If there are POUs that failed to release password protection or skipped POUs, a warning dialog box that displays a list of those POUs appears when the printing is finished.

Print Format of Differences

The definition contents of Project 1 and Project 2 are alternately printed for each item. The differences are surrounded with a box, and are printed in red if printed in color.
The printing format is in accordance with the settings for self-documentation. Chapter numbers are the same as when printing by self-documentation, with page numbers in order when printed.

**SEE ALSO**

For more information about the self-document printing format, refer to:

10., "Self-documentation" on page 10-1
16. Access Control/Operation History Management Function

ProSafe-RS access control/operation history management is one of the functions related to ProSafe-RS security. To use this function, the CHS5170 Access Control and Operation History Management Package is required.

The basic security functions of ProSafe-RS provide password protection for project databases and for certain operations that affect SCS. On the other hand, the access control/operation history management function controls security for individual SENG users.

**SEE ALSO**

For more information about system configuration, operational environment, and precautions when using the access control/operation history management function, refer to:


For more information about the security functions of ProSafe-RS, refer to:

16.1 Overview of Access Control/Operation History Management

This section describes an overview of access control/operation history management.

■ What Is Access Control?

ProSafe-RS access control consists of "log-on/engineer authentication" and "access right check."

Log-on/engineer authentication is performed to confirm the engineer performing operations on SENG. The Authentication dialog box appears for certain operations and if the entered engineer name and password do not match the registered ones, the user cannot log on to SENG or cannot perform the certain engineering operations.

When an engineer attempts to perform an engineering operation, the access right checking function checks whether or not the engineer has the right to perform that operation, and if not, prohibits that operation. Operations by an unauthorized engineer can be thereby prevented.

■ What Is Operation History Management?

In ProSafe-RS operation history management, each operation performed by an engineer on SENG is recorded in an operation log file. Additionally, when a download to SCS is performed, information of changed project data (modification files) is saved. The operation logs and modification files are saved to a database specified in advance, and can be browsed using dedicated viewers. This allows you to keep track of "who," "when," "what" and "how" a change was made.

■ Roles of Engineers And the Administrator

There are two types of user in systems where access control/operation history management is used: "administrator of access control/operation history management" and "engineer." In this chapter, the "administrator of access control/operation history management" is simply called an "administrator."

SEE ALSO

For more information about windows user groups to which the administrator and engineers should belong, refer to:

■ Windows User Groups to which Administrators and Engineers Belong" in B4.5, "Setup when Using the Access Control and Operation History Management Package" in Installation (IM 32Q01C50-31E)

Role of the Administrator

The administrator is in charge of all the tasks related to access control and operation history management shown as follows.

• Managing networks and PCs
• Setting up access control/operation history management
• Starting/Stopping operation history management
• Managing operation history database capacity
• Browsing operation history data

Role of Engineers

SENG users other than the administrator are engineers.

Engineers are responsible for engineering and maintenance tasks, but they cannot execute operations if they do not have the rights. The following operations are added.
- Performing log-on operation when starting use of SENG function
- Entering password when performing certain operations
- Browsing history data (if permitted by Operation History Management Setup Tool)
16.1.1 Overview of Access Control for Engineers

The access control function restricts the operations by which engineers access project databases and SCS.

### Units of Access Control

Access control is performed per PC. An engineers' account file which defines engineers, engineer groups and access rights is specified for each PC. If one common engineers' account file is specified for multiple PCs, the same access control can be performed for multiple PCs.

### Access Rights of Engineers

An engineer needs to belong to an engineer group, and his/her engineer name and password need to be registered. An engineer belonging to a certain engineer group can perform engineering operations and maintenance operations within the rights granted to that group.

The rights of an engineer group are set by the following two kinds of settings.

- Access rights that are set for each operation category
- Range of enabled access rights

For example, rights are enabled or disabled for operations classified in categories such as new project creation, general settings, create/modify POU and downloading. Furthermore, the range of enabled access rights granted is set in RS project/SCS project units.

### ProSafe Authentication Mode and Windows Authentication Mode

There are two types of user authentication available in ProSafe-RS.

ProSafe authentication mode uses engineer accounts that are independent from Windows user accounts, and applies the passwords and password policies that are set for ProSafe-RS.

Windows authentication mode uses Windows user accounts as the engineer accounts. When performing user management in Windows authentication mode, Windows user accounts to be used as engineers must be registered. In Windows authentication mode, the passwords and password policies of Windows users are applied to engineers.
16.1.2 Structure of Access Control/Operation History Management Function

The following figure shows the overall structure of the access control/operation history management function.

![Diagram of Access Control/Operation History Management Function]

*1: These tools are included in the CHS5170 Access Control and Operation History Management Package.

Figure 16.1.2-1 Structure of the Access Control/Operation History Management Function

A summary of the components and their mutual relationships are described as follows.

- **Operation History Management Setup Tool**
  
  This is a tool for setting up access control/operation history management. It performs primarily the following settings.
  
  - Specification of engineers’ account file
  - Specification of user authentication mode (ProSafe authentication mode or Windows authentication mode)
  - Specification of top folder of operation history database
  - Setting of password policies in ProSafe authentication mode
  - Starting/stopping of operation history management

- **Engineers’ Account Builder**
  
  This is a builder for registering engineer names and setting up access rights for engineers.
• Registering Engineer Names
  When in ProSafe authentication mode, any engineer names can be registered. When in
  Windows authentication mode, engineer names that are already registered as Windows
  user names should be registered.

• Creating Engineer Groups
  You can create engineer groups, which are the units in which access rights to project da-
  tabases and SCS are specified. The access rights an engineer has are determined by as-
  signing the engineer to an engineer group.

■ Engineers' Account File
  This is the file that contains engineer account information and the access rights information
  set for engineers. It is specified for each SENG on which engineering is performed. The informa-
  tion set in the Engineers' Account Builder are saved to this file.

■ Operation History Database
  This is the database that stores operation history information (operation logs and modification
  files). It is generated for each RS project in the location specified in the Operation History
  Management Setup Tool.

■ Operation History Database Viewer
  This is a viewer for browsing operation history information (operation logs) saved in the oper-
  ation history database.

  It can display all operation logs or a filtered list, and can export operation logs to a file in CSV
  format. From this viewer, you can start up the Modification Files Viewer.

■ Modification Files Viewer
  This is a viewer for browsing modification files saved in the operation history database.

  If modification files corresponding to an operation log are browsed, it is possible to check the
  modification contents of the project data modified by that operation. Also, the differences be-
  tween modification files corresponding to an operation log at any two points in time can be
  displayed.

■ SCS Manager, Builders, Engineering Tools and Maintenance Tools
  Logon/engineer authentication, access control by rights checking and operation history man-
  agement are performed for engineers' operations performed by using these programs and
  tools.
### 16.1.3 Access Control/Operation History Management

#### Target Operation List

The operations that are the targets of access control/operation history management are as follows.

"Yes" indicates that the process such as Log-on/Engineer Authentication or Access Rights Check is executed, and an empty box indicates that the process is not executed.

<table>
<thead>
<tr>
<th>Operation Name</th>
<th>Log-on/Engineer Authentication</th>
<th>Access Rights Check</th>
<th>Operation Log Recording</th>
<th>Save modification files (*1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start SCS Manager</td>
<td>Yes (log on)</td>
<td></td>
<td>Yes (*2)</td>
<td></td>
</tr>
<tr>
<td>Close SCS Manager</td>
<td></td>
<td>Yes (2)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create new SCS project</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Open SCS project</td>
<td></td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save project</td>
<td></td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Import by SCS Manager</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save dictionary</td>
<td></td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save I/O wiring</td>
<td></td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save binding list</td>
<td></td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save library dependencies</td>
<td></td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Open POU</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save POU</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Open by builder</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save by builder</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Change SCS project properties</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Build</td>
<td></td>
<td>Yes</td>
<td></td>
<td>Yes (user-defined projects only)</td>
</tr>
<tr>
<td>Clean</td>
<td></td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save analyzer's results</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Start document generator</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Start master database restoring function</td>
<td>Yes (log on)</td>
<td></td>
<td>Yes (*)2</td>
<td></td>
</tr>
<tr>
<td>Close master database restoring function</td>
<td></td>
<td></td>
<td>Yes (*)2</td>
<td></td>
</tr>
<tr>
<td>Restore master database</td>
<td></td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Start version control tool</td>
<td>Yes (log on)</td>
<td></td>
<td>Yes (*)2</td>
<td></td>
</tr>
<tr>
<td>Close version control tool</td>
<td></td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Check in to version control</td>
<td></td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Check out from version control</td>
<td>Yes</td>
<td></td>
<td>Yes (if the checked out project is a target of operation history management)</td>
<td></td>
</tr>
</tbody>
</table>

*Continues on the next page*
<table>
<thead>
<tr>
<th>Operation Name</th>
<th>Log-on/Engineer Authentication</th>
<th>Access Rights Check</th>
<th>Operation Log Recording</th>
<th>Save modification files (*1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Offline download</td>
<td>Yes (engineer authentication)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Master database offline download</td>
<td>Yes (engineer authentication)</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Online change download</td>
<td>Yes (engineer authentication)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Restart SCS</td>
<td>Yes (engineer authentication)</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Save operation marks</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Download operation marks</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Start debug mode</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Exit debug mode</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Start logic simulation</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Close logic simulation</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Start test function</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Update test database</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Database validity check</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Repair database</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Start SCS Status Overview window</td>
<td>Yes (logon) (*4) (only when started from Start menu)</td>
<td>Yes (*2)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Close SCS Status Overview window</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Start SCS State Management window</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Close SCS State Management window</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Change SCS security level</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Change security level password</td>
<td>Yes (engineer authentication)</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Lock</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Unlock</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Set values</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enable output</td>
<td>Yes (engineer authentication)</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Start output module</td>
<td>Yes (engineer authentication)</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>IOM download</td>
<td>Yes (engineer authentication)</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
</tbody>
</table>

Continues on the next page
### Table 16.1.3-1 Access Control/Operation History Management Target Operations (Table continued)

<table>
<thead>
<tr>
<th>Operation Name</th>
<th>Log-on/Engineer Authentication</th>
<th>Access Rights Check</th>
<th>Operation Log Recording</th>
<th>Save modification files (*)1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time setting</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Acknowledge/delete diagnostic information messages</td>
<td>Yes (*5)</td>
<td></td>
<td>Yes (*2)</td>
<td></td>
</tr>
<tr>
<td>Change SCS Maintenance Support Tool settings</td>
<td>Yes (*5)</td>
<td></td>
<td>Yes (*2)</td>
<td></td>
</tr>
<tr>
<td>Start IOM Control Right Switching Tool</td>
<td>Yes (log on)</td>
<td></td>
<td>Yes (*2)</td>
<td></td>
</tr>
<tr>
<td>Close IOM Control Right Switching Tool</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Switch IOM control right</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Start Message Cache Tool</td>
<td>Yes (log on)(*4)</td>
<td></td>
<td>Yes (*2)</td>
<td></td>
</tr>
<tr>
<td>Close Message Cache Tool</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Operate Message Cache Tool</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pause message acquisition</td>
<td>Yes (*5)</td>
<td></td>
<td>Yes (*2)</td>
<td></td>
</tr>
<tr>
<td>Resume message acquisition</td>
<td>Yes (*5)</td>
<td></td>
<td>Yes (*2)</td>
<td></td>
</tr>
<tr>
<td>Start operation history management (operation by administrator)</td>
<td></td>
<td></td>
<td>Yes (*7)</td>
<td>Yes (*7)</td>
</tr>
<tr>
<td>Stop operation history management (operation by administrator)</td>
<td></td>
<td></td>
<td>Yes (*7)</td>
<td></td>
</tr>
<tr>
<td>Exceeded number of authentications</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Local user logon in domain environment</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Record a comment (operation by administrator)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*1: Saved if "Do not save in modification files" check box is not selected in Operation History Management Tool.

*2: Not recorded in operation log database for each SCS project, but recorded in common operation log database.

*3: Performed if "Do not require engineer authentication on individual operations" check box is not selected in Operation History Management Tool.

*4: Enter engineer name and password instead of entering password of SCS Maintenance Support Tool in standard security function.

*5: Whether or not to enable access rights is decided regardless of the range of enabled access rights that are granted to Engineers by using the Engineers’ Account Builder.

*6: Whether or not to enable access rights for trip information initialization is decided depending on the range of enabled access rights that are granted to Engineers by using the Engineers’ Account Builder. Whether or not to enable access rights for other operations is decided regardless of the range of enabled access rights that are granted to Engineers by using the Engineers’ Account Builder.

*7: Recorded both in operation log database for each SCS project and in common operation log database.
16.2 Setting Up Access Control/Operation History Management

Setup of access control/operation history management is performed using the Operation History Management Setup Tool and the Engineers' Account Builder after setting up the network and PCs.

This section shows the flow of setup operations, and describes the setup procedures performed using the Operation History Management Setup Tool and the Engineers' Account Builder.

Flow of Setup Operations

The administrator first sets up the network and computers, and checks that the required Windows user accounts have been created. When performing user management in Windows authentication mode, register the Windows user accounts to be used for the engineers. Also, security is set to folders where the operation history database is located. After that, set up the access control/operation history management function on an SENG having a license for "CHS5170 Access Control and Operation History Management Package".

The work flow is as follows.
Start

Windows setup
- Configure network and PC settings required for access control and operation history management.
- Create Windows user accounts.
- Set up password policies. (*1)
  (for Windows authentication mode)
- Configure security setting of the operation history database folder.

Access control setup
1. Specify user authentication mode.
2. Designate an engineers’ account file.
3. Configure settings for ProSafe authentication mode
   Password policies
   Behavior in case of consecutive authentication failures

Operation history management setup
1. Designate the top folder of the operation history database.
2. Add RS projects subjected to operation history management.
3. Specify whether to permit engineers to start the Operation History Database Viewer.

Engineers’ accounts registration
1. Define access groups.
2. Create engineer groups.
3. Create engineers’ accounts.

Start operation history management.

End

*1: You can set password policies any time before operation history management is started.

Figure 16.2-1 Setting Up Access Control/Operation History Management

SEE ALSO
For more information about setting up Windows, refer to:

B4.5, “Setup when Using the Access Control and Operation History Management Package” in Installation (IM 32Q01C50-31E)

For more information about network configuration and operational environment required to use the access control/operation history management function, refer to:


For more information about guidelines for location of engineers’ account file and storage location of operation history database, refer to:

16.2.1 Settings for Access Control

On the Access Control tab sheet of the Operation History Management Setup Tool, perform common settings for access control.

After setup has been performed on the Access Control tab sheet and engineers have been registered in the Engineers’ Account Builder, rights checking and log-on/engineer authentication are started when [OK] or [Apply] is clicked on the Operation History Management Setup Tool.

---

### Starting the Operation History Management Setup Tool

The Operation History Management Setup Tool can be started by administrators only.

1. From the Start menu, select [All Programs] > [YOKOGAWA ProSafe] > [Operation History Management Setup Tool].

---

### Specifying the User Authentication Mode

Specify whether to use ProSafe authentication mode or Windows authentication mode. Windows authentication mode can be used when the standard model security is set on the SENG.
PC and cannot be used when the legacy model security is set. The default setting is ProSafe authentication mode.

1. Perform the following setting on the Access Control tab sheet of the Operation History Management Setup Tool.
   - To use Windows authentication mode, select the "Use Windows user names as system engineer names" check box.
   - To use ProSafe authentication mode, clear the "Use Windows user names as system engineer names" check box.

When the [OK] or [Apply] button is clicked, the setting becomes valid.

In Windows authentication mode, "Windows Authentication Mode" is displayed in the title bar of the Engineers' Account Builder. If you change from ProSafe authentication mode to Windows authentication mode, the set values of items in the categories of "Password" and "Other Parameters" are cleared.

-----

### Specifying an Engineers' Account File

The engineers' account file is the file that contains the engineers' account information edited in the Engineers' Account Builder and the access rights information set for engineers. This file is specified for each SENG PC.

After an engineers’ account file is specified, the Engineers’ Account Builder can be started up to register engineers and set access rights.

#### When Creating a New Engineers' Account File

To create a new engineers’ account file, perform the following procedure.

1. On the Access Control tab sheet of the Operation History Management Setup Tool, clear the "Choose an existing file" check box.
2. In "Refer to:“, specify the folder where the engineers’ account file is to be saved.

Thereafter, the default engineers’ account file is created in the specified folder when the [OK] or [Apply] button is clicked.

#### When Using an Existing Engineers' Account File

In a system that uses multiple SENGs to allow multiple SENGs to use the same engineer names, engineer groups and access control settings such as rights, specify the existing engineers' account file on each SENG so that multiple SENGs can reference the same file.

To specify the existing engineers’ account file, perform the following procedure.

1. On the Access Control tab sheet of the Operation History Management Setup Tool, select the "Choose an existing file" check box.
2. Click the [Change] button.
   The dialog box for selecting a file appears.
3. In the File Selection dialog box, specify the engineers' account file (SengSecurity.sva) to be used, and click [OK].
   The path to the engineers' account file appears in the "Refer to:" box.

### Settings Required When ProSafe Authentication Mode is Selected

If you have selected ProSafe authentication mode on the Access Control tab sheet, set the password policies and the behavior when authentication fails consecutively.
Setting the Password Policy

To set the password policy for ProSafe authentication mode, perform the following procedure.

1. In the "Valid period" box on the Access Control tab sheet, specify the number of days passwords are valid. If 0 is specified, the valid period is unlimited. The default value is 0.

2. In the "Minimum password length" box, specify the minimum number of characters that can be registered as a password. Integers from 1 to 32 may be specified. The default value is 1.

3. To prohibit use of a password that is the same as a previously set password when a password is changed, select the "Do not use previous password" check box. By default, this is not prohibited (check box is empty).

4. If there are character strings that you wish to prohibit as passwords, enter them in the "The password can not be set" box. Setting strings that someone could easily guess can prevent the SENG from being improperly used. To specify multiple strings, separate them by semicolons. Up to 2048 single-byte characters can be specified. Nothing is specified by default.

Setting up the Behavior in case of Consecutive Authentication Failures

To set up the behavior of the system when authentication fails in ProSafe authentication mode, set the following items.

- Notice Consecutive Authentication Failures
  If a wrong password is entered consecutive times when logging onto SENG or performing engineer authentication, it can be regarded as an attempt at improper access, and can be recorded as an authentication error in the operation log. The number of times a wrong password is entered is specified, and when authentication fails consecutively the specified number of times, an authentication error occurs. If 0 is specified, an authentication error does not occur. The default value is 0.

- Enable Account Lockout
  When authentication fails consecutive times, that engineer can be locked out. Since the locked-out engineer cannot perform log-on or engineer authentication, he/she cannot perform engineering work. By default, the lockout function is disabled.

To set up the behavior in case of consecutive authentication failures, perform the following procedure.

1. To log authentication errors, specify the number of consecutive times the wrong password in the "Notice Consecutive Authentication Failures" box of the Access Control tab sheet. Specify 0 if you do not wish to log the errors.

2. To use the lockout function, select the "Enable Account Lockout" check box, and set the "Notice Consecutive Authentication Failures" to 1 or more.

TIP
If the lockout function is changed to disabled, the lockout of previously locked-out engineers is released.

Settings Required When Windows Authentication Mode is Selected

If you have selected Windows authentication mode, set the password policies and the behavior in case of consecutive authentication failures in Windows.
16.2.2 Setup Related to Operation History Management

Operation history management is performed in RS project units. To perform setup related to operation history management, perform the following settings.

Set the following items as PC settings.

- Top folder of operation history database
- Permission to start the Operation History Database Viewer

Add the RS projects for which operation history management is to be performed, and set the following items for each project.

- Free disk space when backup warning is displayed
- Whether or not to save modification files
- Whether or not to perform engineer authentication

**IMPORTANT**

A project for which operation history management is performed and the operation history database are associated with each other. If not correctly associated, operation history management will not work. If the project database is moved or an SCS project is added or deleted, promptly perform the required operations on the Operation History Management tab sheet.

**SEE ALSO**

For more information about the operations required after moving, adding, or deleting a project database, refer to:

- “Tasks Required after Adding, Moving or Deleting a Project Database” on page 16-47

**Specifying Top Folder of Operation History Database**

The top folder of the operation history database is done during the procedure for adding RS projects for which operation history management is to be performed.

**Adding an RS Project for History Management**

To perform operation history management for a certain RS project, add it as a target of operation history management. Perform this according to the following procedure.

1. In the Operation History Management Setup Tool, display the Operation History Management tab sheet.
2. Click the Add Project button on the top right of the Operation History Management tab sheet.

   The following dialog box appears.

3. Select the folder of the RS project and click [OK].

   The selected RS project name appears in the list.

**TIP**
When performing operation history management on multiple PCs, use the same method of referencing the project on each PC. (Whether to reference by a network drive or in UNC format. If by a network drive, use the same drive name.)
A dialog box for selecting the top folder of the operation history database appears.

4. When adding an RS project for the first time, select the top folder of the operation history database, and click [OK].

**IMPORTANT**
When adding a second RS project or thereafter, the dialog box for selecting the top folder of the operation history database appears. If there is no need to change the top folder location, click [OK] in the dialog box as is.

**TIP**
The same operation history database folder cannot be specified for another RS project of the same name in a different location. An error message appears if there is such a duplication.

5. Specify the empty disk space for prompting backup of the operation history database. Select the RS project in the list and enter in units of MB in the "Disk free space size for prompting backup" box. The default value is 3000 MB.

**IMPORTANT**
As modification files accumulate in the operation history database, the amount of free disk space gradually decreases. When the remaining free space almost reaches to the specified free disk space, a dialog box appears to alert low disk space. When the remaining free space becomes lower than the specified free disk space, a dialog box appears to prompt backup and further operations to log the operation history can not be performed. When an alert dialog box appears, you should be ready to backup.

6. If you do not wish to save modification files in the operation history database, select the "Do not save in modification files" check box. By default, modification files are saved.

7. If you do not wish to perform engineer authentication (password input) for individual operations, select the "Do not require engineer authentication on individual operations" check box. By default, engineering authentication is required.

**TIP**
When the "Do not require engineer authentication on individual operations" check box is selected, password input is required only at logon.

### Deleting an RS Project from the Targets of Operation History Management

To delete an RS project for which operation history management is being performed from the targets of operation history management, perform the following procedure.

1. In the list on the Operation History Management tab sheet, click the project you wish to delete.
2. Click the Delete Project button on the top right of the tab sheet.
3. In the confirmation dialog box, click [OK]. The RS project is deleted from the list, and operation history management of the RS project stops.

The data in the operation history data base is not deleted when an RS project is deleted.

### Permission to Start Operation History Database Viewer

By default, only administrators can browse the operation history database.
To also enable general engineers to browse the operation history database, perform the following settings.

1. On the Operation History Management tab sheet, select the "Allow general users to start the viewer" check box.

When this is set, general engineers can start the Operation History Database Viewer. As a result, they can also start the Modification Files Viewer.
16.2.3 Registering Engineers

This section first describes the mechanism of engineer registration including initial engineers' access rights setup and shows examples of settings. The operations for registering an engineer using the Engineers' Account Builder are described next.

Flow of Engineer Registration Operations

Engineer registration operations are performed using the Engineers' Account Builder. The contents set by the Engineers' Account Builder are saved in the engineers' account file. To perform engineer registration operations, perform the following procedure.

1. Determine the policy for access control. (Determine the contents to be set by builder.)
2. Define access groups.
3. Create engineer groups.
4. Register each engineer's account, and assign it to an engineer group.

Steps 1 through 3 are required when using access control/operation history management for the first time. After use has begun, perform only engineer account registration for the engineer registration operations.

Determining Policies for Access Control

Before you start working with the Engineers’ Account Builder, determine the policies for access control.

- Access groups required in the system and their definition contents (determine the rights of assumed users while referring to the default access groups)
- Engineer group names to be created
- Which access group rights to grant to each engineer group
- Range of RS projects/SCS projects that each engineer group is responsible for
- Which engineer group to assign engineers to

Relationship Between Engineers, Engineer Groups and Access Groups

Access control in ProSafe-RS sets the access rights of engineers by assigning engineers to user groups called "engineer groups."
Figure 16.2.3-1 Relationship Between Engineers, Engineer Groups and Access Groups

One engineer may belong to one engineer group. For each engineer group, the access rights to project databases and/or SCS and the range of RS projects/SCS projects for which those rights are enabled are specified.

Access rights are set by assigning an "access group" to each engineer group. An access group is a combination of rights to execute various operations that access project databases or SCS, and needs to be predefined for the assumed user types.

## Types of Access Rights

There are access rights for project databases and access rights for SCS/SCS simulators. These access rights are further broken down into categories.

If an engineer has access rights of a certain category, that engineer can execute the operations that pertain to that category. If he does not have access rights, he cannot execute those operations.

<Example>

- If an engineer has access rights for the Project Creation category, he can execute operations to create new SCS projects in the SCS Manager.
- If an engineer has access rights for any of the categories General Settings, POU, I/O, Safety Communication, External Communication, CENTUM Alarm Definition, Offline Download, Online Change Download and SCS Simulator, the engineer can execute the operations of build, acknowledgement by analyzers and database validity check.
Default Access Groups

Default access groups are predefined in the Engineers' Account Builder. The default access groups are ALL, which provides access rights for all categories, NONE, which provides no access rights for any categories, and Operator1, Operator2, Engineer1, Engineer2, Maintenance1 and Maintenance2, which provide typical operator, engineer and maintenance rights.

Access rights can be set up efficiently by editing these access groups. The access rights settings of each access group are as follows.

<table>
<thead>
<tr>
<th>Category</th>
<th>ALL</th>
<th>NONE</th>
<th>Operator1</th>
<th>Operator2</th>
<th>Engineer1</th>
<th>Engineer2</th>
<th>Maintenance1</th>
<th>Maintenance2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Creation</td>
<td>Y</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>General Settings</td>
<td>Y</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>POU</td>
<td>Y</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>I/O</td>
<td>Y</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Safety communication</td>
<td>Y</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>External communication</td>
<td>Y</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CENTUM Alarm Definition</td>
<td>Y</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Version Control Tool (Check-in)</td>
<td>Y</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Version Control Tool (Check-out)</td>
<td>Y</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Master Database Restore</td>
<td>Y</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Offline Download</td>
<td>Y</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Online Change Download</td>
<td>Y</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Operation Mark Save</td>
<td>Y</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SCS Simulator</td>
<td>Y</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Debug</td>
<td>Y</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Forcing</td>
<td>Y</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Maintenance</td>
<td>Y</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Diagnosis Acknowledgment</td>
<td>Y</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Message Cache</td>
<td>Y</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Y: Right is granted.  Blank: Right is not granted.

Figure 16.2.3-2 Default Access Groups

Example of Adding an Access Group

To set up rights other than those of the default access groups, create a new access group. For example, for a certain engineer group, you may wish to add download rights to the rights of the default access group Operator2. In this case, first, copy the Operator2 access group to create a new access group PowerOperator. Then, set the categories Offline Download and Online Change Download to Yes.
### Default Engineer Groups

The engineer groups shown in the following table are predefined in the Engineers' Account Builder.

#### Table 16.2.3-1 Default Engineer Groups

<table>
<thead>
<tr>
<th>Engineer Group</th>
<th>Access Group</th>
<th>RS PJT Range</th>
<th>SCS PJT Range</th>
<th>Exclude RS PJT</th>
<th>Exclude SCS PJT</th>
</tr>
</thead>
<tbody>
<tr>
<td>DEFGRP</td>
<td>ALL</td>
<td>*</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>NONEGRP</td>
<td>NONE</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>OPE1GRP</td>
<td>Operator1</td>
<td>*</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>OPE2GRP</td>
<td>Operator2</td>
<td>*</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ENG1GRP</td>
<td>Engineer1</td>
<td>*</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ENG2GRP</td>
<td>Engineer2</td>
<td>*</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MNT1GRP</td>
<td>Maintenance1</td>
<td>*</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MNT2GRP</td>
<td>Maintenance2</td>
<td>*</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

For example, access group ALL is assigned to DEFGRP for all RS projects. Access group NONE is assigned to NONEGRP for all RS projects. Engineers belonging to DEFGRP can perform all operations on all SCS projects in all RS projects. Engineers belonging to NONEGRP can only reference files in all SCS projects in all RS projects. They cannot change, create or delete files, and cannot perform operations on SCS.
The default engineer group settings are as follows.

### Range of Enabled Access Rights

Assign an access group to each engineer group, and set the range of enabled access rights. This section describes specification of the range of enabled access rights.

**SEE ALSO**
For more information about operations to set the range of enabled access rights, refer to:

- "Creating Engineer Groups" on page 16-29

### Setting The Range of Enabled Access Rights

By setting the following items on the Engineer Group tab sheet of the Engineers' Account Builder, the range of RS projects and SCS projects for which rights defined by the access group are enabled is specified.

- **RS project range (RS PJT Range)**
  Enter the RS project names for which rights specified by the access group are enabled. If "***" is specified, the rights will be enabled for all RS projects.

- **SCS project range (SCS PJT Range)**
  If you wish to enable rights specified by the access group only for certain SCS projects within the specified RS project range, enter the SCS project name (SCSddss or library project name). If the section is blank, rights are enabled for all SCS projects included in the specified RS project range.

- **RS project exclusion range (Exclude RS PJT)**
  Two types of specification may be performed for this item.
  1. If there is an RS project that you wish to exclude among the RS projects specified by the RS project range, enter that RS project name. If the section is blank, there is no exclusion range.
     
     For example, if "***" is specified in the "RS PJT Range" section and "MYRSPJT" is entered in the "Exclude RS PJT" section, rights specified by the access group are enabled in all RS projects except MYRSPJT.
  2. When you specify any SCS that you wish to exclude in the "Exclude SCS PJT" cell, specify the RS project to which that SCS belongs.

- **SCS project exclusion range (Exclude SCS PJT)**
  If there is an SCS project you wish to exclude among those included in the RS projects specified as the enabled range, enter that SCS project name (SCSddss or library project name). In this case, set the RS project to which that SCS project belongs in the "Exclude RS PJT" cell.
  
  If the "Exclude SCS PJT" cell is blank, the exclusion range is not set.
Input Rules for Specifying the Range of Enabled Access Rights

The input rules for the "RS PJT Range," "SCS PJT Range," "Exclude RS PJT" and "Exclude SCS PJT" columns are as follows.

- When multiple items are entered in one cell, they are to be separated by commas.
- When "**" is specified, all RS projects or SCS projects are specified.
  (In SCS PJT Range, this is the same as a blank cell.)
- A wildcard "**" may be used only at the end of an RS/SCS project name. For example, if "MYRS**" is entered, all RS projects that begin with MYRS are specified. If "SCS10**" is entered, all SCS projects that begin with SCS10 are specified. "**" cannot be used in the middle of a project name, as in "MY*PJT" or "SCS*16".
- "RS PJT Range" and "Exclude RS PJT" may be up to 50 characters each. "SCS PJT Range" and "Exclude SCS PJT" may be up to 200 characters each. However, the total of the character strings specified in the four columns that define the range of enabled access rights on one line must be up to 250 characters.
- If a range of rights cannot be specified on one line, it may be specified by creating multiple lines with the same engineer group name. The range of rights in this case encompasses all ranges specified on all lines (logical OR). When an exclusion range is set on a certain line, the ranges on the other lines are not excluded.

Specifying the Range of Enabled Access Rights in SCS Project Units

To specify access rights ranges in SCS project units, the range of enabled access rights can be set by a combination of "RS PJT Range" and "SCS PJT Range," and the range of rights exclusion can be set by a combination of "Exclude RS PJT" and "Exclude SCS PJT." These settings may be blank but obey the following rules.
### Examples of Engineer Group Assignment

Examples of engineer groups settings in the following system configuration are shown.

#### Table 16.2.3-4 System Configuration (Example)

<table>
<thead>
<tr>
<th>RS Project Name</th>
<th>SCS Project Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>RSPJT-A</td>
<td>SCS0101-SCS0116</td>
</tr>
<tr>
<td>RSPJT-B</td>
<td>SCS1001-SCS1032</td>
</tr>
<tr>
<td>RSPJT-C</td>
<td>SCS2001-SCS2064</td>
</tr>
</tbody>
</table>

#### Example 1:Specifying RS Project Ranges

<table>
<thead>
<tr>
<th>Engineer Group</th>
<th>Access Group</th>
<th>RS PJT Range</th>
<th>SCS PJT Range</th>
<th>Exclude RS PJT</th>
<th>Exclude SCS PJT</th>
</tr>
</thead>
<tbody>
<tr>
<td>ENG</td>
<td>Engineer1</td>
<td>RSPJT-A</td>
<td>*</td>
<td></td>
<td>*</td>
</tr>
<tr>
<td>MAINTE</td>
<td>Maintenance2</td>
<td>RSPJT-A</td>
<td>SCS011*</td>
<td></td>
<td>RSPJT-A</td>
</tr>
<tr>
<td>OPR1</td>
<td>PowerOperator</td>
<td>*</td>
<td>*</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

When set as shown above, the rights that each engineer group has are as follows.

- Engineers belonging to the engineer group ENG have the rights of Engineer1 for all SCS projects of the RS project RSPJT-A.
- Engineers belonging to the engineer group MAINTE have the rights of Maintenance2 for the SCS projects from SCS0110 to SCS016 of the RS project RSPJT-A.
- Engineers belonging to the engineer group OPR1 have the rights of PowerOperator for all RS projects except RSPJT-A.
Example 2: Excluding a Certain SCS Project

Table 16.2.3-6 Engineer Group Assignment Example (2)

<table>
<thead>
<tr>
<th>Engineer Group</th>
<th>Access Group</th>
<th>RS PJT Range</th>
<th>SCS PJT Range</th>
<th>Exclude RS PJT</th>
<th>Exclude SCS PJT</th>
</tr>
</thead>
<tbody>
<tr>
<td>ENG 1</td>
<td>Engineer</td>
<td>RSPJT-A</td>
<td>*</td>
<td>RSPJT-A</td>
<td>SCS0101, SCS0105</td>
</tr>
</tbody>
</table>

When set as shown above, engineers belonging to the engineer group ENG1 have the rights of Engineer for SCS projects other than SCS0101 and SCS0105 among the SCS projects of RS project RSPJT-A. In this case, "Exclude RS PJT" specifies the location of the excluded SCS project.

Example 3: Specifying a Range of Enabled Rights on Multiple Lines

A range of enabled rights can be specified on multiple lines.

Table 16.2.3-7 Engineer Group Assignment Example (3)

<table>
<thead>
<tr>
<th>Engineer Group</th>
<th>No.</th>
<th>Access Group</th>
<th>RS PJT Range</th>
<th>SCS PJT Range</th>
<th>Exclude RS PJT</th>
<th>Exclude SCS PJT</th>
</tr>
</thead>
<tbody>
<tr>
<td>ENG 1</td>
<td>1</td>
<td>Engineer</td>
<td>RSPJT-A</td>
<td>*</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>Engineer</td>
<td>RSPJT-B</td>
<td>*</td>
<td>RSPJT-B</td>
<td>SCS1001</td>
</tr>
</tbody>
</table>

The resulting range of enabled rights of engineer group ENG1 is as follows.

Table 16.2.3-8 Rights of ENG1

<table>
<thead>
<tr>
<th>RS Project</th>
<th>SCS Project</th>
<th>Result due to 1 (*1)</th>
<th>Result due to 2 (*1)</th>
<th>Granted rights</th>
</tr>
</thead>
<tbody>
<tr>
<td>RSPJT-A</td>
<td>SCS0101-SCS0116</td>
<td>Yes</td>
<td>No</td>
<td>Engineer</td>
</tr>
<tr>
<td>RSPJT-B</td>
<td>SCS1001</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>SCS1002-SCS1032</td>
<td>No</td>
<td>Yes</td>
<td>Engineer</td>
</tr>
<tr>
<td>RSPJT-C</td>
<td>SCS2001-SCS2064</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>

*1: Yes: Rights are granted. No: Rights are not granted.

Starting the Engineers' Account Builder

The Engineers’ Account Builder starts up from the Operation History Management Setup Tool. Before starting it, the engineers’ account file must be specified.

1. From the Start menu, select [All Programs] > [YOKOGAWA ProSafe] > [Operation History Management Setup Tool]. The Operation History Management Tool is started, and the Access Control tab sheet appears.
2. In the "Refer to:" box, check that the path to the engineers’ account file is displayed, and click the [Edit] button. The Engineers’ Account Builder starts up.

For more information about how to register an engineers’ account file, refer to:

▸ Specifying an Engineers’ Account File” on page 16-13
Defining Access Groups

To set up access rights for engineer groups, access groups must be defined in advance.

Creation of a new access group can be performed efficiently by copying a default access group or another existing access group and then editing its contents.

SEE ALSO
For more information about default access groups, refer to:
"Default Access Groups" on page 16-21

Adding Access Groups

To add access groups, perform the following procedure.

1. Start the Engineers’ Account Builder, and display the Access Group tab sheet.

![Engineers’ Account Builder (Access Group Tab Sheet: Access Group List)](image)

The currently defined access groups are listed.

TIP
Among the access groups, ALL, NONE, Operator1, Operator2, Engineer1, Engineer2, Maintenance1 and Maintenance2 are default access groups predefined in the Builder.

2. Add a new access group to the end of the list. To create a copy of an access group that is already defined, perform the following operations.
   a. In the list, right-click the line of the access group you wish to copy, and select [Copy] from the pop-up menu. Alternatively, select a line, then select [Edit] > [Copy] from the menu bar.
   b. Right-click the blank line at the end of the list, and select [Paste] from the pop-up menu. Alternatively, select a blank line, then select [Edit] > [Paste] from the menu bar.

TIP
Access groups may not only be added on the last line, but may be inserted between existing lines as well. To insert a line, select the position where you wish to insert a line in the list, and select [Edit] > [Insert Line] from the menu bar. Alternatively, select [Insert Line] from the right-click menu.

3. On the added access group line, enter the access group name and a comment.
An access group name may be up to 16 single-byte characters. A comment may be up to 32 single-byte characters or 16 double-byte characters.

After that, set the access rights for the added access group.

### Setting the Rights of Access Groups

1. In the tree display of the Access Group tab sheet, select an access group. The contents of the access rights settings are listed on the right.

![Figure 16.2.3-6 Engineers’ Account Builder (Access Group Tab Sheet: Individual Access Group)](image)

2. Click on the “Value” cell of each category, and select [Yes] (has rights) or [No] (does not have rights).

**TIP**
When the mouse pointer is placed on a category name in the list, the operations included in that category are displayed in a tooltip.

**SEE ALSO**
For more information about access right categories, refer to:

16.5.2, “Access Rights Category List” on page 16-73

### Deleting Access Groups

To delete an unnecessary access group, perform the following procedure. However, access groups that are assigned to any engineer group cannot be deleted.

1. In the tree display of the Access Group tab sheet, select the [Access Group] folder. Access groups are listed on the right.

2. Select the line of the access group you wish to delete, and from the right-click menu, select [Delete Line]. Alternatively, select [Edit] > [Delete Line] from the menu bar.

### Saving Access Group Definition Contents

Once all of the required settings have been entered on the Access Group tab sheet, save the contents that were set.

1. From the menu bar, select [File] > [Save]. Alternatively, click the "Save" button on the toolbar.
The new definition contents are saved to the engineers’ account file.

**TIP**

If an access group name has been changed and that access group is assigned to an engineer group, the new access group name will be reflected in the registered information of the engineer group to which the access group is assigned.

### Creating Engineer Groups

Once the access groups required in the system are defined, create the engineer groups. For each engineer group, assign an access group and set the range of enabled access rights defined by the access group.

To create engineer groups, perform the following procedure.

1. Start the Engineers’ Account Builder, and display the Engineer Group tab sheet.

   **TIP**

   The engineer groups DEFGRP and NONEGRP displayed in the list are the default engineer groups.

2. Click inside a cell in the "Group Name" column, and enter an engineer group name. Engineer group names may be up to 8 alphanumeric characters (not case sensitive).

3. In the combo box in the "Access Group" column, select or enter the access group you wish to assign to that engineer group.

   **TIP**

   Multiple access groups may be assigned to the same engineer group. In this case, create multiple lines with the same engineer group name, and specify different access groups on each line.

   To insert a line between existing lines, right-click the position where you wish to insert it, and select [Insert Line] from the right-click menu. Alternatively, select [Edit] > [Insert Line] from the menu bar.


5. Enter comments for the engineer group if necessary. A comment may be up to 32 single-byte characters or 16 double-byte characters.
6. Similarly, create all required engineer groups.

7. Select [Save] from the [File] menu or click the “Save” button on the toolbar. The entered contents are saved in the engineers’ account file.

After the required engineer groups are set up, engineers can be registered.

SEE ALSO
For more information about the range of enabled access rights settings, refer to:

- “Range of Enabled Access Rights” on page 16-23

For more information about examples of engineer group setup, refer to:

- “Examples of Engineer Group Assignment” on page 16-25

# Registering an Engineer’s Account

Once the access groups and engineer groups required in the system have been defined, engineers can be registered.

- An engineer name that is already registered or an engineer name that was registered and then deleted after a password was set cannot be specified. If such an engineer name is specified, an error dialog box will appear when you try to save the contents.

- Engineer names that were deleted in the past can be confirmed on the Invalid Account tab sheet.

- In Windows, upper-case and lower-case letters can be used, but in Windows authentication mode, in which the same names as Windows user names are used as engineer names, ProSafe-RS does not distinguish between upper case and lower case letters.

To register an engineer, perform the following procedure.

1. Start the Engineers’ Account Builder, and display the Valid Account tab sheet.

![Figure 16.2.3-8 Engineers’ Account Builder (Valid Account Tab Sheet)](image)

The Valid Account tab sheet displays a list of currently registered engineers.

2. Enter the engineer name in the “Engineer Name” column on a blank line. Up to 16 alphanumeric characters and ASCII symbols can be specified.

- Only uppercase characters can be used.

- The following ASCII symbols and space characters can be used:

  `! # $ % ( ) . ^ _ { | } ~`

• Hyphens (-) and underscores (_) may be used except as the first character.
• Names ending with a period (.) is not allowed.
• The ASCII symbols that can be used as the first characters are the following: ^ _ { | }

IMPORTANT
When using Windows authentication mode, make sure that the pertinent Windows user names follow the above naming rules.

3. Specify the engineer group in the "Engineer Group" column. Select an engineer group from the registered engineer group names displayed in the drop-down list.

4. In the "Printed Name" column, enter the name of the person who uses the engineer name.
   Up to 64 single-byte characters or 32 double-byte characters can be specified.

5. Enter comments in the "Comment" column.
   Up to 32 single-byte characters or 16 double-byte characters can be specified.

6. Enter all engineers in the same way.

TIP
To delete a line from the Valid Account tab sheet, select the line you wish to delete, and select [Delete Line] from the [Edit] menu.

7. For Windows authentication mode, check whether the entered engineer names exist as Windows users.
   a. From the menu bar, select [Tools] > [Check user names]. Alternatively, click the "Check user names" button in the toolbar.
      If there is an engineer name that does not exist as a Windows user, it is output in the message display area.
   b. If you wish to register an engineer name that does not exist as a Windows user, create a Windows user account of that name.

8. From the menu bar, select [File] > [Save], or click the "Save" button in the toolbar.
   The newly registered contents are saved in the engineers' account file, and the time at which the engineer was registered is displayed in the "Registered Time" column.

A password is not yet set for the newly registered engineer. The first time the engineer logs onto SENG, a dialog box for setting a password appears, and a password should be set there.

TIP
Users for local authentication:
When the system is used in a domain environment and Windows authentication mode is used, you need to create users for local authentication in order to enable log-on to SENG in an emergency situation such as when the domain controller has failed.

A user name starting with an underscore (_) is handled as a local authentication user and, for a Windows authentication, the user is authenticated on the local computer regardless of whether domain management or workgroup management is applied.

Local authentication users are not for use in normal situations. If someone attempts to log on with this user name while the domain controller is accessible, a warning message is displayed and the following message is recorded in the operation log.

Local Authentication Detected User=_xxxxxxxx
This is because there may be a problem in security if a local user account, which is for emergency use, is used while user authentication is available on the domain.
## Checking Invalid Engineer Accounts

An engineer name that was once registered and deleted after a password was set cannot be registered again. You can check such engineer names on the Invalid Account tab sheet.

![Engineers' Account Builder (Invalid Account Tab Sheet)](image)

The Invalid Account tab sheet displays a list of deleted engineers. Only browsing is possible on this tab sheet, and editing cannot be performed. In addition to the information at the time of account registration, the time at which the engineer was deleted is displayed in the "Deleted Time" column.

### Printing the Contents Set in Engineers' Account Builder

To print the contents set in the Engineers' Account Builder, perform either of the following operations.

- From the menu bar, select [File] > [Print].
- Click the "Print" button on the toolbar.

The engineer's account file name is printed in the header, and the date/time and page number are printed in the footer.
16.2.4 Starting Operation History Management

Once the settings required for operation history management have been completed, start operation history management. Operation history management can be started in RS project units.

To start operation history management, perform the following procedure.

1. In the Operation History Management Setup Tool, display the Operation History Management tab sheet.
2. From the list, select the RS project for which you wish to begin operation history management.
3. Click the [Start Operation History Management] button. A dialog box for confirming start of operation history management appears.
4. Click [OK]. Saving of operation logs and modification files to the operation history database begins, and the operation history management start operation is logged.

**TIP**

- The [Start Operation History Management] button can be used when the status of the selected RS project is "Stopped" or "******". "******" means that the status of operation history management is "Running" for some SCS projects and "Stopped" for the other SCS projects that belong to the RS project.
- When operation history management is started, the newest RS project database is copied to the operation history database. For this reason, if the project database and the operation history database have become inconsistent with each other, the consistency can be recovered by starting operation history management.
16.2.5 Window Configuration of Engineers' Account Builder

This section describes the window configuration of the Engineers' Account Builder.

![Window Configuration of Engineers' Account Builder](image)

The following tab sheets can be displayed in the workspace.

- Valid Account tab sheet: Sets up engineer accounts.
- Invalid Account tab sheet: Displays invalid engineer accounts.
- Engineer Group tab sheet: Sets up engineer groups.
- Access Group tab sheet: Sets up access groups.

**SEE ALSO**

For more information about the data menu area and message display area, refer to:

1.2, "Window Components Common to Builders" on page 1-6

### Menu Bar

This section describes the following menu bar items.

- [File] menu
- [Edit] menu
- [Tool] menu

**Table 16.2.5-1 File Menu**

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save</td>
<td>Save the contents set in the Builder into the engineers' account file.</td>
</tr>
<tr>
<td>Properties</td>
<td>Display the property information of the file.</td>
</tr>
<tr>
<td>Print Preview</td>
<td>Display the print image.</td>
</tr>
<tr>
<td>Print</td>
<td>Print the set contents.</td>
</tr>
<tr>
<td>Exit Builder</td>
<td>Close the Engineers' Account Builder.</td>
</tr>
</tbody>
</table>
Table 16.2.5-2 Edit Menu

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>Cancel the previously performed edit operation.</td>
</tr>
<tr>
<td>Cut</td>
<td>Delete the selected character string and copy it onto the clipboard.</td>
</tr>
<tr>
<td>Copy</td>
<td>Copy the selected character string onto the clipboard.</td>
</tr>
<tr>
<td>Paste</td>
<td>Insert the character string stored on the clipboard.</td>
</tr>
<tr>
<td>Clear</td>
<td>Clear the character string of the selected field.</td>
</tr>
<tr>
<td>Select All</td>
<td>Select all cells.</td>
</tr>
<tr>
<td>Deselect All</td>
<td>Cancel selected status.</td>
</tr>
<tr>
<td>Insert Line</td>
<td>Insert a line before the selected line.</td>
</tr>
<tr>
<td>Delete Line</td>
<td>Delete the selected line.</td>
</tr>
<tr>
<td>Find</td>
<td>Search for a character string in the set data.</td>
</tr>
<tr>
<td>Replace</td>
<td>Replace a character string of the set data.</td>
</tr>
<tr>
<td>Release Lockout Account</td>
<td>Release lockout (can be selected only in ProSafe authentication mode).</td>
</tr>
<tr>
<td>Reset Password</td>
<td>Reset the password (can be selected only in ProSafe authentication mode).</td>
</tr>
</tbody>
</table>

Table 16.2.5-3 Tool Menu

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Options</td>
<td>Specify options.</td>
</tr>
<tr>
<td>Check User Names</td>
<td>Check engineer names (can be selected only in Windows authentication mode).</td>
</tr>
</tbody>
</table>

## Toolbar

The functions of each button on the toolbar are as follows.

![Toolbar Buttons and Names](image)

Table 16.2.5-4 Functions of Toolbar

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display/Hide Data Menu</td>
<td>Shows or hides the data menu area</td>
</tr>
<tr>
<td>Insert Line</td>
<td>Inserts a line before the selected line</td>
</tr>
<tr>
<td>Delete Line</td>
<td>Deletes the selected line</td>
</tr>
<tr>
<td>Check User Names</td>
<td>Performs engineer name check (available only in Windows authentication mode)</td>
</tr>
</tbody>
</table>
16.3 Operations of SENG That Use Access Control/Operation History Management

This section describes the operations of engineers and the operations of administrators in a system that uses access control/operation history management.

SEE ALSO
For more information about operations that are targets of access control/operation history management, refer to:

16.1.3, "Access Control/Operation History Management Target Operation List" on page 16-7
16.3.1 Engineer Operations under Access Control

In systems where access control/operation history management is used, when an engineer operates the SCS Manager, the various builders, the Engineering Tool or the SCS Maintenance Support Tool, logon/engineer authentication and rights checking are performed for operation control and operations are logged.

This section describes the following access control-related operations, which are performed when an engineer uses SENG.

- Logging on to SENG function
- Engineer authentication
- Operation control by rights checking
- Changing a password

Logging on to SENG Function

Logon is performed to check that the engineer who attempts to start SENG operations is a registered engineer.

After starting SENG, when any of the following programs is started, a Logon dialog box appears, and the engineer name and password are requested.

- SCS Manager
- SCS Status Overview window (only when started from the Start menu)
- IOM Control Right Switching Tool
- Master Database Restoring Function
- Version Control Tool
- Message Cache Tool

**TIP**

After logging on to any of the above programs, logon is not required when starting any other program. In this case, a confirmation dialog box appears, showing the currently logged on engineer.

Logon operations are as follows.

1. Perform operations to start a program that requires logon.
   The Logon dialog box appears.

![Logon Dialog Box (ProSafe Authentication Mode)](image)

Figure 16.3.1-1 Logon Dialog Box (ProSafe Authentication Mode)
In the case of Windows authentication mode, the user name logged on to Windows as an engineer is displayed in gray, and cannot be changed.

2. In the case of ProSafe authentication mode, enter the engineer name and password, and click [OK]. In the case of Windows authentication mode, enter the password for the Windows user, and click [OK].

If the engineer name and password match the registered information, the program is started.

Once work using SENG is finished, log out by closing all programs that require logon when started.

- **Logon Operation immediately after Engineer Registration**

In ProSafe authentication mode, when an engineer logs on for the first time after being registered, no password is set for the engineer. In this case, perform the following operations.

1. In the Logon dialog box, enter the engineer name and click [OK].

   A dialog box that prompts password registration appears.

2. Click [OK].

   In the Password Change dialog box that appears, set a password.

   You can use up to 63 alphanumeric characters and ASCII symbols for a password.
   - Passwords are case sensitive.
   - The following ASCII symbols and space characters can be used:
     
     ! " # $ % & ' ( ) * + , - . / : ; < = > ? @ \ [ \ ] ^ _ `{ | } ~

   However, semicolons (;) are not allowed in ProSafe authentication mode.
   - In ProSafe authentication mode, passwords need to follow the password policies set with the Operation History Management Setup Tool.
   - In Windows authentication mode, passwords need to follow the password policies set for Windows.

- **Engineer Authentication**

Engineer authentication is performed to confirm the engineer who attempts an SENG operation that affects an actual SCS. The operation cannot be executed unless the password of the engineer logged on is entered. The operations that require engineer authentication are as follows.

- Offline Download
- Master Offline Download
- Online Change Download
- SCS Restart
- SCS Security Level Password Change
- Output Enable Operation
The engineer authentication operations are as follows.

1. When any of the above operations is performed, the Engineer Authentication dialog box appears.

![Engineer Authentication Dialog Box](image)

The name of the engineer logged on is displayed in gray in the engineer name box.

2. Enter the password and the reason for performing the operation, and click [OK].

If the engineer name and password match the registered information, the operation is executed. The "Reason" character string that was entered is recorded in the operation log.

### Operations When Log-on/Engineer Authentication Fails

If log-on/engineer authentication fails consecutively the set number of times, an error message is displayed and an authentication error is recorded in the operation log. The behavior after an authentication error has occurred is as follows.

- If the lockout function is enabled, the engineer is locked out. The Log-on/Engineer Authentication dialog box appears even after lockout, but authentication will not succeed for the locked-out engineer name. An authentication error is not generated in this case. To release lockout, ask the administrator.
- If the lockout function is disabled, an authentication error is recorded each time the engineer enters the wrong password. If the correct password is entered, authentication is successful.

**SEE ALSO**

For more information about setting a lockout due to authentication failure, refer to:

- "Settings Required When ProSafe Authentication Mode is Selected" on page 16-13

For more information about how to release a locked-out engineer, refer to:

- "Releasing a Locked-out Engineer" on page 16-42

### Operation Control by Rights Checking

When an engineer attempts to perform an operation on a project database or SCS, if the engineer does not have the right to perform that operation, a warning dialog box appears and that operation cannot be performed. Or, the relevant menu may be grayed out to disable the operation.

Also, when a project is opened in SCS Manager, the following warning dialog box appears, according to the rights of the engineer.
Changing a Password

To change the password for logon and engineer authentication, perform the following procedure.

1. Perform an operation that requires logon or engineer authentication.
   The Logon dialog box or Engineer Authentication dialog box appears.

2. Enter the engineer name and password, and click [Change Password].
   The Password Change dialog box appears.
   If the entered engineer name and password are incorrect, it results in an authentication error and the password cannot be changed.

3. Enter the new password in "New Password:" and "Confirm New Password:" and click [OK].

TIP

- If a valid period for passwords has been set, a warning dialog box appears if an operation that requires logon or engineer authentication is performed within 14 days before the end of the valid period. Change the password ahead of time.
- If the valid period for passwords has passed, the Password Change dialog box appears. Set a new password. If the password is not changed, logon/engineer authentication will fail.

SEE ALSO

For more information about characters that can be used in a password, refer to:

"Logon Operation immediately after Engineer Registration" on page 16-38
16.3.2 Operations Performed by Administrators

This section describes the operations performed by administrators in a system that uses access control/operation history management.

### Checking the Operating Status of Operation History Management of Each Project

On the Operation History Management tab sheet of the Operation History Management Setup Tool, it can be confirmed whether operation history management is running for each project.

To confirm the operating status of operation history management, perform the following procedure.

1. From the Start menu, select [All Programs] > [YOKOGAWA ProSafe] > [Operation History Management Setup Tool].
   The Operation History Management Setup Tool starts.

2. Display the Operation History Management tab sheet, and confirm the operation history management status of RS projects in the “Status” column of the project list.

   ![Figure 16.3.2-1 Operation History Management Tab Sheet](image)

3. Except when the display in the Status column is "Running," confirm whether or not operation history management is running for each SCS project included in the RS project.
   a. Select an RS project on the project list and right-click.
   b. From the displayed pop-up menu, select [Display Details].
      The detailed statuses of the SCS projects are displayed.
Operation History Management Statuses of RS Projects

The operation history management statuses of RS projects displayed on the Operation History Management tab sheet of the Operation History Management Setup Tool are shown in the following table.

Table 16.3.2-1 Operation History Management Statuses of RS Projects

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Running</td>
<td>The operation history management function is running for all SCS projects belonging to the RS project.</td>
</tr>
</tbody>
</table>
| *****   | • Of the SCS projects belonging to the RS project, the operation history management function is running for some SCS projects and stopped for other SCS projects. (*1)  
  • The RS project does not exist. |
| Stopped | The operation history management function has not been started or is stopped for all SCS projects belonging to the RS project. |

*1: Even if operation history management was started in a batch for the RS project, subsequent actions of copying SCS project and adding it to RS project will result in a mix of SCS projects, some with operation history management running and some with operation history management not running. When a SCS project is newly generated and added to a RS project, the RS project in the state of running allows the added SCS project to run.

Messages Displayed in the SCS Detailed Status Dialog Box

In the SCS Detailed Status dialog box, the following two types of messages are displayed in the Message column of SCS projects whose status is "Stopped."

Table 16.3.2-2 Messages Displayed in the SCS Detailed Status Dialog Box

<table>
<thead>
<tr>
<th>Message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inconsistent with the operation history database.</td>
<td>Inconsistent with the operation history database. In this case, to recover consistency, start operation history management for the RS project that includes this SCS.</td>
</tr>
<tr>
<td>Operation history management is not set up.</td>
<td>Operation history management has not been started.</td>
</tr>
</tbody>
</table>

Releasing a Locked-out Engineer

An engineer who has failed in logon or engineer authentication consecutively the set number of times is locked out. The administrator releases locked-out engineers as necessary.
In ProSafe Authentication Mode

Lockout is released on the Valid Account tab sheet of the Engineers’ Account Builder.

On the Valid Account tab sheet, an asterisk (*) is displayed next to the names of locked-out engineers, and the setting contents of those engineers cannot be changed.

To release locked-out engineers, perform the following procedure.

1. Start the Operation History Management Setup Tool.
2. Click the [Edit] button on the Access Control tab sheet.
   The Engineers’ Account Builder is started.
3. On the Valid Account tab sheet, select the line of the engineer you wish to release from lockout. Multiple lines can be selected.
4. From the [Edit] menu, select [Release Lockout Account].
5. A dialog box appears to confirm lockout release, beginning at the top, for locked-out engineers among the selected engineers. To release lockout, click [OK].

When lockout is released, the asterisk next to the engineer name is deleted, and the contents of that line can be changed.

In Windows Authentication Mode

When in Windows authentication mode, release locked-out users by management tools on the Windows side. Note that in the Engineers’ Account Builder, an asterisk (*) is not displayed next to locked-out engineers.

Resetting a Password

This section describes the procedure for resetting an engineer’s password when in ProSafe authentication mode. When in Windows authentication mode, reset the password using management tools on the Windows side.

1. Start the Operation History Management Setup Tool.
2. Click the [Edit] button on the Access Control tab sheet.
   The Engineers’ Account Builder is started.
3. In the Valid Account tab sheet, select the line of the engineer whose password you wish to reset (multiple lines may be selected).
4. From the menu bar, select [Edit] > [Reset Password].
   A dialog box appears to confirm password reset, beginning at the top for the selected engineers.
5. To reset the password, click [OK].

Writing Comments to Operation Log Files

Log entries of any character strings may be written to the operation log files of a specified project. The written comments may be viewed as operation logs in the Operation History Database Viewer.

To write a comment to an operation log file, perform the following procedure.

1. Start the Operation History Management Setup Tool, and display the Operation History Management tab sheet.
2. Select an RS project from the list and click the [Write to log file] button.
   The following dialog box appears.
3. Enter a comment.
   A comment may be up to 64 single-byte characters or 32 double-byte characters.

4. Click [OK].
   The comment is written to the operation log file.

## Backing up

Creating a backup copy of operation history database has to be performed manually.

### IMPORTANT

Browsing a backup copy of operation history database also requires a backup copy of the target RS project for the operation history management. You need to perform backup both of them. Please note that you will no longer be able to browse the contents in the operation history database of a SCS project once you delete the SCS project in RS project. When you wish to delete a SCS project, ensure to make a backup copy of the relative RS project so that you can browse the backup copy of the operation history database later.

### Steps to backup

1. Using Windows Explorer, create backup copies of the top folder and all its subfolders of the operation history database into an auxiliary storage device. This operation allows you to backup the entire operation log database and modification file database.

2. Stop the operation history management.

3. Delete modification file database by means of the operation history setup tool. Since the operation log database remains untouched, the entire operation logs can be shown in the viewer.

4. Create a backup copy of the target RS project for the operation history management into an auxiliary storage device.

5. Restart the operation history management.

## Operations When Warning Message Prompting Backup Appears

When you perform an operation that causes saving of modification files or operation log, a warning message prompting backup of the operation history database may appear. If such message appears, make a backup of the operation history database, and delete the operation history management data saved in SENG.

Normally, free disk space can be secured by deleting only the modification files in the operation history database. By the following procedure, only the modification files are deleted, so you can still view all operation logs in the viewer after the deletion.

When a warning message prompting backup is displayed, perform the following procedure.

1. Using Windows Explorer, copy the top folder and all its subfolders of the operation history database to an auxiliary storage device.
By so doing, the entire operation log database and modification file database are backed up.

2. Start the Operation History Management Setup Tool, and display the Operation History Management tab sheet.

3. For each RS project, perform the following steps to stop operation history management, delete modification files, and then resume operation history management.
   a. Select an RS project on the project list and click the [Pause] button. Operation history management of the selected RS project stops.
   b. Click the [Clear Operation History Database] button. The following dialog box appears.

   ![Delete Operation History Database Dialog Box](image)

   c. To delete all modification files, select "Delete all data." To delete only the modification files prior to a specified time, select "Delete all data prior to the designated time," and enter the date and time.
   d. Click [OK]. The selected modification files of the RS project are deleted.
   e. Click the [Start Operation History Management] button to resume operation history management of the RS project.

4. Repeat the above procedure, and delete the modification files for all RS projects.

For more information about operation history database configuration, refer to:

16.5.1, “Operation History Database Structure” on page 16-71

For more information about how to browse data in a backup operation history database, refer to:

16.4.3, “Steps to Browse Backed-up Operation History Database” on page 16-67

### Initializing the Operation History Database

The procedure for initializing the operation history database and starting operation history management with a new operation history database in the same location will be described. By this procedure, all operation log files and modification files accumulated on the PC are deleted.

To initialize the operation history database and restart operation history management, perform the following procedure.

1. Start the Operation History Management Setup Tool, and display the Operation History Management tab sheet.
2. Select the RS project from the project list and click the [Pause] button. Operation history management of the selected RS project stops.
3. Similarly, stop operation history management of all RS projects.
4. To make a backup, using Windows Explorer, copy the top folder of the operation history database and all its subfolders to an auxiliary storage device.
5. Using Windows Explorer, delete all folders and files under the top folder of the operation history database of the RS project for which operation history management was stopped.

6. On the Operation History Management tab sheet, select the RS project, and click the [Start Operation History Management] button to restart operation history management.

7. Similarly, restart operation history management of all RS projects.

After operation history management is restarted, the serial numbers of the operation logs start at one.

---

**Adding an Engineer**

To add an engineer, register the engineer’s account on the Valid Account tab sheet of the Engineers’ Account Builder.

---

**Deleting An Engineer**

Deletion of engineers is performed on the Valid Account tab sheet of the Engineers’ Account Builder.

To delete engineers, perform the following procedure.

1. Start the Operation History Management Setup Tool.

2. Click the [Edit] button on the Access Control tab sheet.

3. On the Valid Account tab sheet, select the line of the engineer name you wish to delete, and select [Delete Line] from the [Edit] menu.

4. Select [Save] from the [File] menu.

---

**IMPORTANT**

If you delete a registered engineer for whom a password is already set, that engineer name is deleted from the table on the Valid Account tab sheet, and is added to the Invalid Account tab sheet. It cannot be completely deleted from the database. An engineer name of this type cannot be registered again.

---

**Changing an Engineer's Rights**

To change the rights of a registered engineer, the following operations may be required.

- Change the engineer group to which the engineer belongs.
- Change the access group assigned to the engineer group.
- Change the range/exclusion range of RS projects/SCS projects assigned to the engineer group.
- Change the access group definitions.
  Perform these operations in accordance with the rights to be changed.

**SEE ALSO**

For more information about how to change the above settings in order to change an engineer's rights, refer to:

16.2.3, "Registering Engineers" on page 16-19

### Operations when Inconsistency Is Detected Between Project and Operation History Database

When the Operation History Management tab sheet of the Operation History Management Setup Tool is displayed, consistency between the project and operation history database is checked. If an inconsistency is detected, the following message is displayed.

![Image of Operation History Management Setup Tool]

**Figure 16.3.2-5 Message When Inconsistency Detected (Example)**

Perform the following procedure to resolve the database inconsistency.

1. On the Operation History Management tab sheet, check the status of the RS projects displayed in the preceding message and the detailed status of their SCS projects.
2. Select an applicable RS project on the project list and click the [Start Operation History Management] button.

**TIP**

If the [Start Operation History Management] button is grayed out and disabled, click the [Pause] button to stop operation history management of the selected RS project, and then click the [Start Operation History Management] button.

**SEE ALSO**

For more information about how to check the status of an RS project and the detailed status of SCS, refer to:

- "Checking the Operating Status of Operation History Management of Each Project" on page 16-41

### Tasks Required after Adding, Moving or Deleting a Project Database

When the database of a project that is the target of operation history management is moved, or when an SCS project is added or deleted, the project database and the operation history database become inconsistent with each other. Also, operation history management is not executed for the added or moved SCS project.
IMPORTANT

A project for which operation history management is performed and the operation history database must be associated with each other. If not correctly associated, operation history management will not work. The following operations must be performed after adding, moving or deleting a project database.

For operation history management to be executed correctly, the following operations are required on the Operation History Management tab sheet of the Operation History Management Setup Tool.

- If an RS project was added
  After adding the added RS project as a target of operation history management and performing the required setup, start operation history management.

- If an RS project for which operation history management was already being executed was moved
  After temporarily deleting the RS project as a target of operation history management and then adding it anew and performing the required setup, start operation history management.

- If an RS project was deleted
  Delete the deleted RS project as a target of operation history management.

- If an SCS project was added, moved or deleted
  For an RS project for which operation history management was already being executed, after an SCS project has been added, moved or deleted, stop operation history management of the RS project that includes that SCS project, and then start operation history management again.

SEE ALSO

For more information about how to add or delete an RS project as a target of operation history management, and settings related to operation history management, refer to:

16.2.2, “Setup Related to Operation History Management” on page 16-15

For more information about how to stop or start operation history management, refer to:

“Stopping/Resuming Operation History Management” on page 16-49

Tasks Required after Changing User Authentication Mode

This section describes the operations required after changing the user authentication mode. Note that the engineer’s account information does not change if the user authentication mode is changed.

- When Changed from ProSafe Authentication Mode to Windows Authentication Mode

The Windows password policy and user lockout settings are applied. The status of a user who has been locked out is not inherited.

- Execute an engineer name check to clear out the names that are not registered in Windows, and set up accounts if necessary.

- Since passwords are not inherited, set up passwords in Windows.

- If you wish the status of locked out users to continue, set this up in management tools on the Windows side.
When Changed from Windows Authentication Mode to ProSafe Authentication Mode

Password policy and user lockout settings must be set anew on the ProSafe-RS side. The status of a user who has been locked out is not inherited.

- In the operation history management setup tool, perform password policy and user lockout settings.
- Set a password when your are prompted to when logging onto the SENG function for the first time.

For more information about how to set up password policy and user lockout for ProSafe-RS, refer to:
“Settings Required When ProSafe Authentication Mode is Selected” on page 16-13

Checking Engineer Names in Windows Authentication Mode

In Windows authentication mode, engineer names registered on the builder must be registered as Windows users.

To check whether or not a registered engineer name exists as a Windows user, perform the following procedure.

1. Start the Operation History Management Setup Tool.
2. Click the [Edit] button on the Access Control tab sheet. The Engineers’ Account Builder is started.
3. From the start menu, select [Tools] > [Check user names]. Engineer names that do not exist as Windows users are output in the message display area.

If there is a user name that does not exist, create a user account in Windows.

Stopping/Resuming Operation History Management

You must stop history management before backing up or deleting the operation history database, and resume it after you finish the task. Operation history management can be stopped/resumed for each RS project individually.

Stopping Operation History Management

1. Start the Operation History Management Setup Tool, and display the Operation History Management tab sheet.
2. On the project list, select the RS project for which you wish to stop operation history management and click the [Pause] button, and then click [OK].

After the stopping operation log is recorded, saving of the operation logs and modification files stops.

Resuming Operation History Management

The operations are the same as starting operation history management.

1. In the project list of the Operation History Management tab sheet, select the RS project for which operation history management is to be resumed, and click the [Start Operation History Management] button.
2. In the confirmation dialog box, click [OK].

Saving of operation logs and modification files to the operation history database begins, and the operation history management start operation is logged.
Steps to Update at PC Failures

- **Updating a PC where Operation History Management Function Is Running**
  
  When you wish to replace a PC where operation history management is performed due to PC failures, register operation history database of the relative RS project on the restored PC by means of the operation history setup tool and then restart the operation history management.

SEE ALSO
For more information about PC restoration, refer to:

- C7.2, “When the Computer Used is Not the Same” in Installation (IM 32Q01C50-31E)

- **Updating a PC where Operation History Database Is Implemented**
  
  When you wish to replace a PC where operation history database is implemented due to PC failures, create a shared folder "RS-Share" in the replacement PC, perform IT security tool and then perform the following steps to start operation history management by means of operation history setup tool in a PC where operation history management function runs.

  - When you wish to create new operation history database:
    1. If operation history management is being performed for an RS project, you need to remove its registration.
    2. Register the location of RS project and operation history database again.
    3. Start operation history management.

  - When you wish to use a backup copy of the operation history database:
    1. If operation history management is being performed for an RS project, you need to remove its registration.
    2. Restore the operation history database to the original location.
    3. Register the location of RS project and operation history database again.
    4. Start operation history management.

SEE ALSO
For more information about setup of a file server, refer to:

- A2.2.3, “Setup Procedure for a File Server” in Installation (IM 32Q01C50-31E)
16.4 Browsing Operation History Data

Operation history data such as operation logs and modification files saved in the operation history database can be browsed in the Operation History Database Viewer and Modification Files Viewer.

**IMPORTANT**

By default, only administrators can browse operation history data. To also enable general engineers to browse operation history data, perform the following settings in the Operation History Management Setup Tool.

---

**SEE ALSO**

For more information about how to allow browsing of operation history data by general engineers, refer to:

- "Permission to Start Operation History Database Viewer" on page 16-17

---

**Functions of Operation History Database Viewer**

The Operation History Database Viewer is for browsing operation logs in the operation history database, and has the following functions.

- List display of operation logs
- Searching of operation logs
- Sorting of operation logs
- Displaying details of operation logs
- Printing of operation logs
- Exporting of operation log lists to CSV files
- Startup of the Modification Files Viewer

**Functions of Modification Files Viewer**

The Modification Files Viewer is a viewer for browsing modification files in the operation history database, and has the following functions.

- Displaying the modification files database tree
- Searching modification files
- Acquiring modification files
- Displaying the contents of modification files
- Displaying differences of modification files
- Printing modification files
16.4.1 Browsing and Printing Operation Logs

This section describes how to browse and print operation logs saved in the operation history database in the Operation History Database Viewer, and information recorded in operation logs.

■ Starting the Operation History Database Viewer

The Operation History Database Viewer can be started up from the Windows Start menu or from the Operation History Management Setup Tool.

- Startup from the Windows Start Menu

A general engineer can start up by this method only when the "Allow general users to start the viewer" check box is selected in the Operation History Management Tool.

1. From the Windows Start menu, select [All Programs] > [YOKOGAWA ProSafe] > [Operation History Database Viewer].

The Project Selection dialog box appears.

2. From the "RS Project" drop-down list, select the path of the RS project.

3. In the "SCS Project" box, a list of the SCS projects of the selected RS project and "HISTDB_COMMON" (common operation log) are displayed. Select the check box of the item for which you wish to display the operation log. Multiple check boxes may be selected.

   TIP

   The common operation log is an operation log of the operations that do not depend on the RS project or SCS project, among the operations performed by SENG. For example, startup of the SCS Manager or startup of the SCS Status Overview window apply to the common operation log.

4. Click [OK].

   The Operation History Database Viewer is started, and the operation logs are displayed as a list.

- Starting up from the Operation History Management Setup Tool (Administrator Only)

Because the Operation History Management Setup Tool can be started up only by administrators, general engineers cannot use this method.

1. From the Start menu, select [All Programs] > [YOKOGAWA ProSafe] > [Operation History Management Setup Tool].

   The Operation History Management Setup Tool starts.

2. Display the Operation History Management tab sheet.
3. Select an RS project from the RS project list and click the [Start Viewer] button. The Project Selection dialog box appears.

![Project Selection Dialog Box](image)

**Figure 16.4.1-2 Project Selection Dialog Box (If Started From Operation History Management Setup Tool)**

4. In the "SCS Project" box, a list of the SCS projects of the selected RS project and "HISTDB_COMMON" (common operation log) are displayed. Select the check box of the item for which you wish to display the operation log. Multiple check boxes may be selected.

5. Click [OK]. The Operation History Database Viewer is started, and the operation logs are displayed as a list.

### Browsing Operation Logs

When the Operation History Database Viewer is started, the operation logs of the RS projects/SCS projects specified at startup are listed. If multiple SCS projects have been specified, multiple windows open, one for each SCS project.

![Operation Log List Window](image)

**Figure 16.4.1-3 Operation History Database Viewer**

SEE ALSO

For more information about information recorded in operation log, refer to:

16.5.3, "Information Recorded in Operation Logs" on page 16-77
Specifying SCS Projects and Displaying Operation Logs

To display a list of operation logs of another SCS project after the Operation History Database Viewer has been started up, perform the following procedure.

1. From the menu bar, select [File] > [Open], or click [Open] button on the toolbar.
   The Project Selection dialog box appears.
2. From the "RS Project" drop-down list, select the path of the RS project.
3. In "SCS Project:", select the check box of the SCS project for which you wish to display the operation log.
4. Click [OK].
   A new window opens, and the operation log of the specified SCS project appears.

Displaying Properties

The following information can be displayed for operation logs displayed in the active window in the Operation History Database Viewer.

- SCS project path name
- Path to the top folder of the operation history database
- Date and time of the oldest log
- Date and time of the newest log
- Number of logs

1. Make the window in which you wish to display properties active, and select [Properties] on the [File] menu.

Specifying the Number and Range of Operation Logs to be Displayed

To specify the number and range of operation logs to be displayed, perform the following procedure.

1. From the menu bar of the Operation History Database Viewer, select [View] > [Settings] or click [Settings] in the toolbar.
   The Display Settings dialog box appears.
2. On the Display tab sheet, specify the maximum number of displayed items and the position to start the search.
   Up to 65535 can be entered as the maximum number of displayed items. (Set value when viewer is started for the first time: 1000.) When "Newest First" is selected as the search direction, results are displayed starting from the newest, and when "Oldest First" is selected, results are displayed starting from the oldest until the maximum number to display the operation logs specified here. (Set value when viewer is started for the first time: Newest First.)

Operation Log Filtered Display

Filter conditions can be set in the Display Settings dialog box so that only operation logs that match the conditions are displayed. When multiple conditions are set, only operation logs that match all conditions are displayed. Note that when the viewer is started, no filters are set.
The conditions that can be specified are shown in the following table.

<table>
<thead>
<tr>
<th>Filter Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Serial number</td>
<td>A range of serial numbers (8-digit hexadecimal numbers) can be specified. When a range is specified, specification of either the lowest number or the highest number can be omitted.</td>
</tr>
<tr>
<td>Date and time</td>
<td>A range of dates and times can be specified. When a range is specified, specification of either the earliest date or the latest date can be omitted.</td>
</tr>
<tr>
<td>Engineer name</td>
<td>When specifying multiple items, separate them by a space.</td>
</tr>
<tr>
<td>Operation description</td>
<td>Multiple operations can be selected by check boxes.</td>
</tr>
<tr>
<td>Arbitrary string</td>
<td>Any character string can be specified. Wildcards may not be used. When the specified character string is contained in any of the following items in an operation log, that operation log is considered to have matched the condition. Computer name, engineer name, font, program name, object of operation, reason (serial number, date/time and result of operation are not search targets).</td>
</tr>
</tbody>
</table>

To display filtered operation logs, perform the following procedure.

1. From the menu bar, select [View] > [Settings], or click [Settings] button in the tool bar. The Display Settings dialog box appears.
2. Set up the filter conditions on the Filtering tab sheet.
3. Click [OK]. The search begins, and a list of operation logs that match all filter conditions appears.
TIP
During search, the Searching dialog box is displayed. When [Cancel] is clicked, the search results up to that point are displayed.

At the point when all operation logs in the operation history database have been searched, or the number of operation log search results has reached the maximum number of displayed items specified as a display condition, the search ends and the search results are displayed.

At this time, if all operation logs in the operation history database have been searched, the following is displayed on the bottom right of the Operation History Database Viewer.
"874 Case Display/Searched All"

If the maximum number of displayed items (1000) has been reached and there are still un-searched operation logs remaining, the following is displayed.
"1000 Case Display/Not Searched All"

- Updating the Display
To update the operation log list display, select [View] > [Update] from the menu bar. Alternatively, click [Update] on the toolbar.

The operation logs are searched again under the conditions set in the Display Settings dialog box, and the display is updated.

- Sorting Operation Logs
Click an header item in the operation log list.

The operation logs currently displayed are sorted in the order of that item.

Each time the header item is clicked, the sorted list switches between ascending and descending orders.

- Displaying Operation Log Details
To display the detailed contents of the operation log, double-click an operation log. Alternatively, right-click an operation log, and select [Details] from the pop-up menu.
The Operation Log Detail Display dialog box appears. When [>] is clicked, the details of the next operation log are displayed. When [<] is clicked, the details of the previous operation log are displayed. When [Output log details] is clicked, the detailed information of the operation log is output to a file.

### Saving Operation Logs to a File

The list of operation logs displayed in the viewer and detailed information can be saved to a file.

#### Outputting Operation Log List to a File

Perform this procedure to output the operation log list displayed in the viewer to a CSV text file.

1. From the menu bar, select [File] > [Export] > [Output log overview]. The File Selection dialog box appears.
2. In the File Selection dialog box, specify the save destination file path, and click [Save]. An example of output is shown as follows.
Figure 16.4.1-6 Example of Operation Log List Output

- **Outputting Operation Log Detailed Information to a File**

Detailed information of operation logs can be output in .rtf format or .txt format.

This section describes how to output the detailed information of all the listed operation logs.

1. Display a list of operation logs. If multiple windows that display operation logs have been opened, activate the window of the operation log you wish to output.

2. From the [File] menu, select [Export] > [Output log details].

   The File Selection dialog box appears.

3. Specify the file name and file format (.rtf or .txt) of the output destination and click [OK].

   The detailed information of all the displayed operation logs is output to the file in the same order as the list display.

   **SEE ALSO**

   For more information about how to output detailed information of individual operation logs to a file, refer to:

   - “Displaying Operation Log Details” on page 16-56

- **Printing Operation Logs**

   This section describes how to print the contents of the operation log list and detailed information.

   **Printing an Operation Log List**

   1. Display a list of operation logs. If multiple windows that display operation logs have been opened, activate the window of the operation log you wish to print.


   The Print dialog box appears.

   3. Specify the printer in the Print dialog box, and click [OK].

   The contents displayed in the Operation Log List Display window are printed.

   **Printing Detailed Information of Operation Logs**

   To print detailed information of operation logs, output the detailed information data to a file in .rtf format or .txt format, and print them using the general print function.
16.4.2 Browsing and Printing Modification Files

This section describes how to browse and print modification files saved in the operation history database in the Modification Files Viewer.

**Overview of Modification Files Viewer**

In the Modification Files Viewer, you can look into the saved modification files from the following viewpoints.

- Modification files associated with a certain operation log
- By type of modification file

By searching for modification files by operation log serial number, modification files associated with a specific operation log can be found. Modification files are stored by type in folders in the database, and by selecting a folder in the tree display, modification files of the same type saved up to that point can be displayed in a list.

The modification file contents can be browsed in the following two formats.

- Detailed display
- Detailed difference display

When a modification file is opened in the Modification Files Viewer, a builder or the Multi-language Editor starts up in "viewer mode" according to the type of the modification file, and the contents are displayed. In viewer mode, the contents of files cannot be edited or saved. For modification files that cannot be displayed in a builder or the Multi-language editor, a dedicated viewer is started up.

**About Modification Files**

Modification files are the files that store information that was changed in a project database when an engineer executed an operation.

One or multiple modification files can correspond to one operation corresponding to a certain operation log (that is, serial number). There are also operations for which no corresponding modification file exists.

**Modification Files List**

The types of modification files are as follows.

<table>
<thead>
<tr>
<th>Table 16.4.2-1 Types of Modification Files</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Hierarchy</td>
</tr>
<tr>
<td>Project</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Configuration</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

Continues on the next page
### Table 16.4.2-1 Types of Modification Files (Table continued)

<table>
<thead>
<tr>
<th>Data Hierarchy</th>
<th>Type</th>
<th>Description</th>
<th>Content Display Tool(*1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resource</td>
<td>ResourceProp</td>
<td>Resource properties information</td>
<td>Dedicated viewer</td>
</tr>
<tr>
<td></td>
<td>GlobalVariables</td>
<td>Global variables information</td>
<td>Dedicated viewer</td>
</tr>
<tr>
<td></td>
<td>IODev</td>
<td>I/O module information</td>
<td>Dedicated viewer</td>
</tr>
<tr>
<td></td>
<td>IOMDefSB</td>
<td>I/O parameters</td>
<td>I/O Parameter Builder</td>
</tr>
<tr>
<td></td>
<td>CommIO</td>
<td>Communication I/O definition information</td>
<td>Communication I/O Builder</td>
</tr>
<tr>
<td></td>
<td>ModbusDef</td>
<td>Modbus address definition information</td>
<td>Modbus Address Builder</td>
</tr>
<tr>
<td></td>
<td>DNP3Def</td>
<td>DNP3 communication definition information</td>
<td>DNP3 Communication Builder</td>
</tr>
<tr>
<td></td>
<td>LinkTrans</td>
<td>Link transmission definition information</td>
<td>Link Transmission Builder</td>
</tr>
<tr>
<td></td>
<td>Binding</td>
<td>Binding information</td>
<td>Dedicated viewer</td>
</tr>
<tr>
<td></td>
<td>Tag</td>
<td>Tag name definition information</td>
<td>Tag Name Builder</td>
</tr>
<tr>
<td></td>
<td>AlmPri</td>
<td>Alarm priority level definition information</td>
<td>Alarm Priority Builder</td>
</tr>
<tr>
<td></td>
<td>AlmTbl</td>
<td>Alarm processing table definition information</td>
<td>Alarm Processing Table Builder</td>
</tr>
<tr>
<td></td>
<td>ResourceContent</td>
<td>POU list information/POU property information</td>
<td>Dedicated viewer</td>
</tr>
<tr>
<td></td>
<td>LocalVarsParams</td>
<td>Local variables/parameters information</td>
<td>Dedicated viewer</td>
</tr>
<tr>
<td>POU</td>
<td>Source</td>
<td>POU logic information</td>
<td>Multi-language Editor</td>
</tr>
</tbody>
</table>

*1: The tool started up when the file contents are displayed in Modification Files Viewer. The builder and Multi-language Editor are started up in viewer mode.

### Timing of Saving Modification Files

Modification files are normally saved at the point when a download operation has succeeded. The operation by which modification files are saved and the types of saved modification files are shown as follows.

### Table 16.4.2-2 Operation by Which Modification Files Are Saved

<table>
<thead>
<tr>
<th>Operation Name</th>
<th>Type of Saved Modification File</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create New Project</td>
<td>All modification files.</td>
<td></td>
</tr>
<tr>
<td>Open Project</td>
<td>Modification files added by upgrading.</td>
<td>Saved when first opened after upgrading if any files have been added by upgrading.</td>
</tr>
<tr>
<td>Import SCS Manager</td>
<td>Modification files corresponding to modified information.</td>
<td></td>
</tr>
<tr>
<td>Build</td>
<td>Modification files corresponding to modified information.</td>
<td>Saved only for user-defined projects.</td>
</tr>
<tr>
<td>Offline Download</td>
<td>Modification files corresponding to modified information.</td>
<td></td>
</tr>
<tr>
<td>Online Change Download</td>
<td>Modification files corresponding to modified information.</td>
<td></td>
</tr>
<tr>
<td>Master Database Restoring</td>
<td>All modification files.</td>
<td></td>
</tr>
<tr>
<td>Version Control Check Out</td>
<td>All modification files.</td>
<td>Saved only when check-out destination is a target of operation history management.</td>
</tr>
</tbody>
</table>
Table 16.4.2-2 Operation by Which Modification Files Are Saved (Table continued)

<table>
<thead>
<tr>
<th>Operation Name</th>
<th>Type of Saved Modification File</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Operation History Manage-</td>
<td>When operation history management is started for the first time: All modification files.</td>
<td>Otherwise: Modification files corresponding to modified information.</td>
</tr>
<tr>
<td>ment</td>
<td>Otherwise: Modification files corresponding to modified information.</td>
<td></td>
</tr>
</tbody>
</table>

**TIP**
- If you do not wish to save modification files, select the "Do not save in modification files" check box on the History Management tab of the Operation History Management Setup Tool. By default, modification files are saved.
- If you perform saving in a builder without making any modifications or if you set, change, or delete the password of a POU, the operation is also considered as a modification and saved as a modification file.

### Browsing Modification Files

This section describes operations for starting the Modification Files Viewer and browsing modification files. The Modification Files Viewer is started up from the Operation History Database Viewer.

**Starting the Modification Files Viewer**

To browse modification files, perform the following procedure.

1. Select one operation log in the operation history database.
2. From the menu bar, select [View] > [View Modification Files]. Alternatively, click [Start Modification Files Viewer] button on the toolbar.
3. When the dialog box for entering the project password appears, enter the project password and click [OK].
   The Modification Files Viewer starts.
In the tree display when the Modification Files Viewer starts, the focus is on the folder of the modification files corresponding to the selected operation log. If there are multiple modification files corresponding to that operation log (serial number), the focus is on the modification file found first. If there are no modification files corresponding to that operation log, it is started without the tree view being expanded.

• If the wrong password is entered in the dialog box for entering the project password, the Password Input dialog box appears up to two times.

- Listing Modification Files by Type

In the left pane of the Modification Files Viewer, the contents of the modification files database are displayed in a tree. Modification files are stored by type in each folder. Modification files of POU's deleted during the course of engineering are also retained.

1. To display a list of modification files by type, select the folder of the targeted modification files in the tree display.
   In the right pane, all modification files of the selected type are displayed in a list.

The display contents are as follows.

- Icon
  Indicates whether the modification file is a builder file, other modification file or POU source.

- Serial number
  This is the serial number of the operation log corresponding to the operation associated with the modification file.

- Change date
Each time the heading [No.] or [Change Date] is clicked, the modification file list display in the Modification Files Viewer switches between ascending and descending order. When the viewer is started, the list is displayed in descending order by serial number (No.).

For more information about types of modification files, refer to:

- "Modification Files List" on page 16-59

### Searching Modification Files

Modification files can be searched by the serial number of the operation log.

1. From the menu bar, select [View] > [Find]. Alternatively, click [Find] on the toolbar. A Search dialog box appears.

   ![Search Dialog Box](image.png)

   **Figure 16.4.2-2 Search Dialog Box**

2. Specify the serial number and search direction.

3. Click [Find Next]. If a relevant file is found, the folder of this modification file becomes selected in the tree display. All modification files associated with the specified serial number can be searched by repeatedly clicking [Find Next].

### Displaying the Contents of Modification Files

If SCS Manager is running, the contents of files cannot be displayed. Perform the display operation after confirming that SCS Manager is not running. Password input is required when displaying a modification file of a POU for which a password was set when the modification file was last saved.

To display the contents of a modification file, perform the following procedure.

1. In the Modification Files Viewer, display the files whose contents you wish to display in the list display.

2. In the list display of the Modification Files Viewer, double-click the modification file. Alternatively, select a file, right-click, and select [Details] from the pop-up menu.

3. When the dialog box for entering the POU password appears, enter the POU password and click [OK]. The corresponding builder or the Multi-language Editor is started, or the dedicated viewer is started, and the contents are displayed.

   An example when displayed in the dedicated viewer is as follows.
Figure 16.4.2-3 Dedicated Viewer Example (GlobalVariables)

For more information about builder, multi-language editor and dedicated viewer corresponding to the type of modification file, refer to:

- Modification Files List on page 16-59

Displaying Differences of Two Modification Files

This section describes the procedure for displaying the differences of two modification files of the same type.

Differences cannot be displayed if the SCS Manager is running. Perform the display operation after checking that the SCS Manager is not running. Password input is required to display a modification file of a POU for which a password was set when the modification file was last saved.

1. In the tree display of the modification file viewer, select the folder of the modification file of the type for which you wish to display the differences.
   A list of modification files appears in the right pane.
2. Double-click a modification file in the modification file list display, and display the contents of the file.
3. If the dialog box for POU password input appears, enter the password of that POU and click [OK].
   The corresponding builder or the Multi-language Editor starts up in viewer mode, and the contents appear.
4. Similarly, display the contents of another modification file.
5. Click [Start Difference Display] button on the toolbar. Alternatively, from the menu bar, select [Difference Display] > [Start Difference Display].
   The windows of the two files are aligned, and items or objects containing differences are displayed in red.
An example of the display when POU modification files have been selected is as follows.
When difference display is executed, the two windows come out with the first difference selected. If the item or object selected in one window does not exist in the other window, nothing is selected.

**TIP**
In builders or a viewer that is dedicated to viewer mode, order of the data in a document window will be sorted according to the data order in the active document window when difference display is executed in a spreadsheet type window such as tag name builder. Consequently, choosing different active window makes the order of displayed data different when you execute difference display.

The selected state (focus) on the difference can be moved to the next or previous difference by the following operations.

- Each time [Find Next] button on the toolbar is clicked, the focus shifts to the next difference.
- Each time [Find Previous] button on the toolbar is clicked, the focus shifts to the previous difference.

The same focus shifts occur when [Difference Display] > [Find Next] or [Find Previous] is selected from the menu bar. For a builder with multiple tabs, the tab also switches.

**TIP**
The units of differences in the Multi-language Editor depend on the type of the diagram as follows.

- FBD: Object (variable, function block, link, text comment)
- LD: Rung
- ST: Line

Differences that have no effect on logic operations, such as the position or shape of an object, are also displayed as differences.
Acquiring Modification Files

Some modification files can be acquired as temporary files of the Builder (file extension .sva) into the specified folder by the specified name. The acquired temporary files can be imported to their corresponding builders. Files that can be acquired are shown in the following table.

Table 16.4.2-3 Modification Files That Can Be Acquired

<table>
<thead>
<tr>
<th>Type of Modification File</th>
<th>Corresponding Builder</th>
</tr>
</thead>
<tbody>
<tr>
<td>StnDef (*1)</td>
<td>SCS Constants Builder</td>
</tr>
<tr>
<td>IOMDefSB</td>
<td>I/O Parameter Builder</td>
</tr>
<tr>
<td>CommIO</td>
<td>Communication I/O Builder</td>
</tr>
<tr>
<td>LinkTrans</td>
<td>SCS Link Transmission Builder</td>
</tr>
<tr>
<td>ModbusDef</td>
<td>Modbus Address Builder</td>
</tr>
<tr>
<td>Tag</td>
<td>Tag Name Builder</td>
</tr>
<tr>
<td>AlmPri</td>
<td>Alarm Priority Builder</td>
</tr>
<tr>
<td>AlmTbl</td>
<td>Alarm Processing Table Builder</td>
</tr>
</tbody>
</table>

*1: Two files, those with “-s” or “-i” appended to the base of the specified file name, are acquired.

To acquire modification files, perform the following procedure.

1. In the list display of the Modification Files Viewer, select one modification file.
2. From the menu bar, select [File] > [Acquire]. Alternatively, right-click and select [Acquire] from the pop-up menu.
   The File Selection dialog box appears.
3. Specify the folder where the modification file is to be saved and the file name, and click [Save].
   The modification file is saved in the specified folder.

Printing Modification Files

This section describes the operations for printing the contents of modification files and operations for printing the differences between two selected modification files. Since printing cannot be performed while the SCS Manager is running, print after closing the SCS Manager.

- Printing the Contents of Modification Files
  1. In the list display of the Modification Files Viewer, select a modification file.
  2. From the menu bar, select [File] > [Print].
     The Print dialog box appears.
  3. Click the [OK] button.
     Printing begins.

- Printing Differences Between Two Modification Files
  1. In the list display of the Modification Files Viewer, select two modification files.
  2. From the menu bar, select [File] > [Print].
     The Print dialog box appears.
  3. Click [OK].
     Printing begins.
16.4.3 Steps to Browse Backed-up Operation History Database

When you try to browse the contents of backed-up operation history database, perform following steps in a PC where operation history management function is performed.

### TIP

Use the following backup copies to browse the contents of backed-up operation history database.
- Backup copy of the operation history database that you wish to browse.
- Backup copy of RS project that possesses the SCS project you wish to browse.

1. Prepare a folder where operation history database and RS project to be restored in a PC or in a file server under the share name “RS-Share”.
   a. When you first use the shared folder “RS-Share”, perform appropriate IT security settings.
   b. Create a folder for restoration under the shared folder “RS-Share”.
2. Restore the backup copy of operation history database into the folder created at the above step.
3. Restore the backup copy of RS project into the folder created at the above step.
4. Register the restored RS project and the restored operation history database by means of operation history setup tool.
5. Start operation history management of the registered operation history database. Log of this manipulation to start operation history management can be ignored.
6. Specify the restored operation history database to open operation history database viewer.

### SEE ALSO

For more information about how to browse operation logs and modification files, refer to:
- 16.4.1, “Browsing and Printing Operation Logs” on page 16-52
- 16.4.2, “Browsing and Printing Modification Files” on page 16-59

For more information about setup of a file server, refer to:
- A2.2.3, “Setup Procedure for a File Server” in Installation (IM 32Q01C50-31E)
16.4.4 Lists of Viewer Tool Buttons

The functions of the buttons on the toolbar of the Operation History Database Viewer, Modification Files Viewer and Builder in viewer mode are as follows.

![Image of toolbar buttons]

**Figure 16.4.4-1 Toolbar Buttons and Names (Operation History Database Viewer)**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>Specify the SCS project and display the list of operation logs. Same as [Open] of the [File] menu.</td>
</tr>
<tr>
<td>Details</td>
<td>Display detailed information of the operation log. Enabled only when one operation log has been selected. Same as [Details] of the [View] menu.</td>
</tr>
<tr>
<td>Settings</td>
<td>Set the display conditions for the list of operation logs. Same as [Settings] of the [View] menu.</td>
</tr>
<tr>
<td>Update</td>
<td>Update the display of the list of operation logs according to the latest display conditions. Same as [Update] of the [View] menu.</td>
</tr>
<tr>
<td>Start Modification Files Viewer</td>
<td>Start the Modification Files Viewer. Enabled only when one operation log has been selected. Same as [View Modification Files] of the [View] menu.</td>
</tr>
</tbody>
</table>

**Table 16.4.4-1 Toolbar Buttons (Operation History Database Viewer)**

![Image of toolbar buttons]

**Figure 16.4.4-2 Toolbar Buttons and Names (Modification Files Viewer)**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Details</td>
<td>Display the contents of modification files. Enabled only when one modification file has been selected. Same as [Display Details] of the [View] menu.</td>
</tr>
<tr>
<td>Find</td>
<td>Searches for modification files by serial number of operation log. Same as [Find] of the [View] menu.</td>
</tr>
</tbody>
</table>

**Table 16.4.4-2 Toolbar Buttons (Modification Files Viewer)**

![Image of toolbar buttons]

**Figure 16.4.4-3 Toolbar Buttons and Names (Builder in Viewer Mode)**
### Table 16.4.4-3 Toolbar Buttons (Builder In Viewer Mode)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Difference Display</td>
<td>Display the differences between two modification files. Enabled only when the contents of two modification files are displayed. Same as [Start Difference Display] of the [Difference Display] menu.</td>
</tr>
<tr>
<td>Find Next</td>
<td>Move focus to the next difference in the difference display. Same as [Find Next] of the [Difference Display] menu.</td>
</tr>
<tr>
<td>Find Previous</td>
<td>Move focus to the previous difference in the difference display. Same as [Find Previous] of the [Difference Display] menu.</td>
</tr>
</tbody>
</table>
16.5 Detailed Information of Access Control/Operation History Management

This section describes the detailed information pertaining to access control and operation history management.
16.5.1 Operation History Database Structure

The operation history database is generated for each RS project in the location specified in the Operation History Management Setup Tool. The operation history database of each RS project consists of the operation log database and modification files database of each SCS project. The operation log of operations common to all RS projects, such as SCS Manager startup, is recorded in the common operation log database. Modification files are stored by type below the folder of the modification file type name.

The folder structure of the operation history database is shown in the following figure.

*1: The folder name is the same as the RS project name.
*2: The folder name is the same as the SCS project name.

Figure 16.5.1-1 Operation History Database Structure
For more information about how to specify the location of the top folder of an operation history database, refer to:

"Specifying Top Folder of Operation History Database" on page 16-15

For more information about how to browse the contents of the operation history database, refer to:

16.4, "Browsing Operation History Data" on page 16-51
### 16.5.2 Access Rights Category List

The following table shows a list of access right categories.

<table>
<thead>
<tr>
<th>Category</th>
<th>Operation Description</th>
<th>Operation Program Tool</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Creation</td>
<td>Creation of new SCS projects/libraries</td>
<td>SCS Manager</td>
</tr>
<tr>
<td>General Settings</td>
<td>Change of project properties, project descriptions&lt;br&gt;Change of configuration names, configuration descriptions&lt;br&gt;Change of connection properties (IP addresses)&lt;br&gt;Change of resource names, resource properties, resource descriptions&lt;br&gt;Change of POU properties, POU descriptions&lt;br&gt;Addition, deletion or name change of POU&lt;br&gt;Addition, deletion or change of variable groups&lt;br&gt;Clean&lt;br&gt;Build&lt;br&gt;Addition, deletion or change of library dependencies&lt;br&gt;SCS Manager import (*1)</td>
<td>SCS Manager</td>
</tr>
<tr>
<td>Change of SCS project properties</td>
<td></td>
<td>SCS Project Properties</td>
</tr>
<tr>
<td>Change of SCS constants definitions</td>
<td></td>
<td>SCS Constants Builder</td>
</tr>
<tr>
<td>Acknowledgement by analyzer</td>
<td></td>
<td>Integrity Analyzer, Cross Reference Analyzer</td>
</tr>
<tr>
<td>Database validity check&lt;br&gt;Repair database</td>
<td></td>
<td>Database Validity Check Tool</td>
</tr>
<tr>
<td>POU</td>
<td>Change of POU logic&lt;br&gt;Addition, deletion or change of defined words&lt;br&gt;Addition, deletion or change of variables&lt;br&gt;Addition, deletion or change of parameters&lt;br&gt;Build&lt;br&gt;SCS Manager import (*1)</td>
<td>SCS Manager</td>
</tr>
<tr>
<td>Acknowledgement by analyzer</td>
<td></td>
<td>Integrity Analyzer, Cross Reference Analyzer</td>
</tr>
<tr>
<td>Database validity check&lt;br&gt;Repair database</td>
<td></td>
<td>Database Validity Check Tool</td>
</tr>
<tr>
<td>I/O</td>
<td>Addition, deletion or change of I/O devices&lt;br&gt;Addition, deletion or change of I/O wiring&lt;br&gt;Build&lt;br&gt;SCS Manager import (*1)</td>
<td>SCS Manager</td>
</tr>
<tr>
<td>Change of I/O parameter definitions</td>
<td></td>
<td>I/O Parameter Builder</td>
</tr>
<tr>
<td>Acknowledgement by analyzer</td>
<td></td>
<td>Integrity Analyzer, Cross Reference Analyzer</td>
</tr>
<tr>
<td>Database validity check&lt;br&gt;Repair database</td>
<td></td>
<td>Database Validity Check Tool</td>
</tr>
</tbody>
</table>

Continues on the next page
<table>
<thead>
<tr>
<th>Category</th>
<th>Operation Description</th>
<th>Operation Program Tool</th>
</tr>
</thead>
<tbody>
<tr>
<td>Safety Communication</td>
<td>Addition, deletion or change of external bindings Build</td>
<td>SCS Manager</td>
</tr>
<tr>
<td></td>
<td>Change of SCS link transmission definitions</td>
<td>SCS Link Transmission Builder</td>
</tr>
<tr>
<td></td>
<td>Acknowledgement by analyzer</td>
<td>Integrity Analyzer, Cross Reference Analyzer</td>
</tr>
<tr>
<td></td>
<td>Database validity check</td>
<td>Database Validity Check Tool</td>
</tr>
<tr>
<td></td>
<td>Repair database</td>
<td></td>
</tr>
<tr>
<td>External Communication</td>
<td>Change of tag name definitions</td>
<td>Tag Name Builder</td>
</tr>
<tr>
<td></td>
<td>Change of communication I/O definitions</td>
<td>Communication I/O Builder</td>
</tr>
<tr>
<td></td>
<td>Change of modbus address definitions</td>
<td>Modbus Address Builder</td>
</tr>
<tr>
<td></td>
<td>Change of DNP3 communication definitions</td>
<td>DNP3 Communication Builder</td>
</tr>
<tr>
<td></td>
<td>Build</td>
<td>SCS Manager</td>
</tr>
<tr>
<td></td>
<td>Acknowledgement by analyzer</td>
<td>Integrity Analyzer, Cross Reference Analyzer</td>
</tr>
<tr>
<td></td>
<td>Database validity check</td>
<td>Database Validity Check Tool</td>
</tr>
<tr>
<td></td>
<td>Repair database</td>
<td></td>
</tr>
<tr>
<td>CENTUM Alarm Definition</td>
<td>Change of alarm priority definitions</td>
<td>Alarm Priority Builder</td>
</tr>
<tr>
<td></td>
<td>Change of alarm processing table definitions</td>
<td>Alarm Processing Table Builder</td>
</tr>
<tr>
<td></td>
<td>Build</td>
<td>SCS Manager</td>
</tr>
<tr>
<td></td>
<td>Acknowledgement by analyzer</td>
<td>Integrity Analyzer, Cross Reference Analyzer</td>
</tr>
<tr>
<td></td>
<td>Database validity check</td>
<td>Database Validity Check Tool</td>
</tr>
<tr>
<td></td>
<td>Repair database</td>
<td></td>
</tr>
<tr>
<td>Version Control Check In</td>
<td>Version control check in</td>
<td>Version Control Tool</td>
</tr>
<tr>
<td>Version Control Check Out</td>
<td>Version control check out</td>
<td>Version Control Tool</td>
</tr>
<tr>
<td>Master Database Restore</td>
<td>Restoration of master database</td>
<td>Master Database Restoring Function</td>
</tr>
</tbody>
</table>

*1: The SCS Manager import operation can be performed only when the user has access rights for the General Setting, POU and I/O categories.
<table>
<thead>
<tr>
<th>Category</th>
<th>Operation Description</th>
<th>Operation Program/ Tool</th>
</tr>
</thead>
<tbody>
<tr>
<td>Offline Download</td>
<td>Build</td>
<td>SCS Manager</td>
</tr>
<tr>
<td></td>
<td>Master database offline download</td>
<td>Master Database Offline Download</td>
</tr>
<tr>
<td></td>
<td>SCS restart</td>
<td>Restart SCS</td>
</tr>
<tr>
<td></td>
<td>SCS security level setting, password change</td>
<td>Set SCS Security Level</td>
</tr>
<tr>
<td></td>
<td>Acknowledgement by analyzer</td>
<td>Integrity Analyzer, Cross Reference Analyzer</td>
</tr>
<tr>
<td></td>
<td>Database validity check</td>
<td>Database Validity Check Tool</td>
</tr>
<tr>
<td></td>
<td>Repair database</td>
<td></td>
</tr>
<tr>
<td>Online Change Download</td>
<td>Build</td>
<td>SCS Manager</td>
</tr>
<tr>
<td></td>
<td>Download operation marks</td>
<td>Download Operation Marks</td>
</tr>
<tr>
<td></td>
<td>SCS security level setting, password change</td>
<td>Set SCS Security Level</td>
</tr>
<tr>
<td></td>
<td>Acknowledgement by analyzer</td>
<td>Integrity Analyzer, Cross Reference Analyzer</td>
</tr>
<tr>
<td></td>
<td>Database validity check</td>
<td>Database Validity Check Tool</td>
</tr>
<tr>
<td></td>
<td>Repair database</td>
<td></td>
</tr>
<tr>
<td>Operation Mark Save</td>
<td>Save operation marks</td>
<td>Save Operation Marks</td>
</tr>
<tr>
<td>SCS Simulator</td>
<td>Start test function</td>
<td>SCS Test Function</td>
</tr>
<tr>
<td></td>
<td>Update test database</td>
<td>Update Test Database</td>
</tr>
<tr>
<td></td>
<td>Build</td>
<td>SCS Manager</td>
</tr>
<tr>
<td></td>
<td>SCS security level setting, password change</td>
<td>Set SCS Security Level</td>
</tr>
<tr>
<td></td>
<td>Acknowledgement by analyzer</td>
<td>Integrity Analyzer, Cross Reference Analyzer</td>
</tr>
<tr>
<td></td>
<td>Database validity check</td>
<td>Database Validity Check Tool</td>
</tr>
<tr>
<td></td>
<td>Repair database</td>
<td></td>
</tr>
<tr>
<td>Debug</td>
<td>Start logic simulation, start debug mode</td>
<td>SCS Manager</td>
</tr>
<tr>
<td>Forcing</td>
<td>Forcing (lock, unlock, value setting)</td>
<td>SCS Manager I/O Lock Window, Communication I/O Lock Window, SCS Link Transmission Lock Window, Inter-SCS Communication Lock Window</td>
</tr>
<tr>
<td></td>
<td>SCS security level setting, password change</td>
<td>Set SCS Security Level</td>
</tr>
<tr>
<td>Maintenance</td>
<td>Output enable operation, output module start, IOM download, time setting</td>
<td>SCS State Management Window</td>
</tr>
<tr>
<td></td>
<td>Confirm display fonts, colors and messages, set and change deletion operation method</td>
<td>Setup Tool</td>
</tr>
<tr>
<td></td>
<td>IOM control right switching</td>
<td>I/O Control Right Switching Tool</td>
</tr>
</tbody>
</table>

Continues on the next page
<table>
<thead>
<tr>
<th>Category</th>
<th>Operation Description</th>
<th>Operation Program/ Tool</th>
</tr>
</thead>
<tbody>
<tr>
<td>Diagnosis Acknowledgment</td>
<td>Acknowledgment and deletion of diagnostic information message</td>
<td>Diagnostic Information</td>
</tr>
<tr>
<td>Message Cache</td>
<td>Operations such as setting up message collection, initializing trip information in SCS, saving or deleting cache data Stopping and starting of automatic message acquisition</td>
<td>Message Cache Tool</td>
</tr>
</tbody>
</table>
16.5.3 Information Recorded in Operation Logs

The following information is recorded in one operation log.

Table 16.5.3-1 Structure Of Operation Logs

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Serial number (*1) Unique identifier corresponding to one operation (8-digit hexadecimal number).</td>
</tr>
<tr>
<td>2</td>
<td>Date/time (*1) Date and time the operation was executed.</td>
</tr>
<tr>
<td>3</td>
<td>Computer name SENG PC name on which the operation was executed.</td>
</tr>
<tr>
<td>4</td>
<td>Windows user name Windows user name at the time the operation was executed.</td>
</tr>
<tr>
<td>5</td>
<td>Engineer name (*1) Name of the engineer who executed the operation.</td>
</tr>
<tr>
<td>6</td>
<td>Name Name of the person corresponding to the engineer who executed the operation. (Character string entry in &quot;Printed Name&quot; field of Engineers’ Account Builder)</td>
</tr>
<tr>
<td>7</td>
<td>Program name Name of the program that executed the operation.</td>
</tr>
<tr>
<td>8</td>
<td>Operation name (*1) Executed operation.</td>
</tr>
<tr>
<td>9</td>
<td>Object of operation(*1) Target of executed operation.</td>
</tr>
<tr>
<td>10</td>
<td>Reason (*1) Character string (1 line) input as &quot;Reason&quot; in Engineer Authentication dialog box.</td>
</tr>
<tr>
<td>11</td>
<td>Result of operation Contents output to the message area as the result of operation (multiple lines).</td>
</tr>
</tbody>
</table>

*1: These items are displayed in the operation log list of the Operation History Database Viewer. Other items can be browsed on the detailed information display.

Operation Log Information Lists

Here, the information recorded in operation logs is listed by operation type.

The following are the notes on the items omitted in the following tables.

- "Serial Number," "Date/Time" and "Computer Name" are always recorded in every operation log entry.
- For the operations for which engineer names are recorded, the name of the person corresponding to the engineer name is always recorded in "Name."
- In "Reason," the content entered in the "Reason" field of the Engineer Authentication dialog box is recorded.
- In "Result of Operation," the contents displayed in the message area of SCS Manager, builder, or tool are recorded.

Table 16.5.3-2 Operation Log Information List (Operations on Project Database)

<table>
<thead>
<tr>
<th>Operation Name</th>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start SCS Manager (recorded in common operation log database)</td>
<td>Engineer Name</td>
<td>Engineer who executed the operation</td>
</tr>
<tr>
<td></td>
<td>Program Name</td>
<td>SCS Manager</td>
</tr>
<tr>
<td></td>
<td>Operation Name</td>
<td>Start SCS Manager (Log on)</td>
</tr>
<tr>
<td></td>
<td>Object of Operation</td>
<td>-</td>
</tr>
</tbody>
</table>

Continues on the next page
<table>
<thead>
<tr>
<th>Operation Name</th>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Close SCS Manager</td>
<td>Engineer Name</td>
<td>Engineer who executed the operation</td>
</tr>
<tr>
<td>(recorded in common operation log database)</td>
<td>Program Name</td>
<td>SCS Manager</td>
</tr>
<tr>
<td></td>
<td>Operation Name</td>
<td>Terminate SCS Manager (Log off)</td>
</tr>
<tr>
<td></td>
<td>Object of Operation</td>
<td>SCS Project Path Name or Library Path Name Example: C:\RS-Projects\MYRSPJT\SCS0101</td>
</tr>
<tr>
<td>Create new SCS project</td>
<td>Engineer Name</td>
<td>Engineer who executed the operation</td>
</tr>
<tr>
<td></td>
<td>Program Name</td>
<td>SCS Manager</td>
</tr>
<tr>
<td></td>
<td>Operation Name</td>
<td>Create Project</td>
</tr>
<tr>
<td></td>
<td>Object of Operation</td>
<td>SCS Project Path Name or Library Path Name Example: C:\RS-Projects\MYRSPJT\SCS0101</td>
</tr>
<tr>
<td>Open SCS project</td>
<td>Engineer Name</td>
<td>Engineer who executed the operation</td>
</tr>
<tr>
<td></td>
<td>Program Name</td>
<td>SCS Manager</td>
</tr>
<tr>
<td></td>
<td>Operation Name</td>
<td>Open Project</td>
</tr>
<tr>
<td></td>
<td>Object of Operation</td>
<td>SCS Project Path Name or Library Path Name Example: C:\RS-Projects\MYRSPJT\SCS0101</td>
</tr>
<tr>
<td>Save project</td>
<td>Engineer Name</td>
<td>Engineer who executed the operation</td>
</tr>
<tr>
<td></td>
<td>Program Name</td>
<td>SCS Manager</td>
</tr>
<tr>
<td></td>
<td>Operation Name</td>
<td>Save Project</td>
</tr>
<tr>
<td></td>
<td>Object of Operation</td>
<td>SCS Project Path Name or Library Path Name Example: C:\RS-Projects\MYRSPJT\SCS0101</td>
</tr>
<tr>
<td>Import by SCS Manager</td>
<td>Engineer Name</td>
<td>Engineer who executed the operation</td>
</tr>
<tr>
<td></td>
<td>Program Name</td>
<td>SCS Manager</td>
</tr>
<tr>
<td></td>
<td>Operation Name</td>
<td>Import</td>
</tr>
<tr>
<td></td>
<td>Object of Operation</td>
<td>SCS Project Path Name or Library Path Name Example: C:\RS-Projects\MYRSPJT\SCS0101</td>
</tr>
<tr>
<td>Save dictionary</td>
<td>Engineer Name</td>
<td>Engineer who executed the operation</td>
</tr>
<tr>
<td></td>
<td>Program Name</td>
<td>SCS Manager</td>
</tr>
<tr>
<td></td>
<td>Operation Name</td>
<td>Save Dictionary</td>
</tr>
<tr>
<td></td>
<td>Object of Operation</td>
<td>SCS Project Path Name or Library Path Name Example: C:\RS-Projects\MYRSPJT\SCS0101</td>
</tr>
</tbody>
</table>

Continues on the next page
<table>
<thead>
<tr>
<th>Operation Name</th>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save I/O wiring</td>
<td>Engineer Name</td>
<td>Engineer who executed the operation</td>
</tr>
<tr>
<td>Program Name</td>
<td>SCS Manager</td>
<td></td>
</tr>
<tr>
<td>Operation Name</td>
<td>Save I/O wiring</td>
<td></td>
</tr>
<tr>
<td>Object of Operation</td>
<td>SCS Project Path Name</td>
<td>Example: C:\RS-Projects\MYRSPJT\SCS0101</td>
</tr>
<tr>
<td>Save binding list</td>
<td>Engineer Name</td>
<td>Engineer who executed the operation</td>
</tr>
<tr>
<td>Program Name</td>
<td>SCS Manager</td>
<td></td>
</tr>
<tr>
<td>Operation Name</td>
<td>Save external binding list</td>
<td></td>
</tr>
<tr>
<td>Object of Operation</td>
<td>SCS Project Path Name</td>
<td>Example: C:\RS-Projects\MYRSPJT\SCS0101</td>
</tr>
<tr>
<td>Save library dependencies</td>
<td>Engineer Name</td>
<td>Engineer who executed the operation</td>
</tr>
<tr>
<td>Program Name</td>
<td>SCS Manager</td>
<td></td>
</tr>
<tr>
<td>Operation Name</td>
<td>Save dependencies</td>
<td></td>
</tr>
<tr>
<td>Object of Operation</td>
<td>SCS Project Path Name</td>
<td>Example: C:\RS-Projects\MYRSPJT\SCS0101</td>
</tr>
<tr>
<td>Open POU</td>
<td>Engineer Name</td>
<td>Engineer who executed the operation</td>
</tr>
<tr>
<td>Program Name</td>
<td>Multi Language Editor</td>
<td></td>
</tr>
<tr>
<td>Operation Name</td>
<td>Open POU</td>
<td></td>
</tr>
<tr>
<td>Object of Operation</td>
<td>POU name example: PROG01</td>
<td></td>
</tr>
<tr>
<td>Save POU</td>
<td>Engineer Name</td>
<td>Engineer who executed the operation</td>
</tr>
<tr>
<td>Program Name</td>
<td>Multi Language Editor</td>
<td></td>
</tr>
<tr>
<td>Operation Name</td>
<td>Save POU</td>
<td></td>
</tr>
<tr>
<td>Object of Operation</td>
<td>POU name example: PROG01</td>
<td></td>
</tr>
<tr>
<td>Open by builder</td>
<td>Engineer Name</td>
<td>Engineer who executed the operation</td>
</tr>
<tr>
<td>Program Name</td>
<td>Builder name example: Tag Name Builder</td>
<td></td>
</tr>
<tr>
<td>Operation Name</td>
<td>Open Builder</td>
<td></td>
</tr>
<tr>
<td>Object of Operation</td>
<td>Target data example: Tag Name</td>
<td></td>
</tr>
</tbody>
</table>
### Table 16.5.3-2 Operation Log Information List (Operations on Project Database) (Table continued)

<table>
<thead>
<tr>
<th>Operation Name</th>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save by builder</td>
<td>Engineer Name</td>
<td>Engineer who executed the operation</td>
</tr>
<tr>
<td></td>
<td>Program Name</td>
<td>Builder name example: Tag Name Builder</td>
</tr>
<tr>
<td></td>
<td>Operation Name</td>
<td>Save Builder</td>
</tr>
<tr>
<td></td>
<td>Object of Operation</td>
<td>Target data example: Tag Name</td>
</tr>
<tr>
<td>Change SCS project properties</td>
<td>Engineer Name</td>
<td>Engineer who executed the operation</td>
</tr>
<tr>
<td></td>
<td>Program Name</td>
<td>SCS Manager</td>
</tr>
<tr>
<td></td>
<td>Operation Name</td>
<td>Change SCS Project Properties</td>
</tr>
<tr>
<td></td>
<td>Object of Operation</td>
<td>SCS Project Path Name or Library Path Name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Example: C:\RS-Projects\MYRSPJT\SCS0101</td>
</tr>
<tr>
<td>Build</td>
<td>Engineer Name</td>
<td>Engineer who executed the operation</td>
</tr>
<tr>
<td></td>
<td>Program Name</td>
<td>SCS Manager</td>
</tr>
<tr>
<td></td>
<td>Operation Name</td>
<td>Build Project</td>
</tr>
<tr>
<td></td>
<td>Object of Operation</td>
<td>SCS Project Path Name or Library Path Name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Example: C:\RS-Projects\MYRSPJT\SCS0101</td>
</tr>
<tr>
<td>Clean</td>
<td>Engineer Name</td>
<td>Engineer who executed the operation</td>
</tr>
<tr>
<td></td>
<td>Program Name</td>
<td>SCS Manager</td>
</tr>
<tr>
<td></td>
<td>Operation Name</td>
<td>Clean Project</td>
</tr>
<tr>
<td></td>
<td>Object of Operation</td>
<td>SCS Project Path Name or Library Path Name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Example: C:\RS-Projects\MYRSPJT\SCS0101</td>
</tr>
<tr>
<td>Save analyzer's results</td>
<td>Engineer Name</td>
<td>Engineer who executed the operation</td>
</tr>
<tr>
<td></td>
<td>Program Name</td>
<td>Analyzer name example: Integrity Analyzer</td>
</tr>
<tr>
<td></td>
<td>Operation Name</td>
<td>Save Analysis</td>
</tr>
<tr>
<td></td>
<td>Object of Operation</td>
<td>SCS Project Path Name or Library Path Name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Example: C:\RS-Projects\MYRSPJT\SCS0101</td>
</tr>
<tr>
<td>Start document generator</td>
<td>Engineer Name</td>
<td>Engineer who executed the operation</td>
</tr>
<tr>
<td></td>
<td>Program Name</td>
<td>SCS Manager</td>
</tr>
<tr>
<td></td>
<td>Operation Name</td>
<td>Start Document Generator</td>
</tr>
<tr>
<td></td>
<td>Object of Operation</td>
<td>SCS Project Path Name or Library Path Name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Example: C:\RS-Projects\MYRSPJT\SCS0101</td>
</tr>
</tbody>
</table>

Continues on the next page
Table 16.5.3-2 Operation Log Information List (Operations on Project Database) (Table continued)

<table>
<thead>
<tr>
<th>Operation Name</th>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start master database restoring function (recorded in common operation log database)</td>
<td>Engineer Name</td>
<td>Engineer who executed the operation</td>
</tr>
<tr>
<td></td>
<td>Program Name</td>
<td>Master Database Restoring Function</td>
</tr>
<tr>
<td></td>
<td>Operation Name</td>
<td>Start Master Database Restoring Function (Log on)</td>
</tr>
<tr>
<td></td>
<td>Object of Operation</td>
<td>-</td>
</tr>
<tr>
<td>Close master database restoring function (recorded in common operation log database)</td>
<td>Engineer Name</td>
<td>Engineer who executed the operation</td>
</tr>
<tr>
<td></td>
<td>Program Name</td>
<td>IOM Control Right Switching Tool</td>
</tr>
<tr>
<td></td>
<td>Operation Name</td>
<td>Terminate Master Database Restoring Function (Log off)</td>
</tr>
<tr>
<td></td>
<td>Object of Operation</td>
<td>-</td>
</tr>
<tr>
<td>Restore master database</td>
<td>Engineer Name</td>
<td>Engineer who executed the operation</td>
</tr>
<tr>
<td></td>
<td>Program Name</td>
<td>Master Database Restoring Function</td>
</tr>
<tr>
<td></td>
<td>Operation Name</td>
<td>Restore Master Database</td>
</tr>
<tr>
<td></td>
<td>Object of Operation</td>
<td>SCS Project Path Name Example: C:\RS-Projects\MYRSPJT\SCS0101</td>
</tr>
<tr>
<td>Start version control tool (recorded in common operation log database)</td>
<td>Engineer Name</td>
<td>Engineer who executed the operation</td>
</tr>
<tr>
<td></td>
<td>Program Name</td>
<td>Version Control Tool</td>
</tr>
<tr>
<td></td>
<td>Operation Name</td>
<td>Start Version Control Tool (Log on)</td>
</tr>
<tr>
<td></td>
<td>Object of Operation</td>
<td>-</td>
</tr>
<tr>
<td>Close version control tool (recorded in common operation log database)</td>
<td>Engineer Name</td>
<td>Engineer who executed the operation</td>
</tr>
<tr>
<td></td>
<td>Program Name</td>
<td>Version Control Tool</td>
</tr>
<tr>
<td></td>
<td>Operation Name</td>
<td>Terminate Version Control Tool (Log off)</td>
</tr>
<tr>
<td></td>
<td>Object of Operation</td>
<td>-</td>
</tr>
<tr>
<td>Check in to version control</td>
<td>Engineer Name</td>
<td>Engineer who executed the operation</td>
</tr>
<tr>
<td></td>
<td>Program Name</td>
<td>Version Control Tool</td>
</tr>
<tr>
<td></td>
<td>Operation Name</td>
<td>Check In</td>
</tr>
<tr>
<td></td>
<td>Object of Operation</td>
<td>SCS Project Path Name Example: C:\RS-Projects\MYRSPJT\SCS0101</td>
</tr>
</tbody>
</table>
### Table 16.5.3-2 Operation Log Information List (Operations on Project Database) (Table continued)

<table>
<thead>
<tr>
<th>Operation Name</th>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check out from version control</td>
<td>Engineer Name</td>
<td>Engineer who executed the operation</td>
</tr>
<tr>
<td></td>
<td>Program Name</td>
<td>Version Control Tool</td>
</tr>
<tr>
<td></td>
<td>Operation Name</td>
<td>Check Out</td>
</tr>
<tr>
<td></td>
<td>Object of Operation</td>
<td>SCS Project Path Name Example: C:\RS-Projects\MYRSPJT\SCS0101</td>
</tr>
</tbody>
</table>

### Table 16.5.3-3 Operation Log Recorded Information List (Operations on SCS)

<table>
<thead>
<tr>
<th>Operation Name</th>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Offline download</td>
<td>Engineer Name</td>
<td>Engineer who executed the operation</td>
</tr>
<tr>
<td></td>
<td>Program Name</td>
<td>SCS Manager</td>
</tr>
<tr>
<td></td>
<td>Operation Name</td>
<td>Offline Download</td>
</tr>
<tr>
<td></td>
<td>Object of Operation</td>
<td>SCS Project Path Name Example: C:\RS-Projects\MYRSPJT\SCS0101</td>
</tr>
<tr>
<td>Master offline download</td>
<td>Engineer Name</td>
<td>Engineer who executed the operation</td>
</tr>
<tr>
<td></td>
<td>Program Name</td>
<td>SCS Manager</td>
</tr>
<tr>
<td></td>
<td>Operation Name</td>
<td>Master Database Offline Download</td>
</tr>
<tr>
<td></td>
<td>Object of Operation</td>
<td>SCS Project Path Name Example: C:\RS-Projects\MYRSPJT\SCS0101</td>
</tr>
<tr>
<td>Online change download</td>
<td>Engineer Name</td>
<td>Engineer who executed the operation</td>
</tr>
<tr>
<td></td>
<td>Program Name</td>
<td>SCS Manager</td>
</tr>
<tr>
<td></td>
<td>Operation Name</td>
<td>Online Change Download</td>
</tr>
<tr>
<td></td>
<td>Object of Operation</td>
<td>SCS Project Path Name Example: C:\RS-Projects\MYRSPJT\SCS0101</td>
</tr>
<tr>
<td>Restart SCS</td>
<td>Engineer Name</td>
<td>Engineer who executed the operation</td>
</tr>
<tr>
<td></td>
<td>Program Name</td>
<td>SCS Manager</td>
</tr>
<tr>
<td></td>
<td>Operation Name</td>
<td>Restart SCS</td>
</tr>
<tr>
<td></td>
<td>Object of Operation</td>
<td>SCS Project Path Name Example: C:\RS-Projects\MYRSPJT\SCS0101</td>
</tr>
</tbody>
</table>

Continues on the next page
<table>
<thead>
<tr>
<th>Operation Name</th>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save operation marks</td>
<td>Engineer Name</td>
<td>Engineer who executed the operation</td>
</tr>
<tr>
<td></td>
<td>Program Name</td>
<td>SCS Manager</td>
</tr>
<tr>
<td></td>
<td>Operation Name</td>
<td>Save Operation Marks</td>
</tr>
<tr>
<td></td>
<td>Object of Operation</td>
<td>SCS Project Path Name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Example: C:\RS-Projects\MYRSPJT\SCS0101</td>
</tr>
<tr>
<td>Download operation</td>
<td>Engineer Name</td>
<td>Engineer who executed the operation</td>
</tr>
<tr>
<td>marks</td>
<td>Program Name</td>
<td>SCS Manager</td>
</tr>
<tr>
<td></td>
<td>Operation Name</td>
<td>Download Operation Marks</td>
</tr>
<tr>
<td></td>
<td>Object of Operation</td>
<td>SCS Project Path Name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Example: C:\RS-Projects\MYRSPJT\SCS0101</td>
</tr>
<tr>
<td>Start debug mode</td>
<td>Engineer Name</td>
<td>Engineer who executed the operation</td>
</tr>
<tr>
<td></td>
<td>Program Name</td>
<td>Example: SCS Manager</td>
</tr>
<tr>
<td></td>
<td>Operation Name</td>
<td>Start Debug</td>
</tr>
<tr>
<td></td>
<td>Object of Operation</td>
<td>SCS Project Path Name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Example: C:\RS-Projects\MYRSPJT\SCS0101</td>
</tr>
<tr>
<td>Exit debug mode</td>
<td>Engineer Name</td>
<td>Engineer who executed the operation</td>
</tr>
<tr>
<td></td>
<td>Program Name</td>
<td>Example: SCS Manager</td>
</tr>
<tr>
<td></td>
<td>Operation Name</td>
<td>Stop Debug</td>
</tr>
<tr>
<td></td>
<td>Object of Operation</td>
<td>SCS Project Path Name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Example: C:\RS-Projects\MYRSPJT\SCS0101</td>
</tr>
<tr>
<td>Start logic simulation</td>
<td>Engineer Name</td>
<td>Engineer who executed the operation</td>
</tr>
<tr>
<td></td>
<td>Program Name</td>
<td>Example: SCS Manager</td>
</tr>
<tr>
<td></td>
<td>Operation Name</td>
<td>Start Simulation</td>
</tr>
<tr>
<td></td>
<td>Object of Operation</td>
<td>SCS Project Path Name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Example: C:\RS-Projects\MYRSPJT\SCS0101</td>
</tr>
<tr>
<td>Close logic simulation</td>
<td>Engineer Name</td>
<td>Engineer who executed the operation</td>
</tr>
<tr>
<td></td>
<td>Program Name</td>
<td>Example: SCS Manager</td>
</tr>
<tr>
<td></td>
<td>Operation Name</td>
<td>Stop Simulation</td>
</tr>
<tr>
<td></td>
<td>Object of Operation</td>
<td>SCS Project Path Name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Example: C:\RS-Projects\MYRSPJT\SCS0101</td>
</tr>
</tbody>
</table>

Continues on the next page
<table>
<thead>
<tr>
<th>Operation Name</th>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start test function</td>
<td>Engineer Name</td>
<td>Engineer who executed the operation</td>
</tr>
<tr>
<td>Program Name</td>
<td>SCS Manager</td>
<td></td>
</tr>
<tr>
<td>Operation Name</td>
<td>SCS Test Function</td>
<td></td>
</tr>
<tr>
<td>Object of Operation</td>
<td>SCS Project Path Name Example: C:\RS-Projects\MYRSPJT\SCS0101</td>
<td></td>
</tr>
<tr>
<td>Update test database</td>
<td>Engineer Name</td>
<td>Engineer who executed the operation</td>
</tr>
<tr>
<td>Program Name</td>
<td>SCS Manager</td>
<td></td>
</tr>
<tr>
<td>Operation Name</td>
<td>Update SCS Test Database</td>
<td></td>
</tr>
<tr>
<td>Object of Operation</td>
<td>SCS Project Path Name Example: C:\RS-Projects\MYRSPJT\SCS0101</td>
<td></td>
</tr>
<tr>
<td>Database validity check</td>
<td>Engineer Name</td>
<td>Engineer who executed the operation</td>
</tr>
<tr>
<td>Program Name</td>
<td>Database Validity Check Tool</td>
<td></td>
</tr>
<tr>
<td>Operation Name</td>
<td>Check Database Validity</td>
<td></td>
</tr>
<tr>
<td>Object of Operation</td>
<td>SCS Project Path Name Example: C:\RS-Projects\MYRSPJT\SCS0101</td>
<td></td>
</tr>
<tr>
<td>Repair database</td>
<td>Engineer Name</td>
<td>Engineer who executed the operation</td>
</tr>
<tr>
<td>Program Name</td>
<td>Database Validity Check Tool</td>
<td></td>
</tr>
<tr>
<td>Operation Name</td>
<td>Repair Database</td>
<td></td>
</tr>
<tr>
<td>Object of Operation</td>
<td>SCS Project Path Name Example: C:\RS-Projects\MYRSPJT\SCS0101</td>
<td></td>
</tr>
<tr>
<td>Start SCS Status Overview window (recorded in common operation log database)</td>
<td>Engineer Name</td>
<td>Engineer who executed the operation</td>
</tr>
<tr>
<td>Program Name</td>
<td>SCS Status Overview Window</td>
<td></td>
</tr>
<tr>
<td>Operation Name</td>
<td>Open SCS Status Overview Window (Log on)</td>
<td></td>
</tr>
<tr>
<td>Object of Operation</td>
<td>RS Project Path Name Example: C:\RS-Projects\MYRSPJT</td>
<td></td>
</tr>
<tr>
<td>Close SCS Status Overview window (recorded in common operation log database)</td>
<td>Engineer Name</td>
<td>Engineer who executed the operation</td>
</tr>
<tr>
<td>Program Name</td>
<td>SCS Status Overview Window</td>
<td></td>
</tr>
<tr>
<td>Operation Name</td>
<td>Close SCS Status Overview Window (Log off)</td>
<td></td>
</tr>
<tr>
<td>Object of Operation</td>
<td>RS Project Path Name Example: C:\RS-Projects\MYRSPJT</td>
<td></td>
</tr>
</tbody>
</table>

*Continues on the next page*
<table>
<thead>
<tr>
<th>Operation Name</th>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start SCS State Management window</td>
<td>Engineer Name</td>
<td>Engineer who executed the operation</td>
</tr>
<tr>
<td></td>
<td>Program Name</td>
<td>SCS State Management Window</td>
</tr>
<tr>
<td></td>
<td>Operation Name</td>
<td>Open SCS State Management Window</td>
</tr>
<tr>
<td></td>
<td>Object of Operation</td>
<td>SCS Project Path Name Example: C:\RS-Projects\MYRSPJT\SCS0101</td>
</tr>
<tr>
<td>Close SCS State Management window</td>
<td>Engineer Name</td>
<td>Engineer who executed the operation</td>
</tr>
<tr>
<td></td>
<td>Program Name</td>
<td>SCS State Management Window</td>
</tr>
<tr>
<td></td>
<td>Operation Name</td>
<td>Close SCS State Management Window (Log off)</td>
</tr>
<tr>
<td></td>
<td>Object of Operation</td>
<td>SCS Project Path Name Example: C:\RS-Projects\MYRSPJT\SCS0101</td>
</tr>
<tr>
<td>Change SCS security level</td>
<td>Engineer Name</td>
<td>Engineer who executed the operation</td>
</tr>
<tr>
<td></td>
<td>Program Name</td>
<td>SCS Manager</td>
</tr>
<tr>
<td></td>
<td>Operation Name</td>
<td>Change SCS Security Level</td>
</tr>
<tr>
<td></td>
<td>Object of Operation</td>
<td>SCS Project Path Name Example: C:\RS-Projects\MYRSPJT\SCS0101</td>
</tr>
<tr>
<td>Change security level password</td>
<td>Engineer Name</td>
<td>Engineer who executed the operation</td>
</tr>
<tr>
<td></td>
<td>Program Name</td>
<td>SCS Manager</td>
</tr>
<tr>
<td></td>
<td>Operation Name</td>
<td>Change SCS Security Password</td>
</tr>
<tr>
<td></td>
<td>Object of Operation</td>
<td>SCS Project Path Name Example: C:\RS-Projects\MYRSPJT\SCS0101</td>
</tr>
<tr>
<td>Lock</td>
<td>Engineer Name</td>
<td>Engineer who executed the operation</td>
</tr>
<tr>
<td></td>
<td>Program Name</td>
<td>SCS Manager or Lock Window Name Example: SCS Manager</td>
</tr>
<tr>
<td></td>
<td>Operation Name</td>
<td>Lock</td>
</tr>
<tr>
<td></td>
<td>Object of Operation</td>
<td>SCS Project Path Name Example: C:\RS-Projects\MYRSPJT\SCS0101</td>
</tr>
<tr>
<td>Unlock</td>
<td>Engineer Name</td>
<td>Engineer who executed the operation</td>
</tr>
<tr>
<td></td>
<td>Program Name</td>
<td>SCS Manager or Lock Window Name Example: SCS Manager</td>
</tr>
<tr>
<td></td>
<td>Operation Name</td>
<td>Unlock</td>
</tr>
<tr>
<td></td>
<td>Object of Operation</td>
<td>SCS Project Path Name Example: C:\RS-Projects\MYRSPJT\SCS0101</td>
</tr>
<tr>
<td>Operation Name</td>
<td>Item</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>---------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Set values</td>
<td>Engineer Name</td>
<td>Engineer who executed the operation</td>
</tr>
<tr>
<td>Program Name</td>
<td>SCS Manager or Lock Window Name Example: SCS Manager</td>
<td></td>
</tr>
<tr>
<td>Operation Name</td>
<td>Set Value</td>
<td></td>
</tr>
<tr>
<td>Object of Operation</td>
<td>SCS Project Path Name Example: C:\RS-Projects\MYRSPJT\SCS0101</td>
<td></td>
</tr>
<tr>
<td>Enable output</td>
<td>Engineer Name</td>
<td>Engineer who executed the operation</td>
</tr>
<tr>
<td>Program Name</td>
<td>SCS State Management Window</td>
<td></td>
</tr>
<tr>
<td>Operation Name</td>
<td>Output Enable</td>
<td></td>
</tr>
<tr>
<td>Object of Operation</td>
<td>SCS Project Path Name Example: C:\RS-Projects\MYRSPJT\SCS0101</td>
<td></td>
</tr>
<tr>
<td>Start output module</td>
<td>Engineer Name</td>
<td>Engineer who executed the operation</td>
</tr>
<tr>
<td>Program Name</td>
<td>SCS State Management Window</td>
<td></td>
</tr>
<tr>
<td>Operation Name</td>
<td>Start Output Modules</td>
<td></td>
</tr>
<tr>
<td>Object of Operation</td>
<td>SCS Project Path Name Example: C:\RS-Projects\MYRSPJT\SCS0101</td>
<td></td>
</tr>
<tr>
<td>IOM download</td>
<td>Engineer Name</td>
<td>Engineer who executed the operation</td>
</tr>
<tr>
<td>Program Name</td>
<td>SCS State Management Window</td>
<td></td>
</tr>
<tr>
<td>Operation Name</td>
<td>IOM Download</td>
<td></td>
</tr>
<tr>
<td>Object of Operation</td>
<td>SCS Project Path Name Example: C:\RS-Projects\MYRSPJT\SCS0101</td>
<td></td>
</tr>
<tr>
<td>Time setting (recorded in common operation log database)</td>
<td>Engineer Name</td>
<td>Engineer who executed the operation</td>
</tr>
<tr>
<td>Program Name</td>
<td>Adjust Time Window</td>
<td></td>
</tr>
<tr>
<td>Operation Name</td>
<td>Time Setup</td>
<td></td>
</tr>
<tr>
<td>Object of Operation</td>
<td>RS Project Path Name Example: C:\RS-Projects\MYRSPJT</td>
<td></td>
</tr>
<tr>
<td>Acknowledge/delete diagnostic information messages</td>
<td>Engineer Name</td>
<td>Engineer who executed the operation</td>
</tr>
<tr>
<td>Program Name</td>
<td>Diagnostic Information Window</td>
<td></td>
</tr>
<tr>
<td>Operation Name</td>
<td>Diagnosis Acknowledgment</td>
<td></td>
</tr>
<tr>
<td>Object of Operation</td>
<td>SCS Project Path Name Example: C:\RS-Projects\MYRSPJT\SCS0101</td>
<td></td>
</tr>
</tbody>
</table>

Continues on the next page
<table>
<thead>
<tr>
<th>Operation Name</th>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change SCS Maintenance Support Tool settings (recorded in common operation log database)</td>
<td>Engineer Name</td>
<td>Engineer who executed the operation</td>
</tr>
<tr>
<td></td>
<td>Program Name</td>
<td>SCS Maintenance Setup</td>
</tr>
<tr>
<td></td>
<td>Operation Name</td>
<td>Setup SCS Maintenance Window</td>
</tr>
<tr>
<td></td>
<td>Object of Operation</td>
<td>RS Project Path Name Example: C:\RS-Projects\MYRSPJT</td>
</tr>
<tr>
<td>Start IOM Control Right Switching Tool (recorded in common operation log database)</td>
<td>Engineer Name</td>
<td>Engineer who executed the operation</td>
</tr>
<tr>
<td></td>
<td>Program Name</td>
<td>IOM Control Right Switching Tool</td>
</tr>
<tr>
<td></td>
<td>Operation Name</td>
<td>Start IOM Control Right Switching Tool (Log on)</td>
</tr>
<tr>
<td></td>
<td>Object of Operation</td>
<td>-</td>
</tr>
<tr>
<td>Close IOM Control Right Switching Tool (recorded in common operation log database)</td>
<td>Engineer Name</td>
<td>Engineer who executed the operation</td>
</tr>
<tr>
<td></td>
<td>Program Name</td>
<td>IOM Control Right Switching Tool</td>
</tr>
<tr>
<td></td>
<td>Operation Name</td>
<td>Terminate IOM Control Right Switching Tool (Log off)</td>
</tr>
<tr>
<td></td>
<td>Object of Operation</td>
<td>-</td>
</tr>
<tr>
<td>Switch IOM control right</td>
<td>Engineer Name</td>
<td>Engineer who executed the operation</td>
</tr>
<tr>
<td></td>
<td>Program Name</td>
<td>IOM Control Right Switching Tool</td>
</tr>
<tr>
<td></td>
<td>Operation Name</td>
<td>Switch IOM Control Right</td>
</tr>
<tr>
<td></td>
<td>Object of Operation</td>
<td>SCS Project Path Name Example: C:\RS-Projects\MYRSPJT\SCS0101</td>
</tr>
<tr>
<td>Start Message Cache Tool (recorded in common operation log database)</td>
<td>Engineer Name</td>
<td>Engineer who executed the operation</td>
</tr>
<tr>
<td></td>
<td>Program Name</td>
<td>Message Cache Tool</td>
</tr>
<tr>
<td></td>
<td>Operation Name</td>
<td>Start Message Cache Tool (Log on)</td>
</tr>
<tr>
<td></td>
<td>Object of Operation</td>
<td>-</td>
</tr>
<tr>
<td>Close Message Cache Tool (recorded in common operation log database)</td>
<td>Engineer Name</td>
<td>Engineer who executed the operation</td>
</tr>
<tr>
<td></td>
<td>Program Name</td>
<td>Message Cache Tool</td>
</tr>
<tr>
<td></td>
<td>Operation Name</td>
<td>Terminate Message Cache Tool (Log off)</td>
</tr>
<tr>
<td></td>
<td>Object of Operation</td>
<td>-</td>
</tr>
</tbody>
</table>

Continues on the next page
### Table 16.5.3-3 Operation Log Recorded Information List (Operations on SCS) (Table continued)

<table>
<thead>
<tr>
<th>Operation Name</th>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operate Message Cache Tool (initializing trip information)</td>
<td>Engineer Name</td>
<td>Engineer who executed the operation</td>
</tr>
<tr>
<td></td>
<td>Program Name</td>
<td>Message Cache Tool</td>
</tr>
<tr>
<td></td>
<td>Operation Name</td>
<td>Initialize Trip Information</td>
</tr>
<tr>
<td></td>
<td>Object of Operation</td>
<td>SCS name Example: SCS0101</td>
</tr>
<tr>
<td>Pause message acquisition</td>
<td>Engineer Name</td>
<td>Engineer who executed the operation</td>
</tr>
<tr>
<td></td>
<td>Program Name</td>
<td>Message Cache Tool</td>
</tr>
<tr>
<td></td>
<td>Operation Name</td>
<td>Pause Message Acquisition</td>
</tr>
<tr>
<td></td>
<td>Object of Operation</td>
<td>Narrowband group name set by the user Example: Narrowband Group No.1</td>
</tr>
<tr>
<td>Resume message acquisition</td>
<td>Engineer Name</td>
<td>Engineer who executed the operation</td>
</tr>
<tr>
<td></td>
<td>Program Name</td>
<td>Message Cache Tool</td>
</tr>
<tr>
<td></td>
<td>Operation Name</td>
<td>Resume Message Acquisition</td>
</tr>
<tr>
<td></td>
<td>Object of Operation</td>
<td>Narrowband group name set by the user Example: Narrowband Group No.1</td>
</tr>
</tbody>
</table>

### Table 16.5.3-4 Operation Log Recorded Information List (Operations Related to Access Control/Operation History Management)

<table>
<thead>
<tr>
<th>Operation Name</th>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start operation history management (recorded in common and each SCS projects' operation log databases)</td>
<td>Engineer Name</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>Program Name</td>
<td>Operation History Management Setup Tool</td>
</tr>
<tr>
<td></td>
<td>Operation Name</td>
<td>Start Operation History Management</td>
</tr>
<tr>
<td></td>
<td>Object of Operation</td>
<td>RS Project Path Name Example: C:\RS-Projects\MYRSPJT</td>
</tr>
<tr>
<td>Stop operation history management (recorded in common and each SCS projects' operation log databases)</td>
<td>Engineer Name</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>Program Name</td>
<td>Operation History Management Setup Tool</td>
</tr>
<tr>
<td></td>
<td>Operation Name</td>
<td>Pause Operation History Management</td>
</tr>
<tr>
<td></td>
<td>Object of Operation</td>
<td>RS Project Path Name Example: C:\RS-Projects\MYRSPJT</td>
</tr>
<tr>
<td>Operation Name</td>
<td>Item</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------------------------------------------</td>
<td>-------------------------------</td>
<td>----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Exceeded number of authentications (recorded in common operation log database)</td>
<td>Engineer Name</td>
<td>Engineer name entered for logon or engineer authentication</td>
</tr>
<tr>
<td></td>
<td>Program Name</td>
<td>Name of the program for which logon or engineer authentication was attempted</td>
</tr>
<tr>
<td></td>
<td>Operation Name</td>
<td>Authentication Error</td>
</tr>
<tr>
<td></td>
<td>Object of Operation</td>
<td>-</td>
</tr>
<tr>
<td>Local user logon in domain environment (recorded in common operation log database)</td>
<td>Engineer Name</td>
<td>Logged-on engineer name</td>
</tr>
<tr>
<td></td>
<td>Program Name</td>
<td>Logged-on program name</td>
</tr>
<tr>
<td></td>
<td>Operation Name</td>
<td>Local Authentication Detected</td>
</tr>
<tr>
<td></td>
<td>Object of Operation</td>
<td>-</td>
</tr>
<tr>
<td>Record a comment (operation by administrator) (recorded in common operation log database)</td>
<td>Engineer Name</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>Program Name</td>
<td>Operation History Management Setup Tool</td>
</tr>
<tr>
<td></td>
<td>Operation Name</td>
<td>Arbitrary Comment</td>
</tr>
<tr>
<td></td>
<td>Object of Operation</td>
<td>RS Project Path Name Example: C:\RS-Projects\MYRSPJT</td>
</tr>
</tbody>
</table>
Revision Information

Title : Engineering Reference
Manual No. : IM 32Q04B10-31E

Jan. 2015/4th Edition/R3.02.20 or later*

*: Denotes the release number of the Software Product corresponding to the contents of this Manual. The revised contents are valid until the next edition is issued.

All Deleted the descriptions of Windows Server 2003.
Introduction Deleted Safety System document map and changed the notes for protection, safety and modification of this product.
1.1 Changed the table of Engineering Launcher.
1.3 Changed the description of target builders of Builder Environment Tool.
3.1.3 Added the description of DNP3 Slave Function.
4.1 Changed the table of Input/Output modules.
4.3 Added the descriptions of the Mounting Position of Input/Output Module and Setting of Redundancy.

Chapter 10 Added DNP3 communication definition to the printing targets.
Chapter 14 Changed the table of Builders Supporting Import/Export.
Chapter 15 Added the descriptions related to DNP3 Communication Builder.
16.1.3 Changed the table of Access Control/Operation History Management Target Operations.
16.4.2 Changed the table of Types of Modification Files.
16.5.2 Changed the table of Access Rights Category.

October, 2013 / 3rd Edition / R3.02.10 or later

1.2, 3.1.3 Changed figures of SCS Constants Builder.
3.1.3 Changed name from Writing to a "Single holding register" to "16-bit Modbus master support mode" and added descriptions.

Chapter 11 Added descriptions of the database repair function of Database Validity Check Tool and how to operate it. Changed window configuration.
Chapter 16 Added the database repair function and the message acquisition pause/resume functions as the targets of operation history management.

Dec. 2012/2nd Edition/R3.02 or later

4.1, 4.3 Ethernet communication module correspondence.

Aug. 2011/1st Edition/R3.01 or later

Newly published
For Questions and More Information
Online Query: A query form is available on the following URL for online query.
http://www.yokogawa.com/iss

Written by Yokogawa Electric Corporation
Published by Yokogawa Electric Corporation
2-9-32 Nakacho, Musashino-shi, Tokyo 180-8750, JAPAN